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Introduction
This guide describes each feature of Siebel Field Service, and provides the 
information required for configuring and administering this application.

Although job titles and duties at your company may differ from those listed in the 
following table, the audience for this guide consists primarily of employees in these 
categories:

Database 
Administrators

Administrators who administer the database system, including 
data loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Installers Persons responsible for setting up Siebel Field Service for initial 
use. 

Marketing 
Administrators

Administrators who set up and maintain a marketing 
department. Their duties include designing and managing 
campaigns, product marketing information, and product 
distribution lists.

Siebel Application 
Administrators

Administrators who plan, set up, and maintain Siebel 
applications.

Siebel Application 
Developers

Developers who plan, implement, and configure Siebel 
applications, possibly adding new functionality.

Service Center 
Administrators

Administrators who set up and maintain a service center.

Siebel System 
Administrators

Administrators responsible for the whole system, including 
installing, maintaining, and upgrading Siebel applications. 
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How This Guide Is Organized
How This Guide Is Organized
This book shows the progression of tasks to be performed in Siebel Field Service. 

This guide is organized according to the functions of screens that apply to Siebel 
Field Service. For example, screens that apply to service support are grouped into 
one chapter. With the exception of this Introduction and Chapter 1, “Overview of 
Field Service,” each chapter in this guide addresses one or more specific screens and 
their associated functions. 

Although job duties at your site may vary from the classifications used in this guide 
and may overlap, most information is directed to an application administrator or 
Siebel administrator audience. Where appropriate, end user procedures are also 
included. These are to inform the administrator how the default user interface 
functions when set up. 

This guide is designed to be used in combination with a broader set of 
documentation that pertains to all Siebel eBusiness Applications. Most chapters in 
this guide cover only the information that is specific to Siebel Field Service. Where 
applicable, you are referred to other guides. 

NOTE: This guide assumes that you have successfully installed Siebel Field Service. 
If you have not yet installed the application, see Siebel Server Installation Guide or 
Upgrade Guide for the operating system you are using. If you plan to use Siebel 
Remote, you must complete additional implementation tasks described in Siebel 
Remote and Replication Manager Administration Guide. 
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What’s New in This Release
What’s New in This Release
The features that are new in Release 7.5 are as follows:

■ Asset hierarchy. Siebel Field Service allows you to track assets as an n-level 
hierarchy of parent assets and child asset components. Child components inherit 
the properties of the parent asset.

■ Assets screen improvements. New views and new fields on existing views are 
added to the Assets screen in support of new functionality.

■ Asset transactions automation. Inventory transactions performed on an asset 
automatically include the components of the asset.

■ Barcodes. Field Service can now import information scanned into a barcode 
reader.

■ Agreements enhancements. Additional views and tabs in the Agreements screen 
allow you to associate notes, entitlement metrics, and orders with an agreement.

■ Engines as business services. The Fulfillment Engine, Part Locator Engine, 
Replenishment Engine, Cycle Counting Engine, Preventive Maintenance Engine, 
and Mobile Inventory Transaction Engine are implemented as business services.

■ Siebel Invoices ASI. A new ASI (Application Services Interface) imports invoice 
data from third-party invoicing applications into your Siebel application.

■ Quality enhanced reports. New reports are added to the Quality screen.

■ Quality multiple occurrences. You can apply a single product change request to 
multiple product platforms or versions. You can also define parent-child, 
dependency, and other relationships between change requests.

■ Release Manager. A Release Manager module is added to allow you to plan and 
track product development projects.

■ Field Service Analytics Applications. New reports are added to the Agreements 
module. For more information, see Siebel Analytics Installation and 
Administration Guide and Siebel Analytics User Guide.

Your Siebel implementation may not have all the features described in this guide, 
depending on which software modules your company has purchased.
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Additional Resources
Additional Resources
This section lists additional resources, such as other Siebel application guides, that 
may be relevant to your use of Siebel Field Service. 

Additional Documentation
The following additional books also contain essential information about 
functionalities discussed in this guide:

■ Applications Administration Guide

■ Integration Platform Technologies: Siebel eBusiness Application Integration 
Volume II

■ Product Administration Guide

■ Siebel Assignment Manager Administration Guide

■ Siebel Order Management Guide

■ Siebel Professional Services Automation Guide

■ Siebel Wireless Administration Guide
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Revision History
Revision History
Siebel Field Service Guide, Version 7.5, Rev. A

Version 7.5, Rev. A
Table 1. Changes Made in Version 7.5, Revision A

Topic Revision

“Generating Correspondence for a 
Service Request” on page 55

Added a section and procedure on generating 
correspondence for a service request. 

“Accounts Screen” on page 59 In the last paragraph under this heading, changed an 
incorrect cross-reference. 

“Service Requests Views” on 
page 63

In Table 4, added a description of the Group field. 

“Verify Button” on page 65 A note about the Verify button being a business 
service has been removed. The note was incorrect. 

“Setting Alarms for Activities” on 
page 94

Removed the Note paragraph referring to the 
Suppress Calendar check box, which no longer 
appears on the Activities screen. 

“All Activities View” on page 104 In Table 15, removed the description of the Suppress 
Calendar check box, which no longer appears on the 
Activities screen. Also added a description of the 
Repeat Frequency field. 

“Part Tracker View” on page 107 In Table 17, clarified the description of the Commit 
and Commit All buttons. 

“Making Changes to a Schedule” 
on page 148

Added a Caution paragraph regarding manual 
schedule changes. 

“Server Key Mappings View” on 
page 168

Added a paragraph about restarting the server 
component after changing key mappings. 

“Schedule View” on page 170 In Table 37, added a description for the Planned Start 
field.

“To define products covered in an 
entitlement template” on page 203

Added a Caution paragraph at the end of the 
procedure to clarify how to associate a product and 
an entitlement template when the product is an 
agreement line item. 
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Revision History
“Using Agreements and 
Entitlements” on page 208

Added a new procedure to explain how to associate 
primary contacts with an agreement. 

“Agreement View” on page 229 In Table 52, added a description for the Currency 
field and revised the description of the Effective field. 

“Entitlement Details Subview” on 
page 234

In Table 57, added descriptions for the Current Qty 
and Initial Qty fields. 

“Invoice Logic for Agreements” on 
page 247

Added details to Step 2 through Step 5 of the process 
description to make it more accurate. 

“Logic for NRC Line Items” on 
page 248

Modified Step 1 of the process description to make it 
more accurate. 

“Logic for Usage Line Items” on 
page 248

Modified Step 4 and Step 5 of the process description 
to make it more accurate. 

“Setting Up Automatic Invoicing 
for Agreements” on page 253

To the first paragraph, added a clarification about 
how to make automatic invoicing work. 

“To associate an invoice plan with 
an agreement” on page 253

Added a new Step 7 to clarify which fields are 
required for the various types of invoicing. 

“To associate multiple employees 
with an inventory location”

Deleted this procedure from Chapter 9, “Service 
Inventory.” The procedure was inaccurate. 

“Best Practice: Managing 
Inventory Levels” on page 322

Added a subsection explaining a best practice for 
creating certain inventory levels. 

“To specify allocation of products” 
on page 332

Rewrote Step 3 through Step 6 to claritfy the 
procedure. Added a Caution paragraph about 
changing settings. 

“To set a repeating component 
request for the Cycle Counting 
Engine” on page 386

Added a new procedure to explain how to set a 
repeating component request for the Cycle Counting 
Engine. 

Table 1. Changes Made in Version 7.5, Revision A

Topic Revision
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Revision History
Chapter 12, “Quality” Rewrote the chapter to be more task-based and 
better-focused on its user audiences. Changes 
include the following:

■ Reorganized the material into Administrator, 
Product Marketing, Engineering, and Quality 
Assurance user sections. 

■ Added process flow diagrams and descriptions 
for the user tasks.

■ Removed the view descriptions and rolled their 
text into the procedures.

■ Removed procedures for associating a service 
request with a change request, accessing a 
primary occurrence change request from its child, 
and accessing a multiple occurrence change 
request from its parent. 

■ Removed the sections on Charts and Reports.

■ In the Administrator section, added procedures 
for setting up roles and responsibilities, lists of 
values, area-subarea mappings, and product 
builds. 

■ In the Quality Assurance sections, added 
procedures for querying for, adding attachments 
to, reopening, and Close-Verifying change 
requests.

■ To the Engineering section, added a procedure for 
assigning change requests.

■ To the Product Marketing section, added 
procedures for querying for, reassigning, and 
closing change requests. 

■ Added a section with background material and 
new procedures for generating, approving, and 
shipping patch requests. 

“Properties of Assets” on page 490 Added the seventh bulleted paragraph to help clarify 
the relationship between assets and products. 

Table 1. Changes Made in Version 7.5, Revision A

Topic Revision
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Revision History
“To create an asset” on page 494 Added a Note paragraph after Step 5 to clarify asset 
configuration from within a set of records displayed 
by a predefined query. 

“Creating a Hierarchical Asset 
From a Product Bundle” on 
page 495

Added a section and procedure explaining how to 
create a hierarchical asset from a product bundle. 

“To record a reading for an asset” 
on page 503

Added a Caution paragraph about recording readings 
for assets whose products have changed. 

“Service Request Templates” on 
page 537

Rewrote this section to clarify what a service request 
template includes. 

“Time Interval Subview” on 
page 549

In Table 128, added a description for the Interval 
field. 

“Glossary” The book’s Glossary section has been removed. The 
glossary definitions have been added to the main 
Glossary book.

Table 1. Changes Made in Version 7.5, Revision A

Topic Revision
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This chapter describes the Field Service process, the application design, and the 
administrative tasks associated with Field Service.
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The field service process begins with service requests and orders. A service request 
is a customer’s request for information about or assistance with products or 
services. An order is a commitment on the part of the customer to purchase 
products and services at a specific price. Service requests are described in 
Chapter 2, “Service Support,” in this guide. Orders are described in Siebel Order 
Management Guide.

The field service process typically consists of one of the following scenarios:

■ A customer reports a problem to a service center and field engineers are 
dispatched to repair the item. 

■ A customer places an order with a service center and field engineers are 
dispatched to install the item. 

Separate functional groups such as the service center, dispatch, field engineers, and 
parts business need to share information. Siebel Field Service integrates call center, 
dispatch, field activities, and service parts information in a single application. Siebel 
Field Service provides service center agents, warehouse staff, and field service 
engineers with the tools to respond to service requests and orders. Siebel Field 
Service handles tasks including the following: 

■ Receives service calls.

■ Verifies service agreements and entitlements.

■ Enters a service request.

■ Searches for solutions.

■ Creates activities for a service request.

■ Assigns and dispatches field service engineers.

■ Provides parts inventories for parts depots and trunk stock.

■ Provides detailed customer configuration.

■ Tracks parts consumption and logistics. 

■ Manages inventory replenishment. 
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■ Integrates return materials authorizations and service orders.

■ Provides field service engineers with complete service details, including the 
required skills, tools, and parts for all service activities.

■ Manages repair of defective parts.

■ Sets up and manages preventive maintenance plans.

■ Tracks and analyzes service costs.

■ Prepares invoices for service, and tracks payments.

■ Defines characteristics of assets and records readings from equipment (assets) 
in the field for preventive maintenance, billing, and service.

NOTE: A Siebel implementation may not have all the features described in this guide, 
depending on which software modules have been purchased.

Managing the Full Cycle of Field Service
Field service businesses use Siebel Field Service to manage the entire flow of field 
service operations. Inbound service center calls are managed in this sequence:

1 Enter a service request. Service request activities are created throughout the life 
cycle of the service request. 

2 Verify the service level agreements for the caller. 

3 Based on the diagnosis of the problem and the service level agreement, create a 
return material authorization (RMA) or a service order and link it to the service 
request, to allow prompt resolution. 

4 Fill the order and ship the replacement parts to the customer or the field 
engineer. 

5 Dispatch activities to a field engineer with the right skill set, tools, time, 
and location. 
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When a call has been resolved, the engineer reports the details of the resolution 
from the field, updates the customer relationship database to reflect possible cross-
selling opportunities, and updates and replenishes the service parts inventory on 
a just-in-time basis. An invoice can be issued to the customer as proof of work. 
Pending return material authorizations from customers are tracked from receiving 
the items and defective parts are managed through the repair cycle. 

Siebel Field Service consists of the basic functions required by most service 
businesses, as well as optional functions that can be added to fit most field service 
requirements:

■ Base Field Service modules:

■ Call Management

■ Account/Contact Management

■ Field Activities Management 

■ Warranty Management

■ Asset Management

■ Service Order Management

■ On-Site Services Management

■ Knowledge Management

■ Dispatch Board

■ Service Inventory

■ Shipping and Receiving

■ Optional Field Service modules:

■ Contract Management

■ Siebel Scheduler

■ Repair

■ Preventive Maintenance
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■ Logistics Management

■ Quality Management (includes Quality and Release screens)

■ Barcodes

Dispatch Board
Dispatch Board is a graphical user interface that allows call center personnel and 
dispatchers to select, schedule, and assign field service engineers to service 
activities. 

The Dispatch Board screen shows all unplanned activities and a list of the selected 
field service engineers and their schedules. Dragging unplanned activities onto the 
schedules of field service engineers automatically assigns and schedules these 
activities.

Siebel Scheduler
Siebel Scheduler provides automatic scheduling of activities and optimization of 
a service calendar. Appointment booking and schedule optimization are based on 
service region data, employee data, and constraints. Insertion of activities into 
optimized schedules accommodates immediate scheduling needs; for example, 
service calls linked to contractual commitments (entitlements) and emergency 
events. The application provides worldwide scheduling capability. 

Siebel Scheduler includes the following features:

■ Appointment scheduling allows customer service representatives to 
automatically schedule customer visits without exceeding current labor 
capacity. Appointments based on a window of time can be given to the customer 
with granularity down to hours.

■ Siebel Scheduler optimizes deployment schedules based on business-defined 
constraints (for example, minimizing travel and labor costs) while making sure 
that contractual commitments are met. High-priority calls can be scheduled 
immediately, resulting in the reassignment of lower-priority calls.

■ Siebel Scheduler can insert service activities that need immediate attention into 
an already-optimized schedule. Siebel Scheduler can also respond to unplanned 
situations like a vehicle breakdown or unavailable field service engineers.
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■ Siebel Scheduler can use Siebel Assignment Manager to provide an optimized 
list of field service engineers for assignment to each service request or activity. 
Siebel Scheduler also provides to the Assignment Manager data on availability 
of employees.

■ Schedules are optimized in batch mode based on business-defined criteria.

Mobile Computing Support
Field service engineers in the field can access Siebel Field Service on their laptop 
computers, handheld devices, or wireless devices. Later they can synchronize to 
send local changes to the Field Service server and to retrieve new information from 
this server. Siebel applications support synchronization over LANs, WANs, dial-up 
connections, wireless networks, and the Internet.

Siebel Field Service introduces uncommitted transactions for inventory transfers in 
the field. This allows for tracking of part movements without immediate access to 
records in the corporate computer. Upon synchronization with a Field Service 
server, these transactions may be committed and recorded in the server database.

Service Parts Information
Siebel Field Service provides full information about parts availability, including 
installation instructions, operational constraints, and warranty and manufacturing 
data. Siebel Field Service allows the field engineer to graphically navigate through 
the base configuration of any complex product and review the customer’s on-site 
configuration. Siebel Field Service supports parts comparison and replacement 
information so that field service operations can quickly identify alternative parts. 

Field Service Engineer Information
Siebel Field Service tracks a wide variety of information for field service engineers 
such as skill sets, product expertise, location, and business, and contact data like 
cellular phone and paging information. Each field service engineer can define 
notification preferences so that a dispatcher or customer can contact the engineer 
efficiently. Integrated calendar posting and scheduling allows each field engineer to 
maintain a personal calendar. 
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Field Service Engineer Activities
When a service event is reported, Siebel Field Service defines the steps required 
to correct the problem, necessary tools, and required parts and skills. Information 
such as safety data, schematics, and technical notes on the products, may be linked 
to the service activities and parts data. Siebel Field Service also allows the capture 
of billing information related to an activity at a customer site, including parts, 
expenses, and labor charges.

Service Inventory
The Inventory module manages service parts inventory. Inventory is tracked in real 
time across locations and businesses, including trunk inventories, and is accessible 
from anywhere in the company. Siebel Service Inventory provides a Part Locator 
screen to find parts during the RMA/order process or during a dispatch operation. 
The Part Locator Engine offers real-time access to inventory, allowing end users to 
make accurate and informed decisions on parts shipments. 

The Field Service Part Browser allows a field service engineer to investigate the 
availability of a product in all inventory locations within a field service business. 

Agreements and Contract Management
Siebel Contract Management supports the contract life cycle, from service 
opportunity identification, service pricing, and proposal generation to service 
delivery on contractual commitments to contract additions, cancellations, and 
renewals.

With Siebel Contracts, end users can define the terms of an agreement between the 
customer and the service provider. These terms can include the service provider’s 
contractual obligations such as performance metrics, response time, equipment 
maintenance responsibilities, service pricing, discounts, and service entitlements. 
Agreement entitlements allow end users to define service offering details, specifying 
tiered pricing for offerings and determining customer assets’ levels of coverage.
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Additionally, Siebel Contracts allows end users to specify the terms of installment 
payments, renting, leasing, financing, and use-based pricing. When a service 
contract is established, the contract’s recurring, non-recurring and usage-based 
charges can be automatically invoiced. End users can also track and forecast 
financial and service revenue information resulting from the sale of service 
offerings, individual service contracts, and across the service organization overall.

Service providers can use product warranty and off-warranty contract expiration 
data to reprioritize service sales resources. Combined with Siebel Service Analytics, 
Siebel Contracts allows end users to assess customer service needs, personalize 
service offers, and customize coverages. 

Preventive Maintenance and Asset Measurements
Preventive maintenance is often a critical revenue and cost-containment factor for 
a service business. Siebel Field Service allows customers to generate preventive 
maintenance management services automatically. The Preventive Maintenance 
module provides the ability to create automatically predefined preventive 
maintenance service requests and related activities based on usage or frequency. 

Certain equipment (for example, photocopiers or printers) requires regular 
maintenance to remain in good condition. Service businesses often provide 
preventive maintenance services as part of their offerings. Those services are 
sometimes included in warranty agreements, or sold to the customer as part of the 
service contract. 

Monitoring systems can automatically request maintenance when certain 
conditions are met; for example, a meter reading passes a threshold or a fixed 
time period has elapsed. These events trigger the creation of a service request.

To facilitate preventive maintenance, Siebel Field Service provides for the collection 
and processing of asset measurements. Readings taken either manually or 
automatically from equipment in the field are recorded in Field Service. These 
readings can be from gauges, counters, or meters attached to products. This data 
may be used to initiate service requests for repairs or preventive maintenance. 
Usage readings can be used for billing on a fee-per-use basis.
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Shipping and Receiving
Shipping and Receiving are integrated with Siebel Service Inventory, and track 
customer orders to shipment. Siebel Shipping and Receiving manages internal 
orders to transfer stock among inventory locations and receives RMAs and orders, 
closing the loop with each customer.

Field Service Analytics Applications
Siebel Field Service Analytics Applications provide managers with a tool for 
analysis of large volumes of records. The results of the analysis are displayed in 
charts and reports.

Siebel Field Service Analytics Applications are documented separately in Siebel 
Analytics Installation and Administration Guide and Siebel Analytics User Guide.

Siebel Wireless for Field Service
Siebel Wireless provides real-time access to information through a wireless 
application protocol (WAP)-enabled mobile phone or wireless handheld device. 
With Siebel Wireless for Field Service professionals, users can update sales 
opportunities, review account and activity information, access calendar and 
contact details, order and track parts, respond to service requests, and send 
correspondence. See Siebel Wireless Administration Guide.

Siebel Wireless Messaging
The Siebel Short Messaging Service (SMS) Adapter provides connectivity to global 
SMS centers using proprietary APIs. Siebel Wireless Messaging provides wireless 
dispatches and database updates. 
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Siebel Field Service operates as a single Windows NT service that runs components 
such as EIM, Optimization Engine, Assignment Manager, and so on. Siebel Server 
operates components as processes or threads based on the system preferences 
specified for each component. Thus, there can be multiple components running at 
the same time and each component can run a specified number of tasks at a given 
time.

Siebel Professional Services Automation
Siebel Field Service is integrated with Siebel Professional Services, allowing the 
two applications to share resource management, cost tracking, and billing of longer-
term service projects with milestone achievement time lines. See Siebel Professional 
Services Automation User Guide.

Field Service Engines
Siebel Field Service provides the following automated functions:

■ Fulfillment Engine. Analyzes orders, locates parts for each line item, returns the 
located parts (products or substitute products) to the user, allocates parts, and 
generates pick tickets. 

■ Part Locator Engine. Analyzes orders, locates parts for each line item, and returns 
the located parts (products or substitute products) to the user. The user can 
manually allocate these parts and generate the pick tickets. 

■ Replenishment Engine. Selects source and target inventories when restocking is 
needed and generates the orders required to obtain materials from an external 
provider, an internal inventory site, or an internal manufacturing facility.

■ Cycle Counting Engine. Generates cycle counting orders (parts lists).

■ Preventive Maintenance Engine. Generates service requests for the maintenance of 
assets, based on predefined triggers.

■ Mobile Inventory Transaction Engine. Generates inventory and asset transactions 
when a field service engineer reports part movements in the field.
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To facilitate configuration, maintenance, and multi-language support, these 
components are implemented as business services. For information about business 
services, see the chapter on business services in Integration Platform Technologies: 
Siebel eBusiness Application Integration Volume II. For information about setting 
logging levels for these engines, see Appendix A, “Engines Logging Levels.”
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This section describes the types of administrative tasks required for Field Service. 
Instructions for performing these tasks are provided in this guide and in other 
guides in the Siebel eBusiness Applications documentation set. 

The following administrative tasks are required: 

■ Implementation and application administration. You must define and structure a 
number of elements that are used throughout the application. These include 
currencies, exchange rates, organizations, divisions and positions in your 
organization, users and their responsibilities, service territories, and so on. 
These tasks are described in Applications Administration Guide.

■ Product management and administration. Field Service provides two tables for 
product information: an internal product table and an external product table for 
competitive products. In addition to populating these tables, you must define a 
product categorization hierarchy, specify product features, and specify settings 
for products that will be tracked in inventory. You can also define price lists and 
associate them with products. These tasks are described in Applications 
Administration Guide and Pricing Administration Guide.

■ Marketing administration. All the various elements of marketing information must 
be defined and set up for your implementation. These include accounts, 
contacts, and so on. These tasks are described in Siebel Marketing Guide.

■ Assignment administration. Siebel Assignment Manager allows you to 
automatically assign the appropriate people to specific tasks. Instructions for 
using Siebel Assignment Manager can be found in Siebel Assignment Manager 
Administration Guide. 

■ Templates. Service and preventive maintenance plans use activity and service 
request templates to define efficient service calls. These features are described 
in Chapter 2, “Service Support” and Chapter 3, “Field Service Activities.”
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■ Agreements and Entitlements. Service and preventive maintenance plans are 
based on contracts and entitlements that customers purchase. Setting up service 
agreements and entitlements is described in Chapter 5, “Agreements,” in this 
guide.

■ Inventory. Field Service includes the process of setting up a logical inventory 
structure and maintaining a physical inventory. These tasks are described in 
Chapter 9, “Service Inventory” and Chapter 11, “Cycle Counting and 
Replenishment” in this guide.
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This chapter describes the way field service call centers process service calls from 
customers, set up service requests, and attempt to find immediate solutions.
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The workflow for processing a customer’s request for service, shown in Figure 1 on 
page 45, includes the following steps:

1 Receive a request for service.

2 Generate a service request.

3 Verify the request, by confirming:

■ The account

■ The caller (contact)

■ Assets

■ Entitlements for service

■ Warranties

4 Try to solve the problem using known solutions.

5 If known solutions do not solve the problem, generate activities for service.

6 Order parts if needed.

7 Schedule a service engineer and assign activities to that service engineer, if 
needed.

8 Assign and schedule field service activities (see Chapter 4, “Scheduling and 
Dispatch”).
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9 Perform the activities.

10 Close the service request.

Figure 1. Workflow for Processing a Service Request
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This section provides typical procedures for setting up Siebel Field Service to 
process service calls. Setting up service support includes the following tasks:

■ Setting up customer accounts and contacts for these accounts

■ Setting up activity templates

■ Setting up problem resolution

■ Setting up service metrics

■ Setting up employees and their responsibilities

Procedures for Setting Up Service Support
Follow these procedures to set up service support.

To create a service activity template

1 Navigate to Site Map > Application Administration > Activity Templates.

2 Create an activity template.

For information on creating activity templates, see Chapter 3, “Field Service 
Activities.”

3 In the activity template’s Type field, select Service Request. 

4 Click the Service Details view tab.

5 Create a new service detail record.

6 Enter values for the required fields.

7 Click one of the four subview tabs, as needed:

■ Service Activity Steps

■ Assignment Skills

■ Service Activity Items

■ Service Activity Instructions
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8 Create a new record in the subview.

9 Enter values for the required fields.

To set up service metrics

1 Navigate to Site Map > Service Administration > Service Metrics.

2 Create a new service metric record.

3 Enter a name for the metric.

NOTE: Service metrics are named in the Service Metrics list, but they are defined in 
detail in the Entitlements screen. See “To define entitlement template metrics” on 
page 202. After entitlements and service metrics have been defined, you can 
associate an entitlement with a service request. See “To select an entitlement for a 
service request” on page 49.

Setting Up Problem Resolutions
Use the Solution Administration screen to find and add information that can provide 
immediate solutions to requests for service. Table 1 lists and defines the views on 
the Solution Administration screen. 

For more information about setting up solutions, see “Setting Up Solutions” on 
page 79. 

Table 1. Views on the Solution Administration Screen

View Role in Setup

Resolution Documents Associates with solutions document files that describe a 
problem and its solution. 

Related Solutions Associates related solutions with specific solutions.

Service Requests Specifies service requests related to a specified solution.

Change Requests Specifies change requests related to a specified solution.

Solution Categories Associates solution categories with a solution. 
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The first set of tasks the service representative performs in response to a request for 
service includes recording the request and attempting to solve the problem. If the 
service representative cannot resolve the problem, the agent may set up field service 
activities, select the engineers, schedule the engineers, and, finally, inform the 
engineers of their assignments.

The following procedures suggest a typical workflow that is initiated upon receiving 
a request for service.

To verify an account, a contact, and an asset

1 Navigate to the Accounts screen.

2 Query for the caller’s account.

3 Select the record for the caller’s account and click the hyperlink in the Account 
Name field.

The Contacts list appears, showing authorized contacts for that account.

4 In the Contacts list, query for the caller’s name.

5 Click the Assets view tab.

The Assets list shows assets associated with the selected account. 

6 In the Assets list, query for the asset the call is about.

7 If you want to see the product with which the asset is associated, click the 
Service Profile view tab.

The Service Profile list shows products associated with the selected account. The 
Assets list shows the assets associated with a selected product.
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To log a service request

1 Navigate to the Service screen.

2 Create a service request record.

3 Enter values for the required fields. 

4 In the Asset # field, select the asset requiring service.

NOTE: The Siebel state model controls the behavior of the Status and Substatus 
fields. See Siebel Business Process Designer Administration Guide for a detailed 
explanation of the state model.

To verify the service agreements and entitlements for an account

1 Navigate to the Accounts screen.

2 Select an account record. 

3 Click the Agreements tab.

The Agreements list shows agreements associated with this account. The Start, 
End, and Valid fields show which agreements are in effect. 

4 Click the Entitlements tab.

The Entitlements list shows agreements associated with this account. The 
Agreement field shows the agreement with which the entitlement is associated.

To select an entitlement for a service request

1 Navigate to the Service screen.

2 Select a service request that has an associated account or contact.

3 On the More Info tab, click Verify.

The Pick Entitlement dialog box appears showing only entitlements that match 
the criteria for this service request. If no entitlements appear, the selected service 
request is not entitled to receive service.

4 In the Pick Entitlement dialog box, select an entitlement and click OK.
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To verify the valid hours for completing a service request

NOTE: For this procedure to work, you must first verify the entitlement. See “To 
verify the service agreements and entitlements for an account” on page 49.

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Service Hours tab.

The Service Hours list shows the hours during which a customer is entitled to 
receive service.

To verify the warranties for an asset

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Service Details view tab.

4 In the Service Details form, click the show more button.

5 In the Warranty As Of field, enter the date on which to verify a valid warranty.

6 Click Check Warranty.

The Product Warranty, Component Warranty, and Manufacturer Warranty check 
boxes indicate, when checked, which of these warranties are in effect on the 
date you entered.

To associate a change request to a service request

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Change Requests view tab. 

4 In the Change Requests list, click Add.
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5 In the Add Change Request dialog box, select an existing change request or 
create a new one. 

For information on entering change requests, see Chapter 12, “Quality.”

To associate an activity plan with a service request

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, add a new activity plan record.

5 In the Template field, select an activity plan template on which to base this 
activity plan. 

6 Enter values for the other fields, as needed. 

For information about activity plans and activity templates, see Chapter 3, “Field 
Service Activities.”

To associate an activity with a service request

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Activities view tab.

4 In the Activities list, add a new activity record.

5 Enter values for the fields, as needed.
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After a service request is opened, the service center or field service agent can add 
the following information to a service request.

To update activities for a service request

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Activities view tab.

4 Select an activity.

5 Enter new values in the fields, as needed.

To add an asset to a service request

1 Navigate to the Service screen.

2 Select a service request that is not associated with an asset.

3 On the More Info tab, click the show more button.

4 In the Asset # field, enter or select the number for the additional asset.

NOTE: A service request can be associated directly with only one asset. However, 
a service request can be associated with multiple activities, and each activity can 
have one associated asset. To associate multiple assets with a Service Request, 
create multiple activities, associate them with a service request, and associate each 
of the assets with a different activity. For information on managing defective assets, 
see Chapter 12, “Quality.”

To add additional assets to a service request

1 Navigate to the Activities screen.

2 Create a new activity.

3 In the SR # field, select the service request with which you want to associate 
additional asset.
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4 In the Asset # field, select the additional asset to associate with the service 
request.

5 Enter values for other fields, as needed.

To verify field part movements

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Activities view tab.

4 Select an Activity.

5 Click the hyperlink in the Type field.

The Activities screen appears with the Attachments view tab selected.

6 Click the Part Tracker view tab.

The Part Tracker view shows transfers of parts associated with this activity. 

To record a resolution code for a service activity

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Activities view tab.

4 Select an activity record.

5 Click the hyperlink in the Type field.

The Activities screen appears with the Attachments view tab selected.

6 In the Activity form, in the Resolution Code field, select a resolution.

NOTE: Resolutions can also be associated with a service request.
Version 7.5, Rev. A Siebel Field Service Guide 53



Service Support

Updating a Service Request
To review orders associated with a service request

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Orders view tab.

The Orders list displays orders associated with the selected service request.

To generate and print an invoice for a service request

1 Navigate to the Service screen.

2 Select a service request. 

3 Click the Invoices view tab.

4 To generate an invoice, in the Invoices list, click Auto Invoice.

5 Click the hyperlink in the Invoice # field.

The Invoices Line Items view appears.

6 From the application-level menu, choose View > Reports. 

In the Reports dialog box, the Select a Report field shows Customer Invoice.

7 Click Run Now. 

The Siebel Report Viewer window appears with the invoice.

8 Click the print button to print a pro forma invoice.

To view the performance measurements (metrics) for a service request

NOTE: For this procedure to work, you must first verify the entitlement. See “To 
verify the service agreements and entitlements for an account” on page 49.

1 Navigate to the Service screen.

2 Select a service request. 
54 Siebel Field Service Guide Version 7.5, Rev. A



Service Support

Updating a Service Request
3 Click the Metrics view tab.

The Metrics list appears, showing metrics associated with the service request. 

The Metrics list contains read-only records of the metrics associated with this 
service request. Service metrics are defined in the Service Administration screen, 
in the Entitlement Templates list on the Metrics view. See Chapter 5, 
“Agreements.”

To close a service request

1 Navigate to the Service screen.

2 In the Service Request list, select the service request you want to close.

3 In the Status field, select Closed.

The system automatically changes the Substatus field to Resolved and sets the 
Closed field’s date and time to the current date and time. 

NOTE: After closing a service request, the record is read-only. The status of a 
service request must be changed back to Open before the record can accept any 
further changes.

Generating Correspondence for a Service Request
You can generate correspondence for a selected service request. 

To generate correspondence for a service request

1 Navigate to the Service screen.

2 Select a service request for which you want to generate correspondence.

3 From the application-level menu, choose File > New > Correspondence.

The Correspondence view appears with a new record in the Correspondence list. 
The Recipients list shows the contact associated with the selected service 
request.

4 In the Correspondence list, complete the fields as needed for the correspondence 
you want to generate.
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5 Add more recipients to the Recipients list, if needed.

NOTE: The selected service request does not become associated with any 
additional contacts added to the Recipients list for a service request-related 
correspondence. 

6 Click Generate.

For more information about correspondence, see the chapter on correspondence in 
Siebel Sales User Guide.
56 Siebel Field Service Guide Version 7.5, Rev. A



Service Support

Solving a Service Request
Solving a Service Request
The procedures in this section suggest a workflow for researching and solving a 
service request.

To associate a service request with a related service request

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Related SRs view tab.

4 In the Related SRs list, add a new service request record. 

5 In the Add Service Requests dialog box, query for service requests that have a 
similar type, product, account, or other common element.

6 Select the service request you want to associate with the current service request 
and click Add.

To verify associated change requests for a product

1 Navigate to the Products screen.

2 Select a product.

3 Click the Change Requests view tab.

Change requests associated with this product appear in the Change Requests list.

To verify the repair history of a product

1 Navigate to the Repairs screen.

The Repairs list appears.

2 In the Repairs list, create a query on the Product field.

The Repairs list shows all repairs for the selected product.
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To find explanations (decision issues) for a service request

1 Navigate to the Service screen.

2 Select a service request.

3 Click the Decision Issues tab.

A list of decision issues appears, with suggested explanations for the customer.

4 To see more information related to a decision issue (such as literature and 
attachments), select the decision issue and click the hyperlink in the Name field. 

5 Click the Attachments tab to view files associated with this decision issue.
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Accounts Screen
Using the Accounts screen, a customer service representative can verify the 
following information for an incoming service call:

■ The customer’s account (Accounts list or Service Profile view).

■ The contact making the call (Contacts view or Service Profile view).

■ The assets at the customer site that are associated with this account (Assets view 
or Service Profile view).

■ The service agreements for this account (Agreements view).

■ The entitlements for the service agreements belonging to this account 
(Entitlements view).

The customer service representative can automatically verify entitlements for 
specific service agreements by clicking the Verify button on the Service Request 
screen (see “Service Requests Views” on page 63). 

■ The history of service requests logged to this account (Service Requests view).

■ Billing and Shipping information for the account (Bill to/Ship to view).

■ Invoices previously prepared for the account (Invoices view).

For more information on using the Accounts screen, see the chapters on Accounts 
in Siebel Call Center User Guide and Siebel Sales User Guide.

Accounts Across Organizations
An organization limits the visibility of data within a company. However, the 
All Accounts Across Organizations view shows all accounts within a company. 

An employee can belong to one organization and account records can belong to 
one organization. The owner of an account record can see his or her account record 
in the My Accounts view, even if the account record belongs to a different 
organization. However, the same employee using the same login to Siebel Field 
Service, cannot see this account in the All Accounts view. The record is exposed 
only to those people who belong to the same organization.

For more information on setting up organizations, see the chapter on access control 
in Security Guide for Siebel eBusiness Applications.
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Accounts View
The Accounts view provides information about all accounts that belong to a 
service business. Use this list to verify the account for the individual placing a 
service request. 

Contacts View 
The customer service representative (CSR) uses the Contacts view to verify the 
person placing a service call. For more information on using the Contacts view, 
see Fundamentals.

Agreements View
The Agreements view displays all of the agreements associated with an account 
and the status of these agreements. Table 2 describes items in agreement records.

For more information on using the Agreements view, see Chapter 5, “Agreements.”

Table 2. Selected Items in the Service Agreements View

Item Description

Primary A check box that indicates this is a primary agreement for the selected account. 
This check box is for information only.

Type The type of agreement; for example, Service Level Agreement or Price 
Protection.

Valid A check box that indicates this is an active agreement. When checked, an 
agreement may appear in the list that the Verify button produces. See “Verify 
Button” on page 65.
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Entitlements View 
The Entitlements view shows all of the entitlements for service that are associated 
with this account. The Quota fields indicate the number of service calls remaining 
for this entitlement. The Start and End Date fields show the valid range of dates for 
this entitlement. This view is read-only.

Service Profile View 
The Service Profile view shows the products and assets associated with an 
account. The user can enter both new product and asset records in this view. 
The same Products and Assets subviews appear in References >Profile.

Account Reports
Account reports, listed in Table 3, are available from the Reports menu.

Table 3. Selected Account Reports for Service

Report Description

Current Account Service Profile Describes details for products associated with the 
account, including product, product type, version, 
description, vendor and comment. This report also 
describes a purchase history including product 
information, implementation phase, and 
purchase date.

Smart Report Account Summary Describes details of a selected account including 
account history, future revenue, satisfaction, 
organizational hierarchy, and service requests.

Smart Report Account Service Detail Describes all service-related information for 
the selected account including service requests, 
customer satisfaction, and the history of service 
request resolution.
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When responding to a service call, a customer service representative can create 
a service request on the Service screen. The service request tracks all activities 
connected with the call and records the service business’s entire response to 
the service call (activities, orders, parts movements, and assignments). 

On the Service screen, the user can carry out the following tasks:

■ To verify the entitlements for the account requesting service, click the 
Verify button.

■ Find solutions that may resolve a service call (Solutions view).

■ Set up new service requests (All/My Service Requests view).

■ To show the current warranty coverage for an asset associated with a service 
request, choose the Check Warranty menu command (Service Details view).

■ Associate change requests with a service request (Change Requests view).

■ Provide activity plans for a service request (Activity Plans view).

■ Provide individual activities for a service request (Activities view).

■ Assign activities to field service engineers using the Siebel Scheduler, 
Assignment Manager, or Dispatch Board (most Service Request views).

■ Attach documents to a service request (Attachments view).

■ Review orders for a service request (Orders view).

■ To prepare an invoice for all billable activities and expenses for a service request, 
click the Auto Invoice button (Invoices view).
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Service Requests Across Organizations
Service requests, like many other Siebel objects, have organizational visibility. 
This means:

■ The All Service Requests view shows only service requests for the organizations 
to which the user has permission. 

■ The All Service Requests Across Organizations view shows the service requests 
for all organizations within a company.

■ The My Service Requests view shows all service request records belonging to 
the user, even if the user is in a different organization.

For more information on setting up organizations, see the chapter on access control 
in Security Guide for Siebel eBusiness Applications.

Service Requests Views
The Service Requests views create and track service requests. Table 4 describes 
items in service request records.

Table 4. Selected Items in the Service Requests View

Item Description

Agent Closed The date and time that the service request was actually closed, 
displayed in the user’s time zone.

Agent Committed The date and time that the service request is expected to be closed, 
displayed in the user’s time zone. Choosing an entitlement 
automatically generates a value for this field, based on the 
response time in the service request metrics, the service calendar, 
and the date the service was requested. 

Activities associated with this service request inherit the Agent 
Committed value. The Agent Committed field value in the service 
request appears in the Activity Due fields in the activities. 

See also “Calculating the Agent Committed Time for a Service 
Request” on page 66.

Agent Opened The date and time that the service request was created, displayed 
in the user’s time zone. 
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Numbering Service Requests and Other BusComp Object Types
Each new BusComp (for example, service request, order, or activity) is 
automatically assigned a unique record ID (for example, SR #, Order #, Activity #, 
and so on).

Assign This command produces a dialog box with a list of field service 
employees, ranked based on administrative criteria. Select the 
employee best suited to be the owner of a selected service request.

Billable A check box that indicates to the Invoice Engine that the activities 
included in this service request are billable to the account.

Customer Closed The date and time that the service request was actually closed, 
displayed in the customer’s time zone.

Customer Committed The date and time that the service request is expected to be closed, 
displayed in the customer’s time zone. 

Customer Opened The date and time that the service request was created, displayed 
in the customer’s time zone.

Entitlement An entitlement that provides special terms for billing the labor, 
expenses, and parts used in this service request. It also provides 
the calendar and hours in which the customer is entitled to service.

Group Division responsible for communications with the customer 
regarding this service request.

Divisions available in the picklist are those whose Organization 
Type is Service. For information about setting up divisions, see 
Security Guide for Siebel eBusiness Applications.

Verify This button produces a dialog box with the names of the 
entitlements to which a customer has subscribed. If no 
entitlements appear in the dialog box, the selected service 
request is not entitled to receive service.

Note that this button appears only in the Service Request form. 
To see the form, choose the More Info view tab under the Service 
Requests list.

For more information, see “Verify Button” on page 65.

Table 4. Selected Items in the Service Requests View

Item Description
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By default, all Siebel applications use the ROW_ID for these values. The row ID is 
an alphanumeric value composed of a segment number followed by a sequential 
value. For example, the row ID 12-63Q0XT is composed of the segment number 12 
and the sequential value 63Q0XT. To see the row ID for a selected record, click the 
view menu button and choose About Record. The dialog box that appears contains 
a value for Row #.

To display alternative values for the record ID, use one of these methods:

■ Use the Query function Expr: RowIdToRowIdNum ([ID]) to convert the 
alphanumeric value to a numeric value.

■ Use a Sequence Object to automatically generate the value from an RDBMS 
database.

■ Write a script on Buscomp_PreWriteRecord. (Do not use 
Buscomp_PreGetFieldValue.)

Verify Button 
The Verify button finds the entitlements for a specified account, contact, product, 
and asset. Once the user selects an entitlement from the Pick Entitlement dialog 
box, the application computes the Commit Time for the service request from the 
Service Calendar associated with this entitlement and from the Response Time 
specified in the entitlement metrics. Verify searches the database for entitlements 
that match the following data supplied for the service request:

■ Account

■ Contact

■ Product

■ Asset (from the Service Details view)

Only entitlements that match this data appear in the Pick Entitlement dialog box. 
If no entitlements appear, the selected service request, service agreement, account, 
contact, product, or asset is not entitled to receive service.

For information on configuring the Verify button, see “System Preferences for 
Verifying Entitlements” on page 206.
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Calculating the Agent Committed Time for a Service Request
Agent Committed represents the contractual response period for service. The Verify 
button determines the value of Agent Committed and stores this value on a service 
request. The Agent Committed date and time are calculated based on the Date 
Opened, the Response Time metric, and the Service Calendar (schedule hours and 
exception hours). The result appears in the Agent Committed field. The Agent 
Committed time from the service request populates the Due field for activities. 

The Agent Committed time allows the agent either to schedule events that are 
within acceptable time frames, defined by the service calendar, or to tell the 
customer that a requested event is outside of his or her service calendar and is 
therefore, billable. 

Activities associated both directly (in the “Activities View” on page 70) and 
indirectly (in the “Activity Plans View” on page 70) with a service request inherit 
the Agent Committed date and time. The Agent Committed field value in the service 
request appears in the Activity Due fields in the activities. 
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Entitlement Rules for the Verify Button
System Preferences has three settings (see Table 5) which determine the action of 
the Verify button (see “Service Requests Views” on page 63).

Table 5. System Preferences for Verifying Entitlements

System Preference Name Description

Entitlement: Verify Consumer This setting sets the conditions for checking the 
authorization of the contact requesting service. If TRUE, 
the entitlements displayed must meet one of these 
criteria:

■ The contact for the entitlement matches the service 
request contact.

■ The entitlement account is set to All Contacts, and the 
entitlement account matches the service request 
account or the account for the contact for the service 
request. 

If no contact is selected, Siebel Field Service tries to verify 
the entitlement using the other entitlement settings.

Entitlement: Verify Dates This setting checks that the service request falls within 
the time span of the entitlement. If TRUE, the 
entitlements displayed are only those that provide 
coverage on the date the service request was opened, a 
date between the start and end dates for the entitlement.

If the entitlement has no start or end date, it does not 
appear.

Entitlement: Verify Product This setting checks that the asset or product is entitled to 
service. If TRUE, the agreements displayed must meet one 
of these criteria:

■ The entitlement asset matches an asset in the service 
request.

■ The entitlement product matches a product in the 
service request (no asset or serial number specified).

■ The entitlement is set to All Products and the product 
or asset for the entitlement matches the product or 
asset for the service request.

If no product is selected, Siebel Field Service tries to verify 
the entitlement using the other Entitlement settings.
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Assign Command 
The Assign menu command activates the Assignment Manager in interactive mode, 
to provide a ranked list of field service engineers who are qualified and available to 
carry out a service request. The Assignment Manger can also run in dynamic and 
batch modes for any Assignment objects, including Accounts, Opportunities, and 
Campaigns. 

NOTE: For using the Assignment Manger in Mobile mode, for mobile users, see Siebel 
Assignment Manager Administration Guide.

The Assignment Manager scores employees for assignment based on the factors 
specified in the following rules:

■ Check calendar. If this option is enabled, an employee must have calendar 
availability to perform the task. This is based on the assignment rule, Earliest 
Start, Latest Start, and the Duration (of an activity). If the individual is not 
available, this employee is removed from the list of candidates.

■ Assignment availability. The Assignment Manager passes a list of potential 
employees to the Appointment Booking System (ABS), which checks the 
employees’ service schedules (including their geographic service region 
assignments) and the activities already on their calendars. The ABS then returns 
the list of available employees to the Assignment Manger. In an optional step, 
the Assignment Manager may request that the ABS create and schedule a new 
activity for the chosen employee. For more information on the ABS, see 
Chapter 4, “Scheduling and Dispatch.”

■ Workload. For each workload rule specified, the number of activities assigned to 
that employee that meet all of the workload criteria is calculated. This number 
is then reduced by the maximum workload. This result is used to generate a 
score that is inversely proportional to the workload rule weight [Workload 
score = Score * (1 – (current workload/maximum workload)]. For example, 
if the workload rule is for Unassigned and Critical Service Requests, and if the 
maximum load for this rule is 10 and the weight for this workload is 20, then an 
employee load of 10 or greater receives a score of zero, and an employee with a 
load of 2 receives a score of 16.
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■ Attribute match. For each condition specified, the criteria are evaluated. If a 
condition is true, the score equals the weight specified; otherwise the score is 
zero. If the condition is not met and the condition is required, the total score 
for that employee or position is zero.

■ Expertise weighting. For each condition that uses advanced weighting, the score 
for that condition is adjusted, based on the advanced weighting criteria. For the 
employee column that is matched, the expertise for that attribute type must also 
be analyzed. For example, if a condition is specified for a product (product 
expertise) match, with a weighting of 15, and expertise weightings of Expert, 
Intermediate, and Novice are 3, 2, and 1, respectively, the resulting scores for 
this factor would be 15, 10, and 5, respectively.

The total score for an employee is a sum of the scores for each individual factor, 
modified by the factors that override the total score and set the score to zero (check 
calendar, required attribute matches, and so on). The highest score represents the 
most likely individual for assignment.

The Assignment Engine is configured for the Service Request object to either assign 
automatically the highest scoring employee (using SmartScript) or to run in 
interactive mode. In interactive mode, the user selects the Assign command and the 
Assignment Manager returns a ranked list of employees in the Assign Employees 
dialog box. The user can then select an assignee. For information about setting up 
interactive assignment for Siebel objects, see Assignment Manager Configuration in 
the Siebel Assignment Manager Administration Guide. 

NOTE: All assignment rules can be accessed by navigating to the Site Map and 
clicking Assignment Administration. For more information, see Siebel Assignment 
Manager Administration Guide.
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Activity Plans View 
In the Activity Plans view, a field service agent can select a template to define the 
activities required to resolve a service request. Table 6 describes two fields and 
a check box in activity plan records.

Activities View 
In the Activities view, a field service agent can view activities for a service request, 
and add stand-alone activities. An administrator or dispatcher can manually assign 
field service engineers to each activity. 

NOTE: To see the details of an activity, including its items, steps for completion, and 
instructions, click the hyperlink in the Type field. The Activity Attachments view 
appears for this activity. Click, for example, the Items, Steps, or Instructions tab to 
see information related to the selected activity.

Attachments View 
Use the Attachments view to add files created in another program (for example, 
spreadsheet files) to service requests. These files are stored in the Siebel file system 
in compressed form. When decompressed, attachments are written to these two 
directories:

■ <install root>server/files. When a Field Service client is connected to a server, 
this directory is used to decompress read-only files. 

■ <install>/temp. Writable attachments are decompressed in this directory. 

Table 6. Selected Items in the Activity Plans View

Item Description

Lock Assignment A check box that, when selected, instructs the Siebel Assignment 
Manager not to assign activities created as part of this activity plan. 

Planned Start The date and time to begin the activities that resolve a service 
request. The default is the date and time that the record is created.

Template A set of activities for recurring tasks, selected from a drop-down list.
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These directories must have write access. 

Audit Trail View
The Audit Trail view shows the history of changes that have been made to specific 
service request records. This view is read-only. For more information about the 
Audit Trail utility, see Applications Administration Guide. 

Calendar View 
The Calendar view displays the scheduled service activities for a selected service 
request over the next month, starting on a specified day. The user can click on 
the Calendar view to view scheduled activities. For more information, see 
Applications Administration Guide.

Change Requests View 
The Change Requests view describes manufacturing defects in components that 
are associated with a service request. 

Decision Issues View 
The Decision Issues view displays explanations that may be used internally or 
provided to the customer to solve a service request. The user can also add new 
decision issues to a selected service request.

Messages View 
The Messages view records a message concerning the selected service request and 
sends a screen alert or an email to the person selected in the Employees field. For 
more information, see Applications Administration Guide.
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Service Details View
The Service Details view shows the warranties covering an asset, the symptom 
reported for the asset, and the resolution code for a service request. Table 7 
describes buttons, check boxes, and selected fields in Service Details records.

Table 7. Selected Items in the Service Details View

Item Description

Check Warranty This button displays the warranties in effect for an asset on the date in 
the Warranty As of field. Check marks appear next to the types of 
warranty that apply: Product, Components, or Manufacturer. To verify 
the warranties active on another date, change the date in the Warranty 
As of field and click Check Warranty.

For more information about warranties, see Chapter 15, “Warranties.”

Product 
Warranty

A check box that indicates this type of warranty is in effect on the 
specified date. This check box is for information only.

Component 
Warranty

A check box that indicates this type of warranty is in effect on the 
specified date. This check box is for information only. 

Manufacturer 
Warranty

A check box that indicates this type of warranty is in effect on the 
specified date. For information about this type of warranty, see 
Glossary. This check box is for information only. 

Warranty As of The date on which Check Warranty validates the coverage under 
warranties.

Service Region The service region associated with this service request. Activities for 
this service request inherit this service region. The Appointment 
Booking System and Optimizer Engine (see Chapter 4, “Scheduling and 
Dispatch”) require a service region.

Symptoms A description of the symptom that triggered this service request, chosen 
from a dialog box. See “Symptoms Codes for a Service Request” on 
page 73.
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Symptoms Codes for a Service Request
There can be one or more symptom codes for any problem description. A customer 
can report some symptoms during a service request, while the field service engineer 
may find other symptoms and report them on site as part of an activity, and the 
repair technician may report other symptoms in a repair station as part of a repair 
activity. All the symptoms reported appear in the dialog box available in the 
Symptoms field from the Service details view. This is possible because the 
symptoms are stored in an intersection table that also stores the activity and the 
service request ID.

Service Hours View
The Service Hours view shows the hours during which service is provided under 
the specified entitlement. Shaded areas represent service times. Service hours 
appear only if an entitlement is specified for the service request and has been 
verified. 

Survey View 
The Survey view records customer responses concerning the level of service 
received. After a customer service representative enters responses to the questions 
and saves the record, the survey calculates a customer satisfaction score. 

Invoices View 
The Invoices view shows the invoices billed against a service request. Select the 
Auto Invoice command (see “Auto Invoice Command” on page 262) in the Invoices 
view to generate new invoices using orders and activities that have a billable flag 
set. For more information about invoicing and the Invoice Engine, see Chapter 6, 
“Invoices.”

Metrics View 
The Metrics view provides benchmarks of performance for a service request. 
All fields are read-only.
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Orders View
The Orders view presents the orders related to selected service requests. Table 8 
shows the check box in order records.

Solutions View 
The Solutions view associates existing solutions and related, frequently asked 
questions (FAQs) to a service request. Click on the name of the solution to go to 
the Solutions screen and the Resolution Documents view, which displays the 
names of files containing information supporting a solution.

Charts View 
The Charts view provides the analyses, listed in Table 9, of activities.

Table 8. Selected Item in the Orders View

Item Description

Approved A check box that indicates this order was approved. This check box is 
for information only. It does not have associated code.

Table 9. Service Analysis Charts

Chart Analysis

Aging Analysis by Product The duration of a service request as a function of product.

Aging Analysis by Product 
Area

The duration of a service request as a function of field 
service product area.

Aging Analysis by Severity The duration of a service request as a function of severity.

Aging Analysis by Status The duration of a service request as a function of status 
(Open, Assigned, Pending, and so on).

Priority Analysis by Owner The priority of service requests assigned to each field 
service engineer.

Status Analysis by Owner The status of service requests assigned to each field 
service engineer.
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Closed Service Requests by 
Owner

The history of closed service requests assigned to each 
field service engineer.

Closed Service Requests by 
Product

The history of closed service requests for each product.

Customer Analysis The number of service requests for each customer 
account.

New Service Requests The number of new service requests per calendar period.

New Service Requests by 
Owner

The number of new service requests assigned to a field 
service engineer per calendar period or per product.

New Service Requests by 
Product

The number of new service requests for each product per 
calendar period.

Product Analysis The number of new service requests for each product.

Product Version Analysis The number of new service requests for each version of a 
product.

Severity and Priority Analysis Two graphs:

■ The number of service requests as a function of 
severity.

■ The number of service requests as a function of 
priority.

Status and Area Analysis Two graphs:

■ The number of service requests as a function of status.

■ The number of service requests as a function of field 
service product area.

Symptom and Resolution 
Analysis

Two graphs:

■ The number of service requests as a function of 
symptom.

■ The number of service requests as a function of 
resolution.

Trend Analysis by Product The number of service requests for each product as a 
function of calendar period.

Table 9. Service Analysis Charts

Chart Analysis
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Aging Analysis by Priority The duration of a service request as a function of priority.

Trend Analysis by Product 
Area

The number of service requests for each field service 
product as a function of calendar period.

Trend Analysis by Severity The number of service requests for each severity level as 
a function of calendar period.

Trend Analysis by Source The number of service requests logged in by a given route 
(email, phone, and so on) as a function of calendar 
period.

Trend Analysis by Status The number of service requests with a given status as a 
function of calendar period.

Table 9. Service Analysis Charts

Chart Analysis
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Service Reports
Service reports, listed in Table 10, are available from the View menu by selecting 
Reports.

NOTE: Use a query to limit the reports to service requests of interest.

Table 10. Service Reports

Report Description

Service Request Activity (All) Displays a page for each service request, 
with information about the service request 
and each of the associated activities.

Service Request Activity (Public) Displays a page for each service request, 
with information about the service request 
and each of the associated activities.

Service Request Detail (Barcode) Provides detail information about each 
service request.

Service Request Detail (No Barcode) Provides detail information about each 
service request.

Service Request Summary Provides a summary of each service request.

Smart Report Service Request Performance Analyzes the aging of open service requests 
using three metrics: number of open service 
requests, call volume, and resolution time, 
each over the last six months.
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About Solutions
Customer service organizations estimate that approximately 85 percent of 
incoming service requests have been previously resolved by other customer service 
representatives. To minimize costs and maximize the effectiveness of a call center, 
an organization can reuse the solutions for previously resolved problems.

The Solutions module allows you to store, organize, associate, and search the 
knowledge base for resolutions successfully used for similar problems or even 
published solutions for potential problems. 

After a problem is successfully resolved, you can associate the solution with the 
service request for reference, in case the service request is reopened by the 
customer at a later date. Recording the solution also makes it possible for you to 
resolve similar service requests without doing extensive research. You can find 
an existing service request, solution, or resolution document that may provide 
information relevant for the current service request or product defect under 
investigation. You can quickly review the information and associate it with the 
current service request or product defect.

NOTE: Full text search of service requests is configurable. To configure the search 
engine for service requests, see Siebel Search Administration Guide.
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Setting Up Solutions
Use the Solution Administration screen to provide the information that can provide 
immediate solutions to requests for service. 

To add a solution

1 Navigate to Site Map > Solution Administration. 

2 Create a new solution record.

3 Enter values for the required fields.

To add a resolution document to a solution

1 Navigate to Site Map > Solution Administration. 

2 In the Solutions list, select a solution.

3 Click the Resolution Documents view tab.

4 In the Resolution Documents list, create a new resolution document record.

5 In the File Name field, navigate to an electronic document file on your computer 
or on your company’s network, and select it.

To associate solutions with each other

1 Navigate to Site Map > Solution Administration. 

2 In the Solutions list, select a solution.

3 Click the Related Solutions view tab.

4 In the Related Solutions list, add a related solution record.

To associate a service request with a solution

1 Navigate to Site Map > Solution Administration. 

2 In the Solutions list, select a solution.

3 Click the Service Requests view tab.

4 Add a service request record.
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To associate a change request with a solution

1 Navigate to Site Map > Solution Administration. 

2 In the Solutions list, select a solution.

3 Click the Change Requests view tab.

4 Add a change request record.
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Solution Administration Screen
The Solution Administration screen defines solutions to service requests and 
associated resolution documents, solutions, service requests, and change requests. 
It also provides predefined solution categories that add information to a solution.

The information provided in these views appears in the Solutions screen (see 
“Solutions Screen” on page 83).

Solutions
The Solutions list records the name and description of a solution, plus the 
frequently asked questions (FAQs) to which the solution might respond. Table 11 
shows the items in solutions records.

The More Info view for the Solutions list displays Solution Categories that provide 
additional predetermined pieces of information that add to this solution.

Table 11. Selected Items in the Solutions View

Item Description

Publish Internal A check box that indicates this information is available to internal 
users. The check box indicates this solution will not appear in solution 
lists exposed to customers over the Web but appears on internal 
solution lists.

Publish External A check box that indicates this information is available to external 
users. The check box indicates that this solution appears both in 
solution lists exposed to customers over the Web and on internal 
solution lists.
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Resolution Documents View
The Resolution Documents view allows you to associate files with a service request. 
These files can contain information that contributes to solving the service request.

Resolution documents are, by default, read-only. To edit these documents in the 
Solution Administration screen, follow this procedure:

To allow editing of resolution documents

1 Start Siebel Tools.

2 Choose the SR Resolution Item list frame.

3 Choose the list column ResFileName.

4 Change the read-only property from TRUE to FALSE.

5 Compile and test the change.

Related Solutions View 
The Related Solutions view associates solutions records that may contribute to the 
resolution of a selected solution.

Service Requests View 
The Service Requests view associates service requests that may contribute to 
a solution.

Change Requests View 
The Change Requests view associates change requests that may contribute to 
a solution. 

Solution Categories View 
The Solution Categories view associates predefined solutions that may contribute 
to an overall solution. 
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Solutions Screen
The Solutions screen provides predefined solutions with associated resolution 
documents, solutions, service requests, and change requests. This information is 
defined in the “Solution Administration Screen” on page 81. Most of the views 
in the Solutions screen are identical to those in the Solution Administration screen, 
with the exception of Solution Categories, which is unavailable in the Solutions 
screen. 

Most views in the Solutions screen allow users to add records.

Solutions View 
The Solutions view displays the name and description of a solution, the FAQ to 
which the solution might respond, and an answer to the FAQ. These records are 
read-only.

Resolution Documents View 
The Resolution Documents view associates a selected solution with files containing 
information that contributes to solving a service request. 

Related Solutions View 
The Related Solutions view associates a selected solution with solutions records 
that may contribute to the resolution of a selected solution. 

Service Requests View
The Service Requests view associates a selected solution with a service requests 
that may contribute to this solution. 
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Change Requests View 
The Change Requests view associates a selected solution with change requests that 
may contribute to a solution. 

Customer Satisfaction Survey View
The Customer Satisfaction Survey view records the responses from customers on 
the effectiveness of service. The answers to predetermined questions contribute to 
a customer satisfaction score (Satisfaction Level). This survey is associated with a 
selected solution. 
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This chapter shows how Field Service uses activities. For general information about 
activities, see the Activities chapter of Applications Administration Guide.
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Activities Overview 
Using Siebel Field Service, field service engineers work from activities. Activities are 
either attached to a service request or stand-alone. Using an activity template, Field 
Service can automatically provide a set of activities to carry out a service request. 

These are the common types of activities:

■ Service activities that fall into these categories:

■ Installation

■ Preventive maintenance

■ Repair activities, including shipping and receiving

Field Service provides activities to track the tasks done in response to a service 
request, a preventive maintenance request, the report of a change request, and the 
request for a repair. The Activities screen records activities that must be assigned 
to field service or call center personnel.

Field service and repair activities are accompanied by detailed information for field 
service personnel, which includes steps, items (recommended parts/tools), skills 
and instructions, field part movements, expense recording, and time recording.

NOTE: Recommended parts and tools are called Items in Siebel 7. 

These are the major advantages of breaking down a service request into one or 
more activities:

■ The ownership of the problem remains at the call management level, 
when required.

■ The field service engineer looking at assigned activities can easily identify 
only the required information.
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■ Reporting is simplified.

■ Activities can be assigned to more than one person.

NOTE: Field service activities can be stand-alone (for example, preventive 
maintenance activities) or, more commonly, attached to service requests. For 
complex preventive maintenance activities, it may be convenient to formalize 
the activity by creating a service request.

Field engineer activities are an extension of the Siebel Activity object, with 
Field Service customizations that specifically meet the requirements of engineers 
reporting complex, standardized service activities. 

Activity objects may be associated with the following Siebel objects:

■ Accounts

■ Agreements

■ Assets

■ Campaigns

■ Change requests (Quality screen)

■ Contacts 

■ Messages

■ Opportunities

■ Order Items

■ Preventive maintenance

■ Programs

■ Projects

■ Repairs

■ References

■ Service requests
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Activities, once generated, are assigned to appropriate engineers. Assigned activities 
are displayed on the engineers’ calendars and the engineers may receive automatic 
notification by way of their laptop computers, handheld computers, cell phones, or 
pagers. Engineers can accept or decline an activity and, once accepted, use the 
Activities screen to report on its execution.

Assigning activities can take place manually, one by one, on the Activities, Service 
Requests, and Dispatch Board screens. The person assigning can select engineers 
manually or use the Assignment Manager (Assign menu command). Automatic 
assignment uses a variety of criteria for assignments, including skills, availability, 
location, and cost.

Scheduling of assigned engineers can take place manually on the Activities screen, 
on the drag-and-drop interface of the Dispatch Board screen, or automatically using 
Siebel Scheduler. 

For a complete discussion of assigning and scheduling activities, see Chapter 4, 
“Scheduling and Dispatch.”
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Using Activity Templates and Plans
Activity plans are created using activity templates. Activity templates are collections 
of predefined activities. Activity plans may include schedule requirements for 
carrying out these activities. 

In the Activity Plans views on the Service Requests, Accounts, and Repairs screens, 
only the activity templates for specific types of activity are visible. For example, 
when generating an activity plan for opportunities, only activity plans of the type 
Opportunity are visible. Selecting a template selects all the activities in that template 
and the child records of those activities (for example, Service Details, Items, Skills, 
and so on).

Fields Copied from Activity Templates
The following fields are copied from activity templates to an activity plan:

■ Activity type

■ Alarm

■ Category

■ Comments

■ Cost Estimate

■ Description

■ Display In

■ Duration

■ Employee

NOTE: If Employee is defined in the Activity Template, then it is copied. 
Otherwise, the value in the Employee field depends on the activity category. If 
the activity category is not Field Engineer Activity, Repair Activity, Preventive 
Maintenance, or Other, then the Employee field is populated with the current 
login ID.
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■ Lock Assignment

■ Priority

■ Status

Child records associated with the template are copied to the following views on the 
Activities screen:

■ Steps view

■ Instructions view

■ Items view

■ Skills view

NOTE: To copy the child records from the template, set the activity Category field to 
Field Service Activity, Preventive Maintenance, Repair Activity, or Other. See “All 
Activities View” on page 104. 

For more information about views on the Activities screen, see “Activities Screen” 
on page 104.

About the Category Field
The Category field on the Activity Templates Service Details subview determines the 
following for activities generated from the activity template:

■ Whether child records of the activities are created when the template is applied

■ Whether assignment of the activity is locked

■ How the activity is assigned

For more information about this subview, see “Service Details Subview” on 
page 102.
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Child Records
If the Category field is set to Field Engineer Activity, Repair Activity, Preventive 
Maintenance, or Other, then any child records such as service activity steps or 
assignment skills will be created when the activity template is applied.

If the Category field is left blank or set to a value other than those listed in the 
previous paragraph, the activity records will be created when the template is 
applied, but no child records will be associated with the activities.

Lock Assignment
If the Category field is left blank, the Lock Assignment check box for the created 
activity is selected.

Activity Assignment
An activity created with activity templates can be assigned to any one of the 
following users:

■ The employee specified in the template

■ The employee who created the activity by applying an activity template (This is 
usually in a sales situation.)

■ No employee (This is recommended when Siebel Assignment Manager is to be 
used to assign the activity.)

The assignment is determined by the values in the Employee and Category fields of 
the activity record in the Activity Template Details list. Table 12 shows how the 
assignment is determined.

Table 12. Employees and Category Values Determine Activity Assignment

Employees Field Value Category Field Value Assignment

NOT NULL Any value (NULL or NOT NULL) Assigned to the employee 
specified in the Employee 
field of the activity template.
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NULL Field Engineer Activity, Repair 
Activity, Preventive Maintenance, 
or Other 

Not assigned. The Employee 
and Owner fields are blank in 
the created activity.

NULL Not Field Engineer Activity, Repair 
Activity, Preventative 
Maintenance, or Other

Assigned to the employee 
who created the activity by 
applying the activity 
template.

Table 12. Employees and Category Values Determine Activity Assignment

Employees Field Value Category Field Value Assignment
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Setting Up Activities
This section includes the following procedures for setting up field service activities. 
These include defining activity templates and supplying information for carrying 
out each activity.

Setting Up Field Service Activity Templates
Follow these procedures to set up activities.

To define activity templates

1 Navigate to Site Map > Application Administration > Activity Templates.

2 Create an activity template record.

3 Enter values for the required fields.

To associate activities with activity templates

1 Navigate to Site Map > Application Administration > Activity Templates.

2 Select an activity template.

3 Click the Activity Template Details view tab or the Service Details view tab.

4 Create an activity record.

5 Enter values for the required fields.

NOTE: You can associate activities with an activity template in either the Activity 
Template Details or the Service Details view.

To associate steps, skills, parts and tools, and instructions with an activity

1 Navigate to Site Map > Application Administration > Activity Templates.

2 Select an activity template.

3 Click the Service Details view tab.

4 Select an activity record.
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5 Click the Service Activity Steps tab.

a Add a new record for each step. 

b In the Sequence field, specify the sequence of steps.

6 Click the Assignment Skills tab.

a Add a new record for each skill.

b In the Service Activity Skill Item list, specify the type of skill and level of 
expertise.

The fields in this view depend on the content selected for the Item field in 
the Assignment Skills view.

7 Click the Service Activity Items tab.

a Add a new record for each part or tool.

b Specify the quantity of each part or tool.

8 Click the Service Activity Instructions tab and add a new record for each 
instruction.

Setting Alarms for Activities
Activities are attached to many Siebel business objects; for example, Service 
Requests and Opportunities. Siebel applications can notify the user of the start time 
for a pending activity. The Alarm check box in each Activity record turns on this 
notification.

Alarm notification displays a dialog box or pop-up window in the Siebel user 
interface at a predetermined interval before the start of each activity. The Alarm 
dialog box appears only once for each activity, unless the activity is repeated (the 
Repeat box is checked in the activity record). If the activity is repeated, the alarm 
appears at the specified time before the start of each instance of the activity.

Alarms work only through the user interface; they cannot trigger workflow 
processes. Since alarms require High Interactivity, they are available only for 
Siebel Enterprise Applications that have High Interactivity set on.
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Configuring Alarms
Alarms notify users of upcoming activities. One setting configures the time at which 
the notification takes place.

To set the time that alarms appear 

1 Navigate to Site Map > User Preferences > Calendar.

2 In the Alarm Lead Time field, select a time from 5 to 120 minutes before the 
value of Planned Start for each activity.

Turning on Alarms for Activities
To set the alarm for an activity, check the Alarm box in an activity record on 
any screen that provides an Activities view or in the Calendar screen (see the 
following procedure).

To turn on alarms for a calendar activity

1 Navigate to the Calendar screen.

2 Add a new activity record to the calendar.

3 In the Calendar Detail view, complete the required fields.

4 Select the Alarm check box.

5 Click Save This One.
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The following procedures suggest a typical workflow for a field service engineer 
who is working from a set of activities.

To log expenses for an activity

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Expense Tracker view tab.

4 Create a new expense record.

5 Enter values for required fields, plus the amount.

6 Select the Billable check box to include this item in invoices produced 
automatically for this activity.

To log hours spent on an activity

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Time Tracker view tab.

4 To create a time tracker record, click Start.

The Start field is automatically filled in with the time you create the record.

5 To record the end time for an activity, click Stop.

To verify the availability and order status of materials for an activity

1 Navigate to the Activities screen.

2 Select an activity.
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3 Click the Items view tab.

The associated parts and tools appear in the Items list. The Order #, Order 
Type, and Line Status fields show the status for receiving an ordered part.

NOTE: A field service engineer can create an order from the Items list by clicking the 
menu button and selecting the type of order needed (Service or Sales). To verify the 
order or to view order details, save the record and click the hyperlink in the Order 
field; this displays the related order on the Orders screen. 

To order materials for an activity

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Items view tab.

The associated parts and tools appear in the Items list.

4 Select a record in the Items list.

5 Click the menu button and select Service Order. 

This creates a service order for the selected item. 

6 To order all items that have not yet been ordered, select Service Order All from 
the drop-down list.

A new, unique order number appears in the Order # field as a hyperlink and the 
Order Type field shows Service Order. The order also appears in the Orders 
screen. 

To record additional items (parts and tools) required to complete a service activity

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Items view tab.
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4 Create a part record.

5 In the Product field, select a part or tool.

NOTE: A tools record has its Tools check box selected.

To verify on-hand inventory using the Part Browser

1 Navigate to the Part Browser screen. 

The Product Inventory view appears.

2 Select the record for a part and its inventory location. 

3 Check the Inventory Level list for the part’s availability, status, and quantity at 
that inventory location. 

4 Check the Substitutes list to see if there are any alternatives for a part.

To verify on-hand inventory using Check Trunk

1 Navigate to the Activities screen. 

2 Select an activity record. 

3 Click the Items view tab.

4 In the Items list, select the activity item for which you want to verify on-hand 
inventory.

5 Click Check Trunk.

The Available Qty field is updated according to the current user’s trunk 
inventory. 

To record the movement of service parts in the field

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Part Tracker view tab.

4 Create a part movement record.
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5 Enter values for the required fields.

6 Click Commit.

This creates an inventory transaction, an asset transaction, or both (depending 
on the source or destination) in the Field Service server. 

NOTE: Part movements recorded in the field appear here only after synchronization 
with the field service engineer’s mobile computer. If the engineer described the part 
with a write-in serial number, the part transfer appears here only after processing 
by an administrator.

To generate an invoice automatically for a field service activity

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Invoices view tab.

4 Click Auto Invoice.

Auto Invoice creates an invoice record for this activity.

To enter a new activity for a service request

1 Navigate to the Service screen. 

2 Select a service request.

3 Click the Activities view tab.

4 Create an activity record.

5 Enter values for the required fields. 

To record additional recommended steps for a service activity 

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Steps view tab.
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4 Create a step record.

5 In the Step field, select a step. 

6 If you enter multiple steps, correct the sequence of steps by typing the correct 
numbers into the Step # fields.

To record additional skills required to complete a service activity

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Assignment Skills view tab.

4 Create a skill record.

5 In the Item field, select the type of skill.

6 In the Service Activity Skill Item subview tab, create a skill item record.

7 Complete the skill item record fields as needed. 

NOTE: Fields in the skill item record vary according to the selection you made in 
the skill record’s Item field.

To record additional instructions for a service activity

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Instructions view tab.

4 Create an instruction record.

5 Enter values for the required fields.
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Monitoring Field Service Activities
A service center agent can use the following procedures to monitor the progress of 
a service request.

To review a field service engineer’s activities

1 Navigate to the Calendar screen.

2 From the Owner drop-down list, select the name of the field service engineer.

3 For the type of calendar, click the Daily, Weekly, or Monthly tab.

To verify part movements in the field

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Part Tracker tab. 

A record of part movements appears in the Part Tracker list.
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The Application Administration Screen has a view and a subview that are suitable 
for defining Field Service-related activity plan templates.

Activity Templates View
The Activity Templates view creates activity plan templates for all Siebel 
applications. Any number of activities may be associated with these templates. 
Table 13 describes items in activity templates records.

Service Details Subview
The Service Details subview associates multiple activities with each activity 
template. This subview has tabs for associating steps, skills, parts and tools, and 
instructions with an activity.

Table 14 describes items in activity template detail records.

Table 13. Selected Item in the Activity Templates View

Item Description

Public When selected, this check box indicates that the information can be 
accessed by customer and partner applications, as well as by employee 
applications.

Auto Trigger This check box provides the activities from this template to a sales stage, 
when the sales stage is set for an opportunity.

Table 14. Selected Item in the Service Details Subview

Item Description

Breakable When selected, allows Optimizer to insert a break into an activity.

For information about Optimizer, see Chapter 4, “Scheduling and 
Dispatch.”

Category Category under which the activities will fall. For information about the 
effects of selections in field, see “About the Category Field” on page 90.
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Duration Complete duration of the activity, expressed in minutes, and calculated as 
work time + break time.

Lead Time Duration of travel to or other preparation for the activity.

Lock 
Assignment

When selected, prevents reassignment of the activities. 

Units Units of measure for Lead Time field.

Work Time Duration of work.

Table 14. Selected Item in the Service Details Subview

Item Description
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The Activities screen manages all activities that a field service engineer carries 
out in response to a service call.

All Activities View
The All Activities view shows all activities, both active and closed, assigned to field 
service engineers. A field service engineer can add activities or modify existing 
activities; for example, change the status of an activity. The Activities view changes 
from a list to a form after choosing the Instructions, Invoices, Part Tracker, Time 
Tracker, Skills, or Items view.

NOTE: The child records of activities (for example, Steps) may be available only for 
activities of certain types (for example, Service).

Table 15 describes items in Activities records.

Table 15. Selected Items in the Activities View

Item Description

Alarm A check box that turns on a warning if the activity does not begin 
by the planned start date.

Billable A check box that indicates to the Invoice Engine that this activity 
is billable to the customer.

Category Determines the type of child records that are inherited from the 
activity template (see “Fields Copied from Activity Templates” on 
page 89). It also determines the behavior of the Lock Assignment flag 
(see “Rules for Assigning Activities” on page 106). 

Change 
Request #

The defect number for a product associated with this activity, chosen 
from a dialog box. 

Defective Tag The defective tag number (repair number) associated with this 
activity, chosen from a dialog box. In the form only.
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Due This is the last time and date for an activity, usually used to indicate 
contractual commitments or deadlines. This field is automatically 
populated with the value from the Agent Committed field for the 
service request (see “Calculating the Agent Committed Time for a 
Service Request” on page 66). Due is the same as the Latest Start field 
in the Schedules view on this screen. 

Duration The time required to carry out an activity, including breaks and travel 
time. The value is = Planned End – Planned Start. In the form only.

Employees The names of the employees assigned to carrying out a selected 
activity. One employee may be identified as primary.

Repeat 
Frequency

The interval at which to repeat this activity: daily, weekly, monthly, 
quarterly, or yearly. The repeated activity appears multiple times in the 
service engineer’s calendar. The Dispatch Board cannot schedule 
repeated activities.

Private A check box that indicates this activity is internal to the service 
business and is not visible to a customer; for example, over the 
Internet. In the form only.

Lock Assignment A check box that instructs the Assignment Manager not to assign this 
activity. For more information, see “Rules for Assigning Activities” on 
page 106.

Repeat Until End date for repeating this activity. 

Resolution Code The solution code for an activity, chosen from a drop-down list. Also 
applies to a service request, and is labeled Resolution in the Service 
Requests view.

SR # The service request associated with a selected activity.

Status The state of an activity; for example, Approved, Unassigned, or Done. 
Clicking the hyperlink for the value Unscheduled in the Status field 
presents the Dispatch Board screen.

Table 15. Selected Items in the Activities View

Item Description
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Rules for Assigning Activities
When an activity is created with the Category field set to Field Engineer Activity, 
Repair Activity, Preventive Maintenance, or Other, the following occurs:

■ No owner is assigned. 

■ The Lock Assignment flag is set to False—meaning that the Assignment Manager 
automatically assigns this activity. 

After the record is saved, changing the Category value does not have these effects.

Use Siebel Tools to change the default for activity categories (set 
ASGN_USR_EXCLD_FLG to N; the default is Y). 

Use the Lock Assignment flag in the “All Activities View” on page 104, the 
“Schedule View” on page 110, and the “Activity Templates View” on page 102 to 
change this assignment for individual activities. If this flag is checked, the 
Assignment Manager excludes this activity.

Expense Tracker View
The Expense Tracker view allows a field service engineer to record expenses 
related to an activity. Table 16 describes the check box in Expense Tracker records.

In the Expense Tracker view, a Complete button appears at the top of the Activity 
form. This button updates the Cost and Price fields for all the current activity’s 
parts, time, and expense records, and changes the value in the Activity record's % 
Complete field to 100. (Additionally, when the % Complete field reaches 100, the 
Status field value changes to Done.)

Table 16. Selected Item in the Expense Tracker List

Item Description

Billable A check box that indicates this expense is billable to the customer. When this 
flag is set, the Invoice Engine uses this record to create an invoice. 
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Part Tracker View
The Part Tracker view describes the transfer of parts in the field between the client, 
a service order, and the field service engineer’s trunk inventory. Table 17 describes 
items in Part Tracker records.

NOTE: Transactions between inventories and between inventories and customers are 
recorded on the Inventory Transactions screen (see “Inventory Transactions View” 
on page 352).

In the Part Tracker view, a Complete button appears at the top of the Activity form. 
This button updates the Cost and Price fields for all the current activity’s parts, time, 
and expense records, and changes the value in the Activity record's % Complete 
field to 100. (Additionally, when the % Complete field reaches 100, the Status field 
value changes to Done.)

Table 17. Selected Item in the Part Tracker List

Item Description

Billable A check box that indicates this labor is billable to the customer. 
When this flag is set, the Invoice Engine uses this record to 
create an invoice. The service business can define expenses that 
are not billable; for example, a coffee break.

Commit A check box that indicates this transaction was committed. This 
check box is set automatically after clicking the Commit button, 
if all validations are completed (see “Instructions View” on 
page 108).

Commit and Commit 
All buttons

The Commit button creates a transaction for a selected, 
uncommitted record. The Commit All button creates 
transactions for all uncommitted records. 

Once committed, a record becomes read-only. Committed 
records cannot be uncommitted. For more information, see 
“Mechanism of the Commit Buttons” on page 330. 
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Instructions View 
The Instructions view records instructions for carrying out an activity. 
These instructions may be specific to a customer’s site. 

Invoices View
The Invoices view displays invoices created for this activity and it allows manual 
or automatic generation, using the Auto Invoice command, of invoices for any 
activities that are marked as billable. For more information, see “Invoices View” on 
page 262 and “Auto Invoice Command” on page 262.

Readings View
The Readings view displays key characteristics of an asset, defined in the Activities 
form, that may be recorded and tracked. The upper list describes measurements 
that are described for this product. The Readings form records data for the selected 
measurement collected from the asset. The Readings view collects information used 
to trigger preventive maintenance activities and use-based invoicing.

Write-In Asset A check box that indicates the serial number for an asset is not 
in the local database. The user checks this box, and then enters 
a write-in serial number. This check box is for information only; 
it does not have associated code.

Write-In Serial Number A field for entering a serial number. This is for an asset that is 
not yet in the Field Service database on the local computer. An 
administrator generates the inventory transaction for the asset 
after the user synchronizes. 

Table 17. Selected Item in the Part Tracker List

Item Description
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Items View
The Items view shows the recommended parts and tools that a field service 
engineer must have to complete an activity. An activity template can populate these 
records, and the owner of the activity can add records. Table 18 describes items in 
Items records. 

Table 18. Selected Items in the Items View

Item Description

Check Trunk This button displays a pop-up window with the product name, part 
number, inventory location, quantity requested, and quantity available for 
the selected activity item. The quantity available is a calculated quantity.

Order # The number of a sales or service order, if this part or tool is on order, which 
the field technician selects from a dialog box. 

Tool A check box that indicates this is a tool rather than a part. This is for 
information only; there is no associated code.

Note that product records are created in the Product Administration 
screen. The Products form view contains a Tools check box that the 
product is a service tool and not a part that a customer would buy. This 
check box has other effects; for example, with this box checked, the 
customer cannot order this product. 
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Schedule View
The Schedule view provides an extended description of the schedule and the 
scheduling process for a selected activity, plus controls for booking or cancelling 
future appointments and for inserting an activity in an optimized schedule. Some 
of the fields in this view appear also in “All Activities View” on page 104. Table 19 
describes items in Schedule records.

Table 19. Selected Items in the Schedule View 

Item Description

Account Address 
Map

This button provides a hyperlink to the MapQuest web site. Siebel 
does not guarantee the availability or accuracy of any content or 
service provided by MapQuest. 

Allow Breaks This check box allows the Optimization Engine to disrupt an activity 
to insert defined breaks, but not breaks that are separate activities 
(see “Breaks” on page 146).

Book Appt This button sends a request to the Scheduler to find the possible time 
slots for scheduling this activity. For more information, see Chapter 4, 
“Scheduling and Dispatch.”

Cancel Appt This button sends a request to the Scheduler to remove this activity 
from the schedule. For more information, see Chapter 4, “Scheduling 
and Dispatch.”

Contract Schedule This button sends a request to the Scheduler to insert an activity into 
the schedule with minimal disruption to the schedule and without 
significant increase in the cost of the schedule. For more information, 
see Chapter 4, “Scheduling and Dispatch.”

Duration The time required to carry out an activity, including breaks and 
travel time. The value is = Planned End – Planned Start.

Earliest Start The earliest time and date an activity may begin, usually used 
to indicate contractual commitments or deadlines. In some 
configuration settings (see “Scheduling Parameters” on page 150) 
it may be NST (No sooner than).
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Assignment Skills View
The Assignment Skills view describes the skills needed to complete an activity. This 
view contains lists of Service Activity Skills and Service Activity Skill Items. Various 
skills, such as product or language skills, are required for a field service engineer to 
carry out an activity. Add skill types (which appear in the drop-down menu for the 
Item field) using the Assignment Administration screen (see Siebel Assignment 
Manager Administration Guide). The Assignment Manager uses these attributes in 
assigning an activity to the right employee.

Latest Start The latest time and date for an activity, usually used to indicate 
contractual commitments or deadlines. It is the same as the Due field 
in the More Info view on this screen. In some configuration settings, 
it may be NLT (No later than). 

Lock Assignment A check box that instructs the Assignment Manager not to assign this 
activity. The Employees field is never changed. For more information, 
see “Rules for Assigning Activities” on page 106. 

Lock Schedule A check box that prevents the Optimization Engine from scheduling 
this activity. When this flag is set, the engine cannot change the 
values of Planned Start and Planned End.

Planned End The proposed date for completing an activity. Also appears as 
Planned Completion in the user interface.

Planned Start The proposed date for starting an activity. The engines use this value, 
along with Planned End, to calculate the duration of an activity and 
to determine whether to load activity data into the Optimizer cache 
or ABS cache.

Service Region The service region to which this activity is assigned.

Work Time The time required to work on an activity, not including, for example, 
travel and breaks. The engines use this value to calculate the duration 
of an activity and to determine whether to load activity data into the 
Optimizer cache or the ABS cache.

Table 19. Selected Items in the Schedule View 

Item Description
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Steps View
The Steps view describes the recommended procedures for carrying out an activity. 
Table 20 describes an item in Steps records.

Time Tracker View
The Time Tracker view allows a field service engineer to record the hours spent 
on each field service activity. Table 21 describes items in Time Tracker records.

In the Time Tracker view, a Complete button appears at the top of the Activity form. 
This button updates the Cost and Price fields for all the current activity’s parts, time, 
and expense records, and changes the value in the Activity record's % Complete 
field to 100. (Additionally, when the % Complete field reaches 100, the Status field 
value changes to Done.)

Table 20. Selected Items in the Steps View

Item Description

Done A check box that indicates this step was completed. This check box is 
for record keeping; it has no effect on other functions in Field Service.

Table 21. Selected Items in the Time Tracker List

Item Description

Billable A check box that indicates this labor is billable to the customer. When this 
flag is set, the Invoice Engine uses this record to create an invoice. The 
service business can define expenses that are not billable; for example, a 
coffee break.

Start This button creates a new Time Tracker record, records the date and time, 
and defaults the Type field to Work.

Stop This button records the stop date and time for the activity in the Time 
Tracker record. To resume an activity, the field service engineer must click 
Start to create a new record.
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Charts View
The charts view provides the charts listed in Table 22 for the analysis of activities.

Table 22. Activities Analyses

Chart Analysis

Account and Type Analysis Two graphs:

■ The number of activities for each account.

■ The number of activities for each type of account.

Contact Analysis The number of activities for each contact.

New Activities Analysis The number of new activities as a function of 
a calendar period.

Status Analysis by Owner The number of activities for each owner.

Status and Priority Analysis Two graphs:

■ The number of activities for each status category.

■ The number of activities for each priority 
category.

Symptom and Resolution Analysis Two graphs:

■ The number of activities of each symptom type.

■ The number of activities for each resolution code.

Trend Analysis by Activity Type The number of activities of each type as a function 
of calendar period.

Trend Analysis by Product The number of activities for each product as a 
function of calendar period.
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Activity Reports
The Reports menu provides the reports, listed in Table 23, for activities.

Table 23. Activities Reports

Report Description

Activity List A summary of all activities.

Field Engineer Activity Summary A summary of all activities for field service engineers.

Field Engineer Activity Detail A full report of each field service activity, printed 
one per page.
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Products Screen
The Products screen has one view, Service Details, that is useful for field 
service activities.
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Service Details View
The Service Details view provides information about service products and possible 
substitute products. The values are defined in the “Product Administration Screen” 
on page 301. All fields are read-only. Table 24 describes items in Field Service 
Details records.

Table 24. Selected Items in the Service Details View

Item Description

Allocate Below Safety A check box that indicates the Fulfillment and Part Locator 
Engines can allocate this product when its level in inventory is 
below the safety level. 

Auto Substitute A check box that indicates the Fulfillment and Part Locator 
Engines can automatically substitute a product.

Auto Allocate A check box that indicates the Fulfillment and Part Locator 
Engines can allocate this product. If this box is unchecked, the 
engines do not allocate this product.

Field Replaceable A check box that indicates this item may be replaced at the 
customer site. This is informational only. 

Lead Time The wait time for the product to arrive. Allows the user to order 
the part with enough lead time to serve the customer.

MTBF Mean time between failures; a measure of dependability of the 
product.

MTTR Mean time to repair; a measure of the time required to repair the 
product.

Return Defective A check box that indicates this item, if defective, should be 
returned to the service center, This is informational and has no 
effect on other fields or functions.

Serialized A check box that indicates this product and all of its assets are 
serialized. Serialized products are treated in a different way. 
Whenever a serialized product is shipped or received, Field 
Service expects the right number of assets with serial numbers.

Tool A check box that indicates this item is a tool used in service 
procedures. This is informational and has no effect on other fields 
or functions. 
116 Siebel Field Service Guide Version 7.5, Rev. A



Field Service Activities

Products Screen
NOTE: Serialized products are treated differently from non-serialized products. 
Whenever a serialized product is shipped or received, Field Service expects the right 
number of assets. For example, if four serialized hard drives are shipped or received, 
Field Service expects that four separate assets are entered.

Substitute Products Subview
The Substitute Products subview specifies the product that the Fulfillment Engine 
may use to fill an order when the specified product is unavailable from inventory. 
All fields are read-only.

NOTE: Multiple substitute products can be established in the Products 
Administration Screen.

The user chooses from products that are specified in the “Products View” on 
page 301. The Fulfillment Engine can choose this product if the specified product is 
unavailable and the Auto Substitute flag is set. 

NOTE: Substitutions are unidirectional. Product A may substitute for Product B, but 
Product B cannot substitute for Product A unless that substitution is explicitly 
defined. 
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Part Browser Screen
The Part Browser view allows a field service engineer to investigate the availability 
of products and substitute products in all inventory locations within the field 
service business, or only those inventory locations associated with that field service 
engineer. All fields are read-only. 

Depending on the visibility of the user, the Part Browser can show inventory across 
Organizations (see “All Inventory Locations Across Organizations” on page 346).

NOTE: Do not confuse the Part Browser view with the Part Locator. The Part Locator 
is a semi-automatic mechanism that Field Service provides to find products among 
various inventory locations when fulfilling orders (see the “Part Locator Engine” on 
page 287). The Part Browser simply displays products and their inventory locations.
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This chapter describes the various aspects of scheduling and gives details about 
using the Dispatch Board.
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About Schedules
A schedule describes the hours in a week for which the customer is entitled to 
receive service. 

NOTE: Depending on the Siebel application and screen, Schedule is the same as 
Service Hours or Service Calendar.

Schedules are based on a typical work week. For each schedule, an administrator 
can also specify holidays and excluded days for which contractually covered service 
is not offered to a customer.

Service Calendars use Universal Time Code conversions. For more information, see 
the chapter on ongoing application administration tasks in Applications 
Administration Guide.
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Introduction to Siebel Scheduling
This chapter describes how customer service representatives assign and schedule 
personnel to carry out field service activities. 

The process of scheduling field service engineers must take into account a wide 
range of factors, including availability of personnel, proximity to the customer site, 
skills, availability of parts, efficiency of scheduling, and optimizing costs to the 
service provider. 

Siebel Field Service provides these tools for assigning and scheduling activities:

■ Assignment Manager. This function provides a list of personnel who are qualified 
to carry out a service activity or service request. The list, based on a set of rules, 
is ranked by a score that indicates the engineer’s suitability. The dispatcher or 
customer service representative chooses a field service engineer from this list. 
For more information, see Siebel Assignment Manager Administration Guide.

■ Appointment Booking System (ABS). Using the ABS, a customer service 
representative can schedule future appointments, with a choice of time periods 
from which a customer can select, and book appointments. The output of the 
ABS is the assignment of specific field service engineers to service activities on 
specific dates and times.

■ Optimization Engine. The main purpose of the Optimization Engine, or Optimizer, 
is to reorganize and reassign a schedule to reduce the cost of the schedule (see 
“Cost Function” on page 183). The optimizer uses a flexible set of constraints, 
availabilities, and cost considerations.

The Optimizer can reorganize schedules to meet contractual commitments for 
service, accommodate emergency service calls, and meet unforeseen events in 
the service organization (for example, sick days for field service engineers). 
These functions of the Optimizer are known as Contract Scheduling. 

Contract Scheduling inserts high-priority service activities into a schedule with 
minimal disruption of the schedule and without significant increase in the cost 
of the schedule. Contract scheduling requires an immediate response. For 
contract commitments, the Optimizer can either fit the service activity into 
a free spot in a schedule or reschedule and re-optimize an entire schedule to 
accommodate a new activity. 
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■ Dispatch Board. This screen lets a dispatcher or customer service representative 
manually assign and schedule individual activities by drag-and-drop onto a 
Gantt chart.

■ Manual assignment. Manual assignment is available in any Activities view, where 
a dispatcher or customer service representative can fill in the Employees field. 
For procedures, see “Assigning and Scheduling Field Service Activities 
Manually” on page 188.

After an activity is assigned and scheduled, the Workflow Manager can notify a field 
service engineer by sending, for example, an email or a notification to a wireless 
device. The engineer can then synchronize a mobile PC or handheld computer to 
obtain details about an activity.

Business Requirements
Typically, businesses that schedule personnel have the following needs:

■ Match the right person to an activity, depending, for example, on the skills 
required for that activity.

■ Minimize the cost of service. This usually means minimizing overtime, down 
time, and travel.

■ Respect contractual commitments (for example, service personnel must be 
onsite within 24 hours).

Businesses have to schedule service for three different time spans:

■ For emergencies today, making sure that the best person can respond in the 
promised time frame.

■ For the jobs occurring over the next week or two, ensuring that the appropriate 
people are efficiently utilized and not spending excess time traveling from site 
to site.

■ For the weeks and months ahead, booking future jobs such as preventive 
maintenance and installations, using available resources efficiently.
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Best Practice: Wireless Updates
Schedules constantly change in a service region, because a service engineer calls 
in sick, a customer cancels an appointment, or a repair runs overtime. Service 
businesses must constantly shift to accommodate unexpected occurrences.

Wireless communications allow service forces to respond flexibly to change. For 
example, an engineer calls in sick. Using a solution provided by the ABS or 
Optimizer, Field Service can send out pages or Short Message Service (SMS) 
messages to cell phones to reschedule appointments. SMS can send messages up 
to 160 characters and request confirmation of message delivery.

In another example, when time is freed up unexpectedly, break/fix activities can 
be slotted into those times. The critical step is reaching the engineer, through a 
wireless device, and obtaining acceptance. The wireless device can also provide 
basic information about the customer and the problem, preparing the engineer to 
enter the customer site informed and to fix the problem without assistance from the 
service center.

If a job runs over the scheduled time, an engineer can use a wireless device to send 
a message to a dispatcher or customer service representative; the customer service 
representative can then proactively inform the customer of the process.

Best Practice: Integration with Service Inventory System
Approximately 70 percent of all break/fix calls require a part. Because most break/
fix calls occur during the day, service engineers may not have the parts in their 
trunk inventories or the time to pick up replacement parts from a local depot. One 
solution is to schedule a service engineer who has the parts on hand. This can be 
one of the constraints when choosing appropriate personnel. 

Another solution, if the response can wait until the next day, is to reschedule the 
service call and drop-ship the parts overnight to the customer. Tight integration 
with the inventory system (which must track down to the trunk level) is critical to 
any scheduling system. Part utilization is set up using “Scheduling Parameters” on 
page 150.
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Schedule Horizons
The ABS and Optimizer define the following time periods for scheduling of 
activities:

■ Glued period. A time period, starting from today, when no scheduling of activities 
is permitted. This period is required to prevent changes to schedules and 
assignments that are already sent to field service engineers. The period is part 
of the Optimizer horizon. A glued period is not required; you can set it to 0. 

■ Contract Scheduling period. The period of time in days for scheduling immediately 
pending activities for a specific service region. Typically, this period covers days 
2 to 8 (starting from the end of the Glued period to a week from today).

■ Optimizer horizon. A period of time that includes the Glued period and the 
Contract Scheduling period. This is the time period within which the Optimizer 
operates.

■ ABS horizon. The period of time in days for scheduling future activities extending 
from the end of the Optimizer Horizon to some time in the future; for example, 
a month from today or days 9-30.

Both the ABS and the Optimizer horizons are represented by a single time line 
(Figure 2 on page 125), since both are measured from a current time (specifically, 
the time for loading data (see “Loading and Reloading Service Region Data” on 
page 139). 
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Figure 2 shows an example of how these time periods are typically defined. The 
Glued period is day 1. The Contract Scheduling period is days 2 through 7. The 
Optimizer horizon, which spans the Glued period and the Contract Scheduling 
period, is days 1 through 7. The ABS horizon is days 8 through 21, and appointment 
booking is done for that period of time.

Activities move from right to left along this time line. For example, a service activity 
may follow this scenario:

■ An appointment to perform an activity is booked into a time slot some time 8 
to 15 days from now. The ABS assigns the activity to an employee during the 
ABS horizon.

■ As the days go by, the scheduled activity moves closer to today. On day 8 it 
moves from the ABS horizon to the Optimizer horizon. In the Optimizer horizon, 
the Optimization Engine evaluates the schedule and determines the best time 
and person to carry out the service activity, while trying to minimize the costs 
of a schedule.

Figure 2. Scheduling Horizons
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■ The activity remains in the Optimizer horizon for 7 days, where the 
Optimization Engine may adjust the schedule at regular intervals, at least once 
each day. This readjustment may be necessary because of changes in personnel, 
emergency service calls, or service activities that are regulated by contractual 
commitments (for example, a warranty repair required within 12 hours).

■ On day 1, the Glued period begins and the schedule for the activities in a service 
region is locked. 

Service Regions
A service region is a geographic area defined by ZIP Codes and a service team. 
The ABS and the Optimization Engine deal with service regions and their associated 
data when scheduling activities. A field service engineer can belong to only one 
service region. 

Defining Schedules for Service Regions
Every employee and service region has a predefined schedule that includes the days 
and hours that work may take place (normal work hours), plus exceptions that 
deviate from normal work hours. Schedules for service are defined in the 
Application Administration screen, Schedules view. For more information about 
service schedules, see “Defining Schedules for Service Regions” on page 126.

A service region can have only one schedule. This schedule is associated with a 
service region in Scheduling Administration >Service Regions.

The ABS uses the service region schedule and then the employees’ schedules to 
provide appointment bookings. The Optimizer uses the field service engineers’ 
schedules, not the service region schedule, when calculating the best deployment 
of personnel.

Setting schedules for field service engineers must follow these rules:

■ A schedule must have only one shift start per day. 

■ The shift start must be the first time period in a day.

If a shift spans more than one day; for example, Monday 9–11:59 p.m. and 
Tuesday 12–4 a.m., the first day should include the start of the shift.

■ The ABS, but not the Optimizer, can have activities that span more than one day.
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■ It is possible to schedule one or more breaks in a day. 

■ The ABS does not consider overtime for a field service engineer.

■ The Optimizer can schedule activities in overtime and extended overtime.

CAUTION: Do not define breaks during overtime. The Optimizer ignores breaks that 
are scheduled during overtime and treats them as working time. This introduces 
inaccuracies into cost calculations.
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Schedules involve components such as times, locations, and personnel. This section 
contains procedures for defining schedules and their components. This section also 
includes descriptions of a schedule-related screen and its views in your Siebel 
application. 

Defining Schedules
Use the following procedures to define schedules, working days, and working 
hours. For each schedule, you set schedule hours, which define the hours of 
availability (days of week, hours per day, and holidays) for service-providing 
entities (employees, partners, or business units). Exception hours are specific days 
or hours in a schedule for working (for example, Saturday morning in an 12xM-F 
schedule) or not working (for example, a midweek holiday in a 12xM-F schedule).

To create a schedule and set schedule hours

1 Navigate to Site Map > Service Administration > Schedules. 

2 Create a new schedule record by performing the following steps:

a In the All Schedules list, add a new record.

b In the More Info form, enter a name for the schedule. 

c In the Exception Name field, select the name of the exceptions record, if any, 
that applies to this schedule.

3 Create a schedule hours record by performing the following steps:

a Click the Schedule Hours view tab.

b In the Schedule Hours list, add a new record.

c Enter values for the required fields: Start Day, Start Time, and End Time. 

d Select the Shift Start Flag if the time period described in the record defines 
the beginning of a work shift.
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e In the Type field, select a value. 

NOTE: An Extended Overtime period must be preceded by an Overtime 
period.

For rules on setting schedule shifts, see the “All Exceptions View” on 
page 132.

Repeat Step 2 and Step 3 for each day of the week on which you want to provide 
support in this schedule.

NOTE: Schedule hour records can reflect different time periods on the same day of 
the week. However, only one of these records can contain the start of a shift.

To add exceptions and exception hours to a schedule

1 Navigate to Site Map > Service Administration > Schedules.

2 Click the All Exceptions view tab.

3 Create an exception record by performing the following steps:

a In the All Exceptions form, add a new record.

b Enter the name of the exception. 

This usually represents a set of exceptions; for example, U.S. holidays.

4 Create an exception hours record by performing the following steps:

a Click the Exception Hours view tab.

b In the Exception Hours list, add a new record.

c Enter values for the required fields: Name, Start Date, and End Date.

d If the Exceptions Hours record defines a working period, select the Working 
check box.
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e If the exception hours are working hours, in the Type field, select a billing 
type for these hours: Normal, Overtime, or Extended Overtime.

NOTE: In defining schedule hours, Extended Overtime hours must be 
preceded by Overtime hours. 

To associate a schedule with an employee

1 Navigate to Site Map > User Administration > Employees.

2 Select an employee record.

3 In the More Info form, click the show more button to show more fields.

4 In the Schedule field, select a schedule.

To define exception hours for an employee

1 Navigate to Site Map > User Administration > Employees.

2 Select the employee for whom you want to define exception hours.

3 Click the Employee Exception Hours view tab.

4 In the Employee Exception Hours list, add a new record.

5 Complete the fields, as needed.

To associate a schedule with a service region 

1 Navigate to Site Map > Scheduling Administration > Service Regions.

2 Select a service region record. 

3 In the More Info tab, in the Schedule field, select a schedule.
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Service Administration Screen
The Service Administration screen has a Schedules view for setting up the hours 
available for service. 

All Schedules View
You can create multiple schedules in the All Schedules view. For each schedule, you 
set schedule hours, which define the hours of availability. The schedule may also 
include a set of exceptions (in the Exception Name field), which are defined in the 
All Exceptions view and the Exception Hours view. For more information, see “All 
Exceptions View” on page 132 and “Exception Hours View” on page 133.

Schedule Hours View
The Schedule Hours view defines the days and time periods in each day that are 
included in a schedule. For example, an 8x5 schedule will define time periods 
within eight hours on five days. This could be 9 a.m. until 5 p.m., Monday through 
Friday. However, each day could have more than one record, each with a separate 
time period; for example, 9-12 a.m. Monday and 2-5 p.m. Monday. Table 25 
describes some fields in schedule hours records.

Table 25. Items in the Schedule Hours View

Item Description

End Time Indicates the end of a time period on the selected day.

Shift Start Flag Indicates a time period that begins a work shift. The Optimization 
Engine, which uses this setting, requires the following constraints:

■ A schedule must have only one shift start per day. To set up 
multiple shift start times, use multiple schedules, each for a 
separate shift.

■ The Shift Start flag should be set on the first time period in a day 
(the exception being when a shift extends over two days).

■ Shifts can span more than a day, such as Monday 8 p.m. to 11:59 
p.m. and Tuesday 12 a.m to 4 a.m. The Monday record should 
have the Shift Start Flag selected.

Start Day A day of the week that is included in the schedule.
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The All Exceptions view names a set of exceptions to the hours defined in the 
Schedule Hours view. The Exception Hours view contains the definition of these 
exceptions. For more information, see “Exception Hours View.”

Exceptions represent special nonworking days or working days. Different exception 
records may define exceptions for different sites; for example, U.S. holidays for one 
site and Canadian holidays for another. 

To associate an exception with a schedule, define the exception (see “To add 
exceptions and exception hours to a schedule” on page 129) and include this 
exception in the definition of a schedule. 

Start Time Start of a time period on the selected day.

Type Can have a value of Normal, Overtime, or Extended Overtime. The 
Appointment Booking System and the Optimizer use this value. For 
information, see “Appointment Booking System” on page 172 and 
“Optimization Engine” on page 175.

Table 25. Items in the Schedule Hours View

Item Description
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Exception Hours View
The Exception Hours view defines a day or continuous blocks of days as an 
exception to a schedule. These days are often holidays. In some cases, exception 
hours can define working and nonworking periods; for example, no work on 
Sunday from 6 a.m. to 12 a.m. in a 7x12 schedule. For other schedules, the 
exception hours can define work periods on days that are not normal work hours; 
for example, Saturday morning for a 5x8 schedule. Table 26 describes some fields 
in Exception Hours records. 

Table 26. Selected Items in the Exception Hours View

Item Description

Start Date
End Date

A range of calendar days or hours within a specific day that define the 
exception hours. 

Reason Reason for the exception to the schedule. Values may include, for 
example, Appointment, Deadline, Sick Time, and Vacation.

Type Type of billing rate. Can have a value of Normal, Overtime, or 
Extended Overtime. Overtime and Extended Overtime apply to 
exception hours that are marked as Working. The Appointment 
Booking System and the Optimizer use this value. For information, 
see “Appointment Booking System” on page 172 and “Optimization 
Engine” on page 175.

Working Indicates that the record defines a work period.
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Scheduling administration includes setting up and maintaining data for service 
regions, setting parameters, setting up servers to run the Optimization Engine and 
ABS, and adjusting schedules.

Guidelines for Setting Up Scheduling
Consider the following when setting up Siebel Scheduling:

■ Business model. What is your business model? What part does scheduling play? 
Which Siebel application modules are you using? 

■ Service regions. Plan service regions so that movement of service personnel 
between regions should be the exception. Geographic areas that define service 
regions may overlap.

■ Server mapping. Set up servers and processors to distribute the scheduling 
tasks efficiently.

■ Employees. Assign employees to service regions.

■ ZIP or postal codes. Load ZIP Code and geocode data.

■ Constraints. Set up two types of constraints for the Optimization Engine:

■ Hard constraints. The ABS and Optimizer cannot violate hard constraints. 
Activities that do not fit these constraints are not scheduled. As a result, the 
engines are faster in finding solutions, but fewer solutions are obtained. The 
solutions result in higher costs for service. 
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■ Soft constraints. The Optimizer can weight the cost of using or violating a soft 
constraint when calculating solutions for a schedule. Soft constraints result 
in longer optimization times (lower performance of the Optimizer), more 
solutions, and lower costs for service. The result of violating soft constraints 
may be a more costly schedule.

The ABS uses only hard constraints. The Optimizer can use either hard or soft 
constraints.

CAUTION: Do not define contradictory constraints. For example, the following two 
constraints conflict if both are hard constraints and the duration for the activities 
is less than two hours:

A field service engineer must work a minimum of four hours per day.

A field service engineer can have no more than two activities per day. 

■ Cost functions. The Optimizer calculates a cost function for each proposed 
schedule. This function is sum of factors that drive the optimization of a 
schedule; for example, the cost of overtime, travel distance, and penalties for 
violating soft constraints (see “Cost Function” on page 183). 

Setting Up Service Regions
The geographic area of a service region is defined by ZIP Codes and geocodes. 
The Optimizer follows these rules for ZIP Codes:

■ A service region can include more than one ZIP Code. 

■ More than one service region can include the same ZIP Code; this means that 
service regions can have geographic overlap.

CAUTION: If possible, avoid configuring more than one service region per ZIP 
Code. Field Service assigns a service request to a service region according to the 
ZIP Code of its account’s address. If that ZIP Code is in more than one service 
region, the service request is not automatically assigned to a service region and 
a customer service agent must manually select a service region for it. 
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Geocodes and ZIP Codes
The Optimizer uses geocode data and ZIP Codes (or postal codes for international 
users) to identify addresses. Geocode data contains longitude and latitude 
coordinates for physical locations (for example, a customer site), down to minutes 
and seconds. The Optimizer can use data at any level of detail; for example, ZIP 
Codes or ZIP + 4 codes. 

As a ZIP Code can cover several square miles, it is preferable to use ZIP + 4, which 
generally brings the accuracy to the level of buildings for businesses or to within a 
block or two for residential addresses. 

The Optimizer, requires, as a minimum, ZIP or postal codes, country, longitude, and 
latitude. Five-digit ZIP Codes for the United States are shipped with your Siebel 
application’s seed data. ZIP Code information resides in the data model table 
(S_ZIPCODE). Table 27 shows the six columns in this table. 

NOTE: Where longitude and latitude values are the same for two locations, the 
Optimizer uses the Minimum Travel Time (see “Service Regions View” on 
page 160). 

Table 27. S_ZIPCODE Data Model Table

Column Description

ZIP Code Postal ZIP Code in alphanumeric text

City Name of city

State Name of state or province

Country Name of the country

Longitude Longitude number (0 to +/– 180, + for the eastern hemisphere and – for 
the western hemisphere) up to six decimal places

Latitude Latitude number (0 to +/– 90, + for the northern hemisphere and – for 
the southern hemisphere) up to six decimal places
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There are two ways to load data into the S_ZIPCODE table:

■ Use the Siebel Enterprise Integration Manager. For more information, see Siebel 
Enterprise Integration Manager Administration Guide.

■ Import data from Application Administration > ZIP Code Administration.

To import geocode data

1 Navigate to Application Administration > ZIP Code Administration.

2 Click the menu button and select Import from the drop-down list.

The Import wizard appears.

3 Specify the filename containing the data to import and click Next.

4 Complete the information, including field mapping for the data records.

Specifications for Geocode Data
There are several vendors of geocode information. Make sure to specify the 
following information in geocode data:

■ Latitude format. North of the equator is positive; south of the equator is negative. 
The data is interpreted to six decimal places.

■ Longitude format. East of the prime meridian (Greenwich, UK) is positive; west 
of the prime meridian is negative. The data is interpreted to six decimal places.

Siebel stores its latitude and longitude in the decimal degrees format, as this is 
the most widely used format and is easy to use for distance calculations (see the 
following example).

Decimal Degrees Deg:Min:Sec 

Latitude 37.830354 37:49:49.274N 

Longitude –122.284076 122:17:2.674W
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Most data sets are in decimal degrees; if not, use the following formula to convert 
it from the degrees, minutes, seconds to decimal degrees:

Decimal degrees = Degrees + (Minutes/60) + (Seconds/3600)

Example: 

37 Degrees, 25 Minutes, 40.5 Seconds 

= 37. + (25/60) + (40.5/3600)

= 37. +.416666 +.01125

= 37.427916 degrees

Data Cleansing
Address and ZIP Code accuracy are critical for a schedule optimization. Use of a 
data cleansing application, such as the Siebel Data Quality module, is highly 
recommended (see Siebel Data Quality Administration Guide).

Universal Time Codes
Siebel Field Service stores all times as Greenwich Mean Time (GMT). For display 
in the user interface, it converts GMT to the appropriate local time zone. 

Scheduling uses the following time zones:

■ The customer’s time zone. Appointments are booked in the customer’s time zone, 
which is assumed to be the same as the service region’s time zone.

■ The service center’s time zone.

■ The service region’s time zone. Activities displayed in the Activity Gantt Chart on 
the Dispatch Board are in the service region’s time zone.

■ The employee’s (field service engineer’s) time zone. Scheduling ignores the 
employee’s time zone and uses the service region time zone.

CAUTION: Activity times (for example, Earliest Start and Latest Start)1 must be 
specified in the service region time zone. If the dispatcher or service 
administrator is in a different time zone, the conversion to the service region 
time zone must be done manually.
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Service Region Schedules
Each service region is assigned a schedule that the ABS and Optimizer use. This 
may be different than the schedule associated with each employee. Schedules are 
defined in Applications Administration screen, Schedules view (see “Defining 
Schedules” on page 128).

The ABS uses the service region schedule as a base, and then refines its choices 
of time slots based on the employee schedules (see “Employee Availability and 
Schedules” on page 141).

The Optimizer uses only the employee schedules.

Loading and Reloading Service Region Data
The Optimizer acts on the schedule for each service region. Booking appointments 
and optimizing the schedule for activities requires the following data:

■ Schedules for service regions and employees

■ Existing activities and appointments

■ Service activities

■ Service regions

■ Employees

■ Parts available to employees

■ Scheduling parameters

■ Service region parameters

■ System parameters

■ Constraints

■ Time windows

■ A cost function

1. In the user interface, Earliest Start =No Sooner Than and Latest Start =No Later Than = 
Due. 
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To carry out scheduling quickly and efficiently, the server copies data from the 
database into memory caches, one for the ABS and one for the Optimizer. The ABS 
cache holds the time slots in the future, and the Optimizer cache holds the activities 
occurring over the next few days. 

Since the information is cached, it must be loaded into the caches from the database 
when the service is started periodically to synchronize updates. Initial loading and 
reloading of data are automatic processes. The data for a service region is copied 
automatically to the caches each time the server is restarted, and manually by 
clicking the Load buttons; see “Service Regions View” on page 164. Repeat requests 
can also load service region data. 

Since there are two caches, every night, information needs to move from the ABS 
(future) cache into the Optimizer (present) cache. For example, today is July 1st and 
the Optimizer horizon holds all activities from July 1 to July 7. The ABS horizon is 
defined as fourteen days, so the ABS cache holds from July 8th to July 15th. Note 
that both horizons are measured from the beginning of the Glued period. The end 
of the Optimizer horizon is set to the same calendar day (at midnight) as the start 
of the ABS horizon.

After it becomes July 2, the old, July 1 data is no longer necessary; it is in the past 
and is discarded. At the same time, the Optimizer horizon is still looking seven days 
out, so it needs to load the July 9 data into the Optimizer cache. However, before 
the data can be loaded into the Optimizer cache, it must be unloaded from the ABS 
cache. If it is in both caches at the same time, it could be changed in both engines 
simultaneously. Therefore, the activities and data for July 9 are released from the 
ABS cache, and then loaded into the Optimizer cache.

The ABS should always be reloaded before the Optimizer, so that there are no 
conflicts in scheduling between the ABS and the Optimizer. Carry out both reloads 
in the same day.

When a service region is being loaded, it is not available for requests. The request 
is returned with a return code.

At the first load of data from a service region, the Optimizer assumes that the data 
coming from the database was previously optimized. So while generating an initial 
solution, it tries to keep the assignee as well as the sequence of activities for each 
field service engineer. It also keeps the time stamp of this load in the cache.
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Employee Availability and Schedules
Employee schedules (available and unavailable hours) are controlled by the 
Schedule field in User Administration > Employees > Service Details and the 
exception records in User Administration > Employees > Employee Exception 
Hours. The definition of the schedules (which appear in the Schedule field) are set 
in Application Administration > Schedules. 

The ABS uses the service region schedule as a base, and then refines its choices of 
time slots based on the employee schedules (see “Service Region Schedules” on 
page 139).

The Optimizer uses only the employee schedules.

Maintaining and Loading Employee Data
Employee data is loaded with service region data into the ABS or Optimizer cache. 
When activities are loaded, the Assignment Manager retrieves the list of eligible 
employees and the ABS or Optimizer loads this data. 

When you load the data for a new employee, the list of employees eligible for 
existing activities is not updated. The result is that the new employee may not be 
eligible to carry out any of the existing activities, but is eligible for new activities. 
At the next reload of the service region and its employee data, the new employee is 
eligible for all activities.

Shifts
One employee can have only one shift per day, which can include rate types of 
normal time (RT), overtime (OT), and extended overtime (EOT), as defined for 
each employee. A shift must use rate types in the following order:

1 EOT

2 OT

3 RT

4 OT

5 EOT
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Any of these rate types can be missing from the definition of a shift, but the 
remaining types must be in this order. For example:

1 OT

2 RT

3 OT

The rates for overtime and extended overtime are configured in Pricing 
Administration > Cost List > Cost List Line Items as a percentage increase over 
regular time (Standard Cost). Standard Cost is set in User Administration > 
Employees > Service Details.

Skills
Siebel Scheduling is capable of performing skill-based routing (meaning, assigning 
only people with a particular skill set to a job). The engines use the Assignment 
Manager to evaluate skills and it returns a list of appropriate employees, in the 
following manner:

1 Each activity is submitted to the Assignment Manager.

2 The Assignment Manager returns the appropriate people based on 
assignment rules.

3 The Optimizer uses only these people when attempting to schedule that job.

For more information on how to set up skills and evaluation rules, refer to Siebel 
Assignment Manager Administration Guide.

Constraints
Service businesses have a number of union, legal, or business constraints under 
which they must operate. Here are a few examples:

■ Union contracts may stipulate that no worker does more than ten hours of 
overtime in a week. 

■ There may be laws regulating worker safety that restrict employees from 
working more than twelve hours a day. 
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■ To keep costs down, management might specify that no service manager should 
authorize more than forty hours of overtime per week for all of their employees.

A constraint set for each service region provides the criteria that guides the 
Optimizer in searching for a solution. Constraints may be hard or soft. Schedules 
that violate hard constraints are discarded even though they may be better than 
other solutions. The Optimizer may use solutions that violate soft constraints, but 
assigns a penalty to these violations that may make one solution less favorable than 
another solution. The cost function calculated for each solution (see “Cost 
Function” on page 183) includes the penalties for violating soft constraints.

Constraints are created using the Constraint Wizard, which walks the users through 
this process step-by-step. The user chooses a constraint template and then either 
chooses or fills in the appropriate values.

Constraints are designed for flexibility, but it is possible to write constraints that 
are contradictory and cause problems. For example, using these two constraints 
will cause problems, because the two are contradictory:

■ All employees should work at least 40 hours per week.

■ Employees performing break/fix activities should work no more than four 
hours per day. 

If both are hard constraints, the Optimizer cannot find a solution and fails to 
schedule these activities. Be sure to test new constraints before releasing them 
into a production environment; leaving them as soft constraints may help to avoid 
problems. However, too many soft constraints hamper performance, so there needs 
to be a balance. 
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Constraints fall into the following categories (Table 28).

Table 28. Constraints for the ABS and Optimization Engine

Item Description

Appointment Booking 
Activity Time 

Limits the time of day an activity of a specified type or priority can start 
or end.

Appointment Booking FSE Limit Limits the number of activities of any type or of a specified type, or time 
spent on activities by any employee or a specific employee. Or, limits the 
number of activities or time spent on activities that have a specified 
service role (for example, Installation or Preventive Maintenance). 

Appointment Booking Schedule 
Activity Type

Limits the number of activities of any type, or time spent on activities of 
a specified type for a whole schedule.

Optimizer Activity Time Hard Limits when an activity of a specified type or priority must begin or end. 
This is a hard constraint.

Optimizer Activity Time Soft Limits when an activity of a specified type or priority may begin or end. 
Also, specifies the penalty for violating this soft constraint. 

Optimizer FSE Limit Hard Limits the following values for any employee or a specific employee 
during a specified period:

■ % workload

■ Number of activities of any type or of a specified type

■ Total hours of travel time

■ Total work hours 

This is a hard constraint.

Optimizer FSE Limit Soft Limits the following values for any employee, a specific employee, or a 
specified service role (for example, Installation or Preventive 
Maintenance) during a specified period:

■ % workload

■ Number of activities of any type or of a specified type

■ Total hours of overtime

■ Total hours of travel time

■ Total work hours

Also, specifies the penalty for violating this soft constraint.
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Optimizer Fairness1 Ensures the equal distribution of the following values for workload, 
specified as a percentage, for all employees or for a specified service role 
(for example, Installation or Preventive Maintenance):

■ Number of activities of any type or of a specified type

■ Total hours of overtime

■ Total hours of travel time

■ Total work hours

Also, specifies the penalty for violating this soft constraint.

Optimizer Schedule Activity 
Type Hard

Limits the following values for a whole schedule in a specified period:

■ Hours of work time for activities of a certain type

■ Number of activities of a certain type

■ Percentage count of activities of a certain type1

■ Percentage hours for activities of a certain type1

This is a hard constraint.

Optimizer Schedule Activity 
Type Soft

Limits the following values for a whole schedule:

■ Hours of work time for activities of a certain type

■ Number of activities of a certain type

■ Percentage count of activities of a certain type1

■ Percentage hours for activities of a certain type1

Also, specifies the penalty for violating this soft constraint.

Optimizer Schedule Overtime 
Soft

Limits the hours of overtime in a specified period for a whole schedule.

Also, specifies the penalty for violating this soft constraint.

Optimizer Travel Time Limits the travel time between activities for all employees, specific 
employees, or a specified service role (for example, Installation or 
Preventive Maintenance).

This can be a hard or soft constraint.

1. This is called a leeway constraint because it is based on a percentage rather than an absolute value. 
As this is an approximate number, it allows the Optimizer to achieve acceptable schedule assignments 
within acceptable times.

Table 28. Constraints for the ABS and Optimization Engine

Item Description
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Examples of Constraints
The following constraints limit work hours:

■ An engineer cannot work more than 45 hours per week.

■ An engineer cannot engage in an activity type (for example, working with 
hazardous materials) more than four hours per day.

■ Total workload must be less than 95%.

■ Total workload must be greater than 60%.

■ An engineer cannot travel more than four hours a day, for safety reasons.

The following constraint limits timing of an activity:

■ All waste disposal activities must start before 8 p.m.

Breaks
Schedules can include any number of breaks. Breaks are defined as employee 
breaks or activity breaks:

■ Employee breaks are defined in the employee’s schedule or as exceptions to 
this schedule.

■ Activity breaks are defined in Activities > Time Tracker as time periods with 
the Type field set to Break.

The following rules apply to the way the Optimizer uses breaks:

■ Breaks can have their start time = Start Time +1 second. This means that 
a break from 12 to 1 p.m. is the same as a break from 12:00:01 to 1:00:01.

■ Break times during OT or EOT are paid.

NOTE: Since breaks during overtime are considered paid time, it is recommended 
not to define breaks during overtime. Calculating these breaks may slow the 
Optimizer’s calculations.
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■ Breaks can be allowed during activities or excluded from specific activities. 

To include a break, set the Breakable flag in Application Administration > 
Activity Templates > Activity Template Details. (If the Breakable field does not 
appear, it may be necessary to turn on the display of this field.) If this flag is not 
set, a break is not allowed during an activity.

A normal user can set breaks for a selected activity in Activities > Schedule, 
Allow Breaks check box. To see this check box, click the More/Less button.

To define breaks and allow them for activities

1 Navigate to Site Map > Application Administration > Work Types.

2 To create a break type, click New and enter a name for the break type; for 
example, Break1.

3 Complete the other fields as needed.

4 Click the view menu button and choose About Record.

The About Record dialog box shows the Row #.

5 Make note of the value for Row #. (You will need it to complete the next 
procedure.)

6 To give employees access to this break, add them in the Access field.

7 Complete the other fields as needed.

To set the name of the break type

1 Navigate to Site Map > Application Administration > System Preferences.

2 Click Query to find the system preference Sch:Break Time Id.

3 In the System Preference Value field, enter the row ID for the break defined in 
Step 5 on page 147 of the procedure “To define breaks and allow them for 
activities.”

To record break time

1 Navigate to the Activities screen.

2 Select an activity.
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3 Click the Time Tracker view tab.

4 Add a new Time Tracker record.

5 In the Type field, select the Work Type defined in the procedure “To define 
breaks and allow them for activities” on page 147. 

Travel
The Optimizer uses employee travel conditions and travel time when obtaining the 
lowest cost solution for a schedule. These values are set in User Administration > 
Employees > Service Details. The fields Start Shift From and End Shift At define the 
starting and ending conditions for travel to and from service calls. These are the 
possible values of these fields:

■ Home (Travel incl.).The employee travels from home directly to the first job. 
The Optimizer includes the cost of this travel when calculating schedules.

■ Home (Travel Not incl.). The employee travels from home directly to the first job. 
The cost of travel is not included.

■ Depot. The employee starts each day by going to a service depot or office. 
Travel costs are tracked starting from the depot.

Making Changes to a Schedule
Dispatchers and field service engineers may change these specifications for service 
activities: Planned Start date, Planned End date for an activity, and the engineer 
assigned to an activity (in the Employees field). 

NOTE: Planned End, Planned Completion and End are all the same. All these terms 
appear in the user interface.
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All changes require updating an in-memory cache of the activities. If a user changes 
an activity in the database, it becomes out of synch with the cache in memory. 
Activity data can be reloaded manually into memory by clicking the Load button in 
Scheduling Administration > Service Regions > Activities. It can also be done 
automatically using the Workflow Manager.

CAUTION: Manual changes to a schedule should be kept to a minimum. This is 
because the Optimization Engine works on the principles of constraint propagation 
and domain reduction, which are critical to solving complex schedules quickly. This 
means that no activity that violates a hard constraint can be loaded into the 
memory cache. (This includes implicit constraints; for example, using the 
employees’ work schedules or excluding double-booking.) 

Therefore, the Optimizer might reject a manual change when it loads the activity. 
Even if the activity is loaded successfully, the Optimizer may later change the 
schedule for this activity. 

When changing a schedule, a user can set two flags for an activity that freeze its 
scheduled time or assignment:

■ Lock Assignment flag ensures that Optimizer cannot change the assignment 
(Employees field). However, this value can be changed manually.

■ Lock Schedule flag ensures that the ABS or the Optimizer cannot change the 
values of Planned Start and Planned End. 

Even if these flags are set, an activity can be rejected from the schedule if it violates 
a hard constraint. However, the Optimizer does not attempt to change the activity’s 
Planned Start, Planned End, or Employees fields, so that it remains on the user’s 
calendar. Reducing the number of hard constraints used in the schedule can 
minimize the possibility of rejecting an activity.

NOTE: It is recommended that activities with a Status of Done should have the 
Lock Assignment and Lock Schedule flags set.

Where an activity violates a constraint, the Lock Assignment flag is set to TRUE, 
and the Lock Schedule flag is also set to TRUE, then the activity is not loaded into 
memory or updated.
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Moving Activities Between Service Regions
An employee can only belong to one service region. However, this does not prevent 
an employee from performing activities in other service regions. For example, Sue 
Nelson is an engineer based in the San Francisco service region. Today is a light 
day for her, but the San Jose service region is completely booked. In most cases, 
this case would be handled by manually scheduling activities for Nelson using the 
Dispatch Board. However, the Optimizer can schedule Nelson in the San Jose 
service region. This requires switching the service region for the activity. Create a 
button or workflow that carries out these steps:

1 Cancels the activity from Service Region 1 (San Francisco).

2 Sets the activity to Service Region 2 (San Jose).

3 Loads the activity in to Service Region 2 (San Jose).

The Workflow Manager can trigger this process upon rejection of an activity from 
Service Region 1. Or, the user can initiate this process interactively.

Scheduling Parameters
Parameter sets hold key information that determines how the ABS and Optimizer 
operate.
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If the scheduling server starts without Optimizer or ABS parameters (see Table 29), 
the service region is not loaded for the Optimizer or the ABS, respectively. The log 
files (ApptBook_xxx.log and Optimizer_xxx.log in the log directory on the Siebel 
server) specify which parameters are missing. Note that if a service region fails to 
load, the ABS or Optimizer must be restarted. This does not require rebooting the 
computer.

Table 29. Scheduling Parameters

Parameter Required? Value Description

Month Start Date Number, 1–28 Determines what day the month starts on. Used 
for constraints that are defined in terms of months. 
Most users will set this to 1. The default value is 1.

Use Assignment Manager 1/0 Whether to submit the activity to Siebel 
Assignment Manager to receive a list of engineers 
capable of performing this work. This should be 
set to 1 to use the AM, unless all employees in a 
service region have the same skills or all are 
eligible to do all the jobs. The default value is 1.

Week Start Day Number, 1–7 Determines what day the week starts on. Used for 
constraints that are defined in terms of weeks. 
Most users will set this to 1 (Sunday) or 2 
(Monday). The default value is 1.

ABS – Activity Category Sequence 
number for the 
Activity 
Category LOV.

When loading in activities into the ABS, only those 
with the specified category will be loaded. The 
default value is all categories.

ABS – Activity Status Sequence 
number for the 
Activity Status 
LOV.

When loading activities into the ABS, those with 
the specified status are excluded. Recommended 
default: Cancelled.

ABS – Days to End Yes Number When starting the ABS process, specifies how 
many days out the ABS should be booking 
appointments. It is always measured in number 
of days (not an absolute date) showing how far the 
schedule runs. Required for ABS.
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ABS – Days to Start Yes Number When starting the ABS process, this number 
specifies how many days out the ABS should start 
booking appointments. It is always measured in 
number of days, not an absolute date. Required for 
ABS.

ABS – Default Number 
of Slots

Number Specifies how many choices (maximum number 
of appointment slots) are returned to the user. A 
higher number of slots gives more flexibility, but 
may slow the ABS, as it takes longer to search for 
more slots. The default value is 5.

ABS – Logging Level Number, 1–4 Controls how much information is written to the 
ABS log stored on the server (ApptBook_xxx.log). 
The lowest level, 1, writes only basic information 
about the server activities, while the highest level, 
4, writes detailed logs, showing all actions that 
occurred. 

ABS – Range of Heuristic Number, 1–3 Determines the time range that the selection 
heuristic uses:

1 – day

2 – week

3 – month

Table 29. Scheduling Parameters

Parameter Required? Value Description
152 Siebel Field Service Guide Version 7.5, Rev. A



Scheduling and Dispatch

Scheduling Administration
ABS – Selection Heuristic Determines the logic used when finding time slots:

■ 1 – Earliest First method. The earliest 
available time slots are included in the set. 
This method may provide the fastest possible 
response for the activity. 

■ 2 – Resource Leveling method. Time slots are 
selected so that the schedules for qualified 
employees are evenly loaded, to the extent 
possible.

■ 3 – Resource Loading method. Time slots are 
selected so that the schedules for employees 
are filled to the extent possible, one employee 
at a time. If two or more qualified employees 
are available, the time slots for the employee 
with the most complete (filled-up) schedule 
are selected for inclusion in the set.

The number of time slots returned in response to 
the request is configurable though the parameter 
ABS - Default Number of Slots.

ABS – Timeout Number 
(minutes)

Sets how long time slots are locked (in minutes) 
after the user requests them, but has not chosen 
one. After this time, the slots are released and 
made available for booking by other users. This is 
important if the user closes the browser or loses a 
connection, so that the slots are again available.

Optimizer – Activity 
Category

Yes Sequence 
number for the 
Activity 
Category LOV.

When loading in activities into the Optimizer, only 
those with the specified category will be loaded. 
The default value is all categories.

Optimizer – Activity 
Status

Sequence 
number for the 
Activity Status 
LOV.

When loading in activities into the Optimizer, 
those with the specified status are excluded. 
Recommended default: Cancelled.

Optimizer – Default 
Priority

Yes Sequence 
number for the 
Activity 
Priority LOV.

Priority used if no priority is set for an activity.

Table 29. Scheduling Parameters

Parameter Required? Value Description
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Optimizer – Glued Yes Number 
(hours)

The period, in minutes, from now in which the 
Optimizer treats the schedule as frozen. No 
activity may be scheduled during this time period.

Optimizer – Hard Latest 
Start

1/0 Whether the Latest Start value is considered a hard 
or soft constraint: 

0 – Soft constraint

1 – Hard constraint

The default is 0.

Optimizer – Logging 
Level

Number, 1–4 This field controls how much information is 
written to the Optimizer log (Optimizer_xxx.log) 
stored on the server. The lowest level, 1, writes 
only basic information about the server activities, 
while the highest level, 4, writes detailed logs, 
showing all actions that occurred. 

Optimizer – Optimize 
Heuristic

Number, 1–8 The heuristic used to improve the optimization 
solution:

1 – Greedy search

2 – Steepest search

3 – Greedy search followed by a Tabu search

4 – Steepest search followed by Tabu

5 – Greedy search followed by Fast GLS

6 – Steepest search followed by Fast GLS

7 – Greedy search followed by GTS

8 – Steepest search followed by GTS

where:

GLS = Guided Local search

GTS = Guided Tabu search

For more information about these methods, see 
“Heuristics for the Optimization Engine” on 
page 155.

Table 29. Scheduling Parameters

Parameter Required? Value Description
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Heuristics for the Optimization Engine
The Optimizer provides a choice of methods for obtaining solutions for a service 
region’s schedule. Each of these methods involves a different strategy to improve 
the schedule. All methods use operations to move two or a few appointments and 
activities in a schedule and then verify improvements in the overall cost of the 
schedule (see “Cost Function” on page 183). For example, the Optimization Engine 
may try to swap a pair of activities between two field service engineers. This can 
change the cost of the schedule by changing the cost of travel, the amount and cost 
of overtime, and the rate billed by the field service engineer. Any reduction in cost 
is an improvement in the schedule. 

There are five different classes of operations for moving appointments and activities 
in a schedule. Each optimization method uses all of these scheduling heuristics.

Optimizer – Consider 
Parts

0/1 Whether the Optimizer should consider parts in an 
engineer’s trunk inventory when considering the 
engineer for assignment to an activity:

0 - No
1 - Yes

Optimizer – Parts Period Integer (hours) If the Optimizer considers that a service engineer 
has the parts required to solve a problem, this 
parameter tells the Optimizer how far in advance 
to consider parts. 

Optimizer – Save Interval Yes Integer 
(Minutes)

The interval for committing the optimized or 
partially optimized schedule to the database. 
Shorter values mean that the database is more up 
to date, but frequent updates may have an effect 
on performance. 

Optimizer – Tardiness 
Cost

Yes Number 
(Float)

The cash value, in $/hour, of violating the 
Optimizer – Hard Latest Start soft constraint. 

Optimizer – Task Excl 
Cost

Yes Number Penalty used in calculating the cost function if 
an activity is unscheduled. 

Optimizer – Timeout Yes Minutes 
(Integer)

The maximum time in minutes for each 
optimization.

Table 29. Scheduling Parameters

Parameter Required? Value Description
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There are two basic optimization methods, which can be used alone, and three 
methods that can be used in combination with the basic methods. The following 
basic methods consistently search for and accept only improvements (lower cost) 
in the schedule:

■ Greedy search. This method starts with an existing schedule and finds the first 
move that improves the schedule, accepts the move, and then uses this solution 
to find the next improvement. A Greedy search repeats this process until there 
is no more improvement or it reaches a time limit. This method is relatively fast, 
but the result solution is not as good as other methods.

■ Steepest search. This method starts with an existing schedule, tries all moves, 
accepts the move that provides the greatest improvement in the schedule, and 
then uses this solution to find the next improvement. A Steepest search repeats 
this process until there is no more improvement or it reaches a time limit. This 
method takes longer, but generally produces lower-cost schedules. 

The following methods, combined with either the Greedy search or the Steepest 
search, allow moves that temporarily increase the cost of a schedule in order to 
arrive at significant, overall improvements in the schedule. In all cases, the Greedy 
search or the Steepest search quickly finds an improved schedule, and then one of 
the following methods takes over and searches for improvements:

■ Tabu search. This method accepts the next best solution even if it is not an 
improvement over the previous schedule. It keeps a “tabu” list of finite length 
that contains the results of previous moves. The Optimizer cannot repeat a move 
until a move drops off the list.

■ Fast Guided Local search. This method adjusts the cost of a solution to reflect the 
number of times the Optimizer tried a move. This allows the Optimizer to try a 
wider range of changes. 

■ This method combines the Tabu search and the Fast Guided Local search. It 
often finds good solutions faster than either the Tabu or Fast Guided Local 
searches.
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Setting Up Server Processes, Performance, and Key-Based Routing
Every Siebel server can run one or more service regions. Large service regions can 
run on a dedicated server.

Each service region can run on only one application server. This allows the 
information for one service region to be cached within memory instead of being 
continually read from the database, reducing the load placed on the database during 
schedule optimization. 

The ABS and Optimizer interact with the database only at these times:

■ Data loading. The ABS and Optimizer read large amounts of information from the 
database on start up, or when the service region is reloaded (“Loading and 
Reloading Service Region Data” on page 139). For this reason, it is best to avoid 
reloading during a busy time. 

■ Saving schedules. The Optimizer can save its result sets to the database at 
specified time intervals (see the parameter Optimizer – Save Interval in 
Table 29), but unless this is a very large data set, it should not noticeably affect 
database performance.

A scheduling request must be routed to the correct application server. To 
accomplish this, the Siebel Scheduling takes advantage of the key-based routing 
available to Siebel servers (see the “Server Key Mappings View” on page 168). 
There are two server key mappings, one for the ABS and one for the Optimizer.

When the user clicks the Book Appt button, the request is sent to the enterprise 
server. The enterprise server then looks at a map of the service regions and routes 
the request to the appropriate Siebel server that stores that service region. 
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Multi-Processor Support
If the underlying operating system can support multiple processors on one 
computer, Siebel Scheduling can take advantage of those processors by running 
different service regions for the ABS and Optimizer on different processors. This is 
accomplished by setting different process numbers in a server key map. A server 
with a single processor can run multiple processes, but this may reduce 
performance.

NOTE: The number of processes running on a server computer bears no relation to 
the number of processors in that computer. 

Since the ABS and Optimizer are different modules, they are already running as 
separate processes, even though the process number is the same. One module for 
one service region can only run in one process at a time.

For example, consider a four-processor computer, with only two of the processors 
in use. If one service region runs with both the ABS and Optimizer, the key map 
would look like the following example.

NOTE: It is not possible to run one module for a service region as two processes.

Server Service Region Process1

1. Process refers to the number of processes for that component, not the 
processor number on the server.

Module

AppServer1 West Coast Region 1 ABS

AppServer1 West Coast Region 1 Optimizer
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If two service regions run on a four-processor computer, it is possible to use all four 
processors, as in the following example.

If there are more than two service regions on a four-processor machine, it is possible 
to run them as different processes. For example, if the West Coast Region is very 
large and the Central and East Coast regions are smaller, the following scheme 
might be the best use of the processors on a server.

The West Coast region, which requires more computation, uses two processors. 
The East Coast and Central regions run in the same processes and on the same two 
processors. 

Server Service Region Process1

1. Process refers to the number of processes for that component, not the 
processor number on the server.

Module

AppServer1 West Coast Region 1 ApptBook

AppServer1 East Coast Region 2 ApptBook

AppServer1 West Coast Region 1 Optimizer

AppServer1 East Coast Region 2 Optimizer

Server Service Region Process1

1. Process refers to the number of processes for that component, not the 
processor number on the server.

Module 

AppServer1 West Coast Region 1 ApptBook

AppServer1 East Coast Region 2 ApptBook

AppServer1 Central Region 2 ApptBook

AppServer1 West Coast Region 1 Optimizer

AppServer1 East Coast Region 2 Optimizer

AppServer1 Central Region 2 Optimizer
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Each server component is multi-threaded and can load schedules for multiple 
service regions. These schedules are shared by multiple threads. 

Each request to the Optimization Engine runs on a new thread. A request identifies 
the schedule for one service region that it requires and locks it. Requests for 
schedules for other service regions can continue while requests for the same 
schedule are queued.

Scheduling Administration Screen
The Scheduling Administration screen provides data required to configure and 
administer the operation of the ABS and the Optimization Engine.

Service Regions View
The Service Regions view defines service regions in terms of the employees 
assigned to each region, geographic coordinates (in terms of geocode and ZIP Codes 
or postal codes), and the operation of the ABS and Optimization Engine for the 
selected service region. The view also lists all activities assigned to a selected 
service region.

Table 30 describes the fields that define the operation of the ABS and Optimization 
Engine in each service region.

Table 30. Selected Items in the Service Regions View

Item Description

Average Travel Speed Per Hour The average travel speed for field service engineers in the 
service region, used when the Optimizer calculates the 
“Cost Function” on page 183.

Average Travel Time (Minutes) The amount of travel time that the ABS adds to an 
activity when calculating the duration of an activity 
(work time + average travel time).

Constraint Set The constraint set that the ABS and Optimization Engine 
use in optimizing the schedule for the selected service 
region, defined in Scheduling Administration > 
Constraint Sets and the Scheduling Administration > 
Constraints.
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Cost Function The cost function that the Optimization Engine uses in 
optimizing the schedule for the selected service region, 
defined in Scheduling Administration > Cost Functions.

Cost List A cost list for labor, used for calculating overtime costs. 
Costs Lists are defined in Pricing Administration > Cost 
List (see Pricing Administration Guide).

Minimum Travel Time If the calculated travel time between two activities is less 
than this time, the Optimizer uses this time. 

Parameter Set The set of parameters that the ABS and Optimizer use, 
defined in Scheduling Administration > Parameter Sets.

Schedule The name of a schedule that the ABS uses. Schedules are 
defined in Applications Administration > Schedules.

Time Window The name of a set of time windows defined in 
Scheduling Administration > Time Windows. A Time 
Windows view defines the interval of time that should be 
allocated for starting an activity. The ABS uses time 
windows. See the “Time Windows View” on page 165.

Time Zone The name of a time zone used by the ABS and Optimizer. 
Time Zones are defined in Applications Administration 
> Time Zone Administration (see Applications 
Administration Guide).

Travel Cost The cost of travel per unit of travel. The Optimizer uses 
this value when calculating the Cost Function for a 
schedule.

Travel Unit of Measure The unit of travel (miles or KM) that the Optimizer uses 
when calculating the Cost Function for a schedule.

Table 30. Selected Items in the Service Regions View

Item Description
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The Scheduling Administration screen provides the following buttons and 
commands for the manual operation of the ABS and the Optimization Engine 
(Table 31). 

Table 31. Buttons and Commands in the Service Regions View 

Item Description

Coalesce ABS This button attempts to improve a selected appointment schedule by 
removing the time gaps between booked appointments. This 
asynchronous request is carried out for one service region at a time. 

Load ABS This button erases all data for a service region in the ABS cache and 
reloads this data from the database. For each service region, this is an 
asynchronous request to the Siebel server.

Load Optimizer This button erases all data for a service region in the Optimizer cache 
and reloads this data from the database. For each service region, this 
is an asynchronous request.

When an optimization is in progress, this request is not sent to the 
server. The user receives an error message.

Optimize This button sends a request to the Optimization Engine to run an 
optimization on the selected service region. The Workflow Manager 
or repeat requests can start an optimization.

Stop Optimization This command sends an asynchronous request to the Optimization 
Engine to stop an ongoing optimization of the selected service region.

Stopping an optimization may not be immediate because the 
Optimization Engine completes the solution that is in process and 
saves this solution in the database. 

Stopping an optimization is a manual process; the Workflow Manager 
or repeat requests cannot send this command. 
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Activities View
The Activities view displays all activities for the selected service region. This view 
is read-only. Table 32 describes the button in this view.

Employees View
The Employees view lists the employees assigned to a service region. This view is 
read-only. Table 33 describes the buttons in this view for managing the availability 
of employees and loading employee data.

Table 32. Button in the Activities View

Item Description

Load This button sends an asynchronous request to the Siebel server to load the selected 
activities into the ABS or Optimizer cache. 

Based on the values of the Planned Start and Planned End field for an activity and 
the start and end times for the ABS and Optimizer horizons, the data goes either 
to the ABS or Optimizer cache.

Normally, use the Workflow Manager instead of this button to load activities.

The Load request cannot be carried out for a repeating activity.

Table 33. Buttons in the Employees View

Item Description

Unavailable When you select an employee record and click this button, it instructs the 
Optimizer that the selected employee is unavailable for a time defined in 
User Administration > Employees > Employee Exception Hours. The 
button sends an asynchronous request to the Optimizer to load the data for 
the selected employee, including exception hours, and reassigns or 
reschedules activities.

Before using this command, the administrator may have to add a new 
record to the Employee Exception Hours view describing the time that this 
engineer is unavailable.
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Zip Codes View
The Zip Codes view lists the ZIP Codes or postal codes that are included in a service 
region, plus city, state, country, and longitude and latitude for each ZIP Code.

For the Optimizer to schedule an activity, the address of the activity must have valid 
ZIP Codes and country specified. ZIP Codes must have the corresponding Geocodes 
specified (see “Geocodes and ZIP Codes” on page 136). The Zip Code value can be 
a ZIP Code or a ZIP + 4 code.

Cost Functions View
The Cost Functions view defines the function that the Optimizer uses for assessing 
the success of each iteration of a schedule. This view sets up the general description 
of each cost function. Cost functions are associated with service regions in the 
Scheduling Administration screen; see “Service Regions View” on page 160.

Cost Function Details View
The Cost Function Details view defines each variable in a cost function. For more 
information about the structure of cost functions, see “Cost Function” on page 183.

Service Regions View
The Service Regions view contains read-only records listing the service regions that 
use a selected cost function.

Load ABS The button sends an asynchronous request to the Optimizer to refresh the 
data for one or more selected employees in the ABS cache. This command 
must be initiated manually or by the Workflow manager; do not use a 
repeat request. 

Unload ABS The button sends an asynchronous request to the Optimizer to remove 
the data for one or more selected employees from the ABS cache. This 
command must be initiated manually; do not use a repeat request.

Table 33. Buttons in the Employees View

Item Description
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Parameter Sets View
The Parameter Sets view provides the basic definition of the parameters that the 
ABS and the Optimization Engine use. Parameter sets are associated with service 
regions in the Scheduling Administration screen; see “Service Regions View” on 
page 160. Each service region uses one parameter set.

Parameters View
The Parameters view defines each parameter in a parameter set. For more 
information about parameters, see “Scheduling Parameters” on page 150.

Service Regions View
The Service Regions view contains read-only records listing the service regions that 
use a selected parameter set.

Time Windows View
The Time Windows view defines the interval of time that should be allocated for 
starting an activity. The ABS uses time windows.

The Time Windows field in Scheduling Administration > Service Regions 
associates a time window with a service region.

Table 34 shows the required fields in the Time Window view.

Time Window Details View
The Time Windows Details view defines specific mappings that make up each time 
window record. To accommodate activities that vary in duration, this view maps 
each range of durations to a time window. For example, a work time of 1 to 60 
minutes may require a time window of 120 minutes to provide Optimizer the 
flexibility to change the schedule for optimization.

Table 34. Required Fields in the Time Windows View

Item Description

Name The name of the set of time window mappings.

Default Time Window The time window applied to activities of any duration, if the Time 
Windows Details view does not have a mapping for an activity of 
a specific duration.
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Service Regions View
The Service Regions view contains read-only records listing the service regions that 
use a selected time window.

Constraints View
The Constraints view provides the Constraint wizard to direct the definition of 
each constraint. 

To create constraints

1 Navigate to Site Map > Scheduling Administration > Constraints.

2 Add a constraint record.

3 From the Pick a Constraint list, select a constraint template.

The template for the constraint statement appears on the Constraint Statement 
tab below.

4 Click Continue.

The template is ready to receive information.

The illustration that follows shows the Constraint Statement and Insert a... tabs. 
The Constraint Statement tab displays a template statement that reads as 
follows:
166 Siebel Field Service Guide Version 7.5, Rev. A



Scheduling and Dispatch

Scheduling Administration
Appointment Booking constraint : [Planned_Start/End] for 
Activity_Type/Priority should be Greater/Less Time. 

The first variable (Planned_Start/End, in this example) is automatically selected 
and ready to receive information. The square brackets and red highlighting 
indicate a selection. The other variables (Activity_Type/Priority and Greater/
Less Time, in this example) are highlighted in blue. The Insert a... list shows 
items that can be selected for insertion in the selected variable (Planned End and 
Planned Start, in this example).

5 In the Insert a... list, click Insert for the record to use for the selected field.

6 If a dialog box appears with a list of records, select the appropriate record.

The value appears in the template and the selection moves to the next field to 
the right. 

7 Repeat Step 5 and Step 6 for each additional variable.

8 When the constraint is complete, click Save.

The Save a Constraint dialog box appears.

9 Enter a name for the constraint and click Save.

The Constraints list reappears.

Constraint Sets View
Constraint Sets view provides the basic definition of a set of constraints that a 
service region uses for running the Optimization Engine. 

Constraints View
The Constraints view adds predefined constraints (see “Constraints View” on 
page 166) to the selected set of constraints.

o
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Service Regions View
The Service Regions view contains read-only records listing the service regions that 
use a constraint set.

Server Key Mappings View
The Server Key Mappings screen assigns servers to processes and associated service 
regions. Table 35 shows the fields in this view.

After modifying server key mappings, you must restart the relevant server 
component (for example, Appointment Booking System or Optimization Engine) for 
the changes to take effect. 

NOTE: If Server Key Mappings - Optimizer Component is missing from the drop-
down list for the Component field, the server installation was incomplete. To correct 
this, use the Synchronize button on the Enterprise Configuration screen. See the 
complete procedure in Siebel Server Administration Guide.

Table 35. Fields in the Server Key Mappings View

Item Description

Server A type-in field for the name of a Siebel server.

Process # A type-in field for the number of a process running on the server.

Service Region The name of a service region selected from the Pick Service Region 
dialog box.

Component The name of a component, either ABS or Optimizer, selected from 
the Pick Component dialog box. 
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Service Screen
The Service screen includes a view that provides the Book Appt and Cancel Appt 
buttons for running the ABS.

Activities View
The Activities screen displays the activities associated with service requests. 
Table 36 describes the buttons in this view.

Conditions for Appointment Booking
Before booking an appointment, make sure that the service region is specified for 
an activity and that the activity is not repeating.

If the Lock Schedule flag is set (TRUE), provide values in the Planned Start and 
Planned End fields. In this case, no time slots are required and the Book 
Appointment dialog box does not appear.

If the Lock Assignment flag is not set (FALSE), specify manually the employee for 
an activity.

Table 36. ABS Buttons in the Activities View

Item Description

Book Appt This button sends a synchronous request to the ABS for time slots in which 
to book the selected activity. The available appointments return in a dialog 
box.

Cancel Appt This button sends a synchronous request to the ABS or the Optimizer to 
cancel an appointment, release the appointment for other schedules, and 
set the status of the selected activity to Cancelled.

The request is sent to the ABS or Optimizer, depending on the horizon that 
contains this activity. If the activity (Planned Start and Planned End) 
overlaps the ABS and the Optimizer horizons, the request goes to both the 
ABS and Optimizer.

Confirm This button in the Book Appointment dialog box sends a server request to 
confirm the selected appointment and release the lock on the remaining 
slots.

Cancel This button in the Book Appointment dialog box sends a server request to 
reject all proposed appointment slots and to release the lock on these slots.
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Conditions for Cancelling an Appointment
To cancel an appointment, set the service region, make sure the activity is not 
repeating, and the activity (Planned Start – Planned End) is not in the Glued 
period. If the Cancel Appt request is successful, the fields that define an activity are 
unchanged except for the activity Status, which is set to Cancelled.

The choice of sending the Cancel Appt request to the ABS or Optimizer depends on 
these conditions:

■ If the Planned Start and Planned End values are less than the start time for the 
ABS horizon, then send a request to the Optimizer.

■ If the Planned Start value is less than the start time for the ABS horizon, and the 
Planned End value is greater than the start time for the ABS horizon, then send 
a request to the Optimizer and the ABS.

■ If the Planned Start value is greater than or equal to the start time for the ABS 
horizon and the Planned End value is less than the end of the ABS horizon, then 
send a request to the ABS.

Activities Screen
The Activities screen has one view that defines variables that the Optimizer and 
ABS require.

Schedule View
The Schedule view contains the Book Appt, Cancel Appt, and Contract Schedule 
buttons for running the ASB and Optimizer interactively (see Table 37 on page 170). 

Table 37. Selected Items in the Schedule View

Item Description

Book Appt See Table 36 on page 169.

Cancel Appt See Table 36 on page 169.
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Contract Schedule This button sends a request to the Optimizer to insert a priority 
service activity into a schedule with minimal disruption of the 
schedule and without significant increase in the cost of the schedule. 
For more information, see “Appointment Booking System” on 
page 172.

Earliest Start The earliest time and date an activity may begin, usually used to 
indicate contractual commitments or deadlines. In some 
configuration settings (see Table 29 on page 151) this value is 
described as NST (No sooner than).

Latest Start The latest time and date for an activity, usually used to indicate 
contractual commitments or deadlines. It is the same as the Due field 
in the More Info view on this screen. In some configuration settings, 
this value is described as NLT (No later than). 

Planned Start If you specify values for Earliest Start or Latest Start, then Planned 
Start must be later than Earliest Start and earlier than Latest Start.

Duration The time required to carry out an activity, including breaks and travel 
time. The value = Planned End – Planned Start.

Work Time The time required to work on an activity, not including, for example, 
travel and breaks.

Allow Breaks This check box allows scheduling an activity around breaks (see 
“Breaks” on page 146).

Lock Schedule A check box that prevents the ABS and the Optimization Engine 
from changing the values of Planned Start and Planned End.

Table 37. Selected Items in the Schedule View

Item Description
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Appointment Booking System
A significant portion of a service business is concerned with activities happening in 
the future, such as installations or preventive maintenance. The Siebel Appointment 
Booking System (ABS) is designed to automate the process of offering appointments 
to customers. The ABS operates in real time.

The ABS provides a list of available time slots for future appointments, and then 
reserves a selected appointment slot. Customers may prefer a shorter time slot, but 
the window should be large enough that there is a high probability that the engineer 
can meet a commitment. For example, if a customer wants her TV cable installed, 
which is approximately a one-hour activity, the customer service representative 
may give her a time slot from 8 a.m. to 12 p.m.

When preparing a list of possible time slots, the ABS enforces the following rules:

■ The time slots offered must equal the availability of the personnel for a 
service region.

■ The time slots offered must match the personnel who have the required skills. 
The Assignment Manger can enforce this rule.

■ Time slots must meet other constraints; for example, never have an engineer do 
more than four installations per day. Other limits on field service activities can 
meet business or union requirements.

■ The ABS can have activities that extend over more than one day.

■ Activities that cross between the end of the Optimizer horizon and the beginning 
of ABS period are treated as locked by both of these engines.
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Best Practice: Preventive Maintenance and the ABS
The optional Preventive Maintenance module allows users to set triggers on assets, 
which, when tripped, automatically create service requests and activities for these 
assets. There are two types of triggers, time-based and threshold-based.

Threshold-based preventive maintenance depends on asset readings (such as 
number of copies made on a copier) and are reactive (taking a reading results in 
creating a service request). The service requests that the Preventive Maintenance 
Engine creates usually require immediate action, as opposed to action in the future. 
Immediate actions use the Siebel Contract Scheduling module (see “Contract 
Scheduling” on page 181). The ABS is involved only if the service call can be 
delayed more than a specified number of days.

Time-based preventive maintenance triggers, for legal or contractual reasons, 
require periodic, proactive checks on equipment. The Preventive Maintenance 
Engine generates service requests and future activities. One of the activities could 
be an outbound call from the dispatcher or customer service representative to 
schedule a time for service. When the customer service representative calls the 
customer, the representative can use the ABS to negotiate a time.

The ABS Horizon 
The ABS horizon is the length of time, in days, that is available for appointment 
booking for a service region. Typically, this is from days 8 to 56 (starting a week 
from now to eight weeks).

What Happens During Appointment Booking?
The following steps illustrate a typical process for the ABS:

1 A request for service arrives from a customer.

2 The customer service representative opens a service request and selects an 
activity plan to generate activities for this request.

3 The agent clicks the Book Appt button in the Service screen or the Activities 
screen to obtain a list of appointment choices from the ABS, for the selected 
activity.
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4 The ABS searches for available time slots using the Earliest Start field and Latest 
Start field (if a value is supplied) to limit the search. 

5 If the earliest and latest start are not specified, the ABS chooses from all of the 
time slots within the ABS horizon.

The ABS returns time slots and reserves these with a timed lock. 

6 The customer service representative, who sees these choices in a dialog box, 
selects a time slot and clicks Confirm.

7 The ABS marks the selected slot as permanently used. The ABS then frees the 
other reserved time slots, writes the details of the selected slot to the activity 
record, and returns control to the client.

8 If none of the time slots work for the customer, the customer service 
representative clicks Cancel. If these slots are not cancelled, the time-out 
releases the slots.

9 The ABS frees all of the time slots reserved for this activity and returns control 
to the client.

Requirements for Running the ABS
The following settings are required for running the ABS:

■ Service region for each activity

■ Earliest Start and Latest Start values for each activity

■ Key Server mapping

■ Time windows

■ Parameter set

■ Parameters: 

■ ABS- Days to Start

■ ABS - Days to End

■ Optimizer – Default Priority
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Optimization Engine
The Optimization Engine uses a choice of complex algorithms (see “Heuristics for 
the Optimization Engine” on page 155) to meet these objectives:

■ Assign field service engineers to service activities.

■ Schedule these activities.

■ Maximize the efficiency and the quality of service.

■ Minimize cost to the service organization. 

The Optimization Engine can also respond to immediate scheduling demands to 
provide break/fix activities that meet the requirements of service entitlements 
(for example, a response within four hours), emergencies (for example, breakdown 
of service vehicles), and changes in service personnel (see “Contract Scheduling” 
on page 181).

Schedule Optimization
Since the majority of service costs are derived from labor, efficient use of labor is 
one of the primary goals of a service organization. Efficiency encompasses a broad 
array of objectives, some of which may be conflicting:

■ Solving a service request the first time, which requires assigning a field service 
engineer with the right skills and parts.

■ Skilled engineers can finish a task faster; however, they should also be assigned 
to more challenging work so their time is not wasted on trivial tasks.

■ Where possible, travel between jobs should be minimized by grouping jobs in 
a particular area.

■ Engineers should appear onsite within contractually committed times.

The Optimizer provides automated, background optimization of the schedule for 
field service activities and optimal use of resources in each service region. 
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Business Priorities
Every business has a different definition of efficiency in delivering service. 
Businesses that have requirements for critical responses (for example, a utility 
company may have downed power lines) define efficiency as placing someone 
onsite within the shortest time. In this case, response is more important than full 
utilization. Other businesses do not have stringent response requirements, but 
require higher utilization to preserve profits. In either case, a service business 
needs to set priorities when scheduling and dispatching personnel.

Break/Fix Activities and Contract Scheduling
Most service businesses start the day with a schedule of activities to perform, such 
as maintenance, installations, and other booked repairs. During the day, customers 
may call for repairs (break/fix activities), requiring modification of schedules. 

Customers with service contracts often have specific entitlements with a required 
response time. This response time may be tiered according to the level of the 
contract: standard contracts may promise engineers onsite within 24 hours, while 
premium contracts may specify response times as short as two hours.

Break/fix activities must be inserted into the schedule that the Optimizer has 
carefully optimized during the previous night. Optimizing the schedule again is 
usually not practical because optimization routines can run for an hour or two to 
determine good solutions. Customers want a service commitment immediately, 
often while they are on the phone. A balance must be achieved, trading optimized 
schedules for quick responses and customer satisfaction, while still enforcing 
business rules.

The ideal solution for the customer service representatives, in response to break/fix 
requests, is to click a button and receive a time for a service call that respects 
contractual agreements and other constraints. The Optimizer addresses this need.

Best Practices 
The Optimizer is appropriate for field service businesses that have a large number 
of engineers within a concentrated area. In general, if over 30% of a service force 
is located in the top ten areas, then optimization is appropriate. In particular, 
businesses that have the following needs should be looking at an optimization 
solution.
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A Centralized Dispatch Model
A centralized dispatch model, in which a team of dispatchers handle the majority 
of dispatching for the full service business, is often driven by a follow-the-sun 
support model. In this model, customers can call twenty-four hours a day and are 
routed to an open call center somewhere in the world.

Customer support representatives need to assign engineers to a call even though 
they do not know the local requirements and rules. The Optimizer has constraints, 
so that when central dispatchers submit the activity, it is optimized in a fashion that 
is consistent with local priorities. Most activities can be scheduled automatically at 
a central location; any exceptions can be handled manually by a local service 
manager, eliminating the need for dedicated dispatch personnel.

Enforcing Contractual or Legal Constraints
Many companies must comply with strict limits on work hours and hazardous 
work. Union agreements may stipulate special conditions, such as fairness in 
work assignments. Having a system that can automatically track these constraints 
significantly decreases the burden on service businesses.

Working in High-Traffic Areas 
The majority of wasted time in a service business is usually spent getting to 
customer sites. Many service businesses find that their employees are either 
spending too much time in the office or are on the road needlessly, driving back 
and forth between engagements. 

By handling two calls in one area, traveling time is decreased significantly and 
performance is increased by over 10 percent. As service businesses are moving to 
a revenue base, a 10 percent increase in revenue can yield an even higher gain in 
profits.

The Amount of Optimization
Is it possible for a schedule to be too optimized? In general, a schedule with high 
utilization (little free time) is a good thing. However, past a certain point, further 
optimization may bring diminished cost savings. Furthermore, highly optimized 
schedules are easily corrupted; minor changes can cause problems to ripple 
throughout a schedule.
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For example, consider a day’s schedule for one engineer is booked from 9 to 5, 
with no free time. If just one appointment runs over, the engineer will not be able 
to complete all activities, leaving at least one (or more) to overtime or the next day. 
And, unexpected events such as a vehicle breakdown can completely disrupt this 
fully booked schedule.

The goal is to create a schedule that is optimized but still flexible enough to 
accommodate change. There are two ways to do this:

■ Create constraints limiting the percentage of hours booked.

■ Extend the duration of activities to leave extra time. 

The first method is preferable as it allows managers to set up a dependable level of 
work. With the second method, managers are not sure of the true workload for 
their region. 

The balance of working time and available time depends on the business needs. 
Businesses that require more flexibility (and therefore lower utilization 
percentages) have the some or all of the following business requirements:

■ High break/fix volume

■ Critical response (for example, a power line down)

■ Highly variable times for service delivery

■ Many short activities (especially in a high-traffic areas)

■ Tight contractual requirements

Service businesses with a need for higher utilization usually have the following 
business requirements:

■ Longer activities (and therefore less travel)

■ Preventive maintenance as the main type of service

■ Lower break/fix occurrences

■ Longer contractual response time
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When determining the best level of utilization, consider your service needs and 
then set an approximate level. Then adjust the optimization parameters to give 
the best results.

Requirements for Optimization
The following settings are required for running the Optimization Engine:

■ A service region

■ Server Key mapping

■ Cost function

■ Cost list

■ Travel cost

■ Minimum travel time

■ Travel U/M

■ Parameter set

■ Parameters:

■ Optimizer - Activity Category

■ Optimizer - Default Priority 

■ Optimizer – Glued

■ Optimizer – Save interval

■ Optimizer – Tardiness Cost

■ Optimizer – Task Excl Cost

■ Optimizer – Timeout

The Optimization Engine has the following additional requirements:
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■ An activity cannot span more than one day; multi-day activities are not 
scheduled. The Optimizer can schedule other activities during the time intended 
for multi-day activities. However, the penalties for not scheduling these activities 
still contribute to evaluating the potential success of an optimized schedule 
(see the “Cost Function” on page 183).

■ Activities that cross between the end of the Optimizer horizon and the ABS 
horizon are treated as locked by both the ABS and the Optimizer.

When loading activities into the Optimizer cache for the first time, the Optimizer 
produces an initial solution to the schedule by accepting the existing order and 
assignment of appointments. While finding the initial solution, the Optimizer first 
processes the activities which have Lock Assignment and Lock Schedule flags 
(see “Making Changes to a Schedule” on page 148) set to TRUE. This helps to 
ensure that these requests are honored in the optimized schedule.

While the schedule for a service region is being optimized, only insert activity 
(see “Insert Activity Button” on page 182) and stop optimization (see “Service 
Regions View” on page 168) requests are accepted. These are queued, and the 
queue is processed when the optimization finds the next solution. Any other 
request is returned.

Using the Workflow Manager
Scheduling is best considered as a business process. For the Optimizer to be useful, 
it must be fully integrated into the normal process of delivering service. The 
Workflow Manager is the primary vehicle for ensuring this integration. Most Siebel 
customers using the Optimizer would use the Workflow Manager to accomplish the 
following tasks:

■ Manual updates to a schedule

■ Locking in manual changes

■ Synchronizing a schedule with manual changes

■ Updating a schedule for contractual commitments

■ Notify a manager by email of rejected activities

■ Moving activities to a secondary service region 
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■ Verifying a declined assignment through wireless and reassignment 

Availability of Parts
Availability of parts is a constraint only for the Optimizer, not the ABS. Data loaded 
into the Optimizer cache includes all trunk inventories for all field service engineers 
in a service region. 

The Optimizer parameter Consider Parts includes the availability of parts in an 
engineer’s trunk inventory when considering the engineer for assignment to an 
activity. The parameter Parts Period (see “Scheduling Parameters” on page 150) sets 
the number of hours that the loaded parts list is valid for an optimization.

If parts are considered, and the activity includes a part with an Order Item number 
(see the “Part Tracker View” on page 107), and then the product can be drop-
shipped for the service call; the Optimizer does not consider this part as a constraint 
in scheduling.

NOTE: To be considered for a service call, parts in a trunk inventory must have 
a status of Good and an availability of On Hand.

Contract Scheduling
Contract Scheduling is a feature of the Optimizer that is designed for rapid 
scheduling of service appointments while maintaining the critical Optimizer 
requirements: enforcement of contractual deadlines and use of constraints when 
searching for solutions. Companies with the following needs may use Contract 
Scheduling:

■ Same-day break/fix calls are a higher percentage of service calls.

■ Service contracts specify penalties for failing to meet response times 
(for example, free labor or free parts).

■ A large number of constraints must be respected.

Run Contract Scheduling from three locations in Field Service:
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■ Insert Activity button in Dispatch Board > Unscheduled Activities. This sends a 
request to either the ABS or the Optimizer to schedule an appointment or insert 
the selected activity into the optimized schedule, depending on times relative to 
the horizons.

■ Contract Schedule button in Activities > Schedule. This sends a request for 
scheduling the selected activity.

■ Load button in Scheduling Administration > Service Regions > Activities. 
This is similar to the Insert Activity button in the Dispatch Board screen.

Insert Activity Button
The Insert Activity button obtains, for a selected activity, either a confirmed 
appointment from the ABS or it runs the Optimizer to schedule the activity. 
The Insert Activity button is similar to the Contract Schedule button in Activities > 
Schedule (see “Contract Scheduling” on page 181).

Before using Insert Activity, make sure the following conditions are met:

■ The service region is set in the Dispatch Board > Activity Gantt Chart.

■ The activity is not repeating.

■ If Lock Schedule flag is set (TRUE), then the Planned Start and Planned End 
values are not null.

■ If the Lock Assignment flag is set (TRUE), then the activity assignee is not null.

The choice of sending the Insert Activity request to the ABS or Optimizer depends 
on the Earliest Start and the Latest Start values. These values determine whether 
the activity falls within the ABS or the Optimizer horizon:

■ If the Latest Start value is null, sends the request to the ABS.

■ If the Latest Start value is in the Glued period, does not insert the activity, 
but returns an error message.

■ If the Latest Start value is less than the ABS start, sends the request to the 
Optimizer.
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Contract Schedule Button
The Contract Schedule button has the same function as the Insert Activity button. 

Load Button
The Load button for activities is intended for synchronizing data in the cache if 
there have been manual changes to an activity. Before using the Load command, 
make sure the following conditions are met:

■ The activity is not repeating.

■ If Lock Schedule is set, then there are values for Planned Start and Planned End.

■ If Lock Assignment is set, then there is an employee assigned to the activity. 

The choice of sending the activity to the ABS or the Optimizer cache depends on 
these conditions:

■ If Planned Start and Planned End are specified, then the choice of the ABS or 
Optimizer depends on matching these values to the dates for either the ABS or 
the Optimizer horizon.

■ If Planned Start and Planned End are not specified, then the values for Earliest 
Start and Earliest End are used. If these values fall within the Optimizer horizon, 
then the activity goes to the Optimizer cache.

■ If neither of these conditions succeeds, an error message is returned.

Cost Function
The cost function is the sum of factors that drive the optimization of a schedule. 
For each activity in the schedule, the Optimization Engine minimizes the value of 
the cost function while optimizing the schedule. The cost function indirectly 
calculates the monetary cost of carrying out a schedule. 
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There is only one cost function for each service region. However, many service 
regions can use the same cost function. The cost function is the sum of the 
following factors, shown in Table 38:

For all weights in the cost function, start with values of one (which approximate 
the real cost of scheduling an activity), then change these values as needed. 

Table 38. Factors in the Optimizer Cost Function

Factor Calculation of the Factor

Constraint Violation

This is the sum of Rule Violation Costs for each soft constraint violated. 

A violation is proportional to the degree of the violation. The units for the amount 
of the violation are the same as defined for the constraint. Time units are in hours; 
all other cases use the activity.

FSE Overtime

Where, 

Tardiness

Task Exclusion Penalty

Task priority allows higher priority tasks to take precedence over low priority ones. 
This is important when there are not enough resources to schedule all activities. 

The Task Priority term uses the numeric value from the Order column in 
Applications Administration > List of Values (see Applications Administration 
Guide). This is the value that also appears in Activities > More Info, Priority field. 

Task Exclusion Penalty and Weight cannot be zero. If they are zero, no activities are 
scheduled.

Travel Distance

Σ RuleViolationCost Weight×( )

FSEOTCost EndtimeoflastactivityinOT Endofnormalshift–( )× Weight×

FSEOTCost StdCost StdOTpercent×( ) StdCost ExtOTpercent×( )+=

TardinessCost Amountofdelay Weight××

TaskExclusionPenalty
1

TaskPriority
---------------------------------× Weight×

TravelDis cetan T× ravelCost Weight×
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Dispatch
The Dispatch Board screen provides an intuitive interface for selecting field service 
engineers to carry out activities and manual scheduling of these activities.

Setting Up the Dispatch Board
Setting up the Dispatch Board includes the following tasks:

■ Assign employees to service regions in User Administration > Employees > 
Service Details.

■ Assign schedules to employees in Schedule field in User Administration > 
Employees > Service Details and the exception records in User Administration 
> Employees >Employee Exception Hours.

■ Assign responsibilities to employees in User Administration > Employees > 
More Info.

■ Set up rules for the Assignment Manager.

■ Set the system preference for the Dispatch Board.

■ Set the user preferences for the Dispatch Board.

System Preference for the Dispatch Board
The Dispatch Board allows a dispatcher or customer service representative to drag 
an activity from the Unscheduled Activities list to a block of time and employee 
in the Gantt chart. If the service region of the activity is different from the service 
region selected for the Gantt chart, the result depends on the setting of the system 
preference FSDB:Override Service Region:

■ If the value of the system preference is TRUE, then the dispatcher can drop the 
activity on the Gantt chart and the service region for the activity is automatically 
changed to the service region selected for the Gantt chart.

■ If the value is FALSE, then the dispatcher cannot drop the activity on the Gantt 
chart and an error is returned.
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Changing the Behavior of the Activity Gantt Chart
Field Service provides control over many aspects of the Activity Gantt Chart. 
To change these settings, on the application-level menu, choose View > User 
Preferences > Dispatch Board. Table 39 describes the settings for the Dispatch 
Board.

Table 39. Options for the Activity Gantt Chart

Group/Field Description

Time Span Sets the time scale for the Gantt chart:

■ Year/Month

■ Year/Week

■ Month/Week

■ Month/Day

■ Week/Day

■ Day/Hour

Time Interval in Minutes The smallest unit of time displayed on the Gantt chart. 
The default is 30 minutes.

Date Shown The day that appears by default:

■ Today

■ Last Date Chosen (in the Date fields)

Start Day at The start time for a work day. The default is 9 a.m.

End Day at The end time for a work day. The default is 5 p.m. 

Use Color Scheme A drop-down list that applies a color scheme to either 
Activity Priority, Activity Status, or Activity Type. 
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Setting Up a Dispatcher
Field Service provides responsibilities for employees, showing only the views 
needed to complete their job. There is a responsibility for a dispatcher, who can 
assign activities to service engineers. For more information on responsibilities and 
visibility see Applications Administration Guide.

To add a user with the responsibility of a dispatcher

1 Navigate to Site Map > Application Administration > Responsibilities.

2 In the Responsibilities list, select the Dispatcher record. 

If this record is not in the list, create a new record with the responsibility of 
Dispatcher.

3 To add the name of the employee who will take the Dispatcher’s role, add a new 
record on the Users list.

Color The colors of the bars representing scheduled activities. 
A different color can be assigned to each of these categories 
and subcategories:

■ Activity Priority: ASAP, High, Medium, and Low.

■ Activity Status; for example, Not Started, In Progress, 
On Hold, Done, Cancelled, Acknowledged, and 
Declined.

■ Activity Type: Various types, chosen from a 
drop-down list.

Click the Color field to the right of the Category field 
to select a color from a drop-down list. 

Service Region The default value that appears in the Service Region field, 
selected from a drop-down list. 

Auto-Update Service Region This check box determines whether the last service region 
displayed in the Activities Gantt chart appears the next time 
the user goes to the Dispatch Board screen. 

Table 39. Options for the Activity Gantt Chart

Group/Field Description
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4 In the Views list, make sure the selected user has access to the Dispatch Board 
(FS eGanttChart View).

Assigning and Scheduling Field Service Activities Manually
The following procedures are for manually dispatching field service engineers.

To assign field service engineers to service activities manually

1 Navigate to the Service screen.

The Service Requests view appears.

2 Select a service request.

3 Click the Activities view tab.

4 In the Owner field, select an employee.

To assign field service engineers with Assignment Manager

1 Navigate to the Activities screen.

2 Select an activity.

3 On the More Info view tab, click the show more button and make sure the Lock 
Assignment check box is cleared.

4 On the More Info view tab, click the menu button and select Assign.

A dialog box appears with names of field service employees ranked in order of 
preference.

The suggested assignments are based on a variety of criteria including workload 
and skills, set up using the Assignment Manager. For instructions on configuring 
the Assignment Manager, see Siebel Assignment Manager Administration Guide.

NOTE: The Assign command or button is also available in Dispatch Board > 
Unscheduled Activities.

5 In the dialog box, select the employee who will own this activity and click OK.
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To add a service region to the Dispatch Board

1 Navigate to Site Map > Dispatch Board.

The Activity Gantt Chart view appears.

2 At the top of the Activity Gantt Chart view tab, click Select.

3 In the Pick Service Region dialog box, select a service region and click OK.

The field service engineers associated with the selected service region appear in 
the left column of the Gantt chart. 

NOTE: Available hours are shown in the Activity Gantt Chart with colors that 
represent rate types. Non-working periods are grey, working periods are white, 
overtime periods are orange, and extended overtime periods are brown. If no 
colors are specified for activities, yellow boxes are the default to indicate 
activities that are assigned and scheduled. 

To select a subset of field service engineers based on a skill

1 Navigate to Site Map > Dispatch Board.

The Activity Gantt Chart view appears.

2 In the Unscheduled Activity list, select an activity.

3 Click Apply Skills.

Only those engineers from the selected service region having the selected skills 
appear in the Gantt chart. See “Unscheduled Activities List” on page 191.

4 To remove the constraint of the applied skills from this list of field service 
engineers, reselect the service region by clicking Select at the top of the Activity 
Gantt Chart view tab.

To assign and schedule field service engineers manually with the Dispatch Board

1 Navigate to Site Map > Dispatch Board.

The Activity Gantt Chart view appears.
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2 In the Unscheduled Activities list, select an activity.

NOTE: To assign an activity, it must have a type.

3 Click the activity’s drag/drop icon, drag it to the Activity Gantt Chart, and drop 
it on a field service engineer’s schedule. 

The activity appears as a horizontal bar. Holding the cursor over this bar displays 
a pop-up window containing a description of the activity. 

4 To remove an activity, drag it back to the Drag/Drop column in the Unscheduled 
Activities list. 

NOTE: To allow you to remove an activity, the Unscheduled Activities list must 
contain at least one record.

Dispatch Board Screen
The Dispatch Board provides a drag-and-drop interface for manual assignment 
and scheduling of service activities. 
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Unscheduled Activities List
The Unscheduled Activities list displays all activities that have a status of 
Unscheduled. Table 40 shows selected items in the Unscheduled Activities list.

 

Activity Gantt Chart
The Activity Gantt Chart shows the scheduled and unscheduled time periods for a 
group of field service engineers associated with a service region. This view appears 
in a calendar format. 

Schedules are shown in the Activity Gantt Chart with colors that represent rate 
types. Non-working periods are grey, working periods are white, overtime periods 
are orange, and extended overtime periods are brown.

Selecting Data for the Activity Gantt Chart
To select field service engineers and other items that appear on the Activity Gantt 
Chart, use the following options:

■ Click the Service Region select button. Select the service region from the Pick 
Service Region dialog box. The engineers that belong to the selected service 
region appear in the Gantt chart, replacing the previous list of engineers.

Table 40. Selected Items in the Unscheduled Activities List

Item Description

Apply Skills This button runs the Siebel Assignment Manager and updates the Gantt 
chart with a list of employees who belong to the service region and who 
have the skills specified for the activity. 

The Apply Skills button carries out the intersection of the employees in 
a service region and those that the assignment manger returns. The AM 
only checks skills if it has the appropriate rule. 

Assign This button runs the Siebel Assignment Manager. A dialog box appears 
with a ranked list of potential field service engineers for assignment to the 
Employees field for this activity. 

Insert Activity This button sends a synchronous request to the ABS or Optimizer, which 
inserts the selected activity into a schedule with minimal disruption of the 
schedule and without significant increase in the cost of the schedule. For 
more information, see “Insert Activity Button” on page 182.
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■ In the Date fields, enter the date to display in the Gantt chart and click Go. The 
data for the selected date appears in the chart. Also see “Changing the Behavior 
of the Activity Gantt Chart” on page 186.

Notes on Using the Activities Gantt Chart
■ An unlimited number of activities can overlap (be assigned to the same hours 

for a field service engineer), but only three appear in the chart. Adding more 
than one activity to a time slot reduces the height of the bar representing that 
activity and removes the description of the activity. To see the description of an 
activity bar and the properties of this activity, hold the cursor over the bar for a 
few seconds. A pop-up box appears.

■ Activities may be assigned to available or unavailable hours in a field service 
engineer’s schedule.

■ Any activity in the Activity Gantt Chart can be re-assigned or rescheduled.

■ Click an activity type to see more information about the activity. The Activities 
screen, Schedule view appears.

■ Clicking on the name of an employee shows the User Administration screen, 
Employees view, with information about the selected employee.

■ Dragging an activity from the Activity Gantt Chart back to the Unscheduled 
Activities list sets the activity status to Unscheduled and removes the value from 
the Employees field for this activity.

■ The assignment of an activity and its duration may be changed from the 
Unscheduled Activities list or from the Activities view.

■ The Dispatch Board can display instances of a repeated activity, with the 
following restrictions:

■ Drag and drop the repeated activity from the Unscheduled Activities list 
to the Activities Gantt chart. This becomes the first scheduled instance of 
the activity.

■ The repeated instances of this activity fill in automatically.

■ The user cannot drag any instance of a repeated activity to another location 
on the Dispatch Board or back to the Unscheduled Activities list.
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Using Dispatch Board Queries
The Dispatch Board is provided with the following predefined queries useful for 
limiting the amount of data that appears in the Unscheduled Activities list. Select 
these queries from the Favorites drop-down list. These queries apply only to 
unscheduled activities:

■ All Dispatches. Shows all assigned and scheduled activities. This is the default.

■ All Dispatches for Today.

■ All Dispatches for This Week.

■ All Overdue Dispatches.

■ All Priority-1 Dispatches.

■ All Priority-2 Dispatches.

■ My Dispatches for Today.

■ My Dispatches This Week.

■ My Overdue Dispatches.

Set up additional predefined queries in Applications Administration > 
Predefined Queries.

Using the Dispatch Board Queries with Legacy Data
If there is a large quantity of legacy data, older activities that were not scheduled 
using the Dispatch Board may also appear. It is advisable to limit the queries to 
show only records created after the Dispatch Board is installed, to make sure that 
extraneous data does not appear in the Field Activity view.
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This chapter describes how to create and manage contracts (agreements) and their 
specific levels of service (entitlements). It also describes the screens and views that 
contain information relating to agreements and entitlements.
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Agreements Overview
An agreement describes a product or service provided to the customer and the 
financial relationship between parties. In the context of your Siebel application, 
contracts and agreements are synonymous. In your Siebel application’s user 
interface, contracts are referred to as agreements. Consequently, this chapter 
usually presents the term “agreements.” 

Many different types of agreements can be created manually in the Agreements 
screen or automatically from a quote in the Quotes screen. Agreements can have a 
hierarchical relationship; that is, a master agreement can have multiple child 
agreements.

Automatic Entitlements
Entitlements can be applied automatically to agreement line items using entitlement 
templates that are associated with specific products. Each line item in an agreement 
can have multiple entitlements which cover specific costs, contacts, and accounts, 
metrics, service hours, responsiveness, and preventive maintenance plans.

Agreement Management
Siebel Agreements provides for renting, leasing, financing, and usage. Renting, 
leasing, and financing are set up in terms of nonrecurring charges, recurring 
charges, and schedules for agreement invoicing. Usage is set up in terms of use 
plans, asset measurements, and readings.

This chapter discusses nonrecurring charges (NRCs; for example, the one-time fee 
for a service agreement) and recurring charges (RCs; for example, a monthly service 
fee) as they apply to the agreement. Use-based agreements are also addressed here 
because these may include service components. 
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Agreement Invoicing
The Siebel Invoice Engine provides a mechanism for automatically creating 
invoices. The Invoice Engine produces invoices for service-related time, expense, 
and material charges. Invoices for the billing of NRCs, RCs, and usage are generated 
automatically, based on a predefined schedule. For information about the Invoice 
Engine and service-related invoices, see Chapter 6, “Invoices.” 

NOTE: To increase flexibility, invoicing for agreements is implemented as a 
Business Service.
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Setting Up Agreements
Use the following procedures to set up agreements and entitlements. 

To define asset-based pricing

1 Navigate to Site Map > Pricing Administration > Price List.

2 Select a price list. 

3 Click the Service Pricing view tab.

4 Select a product, typically a service product.

5 In the Service Price Details subview tab, click New to add a product record.

6 In the Product field, select a product.

7 Enter values for the fields that determine the pricing of this product when 
combined with the service product: Type of Calculation, Target Price, and 
Adjustment Value. 

The combination of the service product (in the Service Pricing view) and an 
asset in the Service Price Details view defines a unique price. 

To define contract-based pricing of orders

1 Navigate to Orders.

2 In the Service Orders list, select an order.

3 In the form, click the show more button to see more fields.

4 Click the select button in the Entitlement field. 

5 Select an entitlement from the Pick Entitlement dialog box, and click OK. 

6 Click the Line Items subview tab.

7 In the Line items list, click the menu button and select Reprice from the drop-
down list.
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8 In the Totals form, click Save. 

The Reprice command sends the order, line items, and the selected entitlement 
to the Pricing Engine. The engine prices each line item and includes any special 
pricing defined under the entitlement. For background, see “Order-Entitlement-
Based Pricing” on page 201.

To define NRC plans

1 Navigate to Site Map > Service Administration > Non-Recurring Plans.

2 Create a new NRC plan record.

3 Enter values for the Name, Type, and Schedule fields. See “Non-Recurring Plans 
View” on page 224.

4 Click the Plan Details view tab.

5 Create a new Plan Details record.

a Enter values for the Number and NRC % fields. 

b Add additional charges (fixed amount or percentage) to each payment 
as needed.

To define use plans

1 Navigate to Site Map > Service Administration > Use Plans.

2 Create a use plan record.

3 Enter values for the Name and Description fields. 

For a description of the Estimate check box, see “Use Plans View” on page 225.

4 In the Plan Details view tab, click New to add a product record to the use plan.

5 In the Product field, select a product.

6 Select the Commit check box. 

The Commit check box converts this record to read-only.

7 Repeat Step 4 through Step 6 for each product included in the use plan.
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To define pricing for a use plan

1 Navigate to Site Map > Service Administration > Use Plans.

2 Select a use plan record.

3 Click the Plan Details view tab.

4 Select a Plan Details (product) record.

5 Create a new pricing record by performing the following steps:

a In the Pricing list, click the menu button and select New Record.

b Complete the required fields: Measurement Type, starting measurement 
(From field), and Units. 

For more information about the fields, see “Pricing Subview” on page 225.

Asset-Based Matrix Pricing
For an agreement line item (see “Line Items View” on page 230), the combination 
of a product (typically a service product, specified in the Product field) and an asset 
(Asset # field) determines a unique price. This capability is named asset-based 
matrix pricing.

Asset-based pricing is used for pricing products related to assets that a customer has 
already purchased. The Reprice and Reprice All buttons activate the Pricing Engine 
to calculate the price of the combination, price from the price list, or price list entry, 
and supply information on volume discounts.

To configure asset-based matrix pricing, an administrator must use the Siebel 
Pricing Configurator to set up a matrix based-pricing model (see Pricing 
Administration Guide).

For a pricing model, the following data allows asset-based pricing:

■ Pricing Factor Name: any

■ Type: Matrix

■ Matrix Bus Object: Admin Price List

■ Matrix Bus Comp: FS Product Price Item Details
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■ Matrix Search Spec (for Agreements):, [Price List Id]={Service Agreement.Price 
List Id} AND [Parent Product Id]={FS Agreement Item.Product Id} AND 
[Product Id]={FS Agreement Item.Covered Asset Product Id}

■ Matrix Search Spec (for Quotes):, [Price List Id]={Quote.Price List Id} AND 
[Parent Product Id]={Quote Item.Product Id} AND [Product Id]={Quote 
Item.Covered Asset Product Id}

Order-Entitlement-Based Pricing
Orders can have an associated entitlement that provides special pricing for all line 
items in the order. This is also known as contract-based pricing.

To configure contract-based pricing, an administrator must use the Siebel Pricing 
Configurator to set up a matrix-based pricing model (see Pricing Administration 
Guide).

For a pricing model, the following data allows contract-based pricing:

■ Pricing Factor Name: any

■ Type: Matrix

■ Matrix Bus Object: Service Agreement

■ Matrix Bus Comp: FS Entitlement Pricing Details

■ Matrix Search Spec (for Orders):, [Entitlement Id]={Order Entry - 
Orders.Entitlement Id} AND [Product Id]={Order Entry - Line Items.Product 
Id}
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Setting Up Entitlements 
Follow these procedures to set up entitlements.

To set system preferences for the Verify entitlements button

1 Navigate to Site Map > Application Administration > System Preferences.

2 Query the system preferences for entitlements.

Enter Entitlement* in the System Preference Name field.

The query finds the system preferences described in “System Preferences for 
Verifying Entitlements” on page 206.

3 Select TRUE or FALSE for the System Preferences Value field.

To define entitlement templates

1 Navigate to Site Map > Service Administration > Entitlement Templates.

2 Create an entitlement template record. 

The Name field shows an automatically assigned template number. 

3 Change the Name field value to an identifiable name for the template, as needed.

4 Enter values for the other fields, as needed. 

The check boxes automatically associate data with the new template. For a 
description of these check boxes, see “Entitlement Templates View” on 
page 220.

To define entitlement template metrics

1 Navigate to Site Map > Service Administration > Entitlement Templates.

2 Select an entitlement template record.

3 Click the Metrics view tab.

4 On the Metrics view tab, create a metric record.

5 Enter values for the required fields.
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To define service hours

1 Navigate to Site Map > Service Administration > Schedules.

2 Create a new schedule record.

3 Enter values for the required fields.

4 To define the time periods in a schedule, click the Schedule Hours view tab.

5 Create a new schedule hours record. 

Each schedule hours record defines a time period in a schedule, in terms of 
hours in a day.

6 Enter values for the required fields.

To define exceptions to schedules

1 Navigate to Site Map > Service Administration > Schedules.

2 Select a schedule record.

3 To define a schedule exception, click the All Exceptions view tab. 

Schedule exceptions define non-work dates (for example, holidays) in a work 
schedule and special work days in a non-work period.

4 On the All Exceptions view tab, create a new schedule exception record.

5 Enter values in the Name and Description fields.

6 To define the dates and times for an exception, click the Exception Hours 
subview tab.

7 Create a new exception hours record.

8 Enter values for the required fields.

To define products covered in an entitlement template

1 Navigate to Site Map > Service Administration > Entitlement Templates.

2 Select an entitlement template record.

3 Click the Products view tab.
Version 7.5, Rev. A Siebel Field Service Guide 203



Agreements

Setting Up Entitlements
4 Create a product record.

5 In the Add Internal Products dialog box, select a product, and then click OK.

CAUTION: If you follow this procedure and then create an agreement line item with 
the product, then you cannot automatically associate the entitlement with the line 
item by following the procedure “To automatically create entitlements for an 
agreement line item” on page 213. For that procedure to work, you must first 
associate the entitlement template with the product. See “To associate an 
entitlement template with a product” on page 206. 

To define service billing details for entitlement templates

1 Navigate to Site Map > Service Administration > Entitlement Templates.

2 Select an entitlement template record.

3 Click the Service Details view tab.

4 Create a Service Details record.

5 Select an activity type for the Type field, enter values in required fields, 
and select check boxes as needed.

NOTE: Service Details apply to the selected activity for a specific entitlement. To 
define exceptions for a service activity, see “To define exceptions for a service 
activity.”

To define exceptions for a service activity 

1 Navigate to Site Map > Service Administration > Entitlement Templates.

2 Select an entitlement template record.

3 Click the Service Details view tab and select a Service Details record.

4 The appears below the Service Details list.

5 On the Time Exceptions subview tab, create a Time Exceptions record.

a In the Type field, select a project.
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b Enter values for the other fields as needed.

6 From the drop-down list at the top of the Time Exceptions list, select Expense 
Exceptions.

7 Create an Expense Exceptions record.

a In the Expense field, select an expense type.

b Enter values for the other fields as needed. 

8 From the drop-down list at the top of the Expense Exceptions list, select Product 
Exceptions.

9 Create a Product Exceptions record.

a In the Product field, select a product type.

b Enter values for the other fields as needed. 

To define special pricing for entitlement templates

1 Navigate to Site Map > Service Administration > Entitlement Templates.

2 Select an entitlement template record.

3 Click the Pricing Details view tab.

4 Create a Pricing Details record.

5 In the Product field, select a product.

6 Enter values for the fields that determine the pricing of this product when 
combined with the service product: Type of Calculation, Target Price, and 
Adjustment Value. 

For information about these fields and the role of Pricing Details records, 
see “Pricing Details Subview” on page 223.

To define preventive maintenance plans covered by entitlement templates

1 Navigate to Site Map > Service Administration > Entitlement Templates.

2 Select an entitlement template record.

3 Click the Preventive Maintenance view tab.
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4 Create a preventive maintenance record.

5 In the Add Preventive Maintenance Plans dialog box, select a preventive 
maintenance plan and click Add. 

To associate an entitlement template with a product

1 Navigate to Site Map > Product Administration.

2 In the More Info tab’s Show drop-down list, select Product Entitlement.

3 In the More Info list, create a new record.

4 In the name field, select an entitlement template.

System Preferences for Verifying Entitlements
System Preferences has three settings (see Table 41) which determine the action 
of the Verify button (see “Service Requests Views” on page 63).

Table 41. System Preferences for Verifying Entitlements

System Preference Name Description

Entitlement: Verify Consumer Sets the conditions for checking the authorization of the contact requesting 
service. If TRUE, the entitlements displayed must meet one of these criteria:

■ The contact for the entitlement matches the service request contact.

■ The entitlement account is set to All Contacts, and the entitlement 
account matches the service request account or the account for the 
contact for the service request. 
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Entitlement: Verify Dates Checks that the service request falls within the time span of the entitlement. 
If TRUE, the entitlements displayed are only those that provide coverage on 
the date the service request was opened: a date between the start and end 
dates for the entitlement.

If the entitlement has no start or end date, it does not appear.

Entitlement: Verify Product Checks that the asset or product is entitled to service. If TRUE, the 
agreements displayed must meet one of these criteria:

■ The entitlement asset matches an asset in the service request.

■ The entitlement product matches a product in the service request 
(no asset or serial number specified).

■ The entitlement is set to All Products and the product or asset for the 
entitlement matches the product or asset for the service request.

Table 41. System Preferences for Verifying Entitlements

System Preference Name Description
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Using Agreements and Entitlements
This section contains procedures for common agreement management tasks, such 
as creating agreements, entering line items, adding entitlements, and defining 
agreements.

To create new agreements

1 Navigate to the Agreements screen.

2 Create an agreement record. 

3 A new agreement record has, by default, Valid and Service checked, Status set 
to Current, and Type set to Service Level Agreement. Change these as needed.

4 Enter values for the required fields.

To see the entitlements for an agreement

1 Navigate to the Agreements screen.

2 Select an agreement record.

3 Click the Entitlements view tab. 

The Entitlements list shows the entitlements for this agreement. The start and 
end dates indicate whether the entitlement is active.

To verify agreements for a contact 

1 Navigate to the Contacts Screen.

2 Select a contact.

3 Click the Agreements view tab. 

The Agreements list shows the agreements for this contact.

To see products covered by agreements

1 Navigate to the Agreements screen.

2 Select an agreement record.

3 Click the Entitlements view tab.
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4 Select an entitlement record.

5 Click the Products subview tab. 

The Products list shows the products covered by the selected entitlement under 
the selected agreement.

6 Repeat Step 4 and Step 5 for each entitlement in the list. 

To associate primary contacts with an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 In the Account field, select an account to associate with the agreement.

4 Click the Primary Contacts view tab. 

On the Primary Contacts form, the fields for the Legal Contact, Billing Contact, 
and Shipping Contact are automatically filled with the primary contact for the 
selected account.

5 If you want to change a primary contact, click a Last Name field and select 
another contact. 

The list of available contacts is limited to the contacts that are associated with 
the selected account.

To generate an agreement document

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Documents view tab.

4 To create a document record, click New.

a Enter a name for the document.

b From the Template drop-down list, select a document template.

c Click Save.
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5 Click Generate Draft. 

The system launches Microsoft Word or Lotus WordPro and displays a draft 
agreement.

To associate activity plans with an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Activity Plans view tab.

4 Create an Activity Plan record.

5 Select a template for the activity plan.

6 Select Lock Assignment to prevent the Assignment Manager from assigning 
activities that are already in this activity plan.

To add activities to an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Activities view tab.

4 Create an activity record.

a In the Start field, select the date and time for the activity.

b In the Type field, select the activity type.

c Enter values for other fields, as needed.

To add financial details for an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Financials view tab.

a Complete the Order # and Quote # fields.
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b Enter values for other fields as needed.

NOTE: Some fields are calculated and filled in using data from the Line Items view 
and its subviews. For example, Terms = (Agreement End Date - Agreement Start 
Date) / 30, and Months Left = (Agreement End Date - Today) / 30. 

To define terms and shipping information for agreements

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Terms & Totals view tab.

4 Enter values for fields, as needed.

To add products sold under an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Line Items view tab.

4 Add a new product record.

5 Click the Line Detail subview tab, and then click the show more button to add 
additional information about the product.

To specify the product and asset combination for asset-based pricing

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Line Items view tab.

4 Create a line item record.

5 In the Product field, select a product, typically a service product to be priced 
with an asset.

6 In the Asset # field, select an asset to be priced with the selected product.
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7 Enter values in the Price fields, which apply to the product, as needed.

To automatically generate invoices for agreements

■ See “To associate an invoice plan with an agreement” on page 253 and “To 
create an invoice for an agreement line item” on page 258.

To manually generate an invoice for an agreement line item

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Line Items view tab.

4 Select a line item to invoice.

5 Click the Invoices subview tab.

6 Click New to create a new invoice for the selected agreement line item.

7 In the invoice you created, click the Invoice # hyperlink. 

The Invoices screen appears with the invoice displayed.

8 In the Line Items list, add invoice line items if required.

9 From the application-level menu, choose View > Reports > Customer Invoice.

10 Click Run Now. 

The Siebel Report Viewer appears.

11 Click the print button.

To attach files to agreements

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Attachments view tab.

4 Add an attachment record.

5 In the Attachment Name field, select the file to attach and click Add. 
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To automatically create entitlements for an agreement line item

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Line Items view tab.

4 Select a line item (product record).

5 Click Entitle. 

The Entitle button automatically associates entitlements with the line item, 
based on the entitlement template associated with the product.

To manually add entitlements to an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Entitlements view tab. 

4 Add an entitlement record. 

The Name field shows an automatically assigned entitlement number. 

5 Change the Name field value to an identifiable name for the entitlement, as 
needed.

6 In the Type field, select the entitlement type.

7 Enter values in the Priority and Service Hours fields.

To manually associate accounts with entitlements

1 Navigate to Site Map > Entitlements.

2 Select an entitlement.

3 Click the Accounts view tab.

4 Add an account record.

5 To provide complete coverage under the selected entitlement, select the All 
Contacts and All Products fields.
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To manually associate contacts with entitlements

1 Navigate to Site Map > Entitlements.

2 Select an entitlement.

3 Click the Contacts view tab.

4 Add a contact record.

5 To provide complete coverage under the selected entitlement, select the All 
Products field. 

6 Enter values for other fields, as needed.

To manually associate products and assets with entitlements

1 Navigate to Site Map > Entitlements.

2 Select an entitlement. 

3 Click the Products view tab.

4 Add a product record.

5 Do one of the following:

■ In the Asset # field, select an asset.

■ In the Product field, select a product.

To manually associate preventive maintenance plans with entitlements

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Entitlements view tab.

4 Select an entitlement.

5 Click the Preventive Maintenance subview tab.

6 In the drop-down list at the top of the Preventive Maintenance subview, make 
sure PM Plans is selected.

7 Add a preventive maintenance plan record.
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8 In the Add Preventive Maintenance Plans dialog box, select a preventive 
maintenance plan and click Add.

To associate an entitlement with an order for contract-based order pricing

1 Navigate to the Orders screen.

2 Select an order.

3 Click the show more button to see more fields.

4 In the Entitlement field, select an entitlement.

5 Click the Line Items view tab.

6 Click Reprice All. 

The Reprice All button returns a price list for all line items and provides 
information on volume discounts.

To generate preventive maintenance actions for an agreement and entitlement

1 Follow Step 1 through Step 5 of “To manually associate preventive maintenance 
plans with entitlements” on page 214.

2 Select a preventive maintenance plan record.

3 Click Run PM. 

The system generates preventive maintenance actions for the selected agreement 
and entitlement based on the selected preventive maintenance plan. 

To view preventive maintenance actions associated with a PM Plan

1 Follow Step 1 through Step 6 of “To manually associate preventive maintenance 
plans with entitlements” on page 214.

2 Select a preventive maintenance plan record.

3 From the drop-down list at the top of the Preventive Maintenance subview, 
select PM Actions. 

This read-only view shows the actions associated with the selected PM Plan.
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To associate a service calendar with an entitlement

1 Navigate to the Agreements screen. 

2 Select an agreement.

3 Click the Entitlements view tab.

4 Select an entitlement.

5 Click the Entitlement Details subview tab.

6 In the Service Hours field, select a service calendar record.

To manually add performance measurements (metrics) for an entitlement

1 Navigate to the Agreements screen. 

2 Select an agreement.

3 Click the Entitlements view tab.

4 Select an entitlement.

5 Click the Metrics subview tab.

6 Add a metrics record.

7 Enter values in the Value, Units, Priority, and Service Hours fields, as needed.

To verify entitlements for a service request and select an entitlement

1 Navigate to the Service screen.

2 Select a service request.

3 In the service request form, click Verify. 

The Pick Entitlement dialog box appears, with a list of the active entitlements 
for this service request. If no entitlements appear, the selected service request is 
not entitled to receive service.
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4 Select an entitlement record from the Pick Entitlement dialog box, and then 
click OK. 

Selecting an entitlement from the Pick Entitlement dialog box computes the 
Agent Committed time (see “Service Requests Views” on page 63) for the service 
request from the Service Calendar associated with this entitlement and from the 
Response Time specified in the entitlement metrics. 

5 In the service request form, click the show more button. 

The name of the selected entitlement appears in the Entitlement field.

To view the agreements for a contact

1 Navigate to the Contacts screen.

2 Select a contact.

3 Click the Agreements view tab. 

The Agreements list shows the agreements for this contact.
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Application Administration Screen
The Application Administration screen has two views that influence agreements: 
the Schedules view for defining service schedules and the System Preferences view 
for determining the behavior of the Verify (entitlements) button. For information 
about these views, see Applications Administration Guide. 
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Pricing Administration Screen
The Pricing Administration screen provides a view for configuring asset-based 
pricing. Pricing Configurator must be installed for asset-based pricing to work with 
agreement line items.

Service Pricing View
The Service Pricing view allows users to associate multiple products that together 
define a unique price. (This is asset-based pricing.)

Service Price Details Subview
The Service Pricing Details subview specifies products that represent the targeted 
installed base of assets covered by a service product. In an agreement line item 
(see “Line Items View” on page 230), specifying a service product (for example, 
Platinum Coverage) and selecting an asset that is covered by asset-based pricing 
(for example, component G with serial number XYZ) return a line item price based 
on the combination of service product and part.
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The Service Administration screen has views for defining entitlement templates and 
billing plans based on one-time (nonrecurring) charges and asset usage.

Entitlement Templates View
The Entitlement Templates view allows an administrator to predefine entitlements 
and specify the type of service provided. An entitlement template specifies the 
default coverage for the accounts, contacts, preventive maintenance, billing, 
products, and pricing. 

The Entitle button (see “Line Items View” on page 230) automatically finds the 
entitlement templates that correspond to products in an agreement (see “Products 
Subview” on page 223), and then creates the entitlements using the default values 
from the template. An administrator can then modify any of the values. 

Table 42 describes items in the Entitlement Templates view.

Table 42. Selected Items on the Entitlement Templates View 

Item Description

Account All Contacts Indicates the entitlement should cover all contacts associated with 
the account. The effect is to check the All Contacts box in 
Agreements > Entitlements > Accounts.

Account All Products Indicates all products associated with the account under this 
entitlement should be covered. The effect is to check the All 
Products box in Agreements >Entitlements >Accounts.

Activity Override Determines whether the rate and price lists specified for the 
entitlement override the rate and price lists for a service request. 
For contract-based invoicing, check this box.

Billable Indicates one or more services provided by this entitlement are 
billable to the customer. 

Contact All Products Indicates the entitlement should automatically cover all products 
for the contact. The effect is to check the All Products box in 
Agreements > Entitlements> Contacts.

Include Account Indicates the entitlement should automatically cover the account 
on the agreement header.
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Metrics Subview
In the Metrics subview, add performance requirements for the entitlement template; 
for example, response time. Each requirement must be in a separate record.

Preventive Maintenance Subview
In the Preventive Maintenance subview, add a record for each Preventive 
Maintenance plan included in the entitlement template. When selecting a plan from 
the Add Preventive Maintenance Plan dialog box, check the box in the second 
column to select a plan; selecting a record without checking this box fails to select 
one or more plans. 

Service Details Subview
The Service Details subview defines each type of service covered by the entitlement 
and the billing terms for each service. Terms may include a fixed service charge 
and specific billable time, expenses, and parts. Table 43 on page 221 describes some 
items on this view.

Include Contact Indicates the entitlement should automatically cover the contact 
from the agreement header.

Initial Quantity Number of services covered in the entitlement.

Units Unit of measure for the initial quantity covered; for example, 
service requests.

Table 43. Selected Items on the Service Details View

Item Description

Expenses Billable Indicates the service expenses under this entitlement are billable to 
the customer. 

Parts Billable Indicates the parts provided under this entitlement are billable to the 
customer. 

Table 42. Selected Items on the Entitlement Templates View 

Item Description
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Note the following effects of a service detail record:

■ Service Details apply to the selected activity type rather than to a specific 
entitlement template.

■ No additional charges or discounts are applied to a service request activity if no 
corresponding service detail record is defined for the service request’s associated 
entitlement. 

■ No additional charges or discounts are applied to a billable item in a service 
request activity if no corresponding exception record is defined for the service 
detail record in the service request’s associated entitlement. See the “Time 
Exceptions Subview,” “Expense Exceptions Subview,” and “Product Exceptions 
Subview” sections that follow.

The subviews of Service Details define exceptions for time, expenses, and products. 
For example, if labor (time) is generally not billable, the Invoice Engine will only 
bill the exceptions. Conversely, if time is generally billable, the Invoice Engine does 
not bill the exceptions. You access these subviews by selecting from the drop-down 
list in the tab at the bottom of the screen. 

Time Exceptions Subview
Time exceptions define the pricing of time associated with an activity type that 
is different than standard pricing. Time exceptions include a fixed service charge, 
discounts, and a limit on the billable amount.

NOTE: Exception records for time are associated with activity types and specific 
projects (specified in the Type field). For information about projects, see the chapter 
on project management in Siebel Professional Services Automation Guide.

Time Billable Indicates time (labor) under this entitlement is billable to the 
customer. 

Type Defines the type of activity to which a Service Details record applies. 
This required value determines the other fields that appear in the 
Service Details view.

Table 43. Selected Items on the Service Details View

Item Description
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Expense Exceptions Subview
Expense exceptions define pricing of expenses associated with an activity type that 
is different from standard pricing. Expense exceptions include a fixed service 
charge, discounts, and a limit on the billable amount.

Product Exceptions Subview
Product exceptions define pricing of products associated with an activity type that 
is different from standard service pricing. Product exceptions include discounts, 
markups, and overrides.

Products Subview
The Products subview defines specific products or assets covered by the 
entitlement. You can copy these products to an entitlement by selecting the 
Entitlement Template Products check box in the “Entitlement Templates View” on 
page 220. 

Pricing Details Subview
The Pricing Details subview allows contract-based pricing for orders. When creating 
a sales or service order on the Orders screen, the user can select an entitlement 
which applies special pricing, defined on this view, to the Pricing Configurator. 
Table 44 describes the items in this view.

Table 44. Selected Items on the Pricing Details View

Item Description

Type of Calculation Type of price adjustment; for example, a discount or markup.

Adjustment Value Amount of price adjustment described in the Type of Calculation 
field.
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Non-Recurring Plans View
The NRC Plans view defines installment plans for payment of one-time charges; for 
example, 12 monthly payments. Invoices can be generated monthly, quarterly, or 
annually. NRCs are added to invoices based on this schedule. Table 45 describes the 
check boxes on this view.

NOTE: To use an NRC plan, it must be both active and committed.

Plan Details Subview
The Plan Details subview records add specific information for an NRC plan, 
including the percentage of the nonrecurring charge to bill at each schedule interval 
(monthly, quarterly, or annually) and any additional fee to add to each installment 
(as a percentage, a fixed amount, or both). Each record in this view describes the 
amount to charge for each payment. Table 46 describes the items in this view. 

Table 45. Selected Items on the NRC View

Item Description

Active Makes this NRC plan a choice in Agreements > Line Items > Invoice Plan.

Commit Converts this record and child records to read-only status. 

Selecting this check box also makes the Plan Details view read-only.

Table 46. Selected Item on the Plan Details View

Item Description

Number Number of payments for a nonrecurring expense.

NRC % Percentage of the NRC to bill in each payment.
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Use Plans View
The Use Plans view describes plans for billing, based on the use of an asset; for 
example, revolutions, distance traveled, or number of events (clicks). Table 47 
describes the check box in this view. 

Plan Details Subview
The Plan Details view records the products covered by the use plan. Table 48 
describes the check box on this view.

Pricing Subview
The Pricing subview defines the price structure of each product in the selected use 
plan. Enter a record for each range of measurement. The Pricing view allows tiered 
pricing; for example:

Table 47. Selected Item on the Use Plans View

Item Description

Estimate Allows for an estimate of use if the readings do not cover the specified billing 
period. If selected, the Invoice Engine uses the information in the Expected 
Usage and Use Basis (Days) fields (see “Product Measurements View” on 
page 227). If cleared and the Invoice Engine finds incomplete data for this 
billing period, the engine does not bill for this period. 

Table 48. Selected Item on the Plan Details Subview

Item Description

Commit Converts this record to read-only status.

Selecting this check box also makes the fields described in “Pricing Subview” 
on page 225 read-only.

Usage Range (Miles) Price per Mile

0-100 $0.25

101-500 $0.30
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Table 49 describes the items on the Pricing view.

NOTE: To set up aggregate rather than tiered pricing, choose Absolute for the 
Use Plan Bill Method field. This supplies a cumulative reading, starting from the 
beginning of the plan. See “Product Measurements View” on page 227. 

501-1,000 $0.35

Over 1,000 $0.40

Table 49. Selected Items on the Pricing View

Item Description

From Lowest value of a measurement for this pricing record.

Rollback Provides discounted pricing for higher usage. Selecting Rollback on a specific 
tier causes the record’s price to override the prices for all lower tiers. In the 
previous example (see “Pricing Subview” on page 225), a Rollback flag set for 
the tier labelled Over 1,000 would result in all miles billed at the rate of $0.40 
per mile, if the usage reaches this tier during the specified time period.

Units Provides the following selections:

■ Per Count. Charges the amount specified in the Amount field for each unit 
of measure; for example, $0.50 per mile.

■ Total. Charges the amount specified in the Amount field for the total 
measurement interval (From and To fields); for example, $15 for 0 to 100 
miles (100 miles total). 
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Product Administration Screen
The Product Administration screen has one view for defining measurements taken 
from products and one view for associating an entitlement template with a product.

To see these views, choose the More Info view, and then select the Product 
Measurement or Product Entitlement view from the Show drop-down list.

Product Measurements View
The Product Measurements view defines the measurements that are the basis for 
determining asset use (see “Use Plans View” on page 225). You access this view by 
selecting Product Measurements from the Show drop-down list on the More Info 
tab. Table 50 describes items on this view.

A read-only version of the Product Measurements view is available in the 
Products screen.

Table 50. Selected Items on the Product Measurements View

Item Description

Frequency Schedule for obtaining readings of the specified measurement, 
chosen from a list.

Use Plan Bill Method Method of accumulating data from readings:

■ Incremental. Counter increments continuously with each 
reading (10, 20, 30, 40, and so on).

■ Absolute. Counter is reset after each reading (10, 10, 10, 10, 
and so on).

Expected Usage Numeric value for the expected use, which the Invoice Engine uses 
to bill for usage if readings of usage are unavailable and if Estimate 
is checked (see “Use Plans View” on page 225).

Use Basis (Days) Time period, in days, over which the expected use is to occur. This 
value must match the value in the Frequency field. 
Version 7.5, Rev. A Siebel Field Service Guide 227



Agreements

Product Administration Screen
Product Entitlements View
The Product Entitlements view associates entitlements with a product. You access 
this view by selecting Product Entitlements from the Show drop-down list on the 
More Info tab. The Entitle button on the Agreements screen (see “Line Items View” 
on page 230) automatically associates the se entitlements with the products 
described in selected line items. This view contains two check boxes, described in 
Table 51.

Table 51. Selected Items on the Product Entitlement Templates View

Item Description

Agree Line Item Products Copies all products from the agreement line item to an 
automatically generated entitlement (produced by 
clicking the Entitle button). 

Entitlement Template Products Copies all products associated with the entitlement 
template to an automatically generated entitlement 
(produced by clicking the Entitle button). 
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Agreements Screen
The Agreements screen defines agreement of all types. It also includes views for the 
history of approvals for each agreement, entitlements, associated service requests, 
and activities.

Agreement View
The Agreement view displays all agreements that are visible to the user. Table 52 
describes some items in Agreements records.

Table 52. Selected Items in the All Agreements View

Item Description

Amendment Number, text, or similar information that references another object 
that amends this agreement.

Currency Code for the type of currency; for example, USD for U.S. dollars.

For agreement-based invoicing, the Invoice Engine uses this value as 
the target, or overriding, currency. Before performing invoice 
calculations, the Invoice Engine converts all the input currency 
values, such as the ones in the NPR Plan and the Usage Plan, to the 
target currency. The Invoice Engine then performs its calculations in 
the target currency. After the calculations are completed, the Invoice 
Engine writes these values back as Invoices, Invoice Line Items, and 
Invoice Line Item Details, all in the target currency. 

Effective Actual date the agreement is effective. Can be later than, earlier than, 
or the same as the Start date. 

End Date the agreement will end. 

Parent Broader agreement, if any, under which this agreement resides, 
chosen from a dialog box.

Service Indicates this is a service agreement. This check box is for information 
only.
Version 7.5, Rev. A Siebel Field Service Guide 229



Agreements

Agreements Screen
Line Items View 
The Line Items view records a description of each product sold or provided under 
a selected service agreement. Table 53 describes items in this view.

Start Date the agreement is planned to start. 

Valid Indicates the agreement is valid. Must be selected for consideration of 
the entitlements when verifying coverage “Verify Button” on page 65. 
Also, preventive maintenance actions for assets are only initiated if 
this box is selected and the selected entitlement is active, based on its 
start and end dates. 

Table 52. Selected Items in the All Agreements View

Item Description

Table 53. Selected Items in the Line Items View

Item Description

Asset # Number of an asset associated with the product described in this line item 
record, or the number of an asset for a different product, used for asset-based 
matrix pricing. See “Asset-Based Matrix Pricing” on page 200. 

Specifying an asset of the product described in the line item is appropriate, 
for example, when specifying a trade-in. This case can include a discount 
available only for trade-ins. 

Entitle Menu command and button. Automatically associates entitlements (from 
entitlement templates) with the product described in the selected line item. 
Selecting a second time associates any new entitlements, but does not update 
entitlements that are already associated. For more information, see 
“Entitlement Templates View” on page 220 and “Products Subview” on 
page 223.

Product Product for this line item. Can be a service product.

Reprice Menu command. Calculates the price for the selected line item, based on the 
associated price list and pricing model.

Reprice All Menu command and button. Calculates the price for all line items, based on 
the associated price list and pricing model.
230 Siebel Field Service Guide Version 7.5, Rev. A



Agreements

Agreements Screen
Totals Subview
The Totals subview displays the total price, before tax and shipping charges, for the 
agreement line items and applied discounts. To see this subview, click the drop-
down list in the Line Item Attributes subview and select Totals.

Line Item Attributes Subview
If the product is customizable, the product attributes appear in this subview. To see 
this subview, click the drop-down list in the Totals subview and select Line Item 
Attributes.

Line Detail Subview
The Line Detail subview contains additional fields that define an agreement line 
item. Some fields are filled in automatically with the product selected in the Line 
Items view. Table 54 describes items on the Line Detail subview. 

 

Table 54. Selected Items in the Line Detail Subiew

Item Description

Asset # The number of an asset to use (see “Setting Up Agreements” on 
page 198).

Discount % A discount percentage applied directly to the selected line item.

Net Discount % A calculated field whose value is equal to (Start Price - Discount 
Amount) / Start Price.

Discount Amount A discount amount applied directly to the selected line item.

Usage Asset # Number of the asset to use for billing of usage (see “Use Plans View” 
on page 225).

Line # Number assigned to each line item in the Line Items view, 
starting with 1.

Sequence Indicates the hierarchical relationship of line items. 
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Invoice Plan Subview
The Invoice Plan subview records the billing details for the selected agreement line 
item. Table 55 describes items on the Invoice Plan subview. 

Table 55. Selected Items in the Invoice Plan Subview

Item Description

Adjust Invoice Positive or negative adjustment to the amount of an invoice. 
The Invoice Engine clears this field after generating an invoice. 

Auto Invoice Indicates the Invoice Engine should generate an invoice for this line 
item. Activates the Advance to field. If cleared, the Invoice Engine 
ignores this agreement line item.

Invoice Basis Method of invoicing. Make a choice from the drop-down list:

■ Advance. Generates the invoice at the beginning of the interval 
defined by the Invoice Schedule and Invoice Timing fields. 
Estimates use-based charges based on the last readings.

■ Schedule. Generate the invoice at the end of the interval defined 
by the Invoice Schedule and Invoice Timing fields.

Invoice End Last possible date to generate an invoice.

Invoice Schedule Interval for generating invoices, chosen from a list; for example, 
monthly.

Invoice Start Start date for the schedule of invoices. 

Invoice Timing Day of the month on which an invoice is generated.

Last Invoiced Date of the last invoice generated in this schedule of invoices. 

■ If this field contains a date and time, the Invoice Engine waits 
until the end of the billing interval (defined in Invoice Schedule) 
to generate an invoice. 

■ If this field is blank, the Invoice Engine assumes that the first 
invoice has not yet been generated.

Non-Recurring Total amount of the nonrecurring charge. It may include a service 
change or a discount.

NRC Invoiced Total amount invoiced against the NRC amount.
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Invoices Subview
The Invoices subview displays all of the invoices associated with a line item. 
The Invoice Engine automatically produces these records.

NRC Plan Predefined NRC billing plan, chosen from a dialog box. If this field is 
blank, the NRC amount is divided equally among the invoices 
defined in NRC Qty. 

NRC Qty Number of installments for paying the nonrecurring charge.

NRC Schedule Interval for invoicing NRC, chosen from a list; for example, monthly. 
This can be different from Invoice Schedule.

NRC Start Start date for billing nonrecurring charges. The default is the Invoice 
start date.

RC Adjust Amount to bill for partial intervals as defined in RC Schedule. For 
example, if invoices are prepared monthly, this field defines the 
dollars per unit of time that the Invoice Engine uses to calculate the 
RC invoice line item. 

RC Schedule Interval for generating invoices against recurring changes, chosen 
from a list; for example, monthly. The Invoice Engine uses this date 
only for calculating the amount owed. Invoices are issued on 
according to the Invoice Schedule. The default is copied from the 
Invoice Schedule field.

RC Start Date to start billing a recurring charge. The default for this field is 
copied from the Invoice Start field.

Recurring Amount of a recurring charge.

Use Plan Predefined use plan, chosen from a dialog box that displays only the 
plans that apply to the product in the selected line item.

Use Start Value that a Invoice Engine uses to generate the first invoice for 
billing on a use plan. See the logic for use-based billing in Chapter 6, 
“Invoices.” 

Table 55. Selected Items in the Invoice Plan Subview

Item Description
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Entitlements View
The Entitlements view displays entitlements and associates them with specific 
agreements.

NOTE: End users should use the Entitlements view on the Agreements screen. The 
Entitlements screen (“Entitlements Screen” on page 240) is used for general 
administrative work across agreements.

Accounts Subview
The Accounts subview associates accounts with specific entitlements. Table 56 
describes the items in accounts records.

Entitlement Details Subview
The Entitlement Details subview displays additional details for a selected 
entitlement. Table 57 describes items in entitlement detail records.

Table 56. Selected Items in the Accounts Subview

Items Function

All Contacts Indicates all contacts associated with this account are covered by this 
entitlement. Entitlement verification uses this information (see “Verify 
Button” on page 65). 

All Products Indicates all products are covered by this entitlement. Entitlement 
verification uses this information. 

Table 57. Selected Item in the Entitlement Details Subview

Item Description

Current Qty Enter the current quantity covered by the entitlement. 

Your Siebel application does not automatically update the current 
quantity. You must update it manually each time it changes. 
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Products Subview
The Products subview associates assets and products with entitlements. The 
records in this view provide a list of products covered by the selected entitlement. 
These records are used when the All Products check box in the Accounts subview 
is not set, and the entitlement is valid only for specific products or assets.

NOTE: Agreements > Line Items (see “Line Items View” on page 230) specifies 
the products purchased or provided under this agreement. Agreements > 
Entitlements > Products defines the level of service provided for each product 
and asset associated with the agreement.

Contacts Subview
The Contacts subview associates contacts at an account with a specific entitlement. 
The records in this view are used when the All Contacts check box (in the Accounts 
subview) is not set and the entitlement is valid only for specific individuals.

Metrics Subview
The Metrics subview records performance measurements for an entitlement; for 
example, response time for a service call and customer satisfaction rating. The 
Response Time metric is required for calculating Agent Committed time in the 
Service Request view (see “Service Requests View” on page 237). This is the only 
entitlement metric is used directly to determine a level of service.

Initial Qty Enter the initial quantity covered by the entitlement. 

Override Activity Flag Determines whether the rate and cost lists specified in this 
entitlement override the rate list and cost list specified for a 
service request.

Table 57. Selected Item in the Entitlement Details Subview

Item Description
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Service Details Subview
The Service Details subview defines the billing terms for service activities covered 
by the entitlements. Table 58 describes items in Service Detail records.

 

Price Details Subview
The Price Details subview records special pricing considerations for products 
covered by the entitlement; for example, discounts or markups. This special pricing 
is used only for pricing order line items; it requires the Siebel Pricing Configurator.

Line Item Revenue View
The Line Item Revenue view displays all revenue records associated with an 
agreement line item. To obtain information about the revenue for a line item, first 
select the line item in the Line Item View, and then click the Line Item Revenue tab. 

Table 58. Selected Items in the Service Detail Subview

Item Description

Expenses Billable Indicates the service expenses under this entitlement are 
billable to the customer. 

Maximum Expense Discount Limit of expense discounts that a customer may receive for 
a selected activity type.

Maximum Time Billable Limit of time charges that a customer may receive for a 
selected activity type.

Parts Billable Indicates the parts provided under this entitlement are 
billable to the customer. 

Service Charge Fixed charge included in the invoice. This may be the only 
charge if service is based on a flat rate.

Time Billable Indicates time (labor) under this entitlement is billable to 
the customer.
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Revenue Subview
The Revenue subview records the revenues collected for the selected agreement line 
item. A user can manually record payments received for an agreement line item. 
Table 59 describes items in revenue records.

Two additional subviews at this level provide revenue data as a spreadsheet and 
a chart.

Service Requests View
The Service Request view displays new or existing service requests for a selected 
agreement. Service request records appear automatically in this view when a user 
verifies coverage and selects an entitlement.

For more information about service requests, see Chapter 2, “Service Support.”

Financials View 
The Financials view summarizes the cost of materials and the revenues for 
an agreement.

Terms and Totals View
The Terms and Totals view displays the payment, taxes, and shipping information 
for an agreement.

Table 59. Selected Items in the Revenue View

Item Description

(drop-down lists) The two drop-down lists at the top of the Revenue list direct a query 
of existing revenue records in this list. One field allows selection of 
records for specific products, the other for specific users.

Amount Amount of revenue expected on the specified date.

Revenue Date Date for expected revenue.

Revenue Wizard Button. Runs a script wizard that helps users enter multiple revenue 
records over time.
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Totals Subview
The Totals subview displays the totals of service, parts, shipping, and tax billed to 
an agreement. Table 60 describes items in totals records.

Activities View
The Activities view associates activities with agreements. 

Activity Plans View
The Activity Plans view associates activity plans with agreements. 

Approval History View
The Approval History view shows who approved this agreement. The Workflow 
Manager automatically creates these records as people approve an agreement.

Attachments View
The Attachments view displays files related to selected agreements.

Table 60. Selected Items in the Totals Subview

Item Description

Adjustment Value entered in this field is subtracted from the value in the Total field.

Products Sum of agreement line items that have the Service field set to No (see “Line 
Items View” on page 230) minus discounts.

Services Sum of agreement line items that have the Service field set to Yes (see “Line 
Items View” on page 230), minus discounts.

Shipping Cost of shipping. Copied from the Shipping Charges field in the Terms 
and Totals view.
238 Siebel Field Service Guide Version 7.5, Rev. A



Agreements

Agreements Screen
Documents View
The Documents view automatically generates documents required to implement 
a service agreement; for example, subcontractor agreements and work orders. For 
information about how to create document templates, see the chapter on proposals 
in Applications Administration Guide. Table 61 describes items in the 
Documents view.

Discounts View
The Discounts view displays the invoices that are associated with this agreement. 
The Invoice Engine automatically generates these records for service requests that 
are related to a selected agreement based on a selected entitlement. The discounts 
reflected here are based on special pricing defined under the entitlement. 

Notes View
The Notes view allows you to add notes to an agreement. You can add a private note 
(visible only for the logon ID under which it was created) on the Private tab or a 
public note (visible to all users) on the Public tab.

Orders View
The Orders view displays a list of all orders associated with an agreement. This view 
allows you to create orders directly from a selected agreement. 

For information about orders, see Siebel Order Management Guide.

Table 61. Selected Item in the Documents View

Item Description

Auto Document Command and button. Creates a new record from the default document 
template.

Generate Draft Command. Creates a draft document and opens it in Microsoft Word or 
Lotus WordPro. 

Local Indicates this document is stored locally. This field is for information 
only; there is no associated code.
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Entitlements Screen
The Entitlements screen displays the accounts, contacts, entitlement metrics, 
preventive maintenance plans, and products associated with entitlements across 
all agreements. 
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Agreements Charts
The Agreements screen (Agreements > Charts) provides charts for analysis, listed 
in Table 62. 

Table 62. Agreements Analysis

Chart Analysis

Trend Analysis by Effective Date Number of agreements beginning as a function 
of calendar period.

Trend Analysis by Expiration Date Number of agreements ending as a function 
of calendar period.
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Agreements Reports
The Reports menu (View > Reports) provides reports for Agreements, listed in 
Table 63.

Table 63. Agreements Reports

Report Description

Agreement Summary Summary of each agreement, printing three agreements per 
page.

Current Agreement Detail All information about each agreement and associated line 
items.
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This chapter describes how Siebel Field Service can automatically generate invoices 
for service requests, activities, and contracts. 
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Invoice Overview
Siebel Field Service automatically produces invoices for activities, service requests, 
and contracts. As shown in Figure 3, invoices for activities can incorporate charges 
for parts, labor, and expenses. Invoices for service requests incorporate orders, plus 
the charges for all of the activities related to this service request. Only records that 
have the Billable flag set are added to the invoice automatically.

Pro forma invoices can be printed onsite for customers and sent to an accounting 
system to track accounts receivable and revenue. An invoice can also be marked as 
delinquent, then tracked by the Workflow Manager, which can send automatic 
reminders to customers or employees. 

Each invoice can include these line items:

■ Time and materials

■ Miscellaneous expenses and tax

Figure 3. Workflow for Automatic Invoicing
244 Siebel Field Service Guide Version 7.5, Rev. A



Invoices

Invoice Overview
■ Nonrecurring charges

■ Recurring charges

■ Use charges

■ Project charges

■ Credits or other adjustments

Siebel Invoices can be integrated with third-party software to manage taxation for 
entire invoices or for invoice line items. Without tax integration, Siebel Invoices 
prepares pro forma invoices, statements of work, or quick reports to customers. 
The collection of applicable charges and activities is also an efficient way to pass 
this information to a financial system.
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Invoice Logic
This section describes the business logic for generating invoices for service 
requests, activities, and agreements.

Logic for Service Requests
The Invoice Engine uses the following process logic for service requests:

1 For a selected service request, find all records with the Billable flag set. 

2 Find the rate and price lists for the items described in these records.

3 Calculate the price for each item.

4 If an entitlement covers the service request:

a Find the price and rate lists associated with the entitlement.

b If the Activity Override flag is set, recalculate the billable cost for the items 
using the price and rate lists for the entitlement instead of the lists for the 
activity and the entitlement service price details for the activity types 
covered.

5 If there is no entitlement, go to the next billable item.

6 If there are no more billable items, create an invoice.

Logic for Activities
The Invoice Engine uses the following process logic for activities:

1 For a selected activity, find all expense, time, and part records with the Billable 
Flag set.

2 Find the rate and price list for the activity.

3 Calculate the price for each record.

4 Create an invoice.
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Invoice Logic for Agreements 
The Invoicing Engine creates a separate, independent invoice for every agreement 
line item and for every invoicing period. For every agreement line item, it generates 
invoices for all charges in the period after the last invoice was produced.

The Invoice Engine uses the following logic to process invoices for agreement line 
items:

1 If the Valid check box is selected in the parent agreement record, proceed.

2 If all invoices have already been generated for the invoice period (from the 
Invoice Start Date to the Invoice End Date), stop the invoicing process on this 
agreement line item.

3 If the invoice schedule for this agreement line item requires an invoice at this 
time (in other words, if an invoice is required before the Advance To date), 
proceed.

4 If the invoiced agreement line item was cancelled and the invoice period is 
before the cancel date, proceed.

NOTE: The cancel date can be set in the Cancel field in the Agreements screen, 
Line Items view, Line Detail subview.

5 Process all the charges for all billing types specified in the invoice plan 
associated with the agreement line item. 

6 Generate an invoice.

The Invoice Engine can generate periodic invoices that include these types 
of charges:

■ NRC. Installment payments for one-time (nonrecurring) charges; for example, 
a one-time fee for service billed in one or more installments.

■ RC. Payment of periodic (recurring) charges; for example, a monthly 
service charge.

■ Usage. Payments based on the use of an asset; for example, the number of copies 
produced on a color copier each month.
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■ Adjustments. Credits or charges for the selected period.

NOTE: To increase flexibility, invoicing for agreements is implemented as a 
Business Service.

Logic for NRC Line Items
The Invoice Engine uses the following logic to process NRC line items:

1 If there is a previous invoice, find the NRC Invoiced amount. If the Non-
Recurring amount is greater than or equal to the NRC Invoiced amount plus the 
next amount to be invoiced, proceed. 

2 If this is the first invoice and if the NRC amount for the line item is greater 
than zero, proceed.

3 Calculate the NRC amount for the next invoice, using the NRC plan, if selected.

4 Create an NRC line item on the invoice.

Logic for RC Line Items
The Invoice Engine uses the following process logic for recurring cost line items:

1 If the recurring charge for the invoice is greater than zero, proceed.

2 Calculate the RC amount.

3 Create an RC line item on the invoice.

Logic for Usage Line Items
To generate invoices from usage line items, you must first define the asset on which 
the usage is measured. You specify this asset in the Usage Asset # field in the 
Agreements screen, Line Items view, Line Detail subview. For accurate billing, the 
invoice schedule must match the measurement frequency of the asset. 
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If you want to invoice on estimated usage, you must define certain fields in the 
product measurement record of the asset's product. Table 64 lists these fields.

You define these fields in the Product Administration screen, Product Measurements 
view. For more information, see “Product Measurements View” on page 227.

The Invoice Engine uses the following logic for usage line items:

1 If there was a previous invoice for this agreement line item’s use plan, find the 
reading on the last invoice.

2 If this is the first invoice for the use plan, find the reading closest to the Use Start 
date.

3 Find the reading closest to the current date or the Advance Invoice date.

4 If there is no new reading since the last invoice or the Use Start date, and if the 
Estimate check box is selected (on the Service Administration screen, Use Plans 
view), use the calculated average use defined in the Usage field (Assets screen, 
Measurements view) as the estimated reading.

5 If a reading is found, verify these values on the reading:

■ Is the Complete check box selected?

■ Is the Use Plan Bill Method (defined in the Product Administration screen, 
Product Measurements view) set to Incremental or Absolute? 

6 If the conditions in Step 5 are satisfied, calculate the usage.

Table 64. Product Measurement Fields

Field Comments

Frequency The schedule for obtaining readings for the specified measurement.

Expected Usage A numeric value for expected use. If usage readings are unavailable 
and if the Estimate check box is selected, then the Invoice Engine uses 
this value to bill for usage.

Use Basis (Days) The time period, in days, over which the expected use is to occur. This 
value must match the Frequency.
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Logic for Adjustment Line Items
The Invoice Engine uses the following process logic for adjustment line items:

1 For the invoice period and agreement, if any value exists in the Adjustment field, 
add a new line item of this amount to the invoice.

2 Create an adjustment line item on the invoice.

3 Clear the Adjustment and the Adjustment Reason fields.
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Setup for Invoicing
For the Auto-Invoice feature, the following setup is required:

■ There must be a specified price list for all of the product items determined as 
billable for an activity. The products must be listed as line items in the selected 
price list (Pricing Administration screen, Price Lists view, Price List Line Items 
subview).

■ There must be a rate list line item for each type of resource (also known as a 
billing product; for example, a field engineer) used for an activity. The activities 
rate list is specified in the Activities screen, Activities view. In the Pricing 
Administration screen, Rate List view, Rate List Line Items subview, the 
resource, rates, and markups are defined.

■ The rate types (in the Type field) must be identified for billable expenses and 
labor (Activities screen, Expense Tracker view and Time Tracker view).

■ Each user must have a position that is associated with a billing product (Group 
Administration screen, Positions view, Billing Product field). 

■ Activities must have price and rate lists defined. Orders must have a price list 
defined. Auto-invoicing uses these lists to determine the total amount billed to 
a customer.

NOTE: Siebel does not provide configuration settings for the Invoice Engine.

Cost and Price Lists
Siebel Field Service contains a costing infrastructure that allows users to track the 
costs as they are performed, and then export these costs to financial systems for 
posting to the general ledger. Previously, service organizations could only estimate 
the costs of performing service. Now they can associate costs of service calls at the 
time the service is performed.

The costing infrastructure is based on the creation of cost lists. Cost lists specify the 
costs of products. Most companies have this information in their financial systems. 
Incorporating this information into Field Service has the following advantages:
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■ Costs can be associated with service requests and activities at the time they are 
performed.

■ Costs can be associated with orders for analysis of profitability.

■ Cost lists can have time limits, so that they provide an accurate record of costs 
at the time they occurred.

■ Service inventory can be created at any time.

Price lists link cost lists to service requests, orders, and activities. For example, one 
cost list, North American Costs, describes the costs of products and resources in 
North America. When a field service engineer chooses a price list for a service 
request, the associated cost list is automatically linked to the service request. 

To learn more about cost lists, price lists, and rate lists, see Pricing Administration 
Guide.
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Setting Up Automatic Invoicing for Agreements
The Invoice Engine can automatically produce invoices for agreements that have 
associated invoice plans. To direct the Invoice Engine to produce invoices 
periodically without user intervention, you must set up a repeating component 
request. For information about repeating component requests, see the chapter on 
using the Siebel Server Manager GUI in Siebel Server Administration Guide.

For information about nonrecurring, recurring, and use-based invoice plans, see 
Chapter 5, “Agreements.”

To associate an invoice plan with an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Line Items view tab.

4 Select the line item that will have an associated invoice plan.

5 Click the Invoice Plan subview tab.

The Invoice Plan form appears with a default invoice plan record for the selected 
line item.

6 Click the show more button to display more fields.

a Accept the default values or enter new values for the Invoice Start and 
Invoice Schedule fields.

b Define the recurring invoice charges by accepting the default values or 
entering new values for the Recurring, RC Start, and RC Schedule fields.

c Make sure that Auto Invoice is selected.

NOTE: Step b and Step c are the minimal requirements for running the Invoice 
Engine for an agreement. If there is no RC charge, the Recurring field’s value can 
be zero.
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d Accept the default values or enter new values for the fields for a use plan and 
nonrecurring charges.

To set up use plans and NRC plans, see Chapter 5, “Agreements.”

7 Complete the other fields, as required for the type of automatic invoicing you 
want to set up for this line item.

CAUTION: If you do not complete all the required fields for the type of invoices to 
be generated, the Invoice Engine will generate these invoices with a balance of 
0.00.

The following fields are required for all invoices:

■ Invoice Start

■ Invoice Schedule

■ Invoice Timing

■ Invoice Basis

■ Auto Invoice 

The following fields are required for invoices that include use-based charges:

■ Use Plan

■ Use Start

The following fields are required for invoices that include non-recurring charges:

■ Non-Recurring

■ NRC Start

■ NRC Schedule

■ NRC Qty

The following fields are required for invoices that include recurring charges:

■ Recurring
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■ RC Start

■ RC Schedule

■ RC Adjust U/M – Required only if you enter a value in RC Adjust.

For more information about these fields, see “Invoice Plan Subview” on 
page 232 and “Invoice Plan Subview” on page 264. 
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Follow these procedures to produce customer invoices.

To create an invoice manually

1 Navigate to the Invoices screen.

2 Add a new invoice record.

a In the Bill to Account field, select an account from the Pick Account 
dialog box.

b In the Invoice Amount field, enter an initial amount for the invoice. This 
can be $0.00. 

3 Click the Line Items view tab.

4 Add a record for each item in the invoice.

The default value of the Amount field is 0.00. 

CAUTION: If the amounts recorded for the activity and order do not match the 
amounts recorded for the invoice line item, then associating manually entered 
line items with activities or orders could cause data quality issues.

5 Click the Line Item Details subview tab.

6 In the Details subview, add a record for each expense, time item, or part 
movement that is part of the selected line item.

7 Enter values in the Amount field and in the Description field, if needed.

To record billable activities for a service request

1 Navigate to Service > Service Requests.

2 Select a service request.

3 Click the More Info view tab and then click the show more button to display 
more fields.

4 Select a price list, a rate list, and the Billable check box.
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5 Click the Activities subview tab.

6 Select an activity or create a new activity.

To record billable orders for a service request

1 Navigate to Service > Service Requests.

2 Select a service request.

3 Click the More Info view tab and then click the show more button to display 
more fields.

4 Select a price list, a rate list, and the Billable check box.

5 Click the Orders view tab.

6 Select an order or create a new order.

To record billable expenses for an activity

1 Navigate to the Activities screen. 

2 Select an activity.

3 Click the Expense Tracker view tab.

4 Select an expense or create a new expense.

5 Select the Billable check box.

To record billable time for an activity

1 Navigate to the Activities screen. 

2 Select an activity.

3 Click the Time Tracker view tab.

4 Select a time record or create a new time record.

5 Select the Billable check box.

To record billable part movements for an activity

1 Navigate to the Activities screen. 
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2 Select an activity.

3 Click the Part Tracker view tab.

4 Select a part movement record or create a new part movement record.

5 Select the Billable check box.

To automatically generate an invoice for a service request

1 Navigate to Service > Service Requests.

2 Select a service request.

Make sure the Billable check box is selected.

3 Click the Invoices view tab.

4 Click Auto Invoice.

An invoice record appears in the Invoices list.

To automatically generate an invoice for an activity

1 Navigate to the Activities screen.

2 Select an activity.

Make sure the Billable check box is selected. 

3 Click the Invoices view tab.

4 Click Auto Invoice.

An invoice record appears in the Invoices list.

To create an invoice for an agreement line item

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Line Items view tab.

4 In the Line Items list, select a line item to invoice.

5 Click the Invoices subview tab.
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6 In the Invoice list, add a new invoice.

NOTE: To run the Invoice Engine for the selected agreement, you can enter a date 
in the Advance to field and click Invoice. To run the Invoice Engine for an 
agreement, the line items in the agreement first must have invoice plans defined. 
For the procedure, see “To associate an invoice plan with an agreement” on 
page 253.

To print an invoice

1 Navigate to the Invoices screen.

2 Select an invoice record.

3 From the application-level menu, select View > Reports > Customer Invoice.

4 In the Siebel Report Viewer window, do the following:

a Click Run Now.

The invoice appears on screen. 

b Click the print icon. 

To associate a payment with an invoice

1 Navigate to the Invoices screen.

2 Select an invoice.

3 Click the Payments view tab.

4 Create a new payment record.

5 In the Payment # field, select a payment and click OK. 
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The Invoice Engine automatically creates invoices based on the information 
provided in a service request. The user activates this engine by choosing the 
Auto Invoice command in the Invoices view in the Service Requests screen. 

The Invoice Engine searches for any billable orders or activities related to the 
service request, applies the designated price and rate lists, then creates a new 
invoice. Only records that have billable flags set in the Orders and Activities views 
are included in the invoice calculation. 

The billable flag in the Service Requests form defines the default settings for the 
billable flags in associated activities and orders. If the flag is set for a service 
request, but not for the associated orders or activities records, the activities or 
orders are not billed, unless the entitlement overrides the activity’s billable flag.

A user may select an entitlement by clicking Verify in the Service Requests form, 
More Info view or by completing the Entitlement field in the Service Details view. 
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The Activities screen has four views that are related to invoices.

Time Tracker View
The Time Tracker view lists the labor charges associated with an activity. The Start 
and Stop buttons in the Time Tracker view provide convenient recording of time 
spent on an activity. Table 65 describes items in the Time Tracker view.

Auto Time Sheet (selected from the application-level File menu) produces new 
records in the Expense Tracker view. For more information about setting up and 
using Auto Time Sheet, also known as Auto Gen, see the chapters on time reporting 
and expense reporting in Siebel Professional Services Automation Guide.

Table 65. Selected Items in the Time Tracker View

Item Description

Billable A check box that indicates the Invoice Engine should include in an invoice the 
price of this labor, based on the rate list for the activity, in an invoice for the 
associated activity. By default, this flag is set if the Billable flag is set for the 
activity.

Start This button creates a new time record and sets the start time and date. 

Stop This button sets the end time for the activity and calculates the elapsed time.

Type Identifies the specific category of time for the selected record. The types 
displayed are project records called Work Types. Work Types are defined in 
Applications Administration >Work Types.
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Expense Tracker View
The Expense Tracker view records the expenses associated with an activity. Setting 
the Billable flag for an expense record makes this information available to the 
Invoice Engine. By default, this flag is set if the Billable flag is set for the activity.

Auto Expense Report (selected from the application-level File menu) produces 
new records in the Expense Tracker view. For more information about setting 
up and using Auto Expense Report, also known as Auto Gen, see the chapter on 
expense reporting in Siebel Professional Services Automation Guide.

Part Tracker View
The Part Tracker view records products or assets used in the field for an activity. If 
the Billable flag is set in a record, the Invoice Engine includes this part in an invoice. 
By default, this flag is set if the Billable flag is set for the activity.

Invoices View
The Invoices view displays all invoices associated with an activity. Table 66 
describes items in the Invoices view.

Auto Invoice Command
The Invoice Engine requires the following information to generate an invoice 
automatically:

■ Billable flags. Only records that have Billable flags set are included in the invoice.

■ Price list. The price list must be specified.

Table 66. Selected Item in the Invoices View

Item Description

Auto Invoice This button looks for any billable expenses, time, or parts related to the an 
activity, applies the associated price and rate lists, then generates invoices 
for the selected activity. 

When the Invoice Engine runs from this view, it does not consider 
entitlements for service. 
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■ Product prices. In Pricing Administration >Price Lists >Price List Line Items, 
billable products must belong to the selected price list.

■ Rate list. The rate list for field service activities must be specified in Activities > 
More Info.

■ Activity prices. In Pricing Administration >Rate Lists > Rate List Line Items, the 
person carrying out billable service activities, known as the resource, must be 
related to the selected rate list.

■ Positions. In Group Administration > Positions, the Billing Product field for the 
person (known as the Resource on the rate list) providing service must be 
specified.

■ Rate types. In Activities > Expense Tracker and in Activities > Time Tracker, 
the rate types (Rate field) must be identified for billable expenses and labor.

NOTE: The Rate field is not displayed by default. To display it, you must use the 
tab-level menu’s Columns Displayed command. 
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The Agreements screen provides subviews (under the Line Items view) for contract-
based invoicing.

Line Items View
The Line Items view provides controls and subviews for invoicing agreement line 
items. Controls are listed in Table 67.

Invoice Plan Subview
The Invoice Plan view displays the billing details for the selected agreement line 
item. Table 68 describes an item in this view. 

Table 67. Selected Items in the Line Items View

Item Description

Invoice This button and command directs the Invoice Engine to generate invoices for 
the selected agreement line item, based on the invoice plan.

The line items must have any status other than Cancelled.

Invoice All This command directs the Invoice Engine to generate invoices for all line 
items, based on the invoice plan.

The line items must have any status other than Cancelled.

Advance to This field is located in the Line Items menu bar. If the Invoice Basis is set to 
Advance, the Invoice Engine can calculate the invoice amounts up to this 
date and time. 

Table 68. Selected Item in the Invoice Plan Subview

Item Description

Auto Invoice A check box that indicates the Invoice Engine will generate an 
invoice for this line item. If unchecked, the Invoice Engine does 
not create an invoice for this agreement line item.
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Invoices View
The Invoices view displays all invoices associated with an agreement line item and 
allows modification of these invoices or creation of additional invoices. Table 69 
describes a check box in this view. 

Table 69. Selected Item in the Invoices View

Item Description

Late A check box that is set automatically if the current date is past the due date.
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Contacts Screen
The Contacts screen has an Invoices view that displays invoices for the selected 
contact. A user can also enter invoice records manually. 
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Accounts Screen
The Accounts screen has an Invoices view that displays invoices for the selected 
account. A user can also enter invoice records manually. 
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The Invoices screen shows all invoices generated automatically, and allows users to 
manually enter invoices and invoice line items, record payments, attach files, and 
add notes.

Invoices View
The Invoices list shows existing invoices and allows users to create or modify 
invoices. Table 70 describes items in Invoices records.

Table 70. Selected Items in the Invoices List and Form

Item Description

Late A check box that is set automatically if the current date is past the due date. 
The due date is determined by the values of the Invoice Date and the 
Payment Term fields in the Invoices view.

Refresh Total This command uses the data in the Payments, Line Items, and Line Items 
Details views to update the Total Due field in the Invoices view (More Info).

State A color-coded indicator that represents the status of each invoice, based 
on the Status and Late fields. 
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State Indicators
Each record in the Invoices list has a bar that indicates the status of the invoice. If 
the invoice is late, the indicator has the appearance described in Table 71. 

Table 71. Invoice Late—Indicator Appearance

Status Color Amount of Fill

Closed
Cancelled
Written-Off
Submitted

Yellow 100%

New
Draft
In-Process
Consolidated
Paid

Red 50%

Prepared
Partially Paid
Open
Billed

Red 75%

Partially Written-Off
On-Hold
Pending
Rejected

Red 100%
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If the invoice is not late, the indicator has the appearance described in Table 72.

NOTE: A Tool Tip is provided for each indicator. Move the cursor over the indicator 
bar to see its meaning.

Table 72. Invoice Not-Late—Indicator Appearance

Status Color Amount of Fill

Closed
Cancelled
Written-Off
Submitted

Gray 100%

Partially Written-Off
On-Hold
Pending
Rejected

Green 50%

Prepared
Partially Paid
Open
Billed

Green 75%

New
Draft
In-Process
Consolidated
Paid

Green 100%
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Line Items View
The Line Items view shows the billable items for an invoice. Line items can be 
added manually. Table 73 describes items in Line Item records.

Line Item Details View
The Line Item Details view provides details of the current invoice line item.

Table 73. Selected Items in the Invoices Line Items View

Item Description

Order # The order reference number associated with this invoice, supplied 
by the Invoice Engine or chosen from a dialog box. The Invoice 
Engine supplies this number if the invoice is produced by Auto Gen 
(see “Expense Tracker View” on page 262). 

If an order is associated with a service request and the user 
activates the Auto Invoice command for a service request (Service 
screen, Invoice view), the order number is entered into the invoice 
line item.

Activity # The reference number of the activity associated with this invoice, 
supplied by the Invoice Engine or chosen from a dialog box.

Agreement Line Item The ID of an agreement line item associated with this invoice. 
This is supplied by the Invoice Engine or chosen from a dialog box.

Project Role This field contains the project team associated with the current line 
item. 
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Details Subview 
The Details subview provides additional information about the items in the line 
item of an invoice: time, expenses, and parts. Table 74 describes items in the Invoice 
Line Item records.

Line item details are used by the Invoice Engine; a manual invoice does not have to 
use this data.

Payments View 
The Payments view records the payments applied against the invoice. Table 75 
describes items in the Payments records.

Table 74. Selected Items in the Line Item Details Subview 

Item Description

Activity Expense Item # The ID of an expense associated with this invoice line item, 
supplied by the Invoice Engine or chosen from a dialog box. 

Activity Time Item # The ID of a record in the Time Tracker associated with this 
invoice line item, supplied by the Invoice Engine or chosen 
from a dialog box. 

Order Line Item ID The ID of an order associated with this invoice, supplied by the 
Invoice Engine or chosen from a dialog box.

Part Movement # The ID number of a part movement related to this invoice line 
item, supplied by the Invoice Engine or chosen from a dialog 
box.

Table 75. Selected Items in the Payments View

Item Description

Payment # The ID of the payment associated with this invoice, chosen from the Pick 
Payment dialog box. The payment records originate from a back-office 
application, or the user can create them in this dialog box (by using the 
New button).

Reference A reference number that a customer assigns to a payment record.
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Invoice Report 
The Customer Invoice report, from the Reports menu, prints an invoice for the 
selected invoice record. 

Figure 4 shows an example of an invoice generated from your Siebel application. 
The header shows information that uniquely identifies this invoice, such as Invoice 
# and Date. A Description line follows, then Account and Bill To information. The 
body of the invoice contains a list of line items and their charges. Below and at the 
right is the Invoice Amount total. 

Figure 4. Customer Invoice Report
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This chapter tells you how to set up the ability for your Siebel application to obtain 
invoice information from your company’s third-party invoicing system. 
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Invoicing Integration Overview
Siebel invoice integration is designed for companies that rely on traditional back-
office billing and accounting applications to perform billing for products sold and 
services rendered. The invoice retrieval business process assumes that the billable 
source data (billable time, expenses, and materials) has been sent from your Siebel 
application to a billing application for invoice processing. 

After generating a final customer invoice, the third-party invoicing application can 
publish the invoice data into an XML file. This invoice file is then passed to your 
Siebel application. Your Siebel application updates the Invoice business object and 
propagates the invoice data into the base tables. Your Siebel application then 
displays the invoice in the Invoices views, where the data is read-only.

This functionality assists Siebel end users with answering inquiries from customers 
about their invoices. A Siebel end user can view a customer invoice while in the 
Siebel application, without having to access the third party invoicing application. 

Integration with an invoicing application uses the business service named Siebel 
Invoice, of type Data Synchronization. In addition, it uses a prebuilt Application 
Services Interface (ASI) named Siebel Invoice. 

For more information about how to set up, use, and modify integrations based on 
ASIs, see Application Services Interface Reference: Siebel eBusiness Application 
Integration Volume VI.

Invoicing Integration Terms
The following terms are used when referring to invoicing data:

■ Bill. An instance of accumulated charges over a defined period of time for one or 
more products or services that a customer has received and for which the 
customer owes your company.

■ Invoice. A document that displays a balance the customer owes to your company 
and to other involved parties such as third-party shippers and government tax 
bureaus. Consists of billing information plus taxes plus incidentals. Contains 
account balance information and displays transactions against a balance. Can be 
associated with one bill or can consolidate multiple bills. 
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Required Setup Procedures
To set up the use of third-party invoicing systems, you must configure the Web 
service.

Configuring the Web Service
Web services are used to direct the inbound messages from the third-party invoicing 
application. You must make sure that the Web services are correctly configured and 
activated. For more information about configuring Web Services, see Application 
Services Interface Reference: Siebel eBusiness Application Integration Volume VI.

To configure the Web service

1 Navigate to Site Map > Web Services Administration > Inbound Web Services.

2 Select the row with Siebel Invoice in the Name field.

3 In the Inbound Web Services list, make sure that the values of the Namespace, 
Name, and Status fields match the ones in the following table.

4 In the Service Ports list, make sure that the values of the Name, Type, and 
Business Service fields match the ones in the following table. 

5 In the Transport field, enter the type of protocol used for making the Web Service 
call.

6 In the Address field, enter the location of the Web server and the user who is 
authorized to call this Web service.

Namespace Name Status

http://siebel.com/asi/ Siebel Invoice Active

Name Type Business Service

Default Business Service Siebel Invoice
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When setting up the use of third-party invoicing systems, you may want to do the 
following:

■ Extend the data set

■ Turn off invoicing

■ Customize invoicing

Extending the Data Set
The data set can be extended by adding more fields to the relevant integration 
objects, provided that the fields are supported by the Siebel data model.

For information about how to extend the data that is received from the third-party 
inventory management system, see Application Services Interface Reference: Siebel 
eBusiness Application Integration Volume VI.

Turning Off Invoicing
You may want to turn off the third-party invoicing function if, for example, your 
company does not have a third-party billing system. In this case, do not publish the 
ASI. 

For information about publishing ASIs, see Application Services Interface Reference: 
Siebel eBusiness Application Integration Volume VI.

Customizing Invoicing
You may want to customize the third-party invoicing function to add special 
functions or additional business processes, as follows:

Define Service Ports
You may want to define service ports different from, or in addition to, the ones 
provided with your Siebel application. For information about service ports, see 
Application Services Interface Reference: Siebel eBusiness Application Integration 
Volume VI.
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Create Workflow Processes 
You may want to define workflow processes to automate certain functions 
associated with third-party invoicing. For information on creating workflow 
processes, see Siebel Business Process Designer Administration Guide.
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Fulfillment 8
This chapter describes the process flows for orders supported by the Siebel Order 
Entry module and the Fulfillment and Part Locator Engines (components of the 
Field Service Logistics Manager). 
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Fulfillment Overview
Siebel Field Service provides two methods for filling an order automatically:

■ The Fulfillment Engine automatically locates in inventory the ordered items (or 
substitutes for these items), allocates these items, and generates a pick ticket.

■ The Parts Locator is a semi-automatic version of the Fulfillment Engine. It gives 
the user control over fulfillment of individual line items in an order. The user 
can select the line items and choose to carry out these automatic procedures for 
the selected items:

■ Find products or substitutes in inventory.

■ Allocate these items.

■ Generate pick tickets.

Fulfillment Engine
The Fulfillment Engine automatically finds and allocates products for selected 
service orders, and produces pick tickets to use for the orders. The engine uses the 
following information to find a product:

■ Priority of an order, which can influence fulfillment relationships (see the Order 
Priority field in “Relationships View” on page 349).

■ Customer’s preferred inventory location. Each account has a default inventory 
location.

■ Relationships among inventory locations (to determine which location to query 
next if the product cannot be found in a location).

■ Product information (for example, available substitutes).

The engine can run from the Field Service user interface, in batch mode using the 
Repeat Interval, or by Siebel Business Process Designer. As a batch process, 
fulfillment can be initiated at regular intervals (for example, twice a day for pending 
high-priority orders or once a day for other orders) or according to conditions (for 
example, high-priority orders might be fulfilled immediately).
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The Fulfillment Engine uses information entered elsewhere in Field Service to 
decide how to fulfill an order. For example, it considers account information to 
select the default source inventory location if no source inventory location is 
specified at the order and the order line item level. Where substitution of products 
is necessary, the engine uses substitutes specified for a product. If the product is out 
of stock at the warehouse of first choice, it reads the fulfillment relationships 
between inventory locations to determine from which other warehouse to fulfill the 
order. See “Inventory Relationships” on page 318. 

The Fulfillment Engine produces this output:

■ Allocated parts for each order.

■ Pick tickets to be used by picker to pick, pack, and ship each order.

■ Inventory transactions for part allocation.

NOTE: For the Fulfillment or Part Locator Engines to allocate a line item from 
inventory, the line item must have a status of On-Hand for Inventory Level.

Finding Fulfillment Inventory Locations
When fulfilling an order, the Fulfillment Engine looks for parts in this order:

1 The source inventory location, if any, defined in the Line Details subview. See 
“Line Detail Subview” on page 308.

2 The source inventory location defined in the Order Fulfillment view. See 
“Fulfillment View” on page 310. This may be different from the source location 
in the Line Details subview.

3 The inventory location, if any, defined in the Accounts screen. See “Accounts 
View” on page 60.

4 The system preference for DefaultFulfillInvLoc. See “System Preferences for the 
Fulfillment and Part Locator Engines” on page 287. 
Version 7.5, Rev. A Siebel Field Service Guide 283



Fulfillment

Fulfillment Overview
Fulfill Command
The Fulfill command on the Orders screen finds the order line items, allocates these 
items, and generates a pick ticket record for the item. (The Shipping screen, 
PickTickets view processes pick ticket records.) The Part Locator carries out each of 
these tasks separately, controlled by the Locate, Allocate, and Generate PickTickets 
commands.

Locate Button
The Locate button on the Orders screen, Line Items view finds in inventory the 
product specified in an order line item. It also finds substitutes if the product is 
unavailable. For more information about this function, see “Fulfillment Engine” on 
page 282.

Allocate Button
The Allocate button on the Orders screen, Line Items view, Part Locator subview 
creates an inventory transaction of the type Allocate (see Table 86 on page 326) that 
reserves the product.

Generate PickTickets Command
The Generate PickTickets command on the Orders screen produces a pick ticket 
record. This is the logic behind the button:

■ For each line item action of the type Allocate, where the item is not on a pick 
ticket (the Shipment number field in the Line Items view, Actions subview is 
blank), the Generate PickTickets function tries to create a valid pick ticket (a 
new row in table S_SHIPMENT). In doing so, it looks at the source inventory 
where the allocation is done. 

If this inventory is not of the type defined for the InventoryTypeForPT system 
preference, then it tries to find a parent inventory for the source inventory with 
the type defined in the InventoryTypeForPT system preference (the default for 
this is Warehouse). If one is found, then it generates a pick ticket record for this 
location. For other line item actions that have same source, the same pick ticket 
is used. A new pick ticket is generated only when source warehouses are 
different.

■ Associates the line item action to that pick ticket by updating the Shipment 
number field. 
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Figure 5 on page 286 shows how the Fulfillment Engine works for an order. For each 
line item to be fulfilled, it does the following:

1 Sets the source as the default source for the line item or the customer site.

2 Allocates the lesser of the quantity available for this product and the order 
quantity pending.

3 If the quantity allocated does not equal the quantity pending, reviews possible 
substitutes for the product and allocates as appropriate.

4 If the quantity allocated still does not equal the quantity pending, sets the source 
as the next source for this order priority.

5 If there is a next source, repeat Step 2 through Step 4. If there is no next source, 
starts again at Step 1.
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6 When no line items remain to be fulfilled, generates a pick ticket per selected 
inventory location.

Figure 5. The Logic of the Fulfillment Engine
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Part Locator Engine
The Part Locator provides semi-automatic fulfillment of line items in an order. 
The Part Locator Engine analyzes orders, locates parts for each line item, and 
returns the located parts (products or substitute products) to the user. The user can 
manually allocate these parts and generate the pick tickets.

For example, a customer service representative (CSR) receives a service request 
that requires shipping a product. The CSR creates an order, selects a line item in the 
order, and clicks Locate from a line item of the service order. Using the configuration 
parameters, the Part Locator browses various inventory locations and proposes 
sources from which to fulfill the order.

The Locate, Allocate, and Generate PickTickets commands that run the Fulfillment 
Engine in semi-automatic mode appear on the Orders screen. See “Line Items View” 
on page 307 and “Part Locator Subview” on page 309.

The Part Locator follows the fulfillment logic specified in Figure 5 on page 286, and 
uses the same parameters for the fulfillment logic.

The Part Locator, unlike the Fulfillment Engine, cannot run asynchronously; 
meaning that when the Locate button initiates a product search, the Siebel 
application is unavailable for other operations.

System Preferences for the Fulfillment and Part Locator Engines
The Fulfillment and Part Locator Engines use the same system preferences, shown 
in Table 76 on page 288. These system preferences are stored in the table 
S_SYS_PREF. The BusComp is System Preferences. These are the columns of 
main interest:

■ SYS_PREF_CD. Name of the system preference.

■ VAL. Value of the system preference.

Changing the values of these preferences changes the default behavior of each 
engine. Use System Preferences to set these values:

■ Default fulfillment inventory location

■ Default inventory location types

■ Substitution allocation rules

■ Order statuses valid for fulfillment
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■ Line item statuses valid for fulfillment

■ Synchronous or asynchronous fulfillment

NOTE: To activate changes to system preferences, restart the Siebel server.

Table 76. System Preferences for the Fulfillment and Part Locator Engines 

Parameter Default Value Comments

DefaultFulfillInvloc Blank Specifies the default inventory location to use as a 
source inventory location for the Fulfillment Engine 
and Part Locator. This is used as the Source Inventory 
Location if the user does not specify the Source 
Inventory Location at run time. 

The value must be the Row ID of the service inventory 
location. To find this ID, use the following procedure:

1 In any Service Inventory view, select an inventory 
location.

2 From the Help menu, select About Record.

3 In the dialog box, click Details.

InventoryTypeForPT Warehouse Specifies the Inventory location type from which pick 
tickets are generated. The values should be from the 
Inventory location type LOV and individual values 
should be any of the LIVs.

AllocationRule 1 Specifies the rules for substitution. The possible values 
are 1,2,3 where: 

1 Always allocate a substitute before going to the 
next inventory location.

2 Allocate a substitute only if it allows shipment 
from a single inventory location.

3 Never allocate a substitute if the exact product can 
be found in another inventory location.
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Substitution and Allocation Flags
The Fulfillment Engine uses the following inventory-specific attributes in its logic:

■ Auto Allocate. If this flag is set, the Fulfillment Engine can allocate this product.

■ Auto Substitute. If this flag is set, the Fulfillment Engine can allocate substitute 
parts in lieu of this product.

■ Allocate Below Safety. If this flag is set, the Fulfillment Engine allocates from 
available quantity even if this allocation takes the available stock to below safety 
level. If the value is No, then any allocation that can take the level to below 
safety is not carried out.

Allocation and substitution options are set at three levels in Field Service:

■ Products. See “Products View” on page 301.

Fulfill-SearchAllSublevels FALSE Specifies whether to search child locations. Possible 
values are TRUE and FALSE.

TRUE - Search the specified inventory location and all 
its child inventory locations specified by Sublevel 
relationships.

FALSE - Search the specified inventory location and all 
its fulfillment hierarchy locations but not the child 
inventory locations specified by Sublevel 
relationships. 

OrderTypeToBeFulfilled Service Order, 
Internal Order

Specifies the valid values for Order Type. The values 
should be from the Order Type LOV and individual 
values can be any of the LIVs.

OrderStatusToBeFulfilled Open, New, 
Pending 

Specifies the valid values for Order Status. The values 
should be from the Order Status LOV and individual 
values can be any of the LIVs.

OrderItemStatusToBeFulfilled Open, New, 
Pending

Specifies the valid values for Order Item Status. The 
values are from the Order Item Status LOV and the 
individual values are LIVs.

Table 76. System Preferences for the Fulfillment and Part Locator Engines 

Parameter Default Value Comments
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■ Inventory types. See “Inventory Options Subview” on page 304.

■ Inventory locations. See “Product Inventory View” on page 347. 

At the product level, these attributes are binary values, either Yes or No. But at 
the inventory type level or inventory location, they may be Yes, No, or Default. 
A Yes or No value means override the value defined at the product level and use 
this value. A Default value means use the value defined at the product level. 

Conditions for Auto-Substitution
If the Fulfillment Engine is running and any one of the following conditions is met, 
the Fulfillment Engine attempts to allocate a substitute from the inventory's 
sublevel, then from the parent inventory, and then from the fulfillment center 
(based on order priority), assuming there are no exact products at any of these 
locations.

All of these conditions must be met for substitution to take place automatically 
during fulfillment:

■ The Inventory Location and Product Level are set to Yes.

■ The Inventory Location is set to Default and Product Inventory Types are set to 
Yes.

■ The Inventory Location and the Product Inventory Type are set to Default and 
the Product is set to Yes.

■ The Inventory Location, the Product Inventory Type, and the Product are set to 
Yes.

■ A substitute product for the specified line item exists.

■ AllocationRule = 1 (see “System Preferences for the Fulfillment and Part Locator 
Engines” on page 287).

NOTE: FS_PROD_ALLOC_RULES can have the values Yes, No, and Default. These 
values can be specified in the List of Values view (Application Administration > 
List of Values). These values are not related to the AllocationRule values. 
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System Preferences for the Fulfillment Engine
The Field Service engines have system preferences, listed in Table 77, which 
determine the behavior of each engine. These system preferences are stored in the 
table S_SYS_PREF. The BusComp is System Preferences. 

Table 77. System Preferences for the Fulfillment Engine

Parameter Default Value Comments

DefaultFulfillInvLoc Blank Accepts the Row ID of the default inventory 
location; for example, the Row ID for 
Warehouse 32.

OrderItemStatusToBeFulfilled Open, New, Pending Specifies the valid values for the existing 
order item status. The values should be from 
the Order Item Status LOV and individual 
values should be LIVs. 

OrderStatusToBeFulfilled Open, New, Pending Specifies the valid values for the existing 
order status. The values should be from the 
Order Status LOV and individual values 
should be LIVs.

OrderTypeToBeFulfilled Service Order, Internal Order, 
RMA Advance Exchange

Specifies the valid values for the existing 
order type. The values should be from the 
Order Type LOV and individual values 
should be LIVs.

Fulfill-SearchAllSublevels FALSE Specifies whether to search child locations. 
Possible values are TRUE and FALSE.

TRUE - Search the specified inventory 
location and all its child inventory locations 
specified by Sublevel relationships.

FALSE - Search the specified inventory 
location and all its fulfillment hierarchy 
locations but not the child inventory 
locations specified by Sublevel relationships. 

InventoryTypeForPT Warehouse Specifies the Inventory location type from 
which pick tickets are generated. The values 
should be from the Inventory location type 
LOV and individual values should be any of 
the LIVs.
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NOTE: To register changes to System Preferences, restart the Field Service server.

Parameters for the Fulfillment and Part Locator Engines
By specifying input parameters to the Fulfillment and Part Locator Engines, an 
administrator can define the logic for a specific set of orders (using Order Search 
Specifications), for a single order (using Order ID), and for a single line item (using 
Line Item ID). Table 78 contains the parameters for the Fulfillment and Part Locator 
Engines that are set in the Server Requests screen for the server components 
FSFulfill and FSLocate.

To set Fulfillment and Part Locator Engine parameters

1 Identify the predefined system preferences to determine the defaults for the 
Fulfillment Engine.

Table 78. Parameters for the Fulfillment and Part Locator Engines 

Parameter Value Comments

InputMode ORDERSEARCHSPEC Specifies the WHERE clause for the orders and the engine 
will fulfill the orders based on the criteria.

ORDERID Specifies the Single Order ID to be fulfilled and the engine 
will fulfill the specified Order.

LINEITEMID Specifies the Single Order line item ID to be fulfilled and 
the engine will fulfill the specified Order line item.

TEMPTABLE Places all required values into a temporary table with a 
particular Client Request ID and passes that ID to the 
server to retrieve the parameters from Temp Table.

ClientReqId A row ID for retrieving line 
items input from the 
temporary table

Required when InputMode = TEMPTABLE.

RowId Row ID of a single order to 
fulfill or Row ID of a single 
line item to fulfill

Required when InputMode = ORDERID or 
InputMode = LINEITEMID.

OrderSearchSpec A Where clause Required when InputMode = ORDERSEARCHSPEC.
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2 Read all the input parameters and identify all the line items from parameters or 
temp table based on mode.

3 Fulfill each line item:

a Find the product and/or substitute product to fulfill the line item:

Queue the start invloc as the seed to start the search in the relationship.
Search the product throughout the entire inventory location hierarchy:
If this invloc has not previously been visited:
Add the Invloc to the set of Visited Invlocs.
Search the product for required/available Qty in the Invloc 
hierarchy.
If the Qty Product < Qty Required, search the substitute product for
the remaining/available Qty.
If Qty Product or Qty Substitute is > zero, add the product
and substitute availability to the warehouse list for the entire
relationship.
If the warehouse list is created, then:
Add Qty Product to Qty Prod Found.
Add Qty Substitute to Qty Subst Found.
Determine whether the product is found or the search should
continue:
If the allocation rule is Substitute if ship from one location:
If Qty Product + Qty Substitute is ≥ Qty Required, 
stop the search.
Or else, continue the search.
If the allocation rule is No substitute if exact found:
If Qty Product is ≥ Qty Required, stop the search.
Or else, continue the search.
If the allocation rule is Always substitute:
If Qty Prod Found + Qty Subst Found is >
Qty Required, stop the search.
Or else, continue the search.
If continue the search, then:
Queue up all relationships for this invloc for further search.
Continue the search loop until found or all invloc relationships 
are exhausted.
If Qty Prod Found or Qty Subst Found is > zero, select the
best allocation from the list according to the allocation rules.
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b Allocate the product:

Generate the inventory transaction for all the products of type Allocate, and 
generate the inventory transaction for all the substitute products of types 
Substitute and Allocate.

c Generate the pick ticket.

Running the Fulfillment Engine
Start the Fulfillment Engine by the following methods:

■ Use the Workflow Manager.

■ Use Siebel Server Requests.

■ Invoke the engine for orders by clicking the Fulfill or Fulfill All command after 
selecting one or more Order line items.

■ Use the Locate or Locate All command.
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Setup and Configuration
This section includes procedures for setting up order fulfillment.

Setting Up Order Processes
Follow these procedures to define order types.

This procedure makes available from a predefined list the types of orders that 
appear in order-related views.

To define order action types

1 Navigate to Site Map > Data Administration > Order Action Types.

2 Create a new order action type record.

3 In the Line Item Action field, select a value.

To define types of orders

1 Navigate to Site Map > Data Administration > Order Types.

2 In the Order Types list, create a new order type record.

3 In the Order Type field, select a value.

4 In the Associated Action Types list, add a new record. 

This adds an order action type associated with the order type that is selected in 
the Order Types list.

Setting Up the Fulfillment and Part Locator Engines
Follow these procedures to set up the Fulfillment and Part Locator Engines.

To set the component request parameters for the Fulfillment and Part Locator 
Engines

1 Insert or edit a component request for one of the following server components: 

■ Service Order Fulfillment Engine

■ Service Order Part Locator Engine
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2 Add or modify the server component parameters as needed.

For information about server components and component parameters, see Siebel 
Server Administration Guide.

To set asynchronous or synchronous operation of the Fulfillment and Part Locator 
Engines

1 From the application-level menu, choose View > User Preferences > Service.

2 In the ASYNCHRONOUS FULFILLMENT OF section, do one of the following:

■ To set asynchronous operation of the Fulfillment and Part Locator Engines, 
select Orders.

■ To set synchronous operation of the Fulfillment and Part Locator Engines, 
clear Orders.

To set system preferences for the Fulfillment and Part Locator Engines

1 Navigate to Site Map > Application Administration > System Preferences.

2 In the System Preference Name column, locate the name of the system 
preference to set. 

3 Type in a new value in the System Preference Value field, as appropriate.

System preferences are listed in Table 79 on page 297. For specific system 
preference values, see Table 76 on page 288.

4 To register changes to system preferences, restart the Field Service server.
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Table 79. System Preference Names

Parameter Default Value Comments

DefaultFulfillInvloc Default inventory 
location

Enter the Row ID of the inventory location. 

InventoryTypeForPT Inventory location types Enter the Inventory location type from which 
pick tickets are generated. The values should be 
from the Inventory location type LOV and 
individual values should be any of the LIVs.

To add an inventory location type, enter its name 
as it appears in the application, enclosed in single 
quotes. Separate location types with commas.

AllocationRule Allocation rule In the System Preference Value column, enter 1, 
2, or 3 to specify the applicable allocation rule. 

OrderStatusToBeFulfilled Order status To add an order status, enter its name as it 
appears in the application, enclosed in single 
quotes. Separate status values with commas. 

OrderItemStatusToBeFulfilled Order line item status To add an order item status, enter its name as it 
appears in the application, enclosed in single 
quotes. Separate status values with commas. 

Fulfill-SearchAllSublevels Whether to search child 
locations

Enter a value of TRUE and FALSE.

TRUE - Search the specified inventory location 
and all its child inventory locations specified by 
Sublevel relationships.

FALSE (default) - Search the specified inventory 
location and all its fulfillment hierarchy locations 
but not the child inventory locations specified by 
Sublevel relationships. 
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Follow these procedures to fulfill service orders. This involves identifying and 
reserving items specified in an order.

To allocate parts for a service or internal order manually 

1 Navigate to the Orders screen.

2 Select an order. 

3 Click the Line Items tab.

4 Select the line item to allocate.

5 Click the Actions subview tab.

6 To add an action record, click New.

a In the Type field, select Allocate.

b Enter the order quantity in the Qty field.

c Specify inventory information in the Source Location, Source Availability, 
and Source Status fields.

NOTE: If the Logistics Manager and its Fulfillment Engine are installed, the 
Fulfillment Engine automatically specifies Allocate actions.

To generate a pick ticket for an order

1 Navigate to the Orders screen.

2 Select an order. 

3 Click the More Info tab.

4 Click the menu button and select Generate Pick Tickets. 

To locate order line items using the Part Locator

1 Navigate to the Orders screen.

2 Select an order.
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3 Click the Line Items tab.

4 Select a line item.

5 Click the Part Locator tab.

6 In the Line Items list, click one of the following buttons:

■ Locate - Searches for the product through inventory locations, and then loads 
the list of available and substitute parts in the Part Locator subview.

■ Locate All - Finds inventory locations for all line items.

To allocate order line items using the Part Locator

1 Follow the procedure “To locate order line items using the Part Locator” on 
page 298.

2 In the Part Locator subview, select a product/inventory location record in the 
Available Substitute list or the Line Allocation list. 

3 In the Qty field, enter the number of items to allocate.

If no quantity is specified, the total available quantity is allocated.

4 If the selected record is in the Available Substitute list, click the appropriate 
button: 

■ Allocate All. Allocates available parts automatically, starting with the first 
listed inventory location, up to the value in the Qty field.

■ Allocate. Allocates the selected line item from a selected product/inventory 
location record. 

To fulfill orders using the Fulfillment Engine

1 Navigate to the Orders screen.

2 Select an order.

3 Click Fulfill to fulfill the selected order.

To fulfill order line items

1 Navigate to the Orders screen.
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2 Select an order.

3 Click the Line Items tab.

4 Select an order line item.

5 Do one of the following:

■ Click Fulfill to fulfill the selected order line item.

■ Click Fulfill All to fulfill all order line items.

To de-allocate order line items

1 Navigate to the Orders screen.

2 Select an order.

3 Click the Line Items tab.

4 Select an order line item.

5 Click the Actions subview tab.

6 Select the action item (of type Allocate) to de-allocate.

7 Click the menu button and select De-Allocate from the drop-down list.
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Product Administration Screen
The Product Administration screen includes a view for configuring inventory 
locations, allocation, and cycle counting for products. For more information, 
see Product Administration Guide.

Products View
The Products view records basic information about each product; for example, 
product name, part number, and revision. Table 80 on page 301 describes items in 
Product records.

Table 80. Selected Items in the Products View

Item Description

Allocate Below Safety A check box that indicates the Fulfillment and Part Locator 
Engines can allocate this product when its level in inventory is 
below the safety level (set in the “Product Inventory View” on 
page 347).

Auto Allocate A check box that indicates the Fulfillment and Part Locator 
Engines can allocate this product. If this box is unchecked, the 
engines do not allocate this product. 

Auto Substitute A check box that indicates the Fulfillment and Part Locator 
Engines can allocate a substitute for this product.

Equivalent Product The Fulfillment Engine uses this information if the specified 
product is unavailable. This is the same as the specified 
substitutes. See “Substitute Products Subview” on page 305. 

Field Replaceable A check box that indicates this item may be replaced at the 
customer site. This is informational and has no effect on other 
fields or functions.

Orderable A check box that indicates the product may be obtained by 
ordering from any specified source. If the product is not orderable, 
it does not appear in the Pick Product dialog box, which presents 
choices for the Product field in the Orders screen, Service Order 
view, Line Items subview.

Return if Defective A check box that indicates this item, if defective, should be 
returned to the service center. This is informational only.
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Product Field Service Details View
The Product Field Service Details view provides the information used in locating 
and allocating products for use in field service activities. 

NOTE: To navigate to the Product Field Service Details view, use the Show drop-down 
list in the More Info tab.

This view has two subviews, Inventory Options (see “Inventory Options Subview” 
on page 304) and Substitute Products (see “Substitute Products Subview” on 
page 305). 

Serialized A check box that indicates this product and all of its assets are 
serialized. Serialized products are treated in a different way. 
Whenever a serialized product is shipped or received, Field 
Service expects the right number of assets with serial numbers.

Service Product A check box that indicates this product is used for service and may 
have special pricing. See Pricing Administration Guide for 
information on pricing administration and Product Administration 
Guide for information on product administration.

When selected, prevents the Part Locator Engine from allocating 
parts for the product. To allow the Part Locator Engine to allocate 
parts for the product, clear this check box. 

Tool A check box that indicates this item is a tool used in service 
procedures. This is informational only.

Table 80. Selected Items in the Products View

Item Description
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Table 81 describes items in Product Field Service Details records. 

Table 81. Selected Items in the Product Field Service Details View

Item Description

Allocate Below Safety A check box that indicates the Fulfillment and Part Locator 
Engines can allocate this part when its level in inventory is below 
the safety level (see “Product Inventory View” on page 347). This 
check box also appears in the Products view (see “Products View” 
on page 301).

Auto Allocate A check box that indicates the Fulfillment and Part Locator 
Engines can allocate this part. If this box is unchecked, the 
engines do not allocate this product. This check box also appears 
in the Products view (see “Products View” on page 301).

Field Replaceable A check box that indicates this item may be replaced at the 
customer site. This is informational and has no effect on other 
fields or functions.

Lead Time The vendor’s response time in minutes.

MTBF Mean time between failures; a measure of dependability of the 
product.

MTTR Mean time to repair; a measure of the time required to repair 
the product.

Return Defective A check box that indicates this item, if defective, should be 
returned to the service center. This is informational only.

Revision The current version of the product. This is copied to new asset 
records.

Serialized A check box that indicates this product is serialized. Serialized 
products are treated in a different way. Whenever a serialized 
product is shipped or received, the application expects the right 
number of assets with serial numbers. 

Ship carrier The default carrier for the selected product; for example, UPS 
or FedEx.

Ship Via The default mode of transportation; for example, Air, Ground, 
or Sea.
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Inventory Options Subview
The Inventory Options subview sets the inventory locations for a product and 
determines how the Fulfillment Engine allocates a product from inventory or 
chooses a substitute when filling an order. It also sets the cycle counting default 
parameters for each product in inventory (see Chapter 11, “Cycle Counting and 
Replenishment”). Table 82 describes items in Inventory Options records.

Status The status of a product; for example, production, obsolete, or 
prototype. This is copied to new asset records.

Tool A check box that indicates this item is a tool used in service 
procedures. This is informational and has no effect on other 
fields or functions. 

Table 82. Selected Items in the Inventory Options View

Item Description

Auto Allocate When this field is set to Yes, the Fulfillment Engine can 
automatically allocate a product from this location. When set to 
Default, the engine uses the Auto Allocate setting for the product 
at all inventory locations, set in the Product view. This setting 
does not affect replenishment.

Allocate Below Safety When this field is set to Yes, the Fulfillment Engine can 
automatically allocate a product from this location when the 
quantity falls below the safe level. When set to Default, the engine 
uses the Allocate Below Safety setting for the product at all 
inventory locations, set in the Product view. This setting does not 
affect replenishment.

Auto Substitute When this field is set to Yes, the Fulfillment Engine can 
automatically substitute a product. When set to Default, the 
engine uses the Allocate Below Safety setting for the product at all 
inventory locations, set in the Product view. This setting does not 
affect replenishment.

Table 81. Selected Items in the Product Field Service Details View

Item Description
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Substitute Products Subview
The Substitute Products subview specifies the products that the Fulfillment Engine 
may use to fill an order when the specified product is unavailable from inventory. 
The user chooses from products that are specified in the Products view (see 
“Products View” on page 301). The Fulfillment Engine can choose this product if 
the Auto Substitute flag is set.

NOTE: Substitutions are unidirectional. Product A may substitute for product B, 
but B cannot substitute for A unless that substitution is explicitly defined. 
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The Data Administration screen has two fulfillment-related views for configuring 
orders: Order Action Types and Order Types. 

Actions process orders. These actions indicate that the product has been reserved 
for a line item (Allocate action), it has been substituted by another product 
(Substitute action), it has been shipped (Ship action), and so on. 

Order types define the classes of orders that Field Service processes; for example, 
Internal Order, Service Order, RMA Return, and so on. Each Order Type has 
associated Order Action Types; for example, a Purchase Order typically has a 
Receive Order Action Type.

NOTE: New order types and order action types can be added through these views. 
However, the processing that must happen when these new actions and action types 
are selected by end users has to be customized. 

Order Action Types View
The Order Action Types view defines the actions that may be associated with an 
order type. An administrator chooses action types from a drop-down list. The 
choices available in this menu are set in the Applications Administration screen, 
List of Values view.

CAUTION: Never delete order types or order action types, as their Row IDs provide 
values for tables elsewhere in Orders. To change or replace an order type or an order 
action type, modify the List of Values and then update (do not delete and re-enter) 
the Type entry. 

Order Types View
The Order Types view defines the types of orders that are available. The 
administrator chooses order types from a drop-down list. The choices available in 
this menu are set in the Applications Administration screen, List of Values view.

The Type Code field determines whether an order is a sales or service order.
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Orders Screen
The Orders screen includes views that relate to fulfillment.

Line Items View
The Line Items view records all items included in an order. Table 83 describes items 
in Line Item records.

Table 83. Selected Items in the Line Items View

Item Description

Customize This button invokes Siebel eConfigurator for products categorized 
as customizable. See Product Administration Guide.

Fulfill This command creates an inventory transaction that allocates parts 
from inventory and creates pick tickets for the selected line item.

Fulfill All This button creates an inventory transaction that allocates parts 
from inventory and creates pick tickets for all the line items in a 
selected order.

Locate/Locate All These buttons appear in the view only when the Part Locator 
subview tab is selected (see “Part Locator Subview” on page 309). 

Reprice This command activates the Pricing Engine to calculate the price for 
the selected line item based on the associated price list and pricing 
model.

Reprice All This button activates the Pricing Engine to calculate the price for all 
line items based on the associated price list and pricing model.

Qty The quantity of the item in an order. This is normally an integer, 
but may be set to a decimal field. Note that the Replenishment and 
Fulfillment Engines may truncate decimal values.
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Configuration Note
Because of the special behavior of the Line Items business component (based on 
special class CSSBCLineItem), a Line Item record can be updated only if its parent 
Order record is exposed (present and active) in the Orders screen. If the screen 
exposes only the Line Items view without the Service Order view, the Line Item 
records are read-only. 

Totals Subview
The Totals subview provides a breakdown of products and services sold in terms 
of the price for a selected line item, a discount, and a price adjustment. The result 
is the total for the selected line item before adding tax and shipping.

Line Detail Subview
The Line Detail subview contains more information about a selected order line item, 
including details specific to service products, shipping and billing information, and 
pricing. Table 84 describes items in Line Detail records.

Table 84. Selected Item in the Line Detail Subview

Item Description

Billable When selected, indicates to the Invoice Engine that this order line 
item is billable to the customer. The engine adds this item to the 
invoice. Can be selected regardless of the order’s type or status. 

Loaner When selected, indicates that a line item is on loan. 

Ship Complete When cleared, this check box indicates that a service center may 
ship only some of the line items, as needed. This is for information 
only.

Related Activity Associates parts and tools, selected from the Pick Related Activity 
dialog box. 

Warranty Recovery When selected, indicates that a warranty credit is being requested 
for this line item. 

Qty Shipped Updated with the sum of the line item action Quantity for records of 
type Ship where the line item action Status is Complete. 
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Attributes Subview
If the selected product is customizable with attributes, users can use the Attributes 
view to select specific attributes or to view the default attributes. For information 
about customizable products, see Product Administration Guide.

Activity Plans Subview
The Activity Plans subview associates activity templates with order line items. 
The activities that belong to this plan appear in Activities subview. For more 
information, see “Activity Plans View” on page 70.

Part Locator Subview
The Part Locator subview finds the product to allocate to a line item in an order. 
The Locate buttons that appear in the Line Items view activate the Part Locator 
Engine to determine the inventory locations for line items. 

Once located, the Allocate command (in the pull-down menu in the Part Locator 
view) reserves products for the order and the Generate PickTickets button (in the 
Service Order view) creates pick ticket records for the allocated line items.

The Part Locator view has these lists:

■ Available / Substitute. This view lists the inventory locations at which the 
selected line item or a substitute for the selected line item is available.

■ Line Allocation. This view lists the quantities of the selected line item that are 
allocated to each inventory location.

Actions Subview
The Actions subview records all transactions created for the selected line item (for 
example, Allocate, De-Allocate, Ship, and Receive). The Fulfillment and Part 
Locator Engines automatically create Allocate transactions. The shipping process 
can automatically create De-Allocate transactions (see “Process Shipment Button” 
on page 357).

This view also records manual transactions for selected line items. The De-Allocate 
command in the pull-down menu creates a transaction of the type De-allocate.
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For each line item action recorded, the values available in the Type field’s picklist 
vary according to the transactions that have occurred previously. For example, the 
picklist does not offer the choice De-Allocate if no Allocate action has previously 
been performed on the line item.

Warranty Subview
The Warranty subview shows the warranties associated with a product. Pre-existing 
warranties can also be associated with the selected line item. For more information 
about warranties, see Chapter 15, “Warranties.” 

Repair Subview
The Repairs view shows the repair numbers associated with a line item. Repair # 
is the same as Defective Tag. This view is read-only.

Fulfillment View
The Fulfillment view has an Auto Receive flag that applies to Internal Orders. 
Selecting this flag automatically generates receiving line items and processes their 
receipt for the field engineer trunk inventory location when Process Shipment is 
done at the source inventory location. If the order is an Internal Order and the 
destination inventory location type is Trunk, then the flag is selected by default. 
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This chapter describes how a field service business sets up and maintains a service 
inventory. 
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Service Inventory Overview
Service businesses use the Service Inventory module to manage parts throughout 
their life cycles and to monitor parts consumption during order fulfillment and field 
engineer activities. Service Inventory also allows mobile field engineers to manage 
their trunk inventories using a disconnected client.

Figure 6 on page 313 shows the flow of goods through a service inventory. At the 
center of the flow is the service parts life cycle, a closed-loop process. The service 
parts life cycle consists of the following stages: receiving (good), order placement, 
picking and shipping, in-transit, customer, receive, test and sort, repair, restock to 
good, back again to receiving (good), and so on. Incoming goods from the 
manufacturer arrive at the receiving (good) stage. Goods go out to field engineers 
during the in-transit and receive stages. Through the field engineers, these goods go 
to customer sites through an in-transit stage for on-site repairs or replacements. 
Goods also leave the service parts life cycle during the repair stage, where the goods 
may be tested, repaired, scrapped, recycled or replaced by the outsource vendor. 
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Figure 6. Flow of Goods in Service Inventory
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A materials manager can automate all of these tasks using the Fulfillment or Part 
Locator Engines. The Replenishment Engine automates the production of orders to 
restock inventory locations (see Chapter 11, “Cycle Counting and Replenishment”).

Setting Up an Inventory
A primary objective of Service Inventory is to record the organization of inventory.

Figure 7 on page 315 shows an example of an inventory structure. The structure is 
hierarchical. At the top level is US Inventory. At the next level, this is broken out 
into California Field Service Engineers, Dallas (warehouse), Boston Repair Center 
(warehouse), and Field Offices. 

California Field Service Engineers is broken out into Fred Roberts’ trunk and Chris 
Smith’s trunk. Fred Roberts’ trunk has product inventory levels classified as On-
Hand and Reserved. Dallas (warehouse) is broken out into Aisle A, Aisle B, and 
Aisle C. Aisle A has Shelf 1 and Shelf 2. Shelf 1 is broken out into Bin A and Bin B. 
Bin B has product inventory levels for Disk Drives and CD-ROM drives. Boston 
Repair Center (warehouse) is likewise broken out into Aisle A and Aisle B. Field 
Offices is broken out into Boston, Los Angeles, and San Francisco (warehouse).
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Figure 7. Sample of a Service Inventory Structure
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Inventory Locations
Inventory locations consolidate and manage all records having to do with service 
inventory (see “Inventory Locations View” on page 346). An inventory location can 
be a field engineer’s trunk, a warehouse, or a sublevel of a warehouse, such as a 
shelf or an aisle. An inventory level, which specifies availability and status of an 
item, may be added to any location in an inventory structure. 

NOTE: Inventory levels were called product buckets in previous releases of Siebel 
Field Service.

Building an inventory requires answers to the following questions: 

■ Which inventory locations does Service Inventory track, and which are tracked 
by other means, such as an external back office inventory system?

■ How many hierarchical levels are appropriate for each inventory location?

Different types of inventory locations can be defined. The following locations are 
basic to Service Inventory:

■ Warehouse. Default inventory location where the inventory fulfillment and 
replenishment relationships are defined. Also, pick tickets are generated at this 
level. All other inventory locations may be defined as subcategories of the 
warehouse.

■ Trunk. Mobile inventory that is assigned to a field service engineer. Each engineer 
has one trunk inventory. 

■ Field Office. May supply several field service engineers. It is intermediate 
between a warehouse and a trunk inventory.

■ Virtual. A logical, rather than a physical, inventory location. One virtual 
inventory location named External is essential for proper functioning of 
inventory transactions. The External location is part of the seed data, with 
ROW_ID value VIRTUAL_INVLOC. This location allows an inventory system to 
receive items from the outside: a virtual inventory location is the source, while 
the destination is one of the physical inventory locations (for example, a shelf). 
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Figure 8 shows the sequence of tasks for setting up a service inventory. The steps 
are as follows:

1 Create inventory locations and inventory types.

2 Define relationships between inventory locations.

3 Define inventory transactions.

4 Define inventory levels.

5 Configure cycle counting.

Figure 8. Setting Up a Service Inventory
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Trunk Inventory
Managing a trunk inventory location requires recording part movements on the field 
service engineer’s laptop computer. Field service engineers periodically connect 
their laptop computers to a Siebel server and synchronize data. 

To maximize performance during synchronization to and from the field service 
engineer’s local database, docking rules control the number and context of the 
records that are extracted, initialized, and synchronized. Because of these rules, an 
engineer may not have visibility to asset records required to commit a field part 
movement involving a serialized product. To solve this problem, the Field Service 
application allows the engineer to write in asset numbers. Upon synchronization, 
the write-in asset number is reconciled by an administrator with the corresponding 
database record, and the transaction is committed. Once committed, the field 
service engineer must synchronize again to update the local database. 

At the time of synchronizing the laptops in the field, an administrator can use the 
Parts Movement Administration view (see “Parts Movement Administration View” 
on page 342) to review and commit transactions.

Inventory Relationships
An inventory location is linked to other locations by relationships that define 
physical spaces, replenishment sources, fulfillment sources, and cycle counting 
lists. An inventory structure consists of a network of relationships.

Siebel Field Service can implement an inventory structure in several ways:

■ Create one inventory location (for example, a warehouse), maintain the 
products at this location (in inventory levels), and then attach the physical 
location to the inventory level. 

■ Assign locator numbers to logically divide an inventory location. Locators have 
values like A1S3B7, meaning Aisle1, Shelf3, and Bin7. A locator number does 
not imply an inventory type (for example, a bin). The locator numbers should 
be used, along with the locator order, to optimize shipping and cycle counting.
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■ Define each aisle, shelf, and bin as a separate inventory location. Only bin-level 
inventory has products; typically only one or two products reside in each bin. 
The inventory name can reflect the combination of location and product. These 
different inventory locations can be linked to each other with the relationship 
type Sub-level, which indicates, for example, that Aisle1 is a sublevel inventory 
location of Warehouse. 

While considering fulfillment, generating cycle counting lists, or running the 
Replenishment Engine at the warehouse level, all inventories below the Warehouse 
level (and connected using sublevels) are automatically considered. 

To boost performance (for example, to avoid traversing a tree every time it is 
necessary to find all sublevels of inventory for a warehouse), Field Service uses a 
denormalized table. This table stores every child, direct child, or grandchild (to any 
number of levels deep) of a parent inventory. If an inventory hierarchy is defined as 
follows:

■ Inventory A is parent of Inventories B, C, and D

■ Inventory B is parent of inventories E and F

Then Table 85 summarizes the entries in the denormalized table.

Table 85. S_INVLOC_ROLLUP

Parent Invloc Invloc

A B

A C

A D

A E

A F

B E

B F
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Inventory locations may also be related through replenishment. However, 
replenishment relationships should be defined for inventory locations of type 
Warehouse only. For example, configuring the replenishment relationship “Oakland 
field office replenishes trunk” may result in the trunk inventory being overstocked 
if the trunk location is already a sublevel of a parent inventory.

NOTE: Fulfillment and replenishment relationships between inventory locations 
should be set at the warehouse level, and not at lower levels; for example, aisles, 
bins, or shelves. When using relationships, the Fulfillment, Replenishment, and Part 
Locator Engines automatically search for parts at lower levels by using sublevel 
relationships.

Tracking an Inventory Location
There are two methods to track a part’s physical location in an inventory:

■ If inventory locations are defined down to the shelf or bin level, attach the 
inventory level to a bin or shelf, whose fixed location identifies the part.

■ Enter a description of the part’s inventory location in the Locator fields of the 
Product Inventory view. This view provides three Locator fields to allow for 
multiple possible locations; for example, a part called Defective 1 GB HD might 
be found first in the northeast corner of the San Francisco field office, second on 
shelf A in the supplies room, and third on shelf B in the supplies room.

Inventory Levels
Inventory levels are categories of products defined by a combination of availability 
and status. Both availability and status can have a variety of values. Availability 
values are Customer Owned, In Transit, On Hand, On Order, and Reserved. Status 
values are Good and Defective. 

Here are examples of inventory levels for one product:

Availability Status

On Order Good

On Hand Good
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The Inventory screen (see “Inventory Screen” on page 346) records inventory levels 
and asset numbers for each product in inventory. New products and inventory 
levels can be added to an inventory in this view, but it is not necessary to create 
these records manually. When an inventory transaction occurs, products and 
inventory levels are automatically created if they do not exist. However, products 
created this way are not assigned Min, Max, and Safety values or a cycle counting 
class (A, B, or C; X, Y, or Z), so product records may need updating on the Service 
Inventory screen.

You can create or update inventory levels by loading them through the 
EIM_PRODINVLOC table. You can also create or update inventory transactions by 
loading them through the EIM_INV_TXN table. For more information about these 
tables, see Interface Tables Reference.

Negative Inventory Levels
Negative inventory levels may result from certain inventory transactions. Negative 
inventory levels are possible only for non-serialized products. Inventory levels may 
acquire negative values under the following circumstances:

■ When the logical inventory does not match the physical inventory (in other 
words, if the item is on the shelf but the database does not show that it is 
available). 

■ When reconciling transactions to or from an External Location. The External 
Location must have negative quantities so that it can receive inventory from an 
external source.

Reserved Good

In Transit Defective

Availability Status
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Best Practice: Managing Inventory Levels
If the Inventory levels do not exist, they are automatically created by inventory 
transactions. However, Siebel Systems recommends that inventory levels be 
initiated as part of the Authorized Stock List for an inventory location. As part of 
the Authorized Stock List, the default inventory levels (for example, On Hand - 
Good) should be created when an inventory location is created or when a new 
product is added to an inventory location. If your company plans to stock a 
particular inventory level, then you should not rely on an inventory transaction to 
create it.

Creating an inventory level when a product is added to an inventory location can 
be automated by setting up a workflow process. For more information about Siebel 
workflows and how to set them up, see Siebel Business Process Designer 
Administration Guide.

Location Order
Service Inventory can specify a preferred order for using inventory at several 
different locations. By specifying which location to use first, Service Inventory 
minimizes the time required for a warehouse clerk to find an item for shipping 
(pick tickets), to stock inventory (replenishment), or for cycle counting. Location 
order can suggest order management strategies, like First-In-First-Out (FIFO). 
However, allocation takes place inventory levels and does not follow plans like 
FIFO or LIFO.

NOTE: Location Order is for information only. It has no effect on the Fulfillment or 
Cycle Counting Engines. 

Location order is represented by locator numbers (1, 2, and 3). Each locator number 
is defined by a locator code that applies to a specific warehouse or inventory 
system. For example, part H3 may occur at three different inventory locations that 
have these locator codes:

Locator Number Example of a Locator Code Meaning of Code

1 A3S1B1 Aisle 3, shelf 1, bin 1
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The location order can be any sequence of locator numbers; for example, 123 or 
213. Make sure that the location order represents the optimized path through the 
warehouse. 

Inventory locations 1, 2, and 3 (or Locators) are specified for inventory levels in the 
Inventory screen, Product Inventory view, Inventory Level subview (see “Inventory 
Level Subview” on page 348). Location Order appears as a read-only field in the 
Products screen, Inventory Locations view. Locations (1, 2, and 3) appear as read-
only fields in the Cycle Counts screen, Part List view.

NOTE: To see the Inventory Options subview, choose Inventory Options from the 
Show drop-down list in the Service Details view. To see the Substitute Products 
subview, choose Substitutes from the Show drop-down list in the Service Details 
view. 

Inventory and Product Serialization
If a product is serialized by selecting the Serialized check box in the Product Service 
Details view (see “Product Field Service Details View” on page 302), then a serial 
number is required for all movements and transactions of assets of this product, 
including the following:

■ Inventory transactions

■ Field part movements

■ Cycle counts

■ Shipments

■ Receipts

2 A3S2B6 Aisle 3, shelf 2, bin 6

3 A15S3B1 Aisle 15, shelf 3, bin 1

Locator Number Example of a Locator Code Meaning of Code
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Serialized products are treated differently from non-serialized ones. If a product is 
serialized, the user needs to enter assets for the product. Whenever a serialized 
product is shipped or received, Field Service expects the right number of assets with 
serial numbers. For example, if four serialized hard drives are shipped or received, 
Field Service expects that four separate serial numbers are entered.

NOTE: When a serialized asset is allocated through a manual order, the system 
allocates the product quantity specified in the order, not the asset itself. 
Consequently, the asset remains in the On Hand - Good/Defective inventory level.

Asset Transactions
The asset transactions that maintain an install base are Install, Uninstall, Upgrade, 
and Downgrade. These transactions do not directly update quantities in inventory 
levels.

When a field service engineer reports part movements in the field, inventory and 
asset transactions are generated automatically. For example, a record in the Part 
Movement list with a source of Customer and a destination of Trunk means that the 
field service engineer has taken a part out of the customer’s install base and has put 
it in his or her trunk. The Mobile Inventory Transaction Engine reflects this transfer 
by creating an inventory transaction (to receive the part into a trunk) and an asset 
transaction (to change the install base).

When a field service engineer is repairing, updating, or replacing items referenced 
in a service order, the engineer selects Service Order as a source and specifies 
Customer as the destination. Since the item is added to the customer install base, 
only an asset transaction is generated.

You can create asset transactions manually in the Assets screen’s Transactions view.

If you perform any inventory transaction on a hierarchical asset, then only the 
Inventory Location field of the parent component will show the correct location. 
The Inventory Location field of the child sub-components will be blank or will have 
a value of External Location. 
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Changes can occur in some other fields of the asset’s parent component according 
to the type of inventory transaction. Whether these effects occur on the fields of the 
hierarchical asset's child sub-components depends on whether the fields are set to 
cascade their values from the parent to the child. For more information about 
hierarchical assets, see “Hierarchical Assets” on page 492.

Inventory Transactions
The Service Inventory module is transaction-based. Field Service uses inventory 
transactions to update inventory levels in response to parts movements between 
two locations or whenever there is change in an inventory level. Each inventory 
transaction has a product, a quantity, a source, and a destination.

Here are some examples of business activities that create inventory transactions:

■ Perform a part movement by doing an install or uninstall of a part and move it 
into or out of the service engineer’s trunk.

■ Allocate or de-allocate a part against a line item on an order, either manually or 
through the Fulfillment engine.

■ Ship an order and click the Process Shipment button on the Shipping screen.

■ Receive an order and click the Generate Transaction button on the 
Receiving screen.

■ Create a transactions manually in the Inventory Transactions screen.
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Table 86 summarizes the types of inventory transactions.

Table 86. Summary of Types of Inventory Transactions

Type Description

Adjustment Adjusts inventory levels; for example, if after a cycle count 
there is a variance between original inventory and counted 
inventory. Manually generated in the Inventory Transactions 
screen, or automatically in Cycle Counts > Variance (see 
“Cycle Counts Screen” on page 410).

Allocate Adds inventory to an inventory level with an availability of 
Reserved. Automatically generated when an Allocate action is 
called for an order line item. 

De-Allocate Clears inventory from an inventory level with an availability 
of Reserved. Automatically generated when a De-Allocate 
action is called for an order line item. 

Exchange Between FSEs Moves inventory from one trunk inventory to another. 
Intended to move inventory between field service engineers. 
Manually generated in the Inventory Transactions screen.

Over-the-Counter Moves inventory from one inventory location or level to 
another. Intended to move inventory from warehouses to field 
service engineers’ trunks. Manually generated in the 
Inventory Transactions screen.

Receive from TP Moves inventory from a third-party location that is defined in 
the inventory system (in the Orders screen, Fulfillment view) 
to the inventory location defined in the Receiving screen, Line 
Item Receipts view.

Receive Internal Moves inventory from an inventory level with the availability 
of In Transit to a defined physical inventory level, such as a 
shelf in a warehouse. A stock transfer, automatically generated 
in the Receiving screen. 

Receive Other Enters inventory, on receipt, into an inventory level. Part of a 
transaction with a customer, which uses a virtual inventory 
location called External Location or Customer. These locations 
come as seed data with Field Service. Received from the 
Customer location to the location specified in the Receiving 
screen, Line Item Receipts view.
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Conditions for Generating Transactions 
Table 87 defines the types of inventory transactions created for combinations of 
source and destination locations, inventory levels, and serialized versus non-
serialized assets.

Ship Internal For internal orders, moves inventory from a physical inventory 
level to an inventory level with the availability of In Transit. A 
stock transfer, automatically generated in the Shipping screen. 

Ship Other For outside orders, moves inventory from a physical inventory 
level to an inventory level with the availability of In Transit. 
Part of a transaction with a customer that uses a virtual 
inventory location called Customer. The Customer location 
comes as seed data with Field Service. 

Ship to TP Moves inventory from the location from which the item was 
allocated and the pick ticket generated to the destination 
location defined in the Orders screen, Fulfillment view.

Stock Transfer Moves inventory from one inventory level or location to 
another, whether the inventory levels or locations are in the 
same warehouse or in different warehouses. Manually 
generated in the Inventory Transaction screen. 

Table 86. Summary of Types of Inventory Transactions

Type Description

Table 87. Conditions for Generating Transactions Types

Source Destination

Inventory 
Transaction

Inventory 
Txn Type Inventory

Inventory 
Level Assets1 Inventory

Inventory 
Level Assets1

Part 
movement 
on activity

Ship Other Trunk of FE On Hand Yes Customer On Hand Yes

Receive Other Customer On Hand Yes Trunk of FSE On Hand Yes

Allocate 
action 
Insertion 
on order 
entry

Allocate Customer On Order No Ord Part 
Movement 
Source 
Invloc ID

Reserved No
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De-allocate 
action 
Insertion 
on order 
entry

De-allocate Ord Part 
Movement 
Source 
Invloc ID

Reserved  No Customer On Order No

Ship other Ship Other Ord Part 
Movement 
Source Inv

On Hand Yes Customer On Hand Yes

De-allocate Ord Part 
Movement 
Source Inv

Reserved Yes Customer On Order Yes

Ship 
internal

Ship Internal Ord Part 
Movement 
Source Inv

On Hand Yes Order 
header. 
Destination 
Invloc ID

In Transit Yes

 De-allocate Ord Part 
Movement 
Source 
Invloc ID

Reserved Yes Customer On Order Yes

Receive 
RMA/PO

Receive Other Customer On Hand Yes Ord Part 
Movement 
Dest Inv

Ord Part 
Movement 
Avail/
Status

Yes

Receive 
internal

Receive Internal Order Hdr 
Destination 
Inv

In Transit Yes Ord Part 
Movement 
Dest Inv

On Hand Yes

Table 87. Conditions for Generating Transactions Types

Source Destination

Inventory 
Transaction

Inventory 
Txn Type Inventory

Inventory 
Level Assets1 Inventory

Inventory 
Level Assets1
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The following rules regulate the generation of inventory and asset transactions:

■ If a product is serialized:

■ The asset for the part movement must be specified.

■ The quantity of the part movement must be 1.

■ The asset must belong to the source inventory. 

When these conditions are met, the inventory transaction is validated and the 
inventory database is updated.

■ If the product is not serialized and no asset number is specified, a committed 
inventory transaction is generated without validation and committed 
successfully.

■ If the product is not serialized and no asset number is specified, neither an asset 
validation nor an asset transaction takes place. The inventory location is not 
stamped on the asset.

Ship RO Ship to TP2 Ord Part 
Movement 
Source Inv

On Hand Yes Order 
header. 
Destination 
Invloc ID

On Hand Yes

De-allocate Ord Part 
Movement 
Source 
Invloc ID

Reserved Yes Customer  On Order Yes

Receive RO Receive from TP2 Order Hdr 
Destination 
Inv

On Hand Yes Ord Part 
Movement 
Dest Inv

On Hand Yes

1. The assets rows are included in the transaction validation if the product is serialized.

2. Third-party provider.

Table 87. Conditions for Generating Transactions Types

Source Destination

Inventory 
Transaction

Inventory 
Txn Type Inventory

Inventory 
Level Assets1 Inventory

Inventory 
Level Assets1
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Mobile Inventory Transactions
Siebel Field Service can record part movements in the field (mobile inventory) 
without synchronizing with the Field Service server. This allows field service 
engineers to record transfers of assets without having the asset number or serial 
number on their laptop computers. 

Normally, recording transfers of assets without having asset numbers or serial 
numbers would cause a transaction to fail. However, with Field Service, the part 
movement is recorded but not applied to the inventory database. 

If the mobile computer is disconnected, the local database is updated. When the 
mobile computer is synchronized with the Siebel server, the information about the 
part movement is transferred to the server. If the asset was identified in the database 
on the remote computer, the server records the change in inventory location in the 
database and then creates a transaction.

If a part movement was not validated on the remote computer (this includes all 
write-in assets), an uncommitted part movement appears in Service 
Administration >Parts Movement Administration (see “Parts Movement 
Administration View” on page 342). An administrator must review uncommitted 
part movements and reconcile write-in serial numbers with existing asset numbers. 
The Commit button then creates transactions (see “To commit transactions reported 
by mobile clients” on page 340). For information on the types of transactions 
created for specific combinations of source and destination locations, see “Setting 
Up Service Inventory” on page 332. 

The next time the remote computer is synchronized, its database is updated from 
the server database.

Mechanism of the Commit Buttons
Commit buttons appear on the Activities screen’s Expense Tracker, Part Tracker, and 
Time Tracker views; and on the Service Administration screen’s Parts Movement 
Administration view. The commit step of a transaction begins when the record is 
saved with the Commit flag set. The field service engineer uses the Commit button 
on the Activities screen to perform the following validations:

■ Are source and destination inventories specified? This condition must be 
met first. If the asset does not belong to the source inventory level, leave it 
uncommitted.
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■ Is the position of the owner of the activity associated with a trunk inventory 
(location type Trunk)?

■ If an asset number is provided, is it valid?

■ For each asset transaction, is the asset at the specified inventory source location? 
This validation is not performed for the External location or the Customer 
location (see “Setting Up an External Location” on page 347).

■ Is the item available? Availability and status are verified. This validation is not 
performed for the External location.

■ Does the source inventory have the quantity of assets specified? This quantity 
is 1 if the part is serialized.

■ If the product is serialized, does the total quantity for an inventory transaction 
equal the total number of asset entered for this transaction?

If these validation checks are successful, the Commit flag is set in Part Tracker 
records and records are generated to record inventory movements. In detail, the 
following steps are carried out:

■ Create a committed inventory transaction; for example, Receive Other.

■ Create assets for the inventory transaction.

■ Create new database records for the inventory location: source and destination.

■ Update the asset record (ID).

■ Create asset transactions; for example, Install.

■ Commit the part movement by updating the database.
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Setting Up Service Inventory
These are procedures for setting up the structure and operation of an inventory 
system using Siebel Field Service. The procedures may require administrative 
access.

Defining Products for Field Service
Before you set up an inventory system, you must define the products that the 
inventory system will track. For more information on defining products, see Product 
Administration Guide.

To create serialized and non-serialized products

1 Navigate to the Product Administration screen.

2 Select a product.

3 From the Show drop-down list, select Product Service Details.

4 If the product has a serial or asset number, select Serialized.

To specify an asset for a product

1 Navigate to the Assets screen.

2 Create an asset record. 

3 In the Product field, select a product.

4 If the asset has a serial number, enter it in the Serial # field.

To specify allocation of products

1 Navigate to the Product Administration screen.

2 Select a product.

3 From the More Info view tab’s Show drop-down list, select Product Service 
Details.
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4 In the More Info view tab, select the desired allocation modes: Allocate Below 
Safety, Auto Allocate, or Auto Substitute.

See “Product Field Service Details View” on page 302.

CAUTION: If you change the Allocate Below Safety, Auto Allocate, or Auto 
Substitute flags, you must restart the Parts Locator and Fulfillment Server 
components. (You do not have to restart the entire server.) If you do not restart 
these components, the system will not reset the product attribute settings in the 
Part Locator Engine and the Fulfillment Engine. For information about how to 
restart server components, refer to Siebel Server Administration Guide. 

5 Click the Inventory Options subview tab.

6 In the Inventory Options subview, create records for each type of inventory 
location from which this product may be allocated.

This view inherits Allocate Below Safety, Auto Allocate, and Auto Substitute 
values from the More Info view. 

a In the Inventory Type field, select a type of inventory location. 

b Set the Allocate Below Safety, Auto Allocate, and Auto Substitute values if 
different than those specified for the product.

c In the Class ABC and Class XYZ fields, set the cycle counting basis values of 
A, B, or C and X, Y, or Z. 

See “Configuration of the Cycle Counting Engine” on page 381.

Setting Up an Inventory
Follow these procedures to set up an inventory.

To define inventory types

1 Navigate to Site Map > Service Administration > Service Inventory.

2 Make sure the Inventory Location Types view tab is selected.

3 Create an inventory location type record.
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4 In the Location Type field, select an inventory type.

5 Set the parameters for cycle counting, as required. See “Inventory Location 
Types Subview” on page 343 and “Configuration of the Cycle Counting Engine” 
on page 381. 

To create an inventory location

1 Navigate to the Inventory screen.

2 Add an inventory location record. 

3 In the Name field, type in the name of the physical inventory location.

The Name field uniquely identifies the inventory location.

4 In the Type field, select an inventory location type.

5 Enter values for other fields as needed.

To add a product to inventory

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 Click the Product Inventory view tab.

4 Add a product record for the selected inventory location.

5 In the Product field, select a product.

6 Specify Min, Max, and Safety Levels for this product in inventory.

7 Specify the cycle counting basis in the ABC and XYZ fields.

See “Configuration of the Cycle Counting Engine” on page 381.

To create an inventory level

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 Click the Product Inventory view tab.
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4 Select a product.

5 Click the Inventory Level subview tab.

6 In the Inventory Level subview, create an inventory level for the selected 
product.

7 In the Availability field, select a set of Availability and Status values.

To associate an employee with an inventory location

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 In the Ownership field, select Owned from the drop-down list.

4 In the Position field, select a position.

The inventory location appears in the My Inventory Locations view for the 
employee associated with the selected position.

To associate a vendor with an inventory location

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 Click the Vendors view tab and add a vendor record.

4 In the Account field, select a vendor account.

To associate an inventory location with an organization 

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 In the More Info tab, click the show more button to see more fields.

4 In the Organization field, click the select button and select an organization from 
the Organizations dialog box.

a To set the primary (default) organization for this inventory location, select 
the Primary field.
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b If an organization does not appear in the dialog box, click New and select an 
organization from the Add Organizations dialog box. Click OK. 

c In the Organizations dialog box, click OK. 

The organization marked as primary appears in the Organization field.

To define inventory levels

1 Navigate to Site Map > Service Administration > Service Inventory. 

2 Click the Inventory Level Categories view tab.

3 Create a new record.

4 In the Availability and Status fields, select values.

To define the relationships between inventory locations

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 Click the Relationships view tab and add a relationship record. 

a In the Name field, select an inventory location.

b In the Relationship field, select a relationship (Fulfills, Replenishes, or 
Sublevel).

Setting Up Inventory Transactions
Follow these procedures to define inventory transactions.

To define types of inventory transactions

1 Navigate to Site Map > Service Administration > Service Inventory. 

2 Click the Inventory Transaction Types view tab and create an inventory 
transaction type record.

3 In the Name field select, the name of a transaction type.
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Synchronizing Remote and Local Databases 
Siebel Remote allows mobile or remote clients (typically laptop computers) to 
connect to a Siebel Server and exchange updated data and files, a process known 
as synchronization. For information about setting up and using Siebel Remote, see 
Siebel Remote and Replication Manager Administration Guide.
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Follow these procedures to verify inventory and create inventory transactions.

Tracking Inventory
Follow these procedures to verify inventory.

To verify inventory status using the Inventory screen

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 Click the Product Inventory view tab.

4 Select a product.

The Inventory Level subview shows the inventory status for all products at 
the selected location.

To verify inventory status using the Part Browser

1 Navigate to the Part Browser screen.

2 Select a product and inventory location.

The Inventory Level subview shows the inventory status for this product.

To generate inventory status reports

1 Navigate to the Inventory screen.

2 Select an inventory location.

3 From the application-level menu, select View> Reports > Product List by 
Location or Products Below Minimum Level by Location. 

To view cycle counting parameters for a selected location

1 Navigate to the Inventory screen.
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2 Select an inventory location.

Cycle counting parameters appear in the Inventory Locations form on the More 
Info tab.

To view all inventory transactions

■ Navigate to View > Site Map > Inventory Transactions.

Creating Inventory Transactions
Follow these procedures to process inventory transactions.

To create inventory transactions manually

1 Navigate to View > Site Map > Inventory Transactions.

2 Create an inventory transaction record.

3 In the Type field, select a transaction type. 

4 Enter values for all required fields.

To add an asset to an inventory transaction

1 Navigate to the Inventory Transactions screen.

2 Select the inventory transaction for a serialized product with which you want to 
associate an asset.

3 Click the Assets view tab.

4 Add an asset record.

Available assets vary dynamically according to the Source Location in the 
inventory transaction record. The assets available to select are only those at that 
Source Location. If the Source Location is External Location, Field Service shows 
all assets not currently assigned to any location.

To receive a product as a stock transfer or over-the-counter transaction

1 Navigate to View > Site Map > Inventory Transactions.

2 Add an inventory transaction record.
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a In the Type field, select Stock Transfer or Over-the-counter.

b Enter values for all required fields.

If the product for this inventory transaction is serialized, the Serialized check 
box is selected.

3 If the product is serialized, click the Assets tab and add a new asset record for 
the transaction.

a In the Asset # field, select an asset.

b In the Inventory Transaction form, select the Commit check box.

To move an item from one trunk to another: source mobile client

1 Navigate to View > Site Map > Inventory Transactions.

2 Add an inventory transaction record.

3 In the Type field, select Exchange Between FSEs. 

4 Enter values for all required fields.

5 Select the Commit check box.

To move an item from one trunk to another: destination mobile client

1 Navigate to the Activities screen.

2 Select an activity.

3 Click the Part Tracker view tab.

4 Create a part movement record.

5 In the Product field, select a product.

6 Enter a value in the Write-in Serial # field. 

7 Select the Commit check box. 

To commit transactions reported by mobile clients

1 Navigate to Site Map > Service Administration > Parts Movement 
Administration.
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2 Click the show more button in the More Info tab.

3 Select an uncommitted part movement record.

An uncommitted part movement record shows a cleared Commit check box in 
the More Info form.

4 In the Asset # field, select an asset.

The asset should correspond to the write-in serial number entered by the mobile 
field service engineer.

5 Select the Commit check box.

This action generates an inventory transaction that decrements the source 
inventory location and increments the destination location. 

Scrapping Inventory
If you need to create inventory transactions to scrap or write off an inventory of a 
product, follow this procedure.

To scrap or write off inventory

1 Assign one of the following inventory transaction types:

■ The existing type Ship Other

■ A new type that you create; for example, Scrap

For information about assigning a transaction type, see “To create inventory 
transactions manually” on page 339. For information about creating a 
transaction type, see “To define types of inventory transactions” on page 336. 

2 Send the inventory to one of the following inventory locations:

■ The existing virtual location External Location

■ A new virtual location that you create; for example, Scrap Location

For information about assigning an inventory location, see “To add a product to 
inventory” on page 334. For information about creating a virtual inventory 
location, see “To create an inventory location” on page 334. 
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The Service Administration screen has views for managing inventory transactions 
that have taken place in the field and for defining inventory transaction types, and 
for defining inventory level categories.

Parts Movement Administration View
A field service administrator uses the Parts Movement Administration view to 
commit transactions that occurred in the field, but are not yet committed. These 
transactions can be the result of the movement of parts between trunks, customer 
sites, and service orders.

The administrator commits each part movement record by entering an asset number 
that is already in the database and clicking Commit. The Commit button creates the 
appropriate transactions (see “Mobile Inventory Transactions” on page 330) in the 
database. Upon synchronizing with mobile computers, the changes are transferred 
to the databases on the local laptops.

Service Inventory View
The Service Inventory view contains subviews for setting the types of inventory 
categories that appear in drop-down lists in the Service Inventory screen.
342 Siebel Field Service Guide Version 7.5, Rev. A



Service Inventory

Service Administration Screen
Inventory Location Types Subview
The Inventory Location Types subview defines the inventory locations that are 
available in the Type field in Inventory > Inventory Location (see “Inventory 
Locations View” on page 346). Examples of location types are Aisle, Trunk, 
and Virtual.

CAUTION: Do not delete Inventory Types, Inventory Level Categories, or Inventory 
Transaction Types. Their Row IDs provide values for tables elsewhere in Service 
Inventory. To change or replace an Inventory Type, Inventory Transaction Type, or 
Inventory Level Category, modify the List of Values and then update (do not delete 
and re-enter) the Type entry. 

Also, do not delete the Inventory table row with the name External Location and 
the type Virtual, which is shipped as seed data with Field Service. Inventory 
transactions use this row, and cannot take place without it. Changing the name is 
acceptable.

Inventory Transaction Types Subview
The Inventory Transaction Types view defines the transaction types that are 
available in the Type field of the “Inventory Transactions View” on page 352. For 
more information concerning these transaction types, see “Inventory Transactions” 
on page 325.
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Inventory Level Categories Subview 
The Inventory Level Categories subview defines the inventory levels that are 
available in Inventory > Product Inventory (see “Inventory Level Subview” on 
page 348). An inventory category consists of a pairing of two values, availability 
and status. Examples of availability are On Hand, On Order, and Reserved. 
Examples of Status are Good and Defective.

NOTE: It is not necessary to create products and inventory levels manually. When 
an inventory transaction occurs, products and inventory levels are automatically 
created in the database if they do not exist. However, products created automatically 
in this way are not assigned specific levels, allocation values, substitution values, 
or cycle counting classes. It might be necessary to go to the Service Inventory screen 
and update newly created records in the Product Inventory and Inventory Level 
views.
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The Product Administration screen defines products. For more information, 
see Product Administration Guide. You can select the following views from the 
Show drop-down list in the More Info view.

Products View
The Products view records basic information about each product; for example, 
product name, part number, and revision. 

Product Service Details View
The Product Service Details view provides the information used in locating and 
allocating products for use in field service activities. For details, see “Product Field 
Service Details View” on page 302.

NOTE: This view has two subviews, Inventory Options and Substitutes. To navigate 
to these subviews, use the Show drop-down list in the More Info view.

Inventory Options Subview
The Inventory Options subview sets the inventory locations for a product. It 
determines how the Fulfillment Engine allocates a product from inventory or 
chooses a substitute when filling an order. It also sets the cycle counting parameters 
for each product at a specific location (see Chapter 11, “Cycle Counting and 
Replenishment”). For details, see “Inventory Options Subview” on page 304.

Substitute Products Subview 
The Substitute Products subview specifies the products that the Fulfillment Engine 
can use to fill an order when the specified product is unavailable from inventory. 
The user chooses from products that are specified in the Products view (see 
“Products View” on page 345). The Fulfillment Engine can choose this product 
if the Auto Substitute flag is set. For details, see “Substitute Products Subview” on 
page 305.
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The Inventory screen sets up and manages inventory locations and the products 
stored at these locations. For each product, it defines the inventory levels and 
records information about assets of these products. For replenishing inventory, it 
generates orders, displays the authorized vendors, and displays pending orders 
(see “Replenishment” on page 393). For cycle counting of inventory, parameters are 
defined and cycle counting lists are generated (see “Cycle Counting” on page 378).

In addition, the Inventory screen defines the roles of personnel at each inventory 
location.

Inventory Locations View
The Inventory Locations view defines the inventory locations in a service business. 
The drop-down list below the view bar provides these choices for inventory 
locations: My Inventory Locations, All Inventory Locations, and All Inventory 
Locations Across Organizations.

All Inventory Locations Across Organizations
An organization is a category that limits the visibility of data within a company. 
The All Inventory Locations Across Organizations view shows the inventory 
locations for all organizations within a company. Inventory transactions can take 
place only between locations within the same organization (set in the Inventory 
Locations list). For more information on setting up organizations, see the chapter 
on access control in Security Guide for Siebel eBusiness Applications.

The person owning a record can see this record in the My Inventory Locations view, 
even if it is in a different organization. However, for the same person, this record 
does not appear in the All Inventory Locations view. 

CAUTION: Improper configuration of organizations and inventory locations can lead 
to unintended effects. It may not be possible to carry out inventory transactions 
between certain locations.
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Setting Up an External Location
The seed data supplied with Field Service contains an External Location with the 
type Virtual. This is used as the default location in the absence of a source or 
destination location. It also allows inventory transactions between locations in 
different organizations (see “Inventory Transactions Across Organizations” on 
page 352). 

The administrator cannot delete the External Location record. The Row Id (for 
example, VIRTUAL_INVLOC) makes this value unique. Certain C++ code in Field 
Service references this value. If the administrator were to delete this row and 
recreate it, the record would be assigned a new Row ID and certain transactions 
would fail. The administrator can rename the location.

Using the Organization field, associate all organizations in the company with the 
External Location. This assures that all field service engineers in any organization 
within the company can use the External Location.

Product Inventory View
The Product Inventory view associates inventory locations with products, sets 
quantities of each product, and sets cycle counting parameters for the product at the 
selected location. Products are specified in the Product Administration screen 
(“Product Administration Screen” on page 345). Table 88 describes items in Product 
Inventory records.

Table 88. Selected Items in the Product Inventory View

Item Description

Min Minimum acceptable quantity of inventory at this location and product.

Max Maximum acceptable quantity of inventory at this location and product.

Safety Safe quantity of inventory for the selected location and product. The safe 
quantity (≤ Min) is the quantity below which the Fulfillment Engine should 
not allocate a product. 

Serialized Indicates whether instances of this product must have serial numbers 
recorded in the database.
Version 7.5, Rev. A Siebel Field Service Guide 347



Service Inventory

Inventory Screen
Inventory Level Subview
The Inventory Level subview associates inventory levels (availability and status) 
with products and defines the Location Order (see “Location Order” on page 322) 
for each inventory level. Table 89 describes items in Inventory Level records.

Assets Subview
The Assets subview describes all of the assets of the selected product at an 
inventory location. Fields on this subview indicate both asset numbers and serial 
numbers.

Generate Orders View
The Generate Orders view automatically produces orders to restock products in 
inventory, either by internal transfer between inventory locations or by purchase 
from an outside vendor. For replenishment, an inventory level must be defined for 
a product. For replenishment from a vendor, the authorized vendor must also be 
defined. 

The Order button runs the Replenishment Engine to replenish all items that are 
below minimum at the selected location.

The replenishment process describes either a source inventory location to replenish 
a selected location or a target location to be replenished from the selected location. 
Specific relationships between locations are defined in the Relationships view (see 
“Relationships View” on page 349). For a full discussion of replenishment, see 
Chapter 11, “Cycle Counting and Replenishment.”

Table 89. Selected Items in the Inventory Level View

Item Description

Location Order Indicates the preferred order for use of Locators 1 through 3. For 
example, 213 means that the item is best obtained from location 2, then 
1, and finally 3. This order is used for the physical process of shipping 
and cycle counting. It has no effect on the Fulfillment or Cycle Counting 
Engines.

Locator 1-3 Description of the physical location of a product at an inventory level. 
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Pending Orders View
The Pending Orders view lists orders that have been placed to replenish a location, 
either by part movement between inventory locations or by purchases from 
vendors. This view is read-only.

For a full discussion of replenishment, see Chapter 11, “Cycle Counting and 
Replenishment.”

Vendors View
The Vendors view records vendors who may supply products for a selected 
inventory location. 

Relationships View
The Relationships view records the relationships between a selected inventory 
location and other inventory locations. If a business uses more than one inventory 
location, relationships among inventory locations are useful for automating 
inventory replenishment and order fulfillment. A relationship may be physical (for 
example, a shelf belongs to an aisle) or logistical (replenishment of inventory or 
fulfillment of orders). Table 90 shows items in relationships records.

Table 90. Items in the Relationships View

Field Description

Type Type of location; for example, Warehouse or Trunk.

Relationship Relationship of this inventory location to the location selected in the 
Inventory Locations tab. The choices are Fulfills, Replenishes, and 
Sublevel.

Order Priority Priority of an order to be fulfilled from the inventory location, if the 
relationship type is Fulfills (for example, Low, Medium, or High).
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Roles View
The Roles view sets the roles of personnel associated with a selected inventory 
location. 

Cycle Count View
The Cycle Counting Administration view shows the parameters for cycle counting 
at a selected inventory location and the status of cycle counts for this location. To 
reach this view, choose Cycle Counts from the Show drop-down list in the Inventory 
screen. Cycle counts and cycle count periods are discussed in “Cycle Counts View” 
on page 408. 
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Part Browser Screen
The Part Browser screen presents a catalog of all parts in a service inventory. 
The fields in this screen are read-only.

Product Inventory View
The Product Inventory view presents a summary of products at every inventory 
location in a service business. Any product may be at more than one location.

Inventory Level Subview
The Inventory Level subview shows the quantity, availability, and status of products 
at each selected inventory location.

Substitutes Subview
The Substitutes subview shows the quantity, availability, status, and part number 
of every substitute for a selected product and inventory location. 
Version 7.5, Rev. A Siebel Field Service Guide 351



Service Inventory

Inventory Transactions Screen
Inventory Transactions Screen
The Inventory Transactions screen contains views that record the movement of 
products through inventory.

Inventory Transactions View
The Inventory Transactions view lists all inventory transactions created 
automatically (in other screens and views) to allocate, ship, receive, transfer, or 
adjust the quantity and inventory levels for a product. The same transactions can 
be created manually in this view. Table 91 shows items in inventory transaction 
records.

Inventory Transactions Across Organizations
Inventory transactions can take place between organizations by using two 
transactions and the virtual location named External Location:

■ The first transaction is from the source location (Inv1) in one organization to the 
External Location. This transaction is committed by a user who can see Inv1 and 
the External Location.

■ The second transaction is from the External Location to the destination location 
(Inv2) in a different organization. This transaction is committed by a user who 
can see Inv2 and the External Location.

For more information, see “Setting Up an External Location” on page 347.

Assets View
The Assets view shows the asset number of the product associated with the selected 
transaction. If the part is serialized, the view shows its serial number.

Table 91. Button in the All Inventory Transactions View

Field Description

Commit The button records a transaction in the database. Once committed, the record 
is read-only. This button performs all of the validations for an inventory 
transaction (see “Mechanism of the Commit Buttons” on page 330).
352 Siebel Field Service Guide Version 7.5, Rev. A



Service Inventory

Activities Screen
Activities Screen
The Activities screen has a view for recording movement of parts in the field, 
between two trunks, or between a trunk and a customer site. 

Part Tracker View
The Part Tracker view records the movement of parts used to carry out a selected 
activity. This view records the movements of parts that have an asset or serial 
number registered in the database on the mobile computer and parts that do not 
correspond to a registered asset. See also “Part Tracker View” on page 107.

The Commit button in this view checks that the appropriate information is 
provided, then creates a record that triggers an inventory transaction when 
connected to the Siebel server. Once committed, a record becomes read-only. 
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Inventory Reports
The Inventory screen provides the reports listed in Table 92.

Table 92. Inventory Reports

Report Description

Products Below Minimum Level by Location A list of products of good quality and 
below the minimum stock level at a 
selected inventory location.

Product List by Location A list of stock levels for products of good 
quality at a selected inventory location.

Inventory Cost Detail A list of all products at a selected inventory 
location with itemized and total costs.
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This chapter describes the shipping and receiving of orders and the records that 
Field Service creates to track orders.
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Shipments may be to a customer or to another inventory location belonging to 
the service business. Internal shipments may be triggered by the replenishment 
process. 

Shipping activities focus on two documents, the pick ticket and the waybill. The 
pick ticket provides detailed information about the items required to fill orders. The 
waybill, which records data related to the shipment, normally travels with the 
shipment and mediates between shipping and receiving. 

Shipping begins where fulfillment ends; with the generation of a pick ticket. 
Figure 9 illustrates the shipping process, which consists of the following steps:

1 Get pick ticket.

2 Pick parts.

3 Update pick ticket with parts shipped.

4 Choose carrier and update waybill.

5 Process shipment.

Figure 9. Shipping Process
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Process Shipment Button
The Process Shipment button is located on the Pick Ticket view of the Shipping 
screen. This button produces the following processes:

1 Examines all the records for allocated lines (in the table S_ORDPART_MVMT) 
for the selected pick ticket, validating the Ship transaction for each allocated 
line. If one of the validation constraints (for example, Product, Source Inventory 
Location, Source Availability, or Source Status) fails, the entire transaction is 
rolled back. 

2 For each shipped record against an allocated record, generates an inventory 
transaction with a type of Ship and another type of De-Allocate. Process 
Shipment generates inventory transactions (for example, Ship Internal or Ship 
Other) based on the order type of the pick ticket. For a description of these 
inventory transactions, see Table 86 on page 326. 

3 If the shipped quantity is less than the allocated quantity, then inserts a 
De-Allocate action for this line item for any extra items and generates an 
inventory transaction of type De-Allocate. This transaction is in addition to the 
De-Allocate transaction in Step 2.

4 Checks whether the Auto Receive flag is selected in the Order Fulfillment view 
(see “Fulfillment View” on page 310). If this condition is met, generates the 
receiving line item corresponding to the shipping line items being processed and 
processes receipt of the order (see “Process Receipt Button” on page 359).

NOTE: Step 2 and Step 3 are independent processes, so they generate separate 
De-Allocate transactions. This is useful for auditing. 
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Receiving applies to all types of orders:

■ Replenishment of internal orders or internal transfers received by a field office, 
a repair center, or a field service engineer.

■ RMAs (returns from a customer).

■ Purchase orders and repair orders (receipt from an external vendor).

■ For convenience, another receipt type, Unknown, is included to encompasses 
any other items received.

When an item is received, a receipt is generated as proof that the item arrived. 
Figure 10 illustrates the receiving process, which consists of the following steps:

1 If the order is unidentified, generate unknown receipt. If the order is identified, 
create a receipt (Internal, Purchase/Repair Order, or RMA).

2 Generate transactions.

Field Service performs the necessary inventory transactions and creates the 
necessary line item actions on received orders.

Figure 10. Receiving Process
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Checks and Validations for Shipping and Receiving
Siebel Field Service provides these automatic validations for shipping and receiving 
transactions:

■ Quantity to ship should be less than or equal to the quantity allocated.

■ Quantity to receive should be less than or equal to the quantity shipped.

■ Total number of assets should be equal to the total quantity of a serialized 
product.

■ While generating inventory transactions, validates the source location of 
serialized asset. 

After an inventory transaction is generated, no update is allowed for the shipped or 
received line item. However, it is possible to receive partial shipments for all order 
types except internal orders. New receive actions may be added as long as the 
quantity of items received does not exceed the quantity in the order.

Process Receipt Button
The Process Receipt button is located in the Receive Internal Order, Receive 
Purchase Order, and Receive RMA views in the Receiving screen. This button 
generates the following processes within Siebel Field Service:

■ Verifies that the asset physically exists at the source inventory location.

■ Based on an Order Type of Internal/Other, generates the appropriate inventory 
transactions (for example, Receive Internal, Receive Other, and Receive from TP) 
affecting inventory levels. Refer to Table 86 on page 326. 

■ If the product received was serialized, checks that the total number of assets 
received matches the product quantity.
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Shipping and Receiving Hierarchical Assets
When you ship or receive a hierarchical asset, changes occur in certain fields of the 
asset’s parent component according to the type of shipping or receiving transaction 
that occurs. Whether these effects occur on the fields of the hierarchical asset's 
child sub-components depends on whether the fields are set to cascade their values 
from the parent to the child. For more information about hierarchical assets, see 
“Hierarchical Assets” on page 492.
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Processing and Tracking Shipments
Follow these procedures to process the shipping of orders.

To ship an order

1 Navigate to the Shipping screen.

The Pick Tickets view appears.

2 In the Pick Tickets list, select a pick ticket.

3 Click the Pick Ticket subview tab. 

4 In the Allocated Lines list, select a line item.

5 If the selected line item is a serialized product, add a new record for it in the 
Serial Numbers list.

6 In the Allocated Lines list, click Ship to ship one or more selected line items, or 
click Ship All to ship all line items.

This generates a shipped quantity in the Shipped Line subview that is equal to 
the allocated quantity for the line items.

7 In the Pick Ticket form, click Process Shipment to create inventory transactions 
for the line items selected in the Allocated Lines list and for the quantities 
specified in the Shipped Line form.

NOTE: If the Qty field on the Shipped Line form does not contain a value, clicking 
Process Shipment will not create inventory transactions. 

To find a pick ticket for a line item

1 Navigate to the Orders screen.

2 From the Show drop-down list, select an option for displaying service orders or 
sales orders. 

3 Select an order.

4 Click the Line Items view tab and select a line item.
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5 In the Actions list, select the Action record and copy the number in the Pick 
Ticket field. 

6 Navigate to the Shipping screen.

7 In the Pick Tickets list, query the pick ticket number.

To consolidate pick tickets

1 Navigate to the Shipping screen.

The Pick Tickets view appears

2 In the Pick Tickets list, select a pick ticket.

3 From the Show drop-down list, select Consolidation.

4 In the Qualified Lines tab, select one or more other pick tickets to add to the 
consolidation.

5 Click Consolidate.

Line items move from the Qualified Lines applet to the Consolidated Lines 
applet.

To fill in waybills for pick tickets

1 Navigate to the Shipping screen.

The Pick Tickets view appears.

2 In the Pick Tickets list, select a pick ticket.

3 Click the Waybill view tab.

4 Complete the fields as needed to ship the items in the selected pick ticket.
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Processing and Tracking Receipts
Follow these procedures to process the receiving of orders.

To receive an order

1 Navigate to the Receiving screen.

2 Select an order in the Pending Internal Orders list or the Pending POs/ROs/RMAs 
list. 

3 Click the hyperlink in the Receive Type field. 

Either the Receive Internal Order, Receive PO, Receive Repair Order, or Receive 
RMA view appears.

4 In the Line Items list, select a record for a line item to receive. 

5 In the Received Line Item subview, create new records and enter details of the 
line items received. 

6 For serialized line items, in the Serial Numbers subview, create new records and 
enter details of the line items received. 

7 In the Receive Order form, click Process Receipt. 

This generates the appropriate inventory transactions (see “Process Receipt 
Button” on page 359).

To receive repaired items from a third-party vendor

1 Navigate to the Receiving screen.

The All Pending Orders view appears.

2 Select a repair order in the Pending POs/ROs/RMAs list. 

3 Click the hyperlink in the Receive Type field. 

The Receive Repair Order view appears.

4 In the Line Items list, select a record for a line item to receive. 

5 In the Received Line Item subview, create a record that defines the conditions of 
receipt for the selected line item.
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6 In the Repairs subview, create a repair record for the selected line item. 

7 In the Receive Order form, click Process Receipt. 

This records the movement of inventory from the third-party repair vendor to 
the specified inventory location. 

To review all line items for all orders

1 Navigate to the Receiving screen.

2 In the Show drop-down list, select Line Item Receipts.

The Line Item Receipts list shows all received parts.

3 Select a line item and do one or more of the following:

■ Click the hyperlink in the Type field. 

The receipt form for the selected order type shows the status of the receipt 
and the line items received.

■ Click the hyperlink in the Order # field. 

The receipt form for the selected order number shows details of the original 
order.

■ Click the hyperlink in the Waybill # field. 

The receipt form for the selected waybill number shows the shipping waybill 
for this order.

To add Unknown Receipt records

1 Navigate to the Receiving screen.

2 In the Show drop-down list, select All Unknown Receipts.

The Unknown Receipts view shows all shipments received with incomplete 
information.

3 In the Unknown Receipts list, select an item. 
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4 Click the hyperlink on Shipment #.

The Receive Unknown form appears.

5 In the Receive Unknown form, create a new record for the unknown receipt and 
enter values in the fields as needed.

6 If the order number is unknown, you can select a possible order number in the 
Match Order # field.

7 If the receipt has line items with serial numbers, do the following:

a Select a serialized line item. 

b In the Received Serial Numbers list, create a new record for the selected line 
item and enter the serial number.

To review all line items received with incomplete documentation

1 Navigate to the Receiving screen.

2 In the Show drop-down list, select All Unknown Receipts.

The Unknown Receipts view shows all shipments received with incomplete 
information.

3 In the Unknown Receipts list, select an item and do one or more of the following: 

■ If a value is present in the Shipment # field, click the hyperlink.

The Receive Unknown form shows the status of the receipt and the line items 
received.

■ If a value is present in the Match Order # field, click the hyperlink.

The Order form shows information about this order.

■ If a value is present in the Waybill # field, click the hyperlink.

The Waybill Information form shows the shipping waybill for this order.
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The Shipping screen provides information for processing shipments. 

Pick Tickets View
The Pick Tickets view displays pick ticket records generated for specific orders. 
Pick tickets are generated automatically, by the Fulfillment and Part Locator 
Engines, or interactively by using the Generate Pick Tickets button on the Orders 
screen (see the “Generate PickTickets Command” on page 284). The user can 
also create pick ticket records in this view.

The Pending Pick Ticket views, selected from the Show drop-down list, display only 
pick ticket records with a status of Open. The user can create records in this view 
with any status, but only records of status Open appear on return to this view.

Table 93 describes items in the Pick Tickets view.

The Pick Ticket view (see“Pick Ticket View” on page 367) lists the allocated line 
items included in each pick ticket and associated order. 

Pick Tickets and Orders
Pick tickets and orders have the following relationship: 

1 Orders have one or many line items. 

2 Line Items may have one or many records (actions) in the database.

3 One or many records (of type Allocate) can be associated with one pick ticket. 

Table 93. Selected Items in the Pick Tickets View

Item Description

Shipment # A type-in field for a shipping number. The default is the pick ticket number.

Waybill # A type-in field for a waybill number. This field is linked to the Waybill # field 
in the Waybill view.
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While Order ID and Order Item ID do not appear in the Pick Tickets view, these 
values reside in the database:

■ S_SHIPMENT_ID and S_ORDER_ITEM_ID in the S_ORDPART_MVMT table

■ S_ORDER_ID in the S_ORDER_ITEM table

Pick Ticket View
The Pick Ticket view records the allocated parts that appear in a pick ticket record 
and allows the user to generate inventory transactions (see Table 86 on page 326) 
affecting shipping and allocation of inventory. Table 94 describes a button in the 
Pick Ticket view.

The Pick Ticket view has three subviews, Allocated Lines, Shipped Line, and 
Serial Numbers.

Table 94. Selected Item in the Pick Ticket View

Item Description

Process Shipment Button and command. Generates Ship and De-Allocate inventory 
transactions, when appropriate, for the allocated pick ticket line items 
(that appear in the Allocated Lines subview). For the mechanism of 
this button, see “Process Shipment Button” on page 357. After this 
button is activated, the Pick Ticket Status field in the Pick Tickets 
view (see “Pick Tickets View” on page 366) is set automatically to 
Closed.

Note that for orders of type Internal, the status becomes Shipped 
instead of Closed.
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Allocated Lines Subview
The Allocated Lines subview shows the allocated line items associated with a pick 
ticket. It also shows the preferred locations in inventory to obtain each line item. 
This view is read-only. Table 95 describes items in the Pick Ticket view.

Shipped Line Subview
The Shipped Line subview shows the number of items allocated in the database for 
shipment by the Ship button (see the “Allocated Lines Subview” on page 368). The 
Qty field is read-write and accepts values less than the value in the Qty field in the 
Shipped Lines subview. Table 96 describes items in the Shipped Lines subview.

NOTE: If the Shipped Line quantity is less than the quantity in a selected record in 
the Allocated Lines list, the excess is de-allocated through a De-Allocate transaction. 
The De-Allocate transaction (and any other transaction) takes place when the user 
clicks the Process Shipment button.

Table 95. Selected Items in the Pick Ticket View

Item Description

Ship/Ship All These buttons create a record or records in the Shipped Line subview 
with the same quantity as the Qty field in the Allocated Lines subview. 
These buttons do not create inventory transactions. 

Qty The number of items (of this product) shipped. This number matches 
the quantity processed for shipping, displayed in the Shipped Line 
subview. The Process Shipment button determines this value. 

Location 1/2/3 These fields may be used to optimize the pick-pack-ship process. 
They are informational only.

Table 96. Selected Items in the Shipped Line Subview

Item Description

New This button allows the user to enter the shipped quantity (in the Qty field) when 
that quantity is less than the allocated quantity. This creates a record of the type 
Ship.

Qty The number of items shipped. 
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Serial Numbers Subview
The Serial Numbers subview accepts serial numbers for the selected Allocated line 
items. Serial numbers for items available in inventory are selected from a dialog 
box. The number of records cannot exceed the quantity in the Shipped Line 
subview. The quantity in the Shipped Lines subview cannot be greater than the 
quantity in the Allocated Lines subview. 

This view is active only if the Shipped Lines subview displays a number of shipped 
items. The New command for adding records is available only if the selected, 
allocated line references a serialized product.

NOTE: If a product is serialized by checking the Serialized check box in the Product 
Field Service Details view (see “Product Field Service Details View” on page 302), 
then a serial number is required for all movements and transactions of assets of 
this product.

Repair Pick Ticket View
The Repair Pick Ticket view processes the shipment of line items allocated for a 
repair order. The Pick Ticket, Allocated Lines, and Shipped Line views are identical 
to those in the Pick Ticket view (see “Pick Ticket View” on page 367). Instead of 
associating serial numbers with shipped products, this view uses the Repair # 
subview to associate repair numbers. 

The number of repair numbers records must match the Qty field in the Shipped 
Lines subview. This validation constraint is enforced both for selected products that 
are serialized and non-serialized.
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Waybill View
The Waybill view associates waybill records with pick tickets. Table 97 describes 
items in the Waybill view.

Consolidation View
The Consolidation view is a variation of the Pick Ticket view, selected from the 
Show drop-down list, that combines line items from existing pick tickets into a 
single pick ticket. The purpose is to reduce shipping costs. The line items must have 
the same Ship To address, be shipped from the same inventory location, and have 
the same order type. All order types, except for Repair Orders, are processed in the 
this view.

The Consolidation view has two subviews, Qualified Lines and Consolidated Lines. 

Qualified Lines Subview
The Qualified Lines subview displays lines allocated for pick tickets that have the 
following attributes:

■ Open or pending status

■ Same Ship To address

■ Same source inventory location

■ Same order type

Table 97. Selected Items in the Waybill View

Item Description

Shipment # A type-in field for a shipping number. The default is the pick ticket number.

Waybill # A type-in field for a waybill number. This field is linked to the Waybill # field 
in the Waybill view.
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Table 98 describes a button in the Qualified Lines subview.

Consolidated Lines Subview
The Consolidated Lines subview shows the products and quantities combined into 
one pick ticket. The consolidated lines are processed as though they were part of 
the original order.

Table 98. Selected Item in the Qualified Lines View

Item Description

Consolidate Button and command. Copies the qualified line to the selected pick ticket. 
The result of this consolidation appears in the Consolidated Lines subview. 
The donor pick ticket no longer appears in the All Pick Tickets view.
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Shipping Reports
Shipping provides the Pick Ticket Details (Barcode) report and the Pick Ticket 
Details (No Barcode) report. These reports describe each pick ticket and its 
associated products. 
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The Receiving screen tracks incoming orders and their line items. These orders 
originate on the Service Orders screen. For information about service orders, see 
Siebel Order Management Guide.

All Pending Orders View 
The All Pending Orders view, selected from the Show drop-down list, shows all 
orders not yet received. The view contains two subviews: Pending Internal Orders 
and Pending POs/ROs/RMAs.

NOTE: All fields in this view are read-only.

Pending Internal Orders Subview
The Pending Internal Orders view shows all orders arriving from internal inventory 
locations. The line items that appear have a Receive Type of Internal and a status of 
Shipped. The data in this subview originates on the Shipping screen (see “Shipping 
Screen” on page 366).

Pending POs/ROs/RMAs Subview
The Pending POs/ROs/RMAs view shows all orders arriving from external locations 
and resulting from purchase orders, repair orders, and return material 
authorizations of all types.

The line items that appear here are from orders that do not have a Receive Type of 
Sales Order, Web Order, Service Order, or Internal Order and do not have a status of 
Cancelled or Closed.

Receive Orders Views
Clicking on any Receive Type value in the All Pending Orders view exposes a 
corresponding Receive Order view:

■ Receive Internal Order

■ Receive PO
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■ Receive Repair Order

■ Receive RMA

NOTE: The Receive Unknown view is available only from the All Unknown Receipts 
view. For the procedure, see “To add Unknown Receipt records” on page 364.

The Receive Orders views have a Process Receipt button that carries out validations 
for the selected receipt and creates the appropriate inventory transaction (see 
“Process Receipt Button” on page 359).

Line Items Subview
The Line Items subview lists the items received in the selected receipt. The Qty field 
shows the number of each line item in the received order. The records are read-only.

Received Line Item Subview
The Received Line Item subview records the inventory level (availability and status) 
and destination inventory location of received line items. The total quantity cannot 
exceed the Qty value in the selected Line Items record. 

Serial Numbers Subview
The Serial Numbers subview records the serial/asset number for each serialized 
asset received as part of the selected line item. This view accepts only as many 
records as the total quantity in the Received Line Item view.

NOTE: The Serial Number subview does not verify the uniqueness of serial numbers. 

Line Items Receipts View
The Line Items Receipts view, selected from the Show drop-down list, shows all line 
items, pending, processed, and closed, for all orders. This view is useful for auditing 
receipts. For example, a Query by Example (QBE) could return all line items 
received at a location during a specific time interval. All fields in this view are 
read-only.
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All Unknown Receipts View
The All Unknown Receipts view, selected from the Show drop-down list, shows 
received items that arrive with incomplete documentation. Users create this data 
and an administrator matches records with existing orders. All fields in this view 
are read-only.

Receive Unknown View
The Receive Unknown view is available only from the All Unknown Receipts view. 
For the procedure, see “To add Unknown Receipt records” on page 364.

The Match Order # field in this view lets the user choose an order, from the Pick 
Order dialog box, to which this unknown receipt might belong.
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Cycle Counting and Replenishment 11
This chapter presents the features of Siebel Field Service for maintaining inventory: 
cycle counting and replenishment. These functions are part of the Logistics 
Management module.
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Cycle Counting
Cycle counting is a method of counting inventory by grouping products into classes 
and counting the products in each class at designated intervals over a period of 
time. Only part of the products are counted at one time, but over the designated 
time period all products are counted. Products of class A, for instance, might be 
counted once every three months, products of class B once every six months, 
and products of class C once a year.

Since assets are moving in and out of inventory, cycle counting creates a dynamic, 
statistical view of inventory. To enhance statistical accuracy, cycle counting uses 
two methods of product classification (the cycle count basis): ABC and XYZ.

■ The ABC cycle count basis ranks products according to their financial value. 
The Cycle Counting Engine counts the items with a larger dollar value more 
often than those with a lower value.

■ The XYZ cycle count basis ranks products according to their turnover. Higher-
turnover products are counted more often, resulting in a higher accuracy of 
counting.

Cycle counting is configured for inventory location types, inventory locations, 
and products.

NOTE: If a configuration parameter for cycle counting can be set at different levels, 
the parameter for the more specific level takes precedence. For example, the cycle 
count basis (ABC or XYZ, meaning cycle counting based on the value of items 
versus their turnover rate) for an inventory location takes precedence over that for 
an inventory type. The cycle count class, A, B, or C; X, Y, or Z (meaning that it has 
high, medium, or low relative value or turnover rate), for an inventory type takes 
precedence over that for a product.

The Cycle Counting Engine requires this input:

■ One or more inventory locations

■ A start date for creating inventory lists for cycle counting

■ An end date for creating inventory lists for cycle counting
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Whenever the Cycle Counting Engine runs, it produces the following output:

■ Cycle counting periods, which define the calendar dates covered by a 
cycle count.

■ Cycle counting records (headers).

■ Part lists for each cycle counting record. The part list provides instructions for 
the next physical count of inventory. 

The Cycle Counts screen, Part List view accepts manual input of the count data. The 
Cycle Counting Engine compares this to the inventory records in its database, and, 
if there is a variance, allows for an adjustment of inventory. 

Figure 11 on page 380 illustrates the decision path that the Cycle Counting Engine 
uses to generate a parts lists. In following the decision path, the Cycle Counting 
Engine goes through the following steps:

1 Identifies the cycle-counting basis (ABC or XYZ) for the specified inventory 
location or location type.

2 If any remaining product category is to be handled, calculates the number of 
products to count today. If no remaining product category is to be handled, 
prints a parts list.

3 If there are any remaining uncounted products in the category, selects a product 
category that has not been counted in this counting period.

4 Adds the selected product to the parts list (or cycle counting order); flags the 
product counted.
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5 If the products to be counted today have been selected, returns to Step 2. If the 
products to be counted today have not been selected yet, returns to Step 3.

Figure 11. Logic of the Cycle Counting Engine
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Configuration of the Cycle Counting Engine
The Cycle Counting Engine generates cycle counting headers and cycle counting 
part lists by using the configuration information from the Cycle Counts view 
(see“Cycle Counts View” on page 408). 

Cycle counting uses these configuration parameters:

■ ABC or XYZ count basis. The method used for cycle counting of an inventory 
location: ABC = financial value basis, XYZ = turnover basis.

■ A, B, or C classification. The classification of products based on the financial 
value of an item, where A > B > C. 

■ X, Y, or Z classification. The classification of products based on the turnover 
of an item, where X >Y >Z. 

A product receives any combination of class A, B, or C and X, Y, or Z; for 
example, AY. However, cycle counting is based on either ABC or XYZ, not both.

■ Frequency. The interval in days between physical counts of inventory at a 
location; for example, if counting frequency is 7 days, inventory is counted every 
seven days.

■ Period. The time period in days allotted to counting all A or X, B or Y, or C or Z 
class items at this location. For example, if the counting period for class A or X 
products is 90 days, the Cycle Counting Engine makes sure that all the products 
in this class are included in the part list at least once every 90 days. 

■ Start Date and End Date. The time span in calendar days during which the Cycle 
Counting Engine will create cycle count records.

Here is an example of a cycle counting scenario:

An inventory location is configured to count on a financial value basis (ABC). 
There are approximately 100 A-class products in inventory. Every five days 
(Frequency = 5 days) someone spends as much time as needed to count one-
quarter (5/20) of the A-class items, with the goal of counting all of the A-class items 
within 20 days (Counting Period A/X = 20 days). Counting periods do not have to 
be even multiples of frequency.
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Configuration Information for the Cycle Counting Engine
Configuration of cycle counting takes place at several levels, on different screens 
(see Table 99). 

NOTE: If a configuration parameter can be set at different aspects of inventory, the 
parameter for the more specific aspect takes precedence. For example, the count 
basis (ABC or XYZ) at an inventory location takes precedence over the basis 
specified for an inventory type. The cycle count class (A, B, or C; X, Y, or Z) for an 
inventory type takes precedence over that for a product. 

Table 99. Configuration of Cycle Counting

Configuration Parameter Applies to View

Cycle count basis: 
ABC or XYZ

Inventory locations See “Inventory Locations View” on 
page 405.

Inventory location types See “Inventory Location Types View” on 
page 402.

Cycle count class: 
A, B, or C and X, Y, or Z

Products associated with a specific 
inventory types

See “Inventory Options Subview” on 
page 403.

Products associated with specific 
inventory locations

See “Product Inventory Subview” on 
page 406.

Frequency Inventory locations See “Inventory Locations View” on 
page 405.

Inventory location types See “Inventory Location Types View” on 
page 402.

Count period for A/X, B/Y, 
and C/Z

Inventory locations See the “Inventory Locations View” on 
page 405.

Inventory location types See the “Inventory Location Types View” 
on page 402.

Start date and end date Inventory locations See the “Cycle Counts Views” on 
page 410 (on the Cycle Counts screen).
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System Preferences for the Cycle Counting Engine
The Field Service engines have system preferences (Table 100 on page 383) that 
determine the behavior of each engine. These system preferences are stored in the 
table S_SYS_PREF. The BusComp is System Preferences. These are the columns of 
main interest:

■ SYS_PREF_CD. Name of the System Preference.

■ VAL. Value of the System Preference.

Changing the values of these preferences changes the default behavior of 
the engine.

NOTE: To register changes to System Preferences, restart the Field Service server.

Only the inventory levels (buckets) whose Availability and Status match the values 
defined by the above two parameters are included in the cycle counting process.

Table 100. System Preferences for the Cycle Counting Engine

Parameter Default Value Comments

BucketAvailCDtobeCounted OnHand, Customer-Owned Specifies the valid values for 
the buckets’1 availability 
code. The values should be 
from the Bucket Availability 
Code LOV, and individual 
values should be LIVs.

1. The new term for bucket is inventory level.

BucketStatusCDtobeCounted Good Specifies the valid values for 
the buckets’ status code. 
The values should be from 
the Bucket Status Code LOV 
and individual values 
should be LIVs.
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Parameters for the Cycle Counting Engine
All engines can be invoked from the Workflow Manager or from the client. The 
engines require certain parameters to be passed. These parameters are set for the 
component FSCyccnt in Server Requests screen, My Component Requests view. 
Table 101 describes the parameters for the Cycle Counting Engine.

Table 101. Parameters for the Cycle Counting Engine

Parameter Value Comments

Mode SQL Specify the WHERE clause to set up criteria 
and count the parts which meet that criteria.

Id Specify the ID of the inventory location or 
the inventory type and only the parts related 
to that loc/type will be counted.

TempTbl Put all the required parameters into a 
temporary table with a temporary Client 
Request ID and pass that ID to the server to 
retrieve the parameters from Temp Table.

ClientId A row ID for retrieving params 
from the temp table

Required when Mode = TempTbl.

RowID Row ID of an Inventory 
location or Inventory type

Required when Mode = ID.

StartDT Start Date Required. The proposed start date of cycle 
counting.

EndDT End Date Required. The proposed end date of cycle 
counting.

Where Where Clause Business Component search spec mode. 
Required when Mode = SQL.

Loc/Type Inventory Location or 
Inventory Type

Required when Mode = ID or TempTbl.
384 Siebel Field Service Guide Version 7.5, Rev. A



Cycle Counting and Replenishment

Cycle Counting
Methods to Run the Cycle Counting Engine
Use these methods to invoke the Cycle Counting Engine:

■ Invoke the engine from Server Administration > Enterprise Operations > 
Component Requests or Repeating Component Requests views.

■ Invoke the engine by clicking the Generate Counts or the Generate Counts 
(All Locations) button in the Inventory screen, Cycle Counts view.

■ Invoke the engine through the server manager on the application server.

Tracing for the Cycle Counting Engine
You can set different tracing levels for the Cycle Counting Engine, depending on the 
type and quantity of information you want to collect. For information about this 
functionality, see Appendix A, “Engines Logging Levels.”
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Setting Up Cycle Counting
Follow these procedures to set up cycle counting.

To specify asynchronous operation of the Cycle Counting Engine for a specific user

1 From the application-level menu, choose View > User Preferences.

2 From the Show drop-down list, select Service.

3 In the section ASYNCHRONOUS GENERATION OF, select Cycle Counts.

To set component request parameters for the Cycle Counting Engine

1 Insert or edit a component request for the Field Service Cycle Counting Engine 
server component.

2 Add or modify the server component parameters as needed.

For information about server components and component parameters, see Siebel 
Server Administration Guide.

To set a repeating component request for the Cycle Counting Engine

1 Navigate to Site Map > Server Administration > Enterprise Operations.

2 In the Enterprise Servers list, select the server on which you want the Cycle 
Counting Engine component to run. 

3 Click the Repeating Component Requests view tab. 

4 In the Repeating Component Requests form, create a new record. 

5 In the Component/Job field, select Field Service Cycle Counting Engine.

6 Complete the other fields, as needed. 
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7 In the Component Request Parameters list, create new records with field values 
as shown in the following table.

NOTE: If the value of Start Date is equal to the value of End Date, then all the parts 
will appear on one list that can be used for physical inventory.

CAUTION: The Field Service Cycle Counting Engine server component accepts 
date value parameters only in the exact format MM-DD-YYYY. If you enter the 
date in another format, the field will display your entry, but the Cycle Counting 
Engine will not start. 

8 Add additional component request parameters, if needed.

For information about server components and component parameters, see Siebel 
Server Administration Guide.

To change system preferences for the Cycle Counting Engine

1 Navigate to Site Map > Application Administration > System Preferences.

2 In the System Preference Name column, locate the system preference whose 
value you want to change. 

NOTE: For cycle counting engine-related system preferences, see Table 100 on 
page 383).

Name Value

Start Date Date for the repeating component request to start 
running. Enter the date in the format MM-DD-YYYY. 

For example, if you want the request to start running on 
May 22, 2003, enter 05-22-2003. 

End Date Date for the repeating component request to stop 
running. Enter the date in the format MM-DD-YYYY. 

For example, if you want the request to stop running on 
July 15, 2003, enter 07-15-2003. 
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3 In the System Preference Value field, enter a new value.

4 To register changes to system preferences, restart the Field Service server.

To set up cycle counts for specific inventory locations

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.

3 In the More Info form, enter values for the Count Basis, Frequency, and Period 
fields. 

To define the start date and end date for cycle counting

1 Navigate to Inventory > Cycle Counts.

2 In the Inventory Locations list, select an inventory location.

3 In the More Info list, locate the cycle count whose start and end dates you want 
to set.

4 Enter values for the Started and Ended dates.

To define the cycle count basis for inventory locations

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.

3 In the More Info form, in the Count Basis field, select ABC or XYZ.

To define the cycle count basis for inventory location types

1 Navigate to Site Map > Service Administration > Service Inventory.

2 In the Inventory Location Types list, select an existing inventory type record or 
add a new one.

3 In the Count Basis field, select ABC or XYZ.

To define cycle count classes for products at specific inventory locations

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.
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3 Click the Product Inventory tab.

4 Select a product.

5 In the ABC Class and XYZ Class fields, select the relevant cycle counting 
classes (A, B, or C; X, Y, or Z).

To define the cycle count class for products associated with specific 
inventory types

1 Navigate to Site Map > Product Administration.

2 In the Products list, select a product.

3 In the More Info view tab’s Show drop-down list, select Product Service Details.

4 On the Inventory Options subview tab, select an existing inventory type or add 
a new type. 

5 In the Class ABC and Class XYZ fields, select the relevant cycle counting 
classes (A, B, or C; X, Y, or Z).

To define cycle counting frequency and periods for an inventory location

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.

3 On the More Info tab, click the show more button.

4 In the Frequency field, enter the number of days.

5 In the Period A/X, Period B/Y, and Period C/Z fields, enter the relevant 
numbers of days.

To define cycle counting frequency and periods for an inventory location type

1 Navigate to Site Map > Service Administration > Service Inventory.

2 In the Inventory Location Types list, select an existing inventory location type or 
add a new inventory location type. 

3 In the Frequency field, enter the number of days.

4 In the Period A/X, Period B/Y, and Period C/Z fields, enter the relevant 
numbers of days.
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To configure tracing for the Cycle Counting Engine

1 Navigate to Site Map > Server Administration >Servers.

2 Click the Server Parameters view tab.

3 In the Server Parameters list, locate the Trace Flags parameter.

4 Set the appropriate values for the fields in the Trace Flags parameter record.

To manually specify parts for a cycle count

1 Navigate to Inventory > Cycle Counts.

2 In the Inventory Locations list, select an inventory location where the cycle 
count will take place.

3 On the Cycle Counts subview tab, select a cycle count.

4 Click the hyperlink in the Cycle Counts record’s Status field. 

5 In the Part List tab, add a new record.

6 In the Product field, select a product.

7 Complete the other fields as needed. 
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Follow these procedures to carry out cycle counts of inventory.

To run the Cycle Counting Engine interactively 

1 Navigate to Inventory > Cycle Counts.

2 In the Inventory Locations list, select an inventory location for cycle counting.

3 Do one of the following:

■ Click Generate Counts to produce cycle count lists for the selected 
inventory location. 

■ Click the menu button and select Generate Counts (All Locations) to produce 
count lists for all inventory locations.

The cycle counts appear on the Cycle Counts subview tab.

To review pending cycle counts and parts lists for cycle counting

1 Navigate to Inventory > Cycle Counts.

2 In the Inventory Locations list, select an inventory location.

The Cycle Counts subview shows records describing each instance of a cycle 
count. Pending cycle counts have a status of Open or Assigned.

3 Select a cycle count record.

4 Click the hyperlink in the Cycle Counts record’s Status field. 

The Part List tab shows all items included in the selected cycle count.

To record the results of a cycle count

1 Navigate to Site Map > Cycle Counts. 

2 In the Cycle Counts list, select a cycle count record.

3 Click the Part List view tab.

4 In the Count field of each product record, enter the quantity counted. 
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5 If a counted item is serialized:

a Select the product record.

b Enter a value in the Count field.

c Click the Counted Serial Numbers subview tab.

d In the Counted Serial Numbers list, create a record for each serialized asset 
that is an instance of that product.

To complete a cycle count

1 Navigate to Site Map > Cycle Counts.

2 In the Cycle Counts list, select a cycle count record.

3 Click the Part List view tab.

4 Click Count Complete.

This populates the records in the Variance view and the Counted Serial 
Numbers subview.

To review a cycle count

1 Navigate to Site Map > Cycle Counts.

2 In the Cycle Counts list, select a cycle count record.

3 Click the Variance view tab.

4 Review the results (Original, Count, and Variance) of the product count and 
counted serial numbers, if applicable.

5 To adjust the inventory, click Adjust.
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Replenishment is the process of generating orders to restock depleted parts in an 
inventory location. The Replenishment Engine generates internal orders to other 
inventory locations or purchase orders to outside vendors using the following 
information about a product in inventory:

■ Minimum and maximum stock levels, plus a safety level

■ Replenishment relationships with other inventories

There are three sources for replenishment: 

■ Another service inventory location. The Replenishment Engine generates an 
internal order. For example, the main service warehouse replenishes a subsidiary 
warehouse.

■ External provider. The product is purchased from an external vendor. In this case, 
the Replenishment Engine generates a purchase order. 

■ Manufacturing inventory. The product is provided by an internal manufacturing 
division. Such replenishments are usually handled as if from an external 
provider; a purchase order is generated.

NOTE: Replenishment is different from fulfillment (see “Fulfillment Overview” on 
page 282). The replenishment process creates orders to restock inventory; the 
fulfillment process allocates items to fill outgoing orders and generates pick tickets.

The Replenishment Engine requires as input one or more inventory locations.
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Configuration of the Replenishment Engine
The Replenishment Engine uses the configuration parameters listed in Table 102.

System Preferences for the Replenishment Engine
The Field Service engines have system preferences, listed in Table 103 on page 395, 
which determine the behavior of each engine. These system preferences are stored 
in the table S_SYS_PREF. The BusComp is System Preferences. These are the 
columns of main interest:

■ SYS_PREF_CD. Name of the system preference.

Table 102. Configuration of Replenishment

Configuration Parameter Applies to View

Minimum quantity of product 
to keep in stock

Product See the “Product Inventory View” 
on page 347.

Maximum quantity of product 
to keep in stock

Product See the “Product Inventory View” 
on page 347.

Relationships 
among inventory locations

Inventory location See the “Relationships View” on 
page 349.

Vendor Product See Product Administration > 
Product Field Service Details. 

Vendors 
for an inventory location

Inventory location See the “Vendors View” on 
page 349.
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■ VAL. Value of the system preference.

The last three parameters specify what kind of orders, order items, and order types 
to look for when searching for an existing order, to avoid creating duplicate orders.

CAUTION: The Order Status List of Values should have Open as its Language 
Independent Value. If it does not, the Replenishment Engine will not work.

NOTE: To register changes to System Preferences, restart the Field Service server.

Table 103. System Preferences for the Replenishment Engine

Parameter Default Value Comments

InvLocTypeForReplenishRelation Warehouse Specifies the default replenishment level. Orders 
to replenish any level of an inventory location 
have this value as their Destination.

ReplenishOrderPriority Medium Specifies the default order priority for newly 
created orders. The values should be from the 
Order Priority LOV and individual values should 
be LIVs.

OrderItemStatusForOnOrderQty Open, New, Pending Specifies the valid values for the existing order 
item status. The values should be from the Order 
Item Status LOV and individual values should be 
LIVs. 

OrderStatusForOnOrderQty Open, New, Pending Specifies the valid values for the existing order 
status. The values should be from the Order Status 
LOV and individual values should be LIVs.

OrderTypeForOnOrderQty Internal Order, 
Purchase Order

Specifies the valid values for the existing order 
type. The values should be from the Order Type 
LOV and individual values should be LIVs.
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Parameters for the Replenishment Engine
All engines can be invoked from the Workflow Manager or from the client. These 
engines require certain parameters to be passed. These parameters are set for the 
component FSRepl in the Server Component Requests screen, My Component 
Requests view. Table 104 lists the parameters for the Replenishment engine, and 
what they mean.

To set the Implementation Logic for the Replenishment Engine

1 Obtain the system preferences from the system table.

Obtain the user defined parameters to determine the defaults for the 
Replenishment Engine.

Table 104. Parameters for the Replenishment Engine

Parameter Value Comments

InvokeMode Id In this mode, specify the inventory location to 
be replenished and the engine will replenish 
the specified location.

SQL In this mode, specify the WHERE clause, 
meaning specify some criteria and replenish 
the inventory locations which meet that 
criteria.

TEMP In this mode, put all the required parameters 
into a temporary table with a particular Client 
Request ID and pass that ID to the server to 
retrieve the parameters from Temp Table.

ClientId A row ID for retrieving 
parameters from the temp 
table

Required when InvokeMode = TEMP.

SourceType I (Inventory Location) 
V (Vendor)

Required when InvokeMode = TEMP. 
Defaults to I when InvokeMode = Id or SQL.

DestId Destination Inventory ID Required when InvokeMode = Id.

WhereClause SQL Where Clause Business Component search spec. Required 
when InvokeMode = SQL.
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2 Obtain the destination inventory location.

Obtain the value of the destination inventory location based on the Invoke mode 
from one of the following sources:

■ Input Parameter - DestId

■ Input Parameter - Where Clause

■ Temp Table

3 Generate Internal Orders for all the Destination Inventory Locations.

If the InvokeMode is Id/SQL, get the Source Inventory Location for the current 
Destination Inventory location.

Get the On Hand, Min, and Max Qty for all the products in the Destination 
inventory location and the child locations whose On Hand Qty < Min Qty.

For each product do the following:

Calculate the EffectiveQty:
Search existing orders and find the Qty on order.
EffectiveQty = Qty + Qty on order.
If EffectiveQty is less than the Min Qty:
If the order header does not exist (first time only), generate the order
header of type Internal order.
Add a line item to the order header for the ReqQty = 
Max Qty − Effective Qty.
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4 Generate Purchase Order.

Get the On Hand, Min, and Max Qty for all the products in the Destination 
inventory location and the child locations whose On Hand Qty < Min Qty.

For each product do the following:

Calculate the EffectiveQty:
Search existing orders and find the Qty on order.
EffectiveQty = Qty + Qty on order.
If EffectiveQty is less than the Min Qty:
Get the Vendor for this product.
If Vendor exists in the user supplied Vendor list, then:
If the order header does not exists (first time only), generate the 
order header of type Purchase order.
Add a line item to the order header for the 
ReqQty = Max Qty − Effective Qty.

Methods to Run the Replenishment Engine
Use these methods to invoke the Replenishment Engine:

■ Invoke the engine using the Workflow Manager to generate internal and 
purchase orders, based on stock levels.

■ Invoke the engine by clicking the Orders button in the Inventory screen, 
Generate Orders view.

■ Invoke the engine through the Server Manager on the application server.
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Follow these procedures to set up replenishment.

Some procedures for setting up replenishment are the same as for setting up cycle 
counting. When beginning to set up replenishment, use the following procedures, 
and for “cycle counting,” substitute “replenishment.”

■ “To specify asynchronous operation of the Cycle Counting Engine for a specific 
user” on page 386

■ “To set component request parameters for the Cycle Counting Engine” on 
page 386

■ “To change system preferences for the Cycle Counting Engine” on page 387

To set the maximum and minimum quantity of products to keep in stock

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.

3 Click the Product Inventory view tab.

4 Select a product.

5 For the selected product, enter values in the Max, Min, and Safety fields.

To set up replenishment relationships between inventory locations

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.

3 Click the Relationships tab.

4 Create a new relationship record.

5 In the Name field, select another inventory location.

6 In the Relationship field, select Replenishes.

To set up a vendor for a product

1 Navigate to the Products screen.
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2 Select a product.

3 Click the Service Details view tab.

4 From the Show drop-down list, select Inventory Options.

5 In the Primary Vendor field, select a vendor.
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Replenishing Inventory
Follow these procedures to replenish inventory.

To replenish inventory by placing orders

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.

3 Click the Generate Orders view tab.

This view displays a read-only list of authorized vendors for this inventory 
location. The subviews show the source and target locations.

4 Click Order. 

This generates orders to replenish every product at the selected inventory 
location that is under the minimum level. 

To verify pending replenishment orders

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select an inventory location.

3 Click the Pending Orders view tab.

This view displays the numbers and types of pending orders for this location.

To set a vendor for an inventory location

1 Navigate to the Inventory screen. 

2 In the Inventory Locations list, select an inventory location.

3 Click the Vendors tab.

4 Create a new vendor record.

5 In the Account field, select a vendor.

6 In the Type field, select Vendor or Primary Vendor.
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The Service Administration screen contains one view that allows assignment of 
cycle counting parameters to types of inventory locations. 

Inventory Location Types View
You access the Inventory Location Types view by navigating to the Service 
Administration screen and selecting Service Inventory from the Show drop-down 
list. The Inventory Location Types view assigns the following cycle counting 
parameters to all inventory locations of a specific type (see Table 105).

Table 105. Selected Items in the Inventory Location Types View

Item Description

Count Basis A method of inventory classification that determines how often to count a 
product during cycle counting; ABC or XYZ chosen from a list. Inventory 
locations with the inventory type ABC are counted based on their relative 
value and locations with XYZ are counted based on their relative turnover.

Frequency The interval in days between physical counts of inventory at any 
location with this inventory type.

Period A/X The time period in days allotted to counting all A or X class items at 
any location with this inventory type. 

Period B/Y The time period in days allotted to counting all B or Y class items at 
any location with this inventory type.

Period C/Z The time period in days allotted to counting all C or Z class items at 
any location with this inventory type.
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The Products screen has one view, Service Details, that displays information for 
cycle counting and replenishment. All fields are read-only. 

Service Details View
The Service Details view provides the information used in locating and allocating 
products. The Allocate Below Safety, Auto Allocate, and Auto Substitute check 
boxes in this view do not apply to cycle counting or replenishment. This view has 
two subviews, Inventory Options and Substitutes.

Inventory Options Subview
The Inventory Options subview sets the inventory locations for a product and 
determines the cycle counting parameters for each product at a specific location. 
The Allocate Below Safety, Auto Allocate, and Auto Substitute fields in this view 
do not apply to cycle counting or replenishment. Table 106 describes items in 
Inventory Options records.

NOTE: A product can receive any combination of class ABC and XYZ; for example, 
AY. However, cycle counting must be based on either ABC or XYZ, not both.

Table 106. Selected Items in the Inventory Options View

Item Description

Class ABC The classification of a product, A, B, or C, that indicates its value. Class A 
has the greatest financial value.

Class XYZ The classification of a product, X, Y, or Z, that indicates its turnover rate. 
Class X has the greatest turnover rate.
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Substitutes Subview
The Substitutes subview specifies the products that the Replenishment Engine may 
use to fill an order when the specified product is unavailable from inventory. The 
user chooses from products that are specified in the Products view (see “Products 
View” on page 301). 

NOTE: Substitutions are unidirectional. Product A may substitute for product B, 
but B cannot substitute for A unless that substitution is explicitly defined.
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The Inventory screen contains two views for managing cycle counting at inventory 
locations and for inventory replenishment. 

Inventory Locations View
The Inventory Locations view sets the cycle counting parameters for each location. 
Table 107 describes items in Inventory Locations records. To see these fields, click 
the show more button in the More Info view.

Table 107. Selected Items in the Inventory Location Views

Item Description

Count Basis A method of inventory classification that determines how often to count 
a product during cycle counting: ABC or XYZ chosen from a list. Products 
with ABC are counted based on their relative value and products with XYZ 
are counted based on their relative turnover.

Frequency The interval in days between physical counts of inventory at a location.

Period A/X The time period in days allotted to counting all A or X class items at 
this location. 

Period B/Y The time period in days allotted to counting all B or Y class items at 
this location.

Period C/Z The time period in days allotted to counting all C or Z class items at 
this location.
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Product Inventory Subview
The Product Inventory subview associates inventory locations with products and 
sets quantities of product, whether the product is serialized, and cycle counting 
parameters for the product at this location. Products are specified in the Product 
Administration screen (see “Product Administration Screen” on page 301). 
Table 108 describes items in Product Inventory records.

Generate Orders View
The Generate Orders view automatically produces orders to restock products in 
inventory, by either an internal transfer between inventory locations or by purchase 
from an outside vendor. For replenishment, an inventory level must be defined for 
a product. For replenishment from a vendor, the authorized vendor must also be 
defined. These read-only records are derived from data in the Inventory screen (see 
“Inventory Screen” on page 346).

The Order button and command runs the Replenishment Engine and creates 
purchase and internal orders to replenish all items at the selected location that are 
below minimum. 

Table 108. Selected Items in the Product Inventory View

Item Description

ABC Class The classification of a product, A, B, or C, that indicates its value. Class A 
has the greatest financial value. This value overrides the Class ABC on the 
Product Administration screen.

Max A type-in field for the maximum acceptable quantity of inventory at this 
location and product.

Min A type-in field for the minimum acceptable quantity of inventory at this 
location and product.

Safety A type-in field for the safe quantity of inventory at this location and product. 
This quantity (≤ Min), is that below which the Fulfillment Engine a product 
should not allocate. The user can override this value.

Serialized Indicates that instances of this product must have serial numbers recorded. 

XYZ Class The classification of a product, X, Y, or Z, that indicates its turnover rate. 
Class X has the greatest turnover rate. This value overrides the Class XYZ 
on the Product Administration screen.
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The replenishment process describes a source inventory location to replenish a 
selected location and a target location to be replenished from the selected location. 
Specific relationships between locations are defined in the Relationships view (see 
“Relationships View” on page 407).

Source Locations Subview
The Source Locations subview lists valid replenishment sources for the related 
target locations. The Order button creates internal orders to replenish the related 
target locations (in the Target Locations subview).

Target Locations Subview
The Target Locations subview lists target locations lists locations to be replenished 
from a related source location. The Order button creates internal orders to replenish 
the target locations.

Pending Orders View
The Pending Orders view lists internal orders or purchase orders that have 
been placed to replenish a location. The records in this view, generated by the 
Replenishment Engine, are read-only.

For a discussion of replenishment, see “Replenishment” on page 393.

Vendors View
The Vendors view records vendors who may supply products for a selected 
inventory location. For replenishing a location from an outside source, vendors 
must be specified.

Relationships View
The Relationships view records the relationships of a selected inventory location 
with other inventory locations. If a business uses more than one inventory location, 
relationships among inventory locations are useful for automating inventory 
replenishment and order fulfillment. A relationship may be physical, hierarchical 
(for example, a shelf belongs to an aisle), or logistical (for example, Fulfills or 
Replenishes).
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Cycle Counts View
The Cycle Counts view sets specifications that the Cycle Counting Engine uses to 
automatically generate the cycle count lists. To reach this view, choose Cycle Counts 
from the Show drop-down list. 

The Inventory Locations view is the same as previously described (see “Inventory 
Locations View” on page 405), with the addition of a Generate Counts button and 
a Generate Counts (All Locations) command. Table 109 describes commands and 
buttons in the Inventory Locations view for Cycle Counts records.

More Info Subview
The Cycle Counts view has a More Info subview containing the following items 
specific to cycle counting (Table 110). These fields are read-only.

Table 109. Selected Items in the Inventory Locations View for Cycle Counts

Item Description

Generate Counts This button produces a list of products to count for the 
selected inventory location. The list appears in the 
Parts List view (see “Part List View” on page 410).

Generate Counts (All Locations) This command produces a list of products to count for 
all inventory location. The list appears in the Parts List 
view (see “Part List View” on page 410).

Table 110. Selected Items in the More Info Subview for Cycle Counts

Item Description

ABC Class The classification of product, A, B, or C, that indicates its value. Class A has 
the greatest value. 

Ended The actual end date for a cycle count.

Started The date for the actual start of a cycle count. 

Status The status of a cycle count; for example, Assigned, Closed, or Open.

XYZ Class The classification of product, X, Y, or Z, that indicates its turnover rate. 
Class X has the greatest turnover rate. 
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Cycle Counts Subview
The Cycle Counts subview contains read-only records that are derived from the 
data recorded in the Cycle Counts view (see “Cycle Counts View” on page 408). 
Table 111 describes fields in the Cycle Counts subview. 

Table 111. Fields in the Cycle Counts View

Field Description

Assigned To The employee assigned to carry out this cycle count.

Due The date on which the counts of products specified in the Parts 
List view (see “Part List View” on page 410) should be completed. 

End The date the cycle count period ends, which is inherited from 
the Cycle Counts screen.

Inventory Location The name of the inventory location for this cycle count.

Start The date the cycle count period starts. 

Status The status of a cycle count; for example, Assigned, Closed, or Open.
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Cycle Counts Screen
The Cycle Counts screen contains views for defining cycle counts at specific 
inventory locations, providing lists that direct the physical counting of inventory, 
recording the results of cycle counts, and adjusting inventory levels.

Cycle Counts Views
The Cycle Counts views define cycle counts at specific inventory locations and 
specify the timing of these counts. Table 112 describes items in Cycle Count records. 

Part List View
The Part List view displays a list of the products to count at a selected inventory 
location and records the count results. The records in the Part List are created by 
clicking Generate Counts or the Generate Counts (All Locations) in the Inventory 
screen’s Cycle Counts view (see “Cycle Counts View” on page 408). Records can 
also be entered manually. Table 113 describes a button in Part List records.

Table 112. Selected Items in the Cycle Count Views

Item Description

Due A type-in field containing the date on which the counting cycle should be 
completed. This field is for information only; the Cycle Counting Engine does 
not use the date.

End A type-in field containing the actual date that the cycle count was completed. 
This date is used when generating Cycle Count Detail reports.

Start A type-in field containing the date on which the cycle count should start. 
This date is used when generating Cycle Count Detail reports.

Status The status of a cycle count; for example, Assigned, Closed, or Open.

Table 113. Selected Items in the Part List View

Item Description

Count Complete This button compares the value entered in the Count field and the 
number of items in the database, produces the data in the Variance 
view, and lists the missing assets in the Missing Assets subview. 
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Counted Serial Numbers Subview
The Counted Serial Numbers subview accepts serial numbers for each serialized 
product that is counted.

Variance View
The Variance view shows the differences between the quantity in the Field Service 
database and an actual product count. Table 114 describes a button in the Variance 
view.

Table 114. Selected Items in the Variance View

Item Description

Adjust This button creates database transactions to match the quantity recorded in the 
database with the physical count. The transactions are either Receive Other 
(from the External location) or Ship Other (to the External Location). The Cycle 
Counting Engine does not validate (quantity or source) for the External location. 
For more information, see “Setting Up an External Location” on page 347 and 
“Inventory Transactions” on page 325.
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Cycle Counting Report
Cycle Counting Report
The Reports menu on the Cycle Counts screen provides the Cycle Count Detail 
report (Table 115).

Table 115. Cycle Count Detail Report

Report Description

Cycle Count Detail Presents all information about selected cycle counts.
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This chapter describes Quality Management, the Quality screen, change requests, 
and patch requests.

Siebel Quality supports the product development and maintenance life cycle by 
managing change requests, or CRs. A change request (CR) is a formal report or 
recommendation aimed at correcting a defect in or adding an improvement to a 
product. Such products can include hardware, software, manufactured goods, and 
capital equipment. Siebel Quality can manage multiple types of change requests, 
including enhancement requests and product defect reports. 

Siebel Quality supports the work of the various groups that use the change 
management process, such as quality assurance, development engineering, and 
product marketing.

Siebel Quality provides tools for creating, responding to, and tracking CRs. Siebel 
Quality manages CRs by doing the following:

■ Managing CRs from creation through resolution

■ Tracking and analyzing details about CRs

■ Coordinating and integrating CR management activities across multiple 
departments

■ Displaying status information on product stability

If a customer has an urgent need to resolve a CR and cannot wait for the next 
product release, Siebel Quality can generate a patch request, or PR. A patch request 
(PR) is a recommendation to create a maintenance release to implement a product 
defect fix or improvement. 

Features of Siebel Quality
Siebel Quality operates through the Quality screen in your Siebel application. This 
section summarizes some features of Siebel Quality.
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■ Create, track, and close the various types of CRs. These features allow an 
organization to manage a CR from beginning to the end, and also allow different 
process owners to manage specific phases of the CR life cycle.

■ Log, track, and resolve multiple occurrences of a CR. When an issue is found in 
one product, it sometimes occurs in other, related products. In such cases, end 
users can create child CRs, or multiple occurrence CRs, from a primary CR and 
link them together so that they can be managed as a single unit through 
resolution. 

Siebel Quality also allows end users to designate other types of relationships, 
such as CRs that are dependent upon each other or are duplicates of each other.

■ Analyze and report on product issues. Because reports and charts are run on 
demand, organizations can gauge the overall health and stability of products in 
development.

■ Track the history of a CR. Siebel Quality displays information about who the CR 
was assigned to, whether ownership has been reassigned, and whether the 
product area associated with the CR has been modified. 

Quality and Release Manager
Siebel Quality is packaged with Siebel Release Manager, a tool that allows an 
organization to manage product development through functions such as feature 
tracking, engineering allocation, test plan management, and test pass management.

Together, Quality and Release Manager support the product life cycle management 
process from beginning to end. For more information, see Chapter 13, “Release 
Manager.”
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The following section provides some best practices for administering and using the 
Quality functionality. 

■ Assign CRs automatically. As a productivity aid, you can automate the CR 
assignment process. Use Siebel Business Process Designer to detect the creation 
of a new CR and invoke the Siebel Assignment Manager to assign this CR to the 
appropriate person. 

For information about Siebel Business Process Designer, see Siebel Business 
Process Designer Administration Guide. For information about Siebel 
Assignment Manager, see Siebel Assignment Manager Administration Guide.

■ Link multiple occurrences. When the same issue occurs in different builds, testing 
environments, or platforms, you can link the CR records as multiple occurrences 
of each other. When you do this, it is possible to track multiple CRs together and 
close them together. 

■ Appoint multiple owners. To help make sure of follow-up, assign at least two 
people to be involved in processing each CR. For example, one person may log, 
prioritize, and assign the CR while another person implements a solution. 

■ Write descriptively. End users can help make the CR life cycle more efficient by 
writing clear and descriptive CRs that can be understood by everyone involved 
in CR processing.

■ Query frequently. Because the system does not automatically alert owners when 
a new CR has been logged or an existing one updated, end-users in all teams 
that work with CRs should query often for their CRs.

■ Add comments. To help the people involved in processing a CR to trace what has 
gone before and to understand what the current status is, make sure that 
everyone who updates a CR writes a comment describing the update.
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Example Process for Quality
This section provides a summary of the Siebel Quality CR life cycle. The stages of 
the Quality process are described in the following sections, in the order listed. 

1 Set Up and Maintain (Administrator). See “Setup and Maintenance” on page 418.

2 Log CRs (Quality Assurance). See “Logging Change Requests” on page 419.

3 Assess CRs (Product Marketing). See “Assessing Change Requests” on page 420.

4 Resolve CRs (Engineering). See “Resolving Change Requests” on page 422.

5 Verify CR Closures (Quality Assurance). See “Verifying Change Request Closures” 
on page 424.

6 Create Patch Requests (Release Management). See “Creating Patch Requests” on 
page 425.
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Figure 12 illustrates this overall process for Siebel Quality. Each cross-reference in 
a box refers to the title of another figure that illustrates its details.

Details of each of these operations are depicted by the descriptions and diagrams in 
the sections that follow. 

Figure 12. Overall Quality Process

�Administrator Setup and Maintenance 
Process�

�Quality Assurance Logging Process�

�Product Marketing Assessment Process�

�Engineering Resolution Process�

�Quality Assurance Verification Process�

�Release Management PR Process�
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Setup and Maintenance
Before end users can begin working with Quality, the administrator must set it up. 
The tasks applications administrators perform to set up Quality are listed below. It 
is recommended that you do them in the order shown. 

1 Set Up Roles and Responsibilities. Set up roles and responsibilities to allow the 
employees who will use Siebel Quality to access the Quality screen and its views. 
See “Setting Up Roles and Responsibilities” on page 427. 

2 Set Up Lists of Values. Set up lists of values (LOVs) for the fields in the Quality 
screen. See “Setting Up Lists of Values” on page 428. 

3 Map Area-Subarea Combinations. After field value LOVs are entered, map Area and 
Subarea field values to one another. Link each Area-Subarea combination to 
Product Line, Engineering Group, and QA Owner field values. See “Mapping 
Area-Subarea Combinations” on page 430. 

4 Add Release Product Builds. Add product builds that can be linked to CRs. See 
“Adding Release Product Builds” on page 432. 
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These tasks are illustrated in Figure 13. Then are part of ongoing maintenance as 
well as setup. 

Logging Change Requests
After you have set up Siebel Quality, Quality Assurance testers and others can log 
CRs.

1 Query for Existing CRs. After identifying a product issue, but before logging a new 
CR, the CR creator queries to see whether a duplicate issue already exists. See 
“Querying for Existing Change Requests” on page 434. 

■ Update Existing CR Comments. If the search reveals an existing CR for the 
issue, the CR creator enters a comment with relevant information that may 
not already be recorded. 

■ Log New CR. If the CR creator cannot find an existing issue, she then creates 
a new CR. See “Logging Change Requests” on page 434 and “Generating 
Change Requests from Service Requests” on page 436. 

Figure 13. Administrator Setup and Maintenance Process
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2 Add Attachment. Optionally, the CR creator can add attachments such as screen 
captures and configuration files to clarify the issue. See “Adding Attachments to 
a Change Request” on page 436. 

These tasks are illustrated in Figure 14. 

Assessing Change Requests
After CRs are entered in the system, product marketing managers assess the CRs to 
determine how important they are and who should resolve the issues.

1 Query for Unassigned CRs. The product manager queries for new CRs in his area 
of responsibility. See “Querying for Unassigned Change Requests” on page 438. 

■ Close CR. If the product manager decides the CR is not a real issue, he closes 
it. See “Closing Unassigned Change Requests” on page 439. 

■ Reassign CR. If the product manager decides that the CR is a real issue, he 
determines whether it can be resolved by his team. If he finds that the CR’s 
functional area was incorrectly set, he assigns it to a new owner. See 
“Reassigning Change Requests” on page 439. 

Figure 14. Quality Assurance Logging Process
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■ Close CR. The product manager investigates whether the CR is a duplicate of 
an existing issue. If it is, he closes the new CR as a duplicate. See “Closing 
Unassigned Change Requests” on page 439. 

2 Prioritize and Assign CR. If the product manager determines that the CR represents 
a real issue in his area of responsibility and is not a duplicate of another CR, he 
prioritizes the CR and assigns it to an engineering manager. See “Prioritizing and 
Assigning Change Requests” on page 440. 

These tasks are illustrated in Figure 15.

Figure 15. Product Marketing Assessment Process
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Resolving Change Requests
After Product Management has assigned CRs to Engineering, Engineering can 
proceed to resolve the CRs.

1 Assign CRs (Manager). The engineering team manager to whom the product 
manager assigned the CR, in turn assigns it to an engineer on her team. See 
“Assigning Change Request to Engineers (Manager)” on page 441. 

2 Query for My CRs. The engineer performs a query to find CRs assigned to him. 

3 Reproduce the Issue. Upon receiving a newly assigned CR, the engineer tries to 
reproduce the issue in the CR. 

4 Close CR. At this point, the engineer may close the CR for the following reasons: 

■ The engineer cannot reproduce the issue.

■ The engineer can reproduce the issue, but it is not an issue with your 
company’s current product. 

See “Closing Resolved Change Requests” on page 445. 

5 Create Multiple Occurrence CR. If the engineer determines that the CR contains a 
real issue with your company’s current product, he checks whether the same 
issue occurs in multiple versions of the same product. If it does, he creates a 
multiple occurrence CR for each product variant or version that has the same 
issue. See “Creating Multiple Occurrence Change Requests” on page 441. 

6 Break Multiple Occurrence Link. If subsequent investigation shows that the issue 
does not occur in one of the other product versions, or occurs differently, the 
engineer breaks the multiple occurrence link. See “Breaking Multiple 
Occurrence Links” on page 442. 

7 Define Relationship. If the CR is not a multiple occurrence, the engineer tries to 
determine whether it is related to other CRs in some other way. For example, 
correcting the issue in one CR might depend on first correcting the issue in 
another. If this is the case, he determines the relationship. See “Linking Related 
Change Requests” on page 443. 

8 Fix Issue. The engineer then applies the appropriate fix and closes the CR. See 
“Closing Resolved Change Requests” on page 445. 
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These tasks are illustrated in Figure 16.

Figure 16. Engineering Resolution Process
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Verifying Change Request Closures
After engineers resolve CRs, the CR creator attempts to verify the resolutions.

1 Query for Closed CRs. The creator queries for CRs that she has logged that are now 
closed. See “Querying for Closed Change Requests” on page 448. 

2 Verify Resolution. The creator tries to verify the resolution. 

■ Reopen CR. If she determines that the issue is not resolved, she reopens the 
CR. This sends the CR back to engineering for further review. See “Reopening 
Change Requests” on page 448. 

■ Close CR as Verified. If she determines that the CR is correctly resolved as 
stated, she closes the CR as verified. See “Closing Change Requests as 
Verified” on page 448. 

At this point, the CR life cycle is complete. 

These tasks are illustrated in Figure 17.

Figure 17. Quality Assurance Verification Process
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Creating Patch Requests
After CRs have been closed as verified, the Release Management group may 
determine that a particular CR fix needs to go to a customer immediately rather than 
in the next release of the product. 

1 Find Verified CRs With Urgent Customer Need for Fix. A member of the Release 
Management group identifies a closed and verified CR that represents a fix for 
which a customer cannot wait until the next scheduled release. 

2 Generate PR from CR. A release manager generates a PR from a CR. See 
“Generating Patch Requests from Change Requests” on page 450. 

3 Enter Approvals. The release manager obtains the approvals necessary for 
shipping the patch and records the approvals in the PR record. See “Approving 
and Shipping Patch Requests” on page 451. 

4 Retest. If all approvers do not agree that the patch is ready to ship, the patch is 
sent back for further development, testing, and another approval cycle. 

5 Ship Maintenance Release. After all approvals are gathered for the PR, the 
maintenance release is ready to go to the customer. See “Approving and Shipping 
Patch Requests” on page 451. 
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These tasks are illustrated in Figure 18.

Figure 18. Release Management PR Process
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Setting Up Roles and Responsibilities
You are typically responsible for setting up access to your Siebel application’s 
screens and views by assigning roles and responsibilities. This includes access to 
the Quality screen and its associated views. 

For information about setting up roles and responsibilities and associating screens 
and views with them, see Security Guide for Siebel eBusiness Applications.
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Setting Up Lists of Values
You are typically responsible for setting up lists of values (LOVs) for use in Siebel 
eBusiness Applications. This includes LOVs that are specific to Siebel Quality. For 
information on setting up LOVs, see Applications Administration Guide.

Table 116 lists the LOVs to be set up before using Siebel Quality.

Table 116. Quality LOVs

Field Type Value for LOV Items Description Example LOV Items

Area PROD_DEFECT_AREA Functional product area Accounts

Orders

Browser PSTASK_CLIENT_BROWSER Type of Web browser running in 
the test environment

IE 5.5

NS 6.2

Client OS PSTASK_CLIENT_OS Type of operating system running 
on the client computer

Win 2000

Mac OS

Database PSTASK_CLIENT_DB Type of database running in the 
test environment

IBM DB2

MS SQL Svr 7.0

Priority PROD_DEFECT_PRIORITY Relative importance of the issue P1-Critical

P3-Medium

Server OS PSTASK_SERVER_OS Type of operating system running 
on the server

HP-UX 11i

Solaris 8

Severity PROD_DEFECT_SEVERITY How severe the issue is 3-Wrong Behavior

4-Minor Error

Special Tag PD_SPEC_TAG Statuses or actions that are not 
identified by the other fields, for 
reporting, querying, exporting, or 
localization purposes

BETA3

HIGH RISK

Status PROD_DEFECT_SUB_STATUS Implementation or development 
stage

Open-Disagree

Closed-Verified
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Subarea PROD_DEFECT_SUB_AREA Functional product area 
subdivision

Expenses

Fulfillment

Substatus PROD_DEFECT_SUB_STATUS Implementation or development 
substage

Unassigned

Approved

Type PROD_DEFECT_TYPE Type or classification for the CR Product Defect

Enhancement

Web Server OS PSTASK_SERVER_OS Type of operating system running 
on the Web server

AIX 4.3.3

Win NT 4.0

Table 116. Quality LOVs

Field Type Value for LOV Items Description Example LOV Items
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Mapping Area-Subarea Combinations
When an end user navigates to the Quality screen and selects any combination of 
Area and Subarea field values, the Product Line, Engineering Group, and QA Owner 
fields are automatically populated. You activate this process by setting up mappings 
for Area and Subarea combinations. After defining the lists of values, or LOVs, for 
Area and Subarea, you define each Area-Subarea combination. Then you designate 
the Product Line, Engineering Group, and QA Owner field values for each Area-
Subarea combination.

As product parameters change in the course of development, you may need to map 
new Area-Subarea combinations. 

To add an Area-Subarea combination

1 Navigate to Site Map > Quality > Quality Administration.

2 In the Quality Administration list, add a record for each Area-Subarea 
combination.

For example, if you want a selection of Inventory in the Area field to constrain 
the choices in the Subarea field to Shipping, Receiving, and Cycle Counting, then 
create three records with the Area and Subarea fields completed as shown in the 
following table.

Area Subarea

Inventory Shipping

Inventory Receiving

Inventory Cycle Counting
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3 Complete the other fields. These fields are described in the following table.

When these mappings are set up, the pick list values available in the Subarea 
field on the Quality screen’s views change dynamically according to the value 
an end user selects in the Area field. When the end user then selects a value in 
the Subarea field, the system automatically populates the Product Line, 
Engineering Group, and QA Owner fields. 

Field Comments

Engineering Group Engineering team with which this Area-Subarea combination is 
associated.

Product Line Grouping of products with which this Area-Subarea combination 
is associated. 

QA Owner Quality Assurance team owner with which this Area-Subarea 
combination is associated.
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Adding Release Product Builds
You control product version information for the organization by setting up release 
product builds. Because every Release Manager and Quality record must be 
associated with a specific release product build, you must set these up before end 
users enter any records.

As a product progresses through the release cycle, increasingly advanced product 
prototypes are created. (In the case of software development, these prototypes are 
known as builds.) As each new prototype becomes available, you are responsible 
for entering it into Quality. This allows end users of Quality and Release Manager 
to record each record against the appropriate build. 

There are two types of releases, as follows:

■ Future Releases. Though only one active release may be in progress, you must 
set up records for future releases as well. That way, if a feature or fix is deferred 
from the current release, an end user can target it to a specific future release.

■ Unspecified Releases. Sometimes the appropriate future release for a given 
feature or fix may be unknown. For this contingency, you must set up at least 
one artificial release called “Unspecified Release” or some similar term. Orphan 
items can be linked to this release. When the appropriate future release has been 
determined, an item can then be retargeted to that release.

To add a release product build

1 Navigate to Site Map > Quality > Release Product Administration.

2 Add a record for a build. 
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3 Complete the fields. Some fields are described in the following table.

When you create a record in the Release Product Administration screen, the 
information in the Build, Language, Product, and Version, fields becomes 
available to end users in the Build field in the Release screen’s QA Tests view 
and Quality screen’s Change Requests view. If you selected the Target Version 
check box, this information also becomes available in the Target field in the 
Quality screen’s Change Requests view.

Field Comments

Build Number or code that identifies this build. 

End Date To cause this build to disappear from the Build and Target fields 
of the Change Requests view after a certain time, enter a date 
after which it should not appear.

Language Three-letter language code. 

Product Product of which this build is a prototype. 

Target Version Select to make this build available as a choice in the Target field 
of the Change Requests view.

Version Version number of the product. 
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Logging Change Requests (QA End User)
Anyone can log a CR. The Quality Assurance organization, however, creates the vast 
majority of CRs. Quality Assurance discovers most product issues during testing. 
When a QA tester discovers a product issue, she creates a new CR.

To add CR records and fill them out with necessary information, follow the 
procedures in this section.

Querying for Existing Change Requests
Before logging a new CR, a CR creator should query to see whether a duplicate issue 
is already recorded in an existing CR. She can do this by searching on various 
combinations of key words used to describe the problem.

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 Initiate a query.

3 In the Summary field, enter a phrase that might describe the issue in other CRs.

For example, if you find a problem with attaching documents to a record, you 
might query on phrases such as “attachment not working” and “attachment 
function broken.”

4 Run the query. 

5 If the query reveals that a CR already exists for the issue, update the Comments 
field with relevant information that is not already recorded.

Logging Change Requests
If the CR creator cannot find an existing CR that describes the issue, she creates a 
new CR. The CR creator must enter all relevant details including the functional area 
in which the problem was found, the environment (operating system, server type, 
and so on) where the problem occurred, and the precise steps for reproducing the 
issue.

Most of this information is entered in the left side of the Change Requests form, 
labeled “Change Request Description.” 
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To log a change request 

1 Navigate to Site Map > Quality. 

The Change Requests view appears. 

2 In the More Info form, click the show more button.

3 Create a new CR record.

4 Enter values for the fields, as needed.

Some fields in the Change Requests view are listed in Table 117.

Table 117. Fields for Logging a CR

Field Comments

Area Functional product area to which the CR pertains.

Comments Enter a comment describing what was done with this CR, and 
any additional information that may be needed by other users 
to understand, track, or resolve the issue. 

Description/How to 
Reproduce

Detailed description of the issue. If the CR describes a 
product defect, write complete step-by-step directions for 
reproducing the issue. 

Build Product build in which the issue occurs. 

Product Line Product line affected by the CR. Automatically filled in when 
the Subarea value is set. 

QA Owner Quality Assurance team owner of the CR. Automatically filled 
in when the Subarea value is set. 

Severity Creator’s assessment of the seriousness of the issue. 

Special Tag Allows you to select statuses or actions that are not identified 
by the other fields. Special tags may be used for purposes 
such as reporting, tracking, querying, exporting, and 
localization. You can select one or more values. 

Subarea Functional product area subdivision to which the CR 
pertains. When you make a selection in this field, the Product 
Line, QA Owner, and Engineering Group fields are populated 
automatically. 
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Generating Change Requests from Service Requests
Occasionally, a CR originates from a customer by way of a service request. If the 
technical support person who receives the customer’s service request decides that 
it represents a product issue, she can log a CR for the service request.

For more information about service requests, see Chapter 2, “Service Support.”

To log a change request for a service request

1 Navigate to the Service screen.

2 Select a Service Request record.

3 Click the Change Requests tab.

4 Create a new CR record.

5 Complete the fields, as needed, from the information in the service request.

For a description of CR fields, see Table 117 on page 435.

6 In the Comments field, note that this CR originated from a service request, and 
add any additional information that may be relevant. 

The new CR appears in the Quality screen’s Customer Change Requests view.

Adding Attachments to a Change Request
Optionally, after adding a CR, the CR creator might want to add documents or 
graphics to further explain or illustrate the issue. In this case, the creator can add 
attachments, such as screen captures or configuration files.

Summary Brief description of the CR. Should be concise enough so a 
reader can immediately understand the overall issue. 

Tag Summary Displays all the tags selected in the Special Tag field. 

Type CR type. Accept the default Product Defect, or select another 
value to identify the CR as an enhancement request, a user 
interface issue, and so on. 

Table 117. Fields for Logging a CR

Field Comments
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For information about how to add an attachment, see the chapter on working with 
data in Fundamentals. 
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Assessing Change Requests (Product Marketing End 
User)

After CRs have been logged, the Product Marketing team assesses the new CRs in 
its functional areas.

Product managers assess and assign CRs. A product manager reviews each new CR 
logged in his area of responsibility. If he determines that an issue is a real one, he 
defines the priority and assigns the CR to the appropriate engineering manager. 

Querying for Unassigned Change Requests
The product manager queries for unassigned CRs in his functional area. 

To query for unassigned change requests

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 Create a query with the appropriate field values. Some values you can use in the 
query are listed in the following table.

3 Run the query. 

Field Value

Area (your product area)

Owner IS NULL

Priority IS NULL

Status Open

Subarea (your product subarea)

Substatus Open
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Reassigning Change Requests
If the product manager decides that the CR describes a real issue, he first confirms 
that the CR is in his functional area. If he determines that the CR’s functional area 
was incorrectly set, he reassigns the CR to the appropriate area.

To reassign a change request

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 Change the values in the Area and Subarea fields, as needed.

3 In the Comment field, add a brief explanation of why you reassigned the CR.

Closing Unassigned Change Requests
If the product manager decides the CR is not a real issue, he closes it with various 
possible reasons. For example, he may determine that the issue is not a product 
defect, or he may decide to decline an enhancement request.

To close an unassigned change request

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 In the Status field, select Closed.

3 In the Substatus field, do one of the following:

■ If the CR does not reflect a real issue in the current product, select a value 
such as Not a Bug or No Longer Applicable.

■ If the CR is an enhancement request and you decide that the request cannot 
be accommodated, select Enhancement Declined. 

■ If the CR is a duplicate of an existing issue, select Dup-Double Entry. Enter 
the existing issue’s CR number in the Primary Occurrence field.

4 In the Comments field, add a note explaining the reason for closing the CR. 
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Prioritizing and Assigning Change Requests
If the assessment of a CR is complete and the product manager determines this is a 
new issue that needs to be resolved, he assigns a priority, a target release, and an 
owner to the CR. The product manager usually assigns the CR to the engineering 
manager who is in charge of the product area where the issue occurs. 

The product manager enters priority and assignment information on the right side 
of the Change Requests form, labeled “Resolution.” 

To prioritize and assign a change request

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 In the Comments field, add a comment summarizing why you prioritized and 
assigned this CR as you did. 

3 Complete the other fields as needed. Some fields are described in the following 
table. 

Field Comments

Engineering Group Displays the group responsible for delivering the fix. 
Automatically filled in when the Subarea value is set. 

Owner Select the engineering manager responsible for resolving 
the issue reported in the CR. 

Priority How urgent it is to resolve the issue compared to other 
issues at hand. Does not have to be the same as the value 
in the Severity field. 

Special Tag Allows you to select statuses or actions that are not 
identified by the other fields. Special tags may be used 
for purposes such as reporting, tracking, querying, 
exporting, and localization. You can select one or more 
values. 

Tag Summary Displays all the tags selected in the Special Tag field. 

Target Release in which the CR issue is to be fixed.
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Resolving Change Requests (Engineering End User)
The engineering manager who owns an open CR assigns the CR to an engineer on 
her team. The engineer first tries to re-create the issue by following the description 
entered by the CR creator. He debugs the issue and isolates its cause. He then makes 
the appropriate fix, updates the CR with all relevant details, and closes the CR. 

Assigning Change Request to Engineers (Manager)
After the product manager assigns the CR to an engineering manager, the 
engineering manager assigns the CR to an engineer who has the right expertise to 
resolve the issue.

To assign a change request to an engineer

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 In the Owner field, select the engineer you want to assign to resolve the issue.

3 In the Comment field, enter any comment or explanation that might be 
necessary for the engineer to understand the issue. 

Creating Multiple Occurrence Change Requests
In the course of resolving a CR, an engineer might find the same problem in another 
testing environment, another language version, or another product release version. 
For this situation, your Siebel application allows end users to create parent-child 
relationships between CRs. With this functionality, end users can create multiple 
occurrence CRs and link them to a parent CR. 

CRs are multiple occurrences when they have the same functional description but 
are logged against more than one critical factor such as environment, language, or 
product. Alternatively, multiple occurrence CRs can describe different symptoms 
that originate from the same problem and require the same resolution. Multiple 
occurrence CRs must have the same owner, and the files or other components to be 
fixed must be the same. 

The ability to create multiple occurrence CRs allows end users to manage related 
issues from one source, eliminate double-counting of product issues, and track the 
linked CRs together.
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To create a new multiple occurrence CR (child) for an existing primary occurrence 
CR (parent), use the following procedure.

To create a multiple occurrence change request

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 Select a CR that will be the parent to multiple occurrences.

3 On the Change Request form, click the view menu button and choose Create 
Multiple Occurrence.

The system creates a copy of the original record with a new CR number. The 
number of the original CR (the parent) appears in the Primary Occurrence field.

4 In the new CR record, change the field values for information that is different 
from the original CR. Some fields in the Change Requests view are listed in 
Table 117.

5 In the Comments field, record the action you have taken and note any additional 
information that may be relevant. 

The parent and child CRs are linked and the new CR becomes a multiple 
occurrence CR.

Breaking Multiple Occurrence Links
In some cases, links between multiple occurrence CRs need to be removed. For 
example, further investigation may reveal that multiple occurrence CRs are not 
related to each other. 

You can break a multiple occurrence link either from a parent CR or from a child 
CR. To break Multiple Occurrence links, use the following procedures.

To break a multiple occurrence link from the parent change request

1 Navigate to Site Map > Quality.

2 Select a CR record for a parent multiple occurrence CR.
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3 Click the Related CRs view tab.

The Related CRs list displays the CRs with child relationships to the selected 
primary CR.

4 In the Related CRs list, select the multiple occurrence CR you wish to remove.

NOTE: Child multiple occurrence CRs are identified by a value of Multiple 
Occurrence in the Relationship Type field. 

5 In the Related CRs list, click the view menu button and select Delete 
Relationship. 

6 In the confirmation window, click OK.

The CR is removed from the Related CRs list.

7 In the Comments field, record the action you have taken and note any additional 
information that may be relevant. 

To break a multiple occurrence link from the child change request

1 Navigate to Site Map > Quality.

2 Select a CR record for a child multiple occurrence CR.

3 Delete the value in the Primary Occurrence field. (The value in this field is the 
parent CR.) 

4 In the Comments field, record the action you have taken and note any additional 
information that may be relevant. 

5 Click the menu button. 

If the link was broken successfully, the Go To Primary Occurrence option is 
unavailable. 

Linking Related Change Requests
In addition to multiple occurrence, Siebel Quality uses several other designations to 
define the relationships that can occur among CRs. Related CRs are useful when 
investigating a solution for a CR that may be similar to others. 
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■ Duplicate (Dup-Double Entry). The same CR entered more than once. Not only is 
the functional description the same, but other critical factors such as 
environment, language, or product are also the same. 

■ Dependent Upon. A CR that cannot be resolved until it receives a fix from another 
CR. 

■ Miscellaneous (Misc). An arbitrary relationship between CRs. Allows you to track 
multiple CRs together, though they may not be dependent on one another or 
match one another. 

This section contains procedures for creating and managing the related CRs. To 
create a relationship between two existing CRs, use the following procedures.

To link a related change request from a parent change request

1 Navigate to Site Map > Quality.

2 Select the primary CR to which you want to relate another CR.

3 Click the Related CRs view tab.

4 In the Related CRs list, create a new record.

5 In the Add Change Request dialog box, select the CR you want to relate to the 
primary CR as a child and click Add.

6 In the Relationship Type field, select the type of relationship the related CR has 
to the parent CR.

7 In the Comments field, record the action you have taken and note any additional 
information that may be relevant. 

To link a related change request from a child change request

1 Navigate to Site Map > Quality.

2 Select the CR you want to link to another CR as a child.

NOTE: The child CR cannot have any related child CRs of its own. To verify this, 
check its Related CRs view tab. 
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3 On the Change Request form, in the Primary Occurrence field, select the CR 
number of the parent CR.

4 In the Comments field, record the action you have taken and note any additional 
information that may be relevant. 

5 Click the view menu button and choose Go to Primary Occurrence.

The Change Request form displays the CR you just designated as the parent 
(primary occurrence). 

6 Click the Related CRs view tab.

7 In the Related CRs list, select the child CR you just linked to the parent as related.

8 In the Relationship Type field, select the type of relationship the child CR has to 
the parent CR.

Closing Resolved Change Requests
Upon receiving a newly assigned CR, the engineer tries to reproduce the issue. At 
this point, the CR may be closed for several reasons, such as the issue being with a 
third-party product, no longer applicable to the current release, or the engineer 
being unable to reproduce it. 

If the engineer determines that the CR is a real issue, he investigates further, makes 
the appropriate fix, and tests the fix. When the fix is complete, he closes the CR and 
enters relevant information about the fix.

When closing a primary occurrence CR, an engineer can close a parent CR and all 
its child CRs at once, close the parent CR only, or close a child CR independently of 
its parent. 

When closing a CR, the engineer enters information in the right side of the Change 
Requests form, labeled “Resolution.” Use the following procedures to close CRs that 
have been fixed or otherwise resolved. 

To close a resolved change request

1 Navigate to Site Map > Quality.

2 Select a CR record that you want to close as fixed.

3 Set the Status field to Closed.
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4 In the Comments field, add a comment explaining the resolution. 

Complete the other fields as needed. Some fields in the Change Requests view are 
listed in Table 118.

Table 118. Fields in the Change Requests View

Field Comments

Approvals Allows the employees involved in processing the CR to 
mark and track approvals for the stages of the fix. 

Files Fixed Filename and archiving system location of each electronic 
file modified for the fix. Becomes a required field when the 
Substatus or Integration Status changes to Fixed. 

Fixed Build Product version where the resolution is implemented.

Integration Fixed Build Integration branch build number in which the fix was 
made.

Integration Fixed Date Date when the fix was made in the integration branch. 

Integration Status Status of the CR on the integration branch. When the 
Integration Status field is set to Closed, the Integration 
Fixed Date field is automatically populated and the 
Integration Fixed Build field becomes required.

Special Tag Allows you to select statuses or actions that are not 
identified by the other fields. Special tags may be used for 
purposes such as reporting, tracking, querying, exporting, 
and localization. You can select one or more values. 
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To close a resolved parent multiple occurrence change request

1 Follow the steps of “To close a resolved change request” on page 445 for a parent 
CR.

When you save the record, a message box appears. 

2 Do one of the following:

■ Click OK to close all the associated multiple occurrence CRs with the same 
resolution information as the primary CR. 

■ Click Cancel to close only the primary CR. 

Substatus Reason for closing the CR. Some values are as follows:

■ FOL. Fact of Life. Because of a limitation such as 
dependency on a third-party product, your company’s 
development team has no control over the issue. 

■ No Longer Applicable. The issue applies to an older or 
different version of the product, but not to the current 
version or the version under development. 

■ Not Reproducible. The issue cannot be reproduced as 
described. (In cases where the CR issue cannot be 
reproduced, Siebel Systems recommends that before 
closing the CR, you contact the CR creator directly to 
obtain clarification.) 

■ Fixed. The issue has been corrected. 

Tag Summary Displays all the tags selected in the Special Tag field. 

Table 118. Fields in the Change Requests View

Field Comments
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After the engineer resolves a CR, the QA tester or other CR creator who reported the 
issue verifies that the resolution is correct.

Querying for Closed Change Requests
The CR creator queries for closed CRs in her functional area. 

To query for closed change requests

1 Navigate to Site Map > Quality > Change Requests Reported by Me.

The Change Requests view appears. 

2 Create a query with Status = Closed. 

3 Run the query. 

Reopening Change Requests
The CR creator tries to verify the resolution on the version identified by the 
engineer. If she determines that the issue is not resolved, she reopens the CR, which 
sends it back to the engineer for further review.

To reopen a change request

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 In the Status field, select Open-Disagree.

3 In the Comment field, enter an explanation of why you disagree with the 
resolution. 

Closing Change Requests as Verified
If the creator determines that the CR is correctly resolved, she closes out the CR as 
verified. At this point, the CR life cycle is complete.
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To close a change request as Verified

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 In the Status field, select Closed-Verified.

3 In the Comment field, enter a note that you agree with the resolution. 
Version 7.5, Rev. A Siebel Field Service Guide 449



Quality

Creating Patch Requests (Release Management End User)
Creating Patch Requests (Release Management End 
User)

The release management team, which may consist of representatives from the 
major functional groups, tracks the overall health of the product release. They 
monitor product status and stability. They monitor the development effort’s 
progress through Siebel Quality’s reports and charts. They then provide the final 
recommendations for shipment of the product.

The release management group also manages patch requests (PRs). A patch request 
(PR) is a resolved product issue whose fix must be delivered to a customer prior to 
the next scheduled release, through a maintenance release. The release 
management group makes sure that critical issues for which customers need fixes 
immediately get resolved as maintenance releases.

Generating Patch Requests from Change Requests
A member of the release management team generates a PR from a CR. The PR then 
forms the basis of a maintenance release. To generate a PR, use the procedure that 
follows. 

To generate a patch request from a change request

1 Navigate to Site Map > Quality.

The Change Requests view appears. 

2 In the Change Requests list, select the closed and verified CR from which you 
want to generate a PR.

3 In the Change Requests form, click the view menu button and choose Copy To 
Patch.

The Patch Requests view appears with the new PR record generated from the CR. 
Most fields are filled in from the CR. 

4 In the Account field, select the customer that is to receive the patch.

5 In the Date Required field, enter the date on which the PR fix must be delivered 
to the customer.
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Approving and Shipping Patch Requests
A PR is approved for shipping as a maintenance release in the Patch Requests view, 
which is used by the release management team. The main groups involved in 
product development must approve a patch before it can be delivered to a customer. 

To record approvals and clear a patch for shipping, use the procedure that follows.

To approve and ship a patch request

1 Navigate to Site Map > Quality > All Patch Requests.

The Patch Requests view appears. 

2 Find the patch you want to ship.

3 As you receive approvals for the patch to be shipped, complete the Technical 
Services, Product Marketing, Engineering, and QA fields.

4 When all teams have approved the PR, in the Patch Status field, select Approved 
to Ship. 

5 When the patch is shipped, in the Patch Status field, select Closed-Shipped.
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By reading this chapter, an applications administrator can gain an overview of 
product development and release management as it is processed through your 
Siebel application, including both administrator and end user tasks. An applications 
administrator can also learn the information and procedures that all users must 
know to do their parts in the release cycle. 

Applications administrators can use this chapter for guidance in setting up the 
Siebel application so end users can use Release Manager, and in keeping Release 
Manager information current. Product Marketing, Engineering, Quality Assurance 
(QA), and Technical Publications managers can use this chapter to guide them in 
monitoring their teams’ progress. End users (product marketers, engineers, QA 
testers, and technical writers) can refer to this chapter for procedures for recording 
their development tasks. 

The Release Manager and Quality modules of Siebel Service work together. After a 
product is released, the Quality module tracks the product improvement process 
and channels requests for improvements to future releases. For more information 
about the Quality module, see Chapter 12, “Quality.”
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The Release Manager module helps to manage new product development and 
release cycles from beginning to end. Release Manager uses data collected in your 
Siebel application to help guide product feature selection and development. 

Release Manager assists with a number of release-related activities. With Release 
Manager, users can do tasks including the following:

■ Communicate feature descriptions throughout the organization

■ Prioritize features so that the most important ones get implemented

■ Develop marketing requirements documents (MRDs) for engineers to use as 
product specifications

■ Allocate engineering resources and track engineering tasks

■ Track QA test plan development and test execution

■ Track documentation development

■ Track activities associated with release-related items

■ Monitor development status

Release Manager Structure
You can think of a product release as a composite of features. The decision to 
implement these features generates multiple release-related items: MRDs to further 
specify the features, engineering tasks to implement the features, QA test plans to 
test the features, and documentation to describe the features. The system helps to 
make sure that each task, test plan, and document derives from one or more new 
features. 

Release Manager is built around features. In Release Manager, engineering tasks, 
MRDs, QA test plans, and technical publications documents are linked to their 
associated features. Users gain benefits such as the following:

■ Executives can justify decisions on how to allocate engineering resources and 
schedule QA testing.
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■ Product marketing managers can see the features specified in MRDs, and 
determine the development, testing, and documentation status for a given 
feature.

■ Engineering and QA managers can know what new features need to be 
incorporated into their project plans and test plans.

Figure 19 on page 456 shows how the various release-related items are linked to 
features. This illustration shows an area that represents Release Manager. Within 
the area, tests are linked to test plans, and test plans, engineering tasks, MRDs, and 
documentation are all linked to features at the center. 
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Figure 19. Release Manager Release-Related Items and Attributes
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Product Release Process
The product release process consists of the following stages:

■ Stage 1. Product Marketing begins the release cycle by defining product features, 
entering those features into the system, determining which features will be 
implemented, and developing marketing requirements documents (MRDs).

■ Stage 2. Engineering builds the features. Engineering defines the tasks required 
to implement the features, builds the features, and uses the system to track task 
completion. 

■ Stage 3. Quality Assurance (QA) defines test plans to be run against the new 
features, and uses Release Manager to track the test plan development. QA then 
tests the features by executing the test plans in various operating environments, 
and records the details of each test iteration. 

■ Stage 4. Technical Publications documents each feature in the appropriate 
publication and uses Release Manager to track document development status.

In practice, these stages are not rigidly sequential. At any given point in the release’s 
development cycle, activities for several of the stages may overlap as teams pursue 
their goals simultaneously. 
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As illustrated in Figure 20, Stage 1 (Product Marketing), Stage 2 (Engineering), 
Stage 3 (Quality Assurance), and Stage 4 (Technical Publications) all lead toward 
the final stage, Ship. 

Figure 20. The Product Release Process
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Business Scenario for Release Manager
This scenario provides an example of a process flow performed by an applications 
administrator and managers and line employees in product marketing, engineering, 
QA, and technical publications. Your company may follow a different process flow 
according to its business requirements. 

Siebel Administrator, Setup
Before the release cycle begins, the administrator sets up a master record for the 
release in the Siebel application. Then the administrator defines an access list of 
people who will be associated with the release. Afterward, the administrator 
designates the people on the access list for project teams that will be associated with 
various stages of the release. The administrator also sets up lists of values for 
picklist fields in the Release Manager views. Finally, the administrator sets up 
activity templates by which end users can associate lists of specific activities with 
certain stages of the release process.

Product Marketing
At the beginning of a release cycle, the Product Marketing group defines a set of 
release-defining features, requirements and enhancements for the products based 
on customer needs. After the detailed features list has been finalized and 
prioritized, Product Marketing enters the features into Release Manager as Feature 
records. If a feature is a complex one with multiple components, Product Marketing 
enters each component as a Feature record, then designates the main feature as its 
parent feature. 

After the features for a release have been entered, Product Marketing writes 
Marketing Requirement Documents (MRDs) and enters them into Release Manager. 
Product Marketing creates a new record for each MRD or logical group of MRDs. 
After the MRD records have been created, Product Marketing links the MRD 
document files to their respective MRD records as attachments. Finally, Product 
Marketing links the MRDs to the features they reference. 
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Engineering
As Product Marketing defines release features, Engineering writes engineering tasks 
to implement those features in the product. Each engineering task is entered as an 
individual record in Release Manager. Each engineering task is linked to the features 
it is designed to implement. If a task is a complex one with multiple components, 
Engineering enters each component as a subtask record, then links it to the main 
engineering task. 

Quality Assurance
As Product Marketing defines release features and Engineering implements them, 
Quality Assurance writes test plans to validate the features. Each completed test 
plan is entered as an individual record in Release Manager. Each test plan is linked 
to the features it is designed to validate.

Next, Quality Assurance creates test strategies, which are logical groupings of test 
plans. (For example, all test plans for one application module might be grouped 
together as a test strategy. Alternatively, all test plans to be executed on the same 
platform and browser combination might be grouped together as a test strategy.) 
Each completed test strategy is entered as an individual record in Release Manager. 
Each test strategy is linked to the test plans that it groups together.

After test strategies have been defined, Quality Assurance runs test plan executions, 
or test passes. Each test plan execution is logged as a test pass record. As the test 
passes are recorded, Quality Assurance links the test pass records to their respective 
test plans. Defects found during testing are recorded as change request records and 
linked to the test passes from which they were recorded. 

During and after testing, Quality Assurance managers can run various reports on 
test pass results to monitor the health and progress of the product release effort.
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Technical Publications
As the other teams design, implement, and test the release features, Technical 
Publications writes technical documents to describe the product and explain how 
to use it. Each technical document is entered as an individual record in Release 
Manager. Each technical document is linked to the features it describes. Technical 
Publications then links an activity plan with standard milestones and deadlines to 
each technical document record. After the technical document records have been 
created, Technical Publications links the technical document files to their respective 
records as attachments. 

Siebel Administrator, Maintenance
While release work is ongoing, the administrator may need to do certain 
maintenance tasks to make sure Release Manager continues to run smoothly for end 
users. As Engineering completes builds of the product, the administrator adds 
product prototype records for Quality Assurance to record tests against. As product 
parameters change in the course of development, the administrator may need to add 
new Area and Subarea category combinations to add to Release Manager’s lists of 
values. When a new release cycle begins, the release administrator determines the 
need for new and revised test plans and test strategies. 
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Example Process Flow for Release Manager
This section presents an example process flow for setting up, using, and 
maintaining the Release Manager module.

Administrator Setup Procedures
Before end users can begin working with Release Manager, the administrator must 
set it up. The tasks applications administrators perform to set up Release Manager 
are listed below. It is recommended that you do them in the order shown. 

1 Set up releases. (See “Setting Up Releases” on page 465.) 

2 Set up the access list. (See “Setting Up the Access List” on page 466.) 

3 Set up project teams. (See “Setting Up Project Teams” on page 466.) 

4 Set up activity templates. (See “Setting Up Activity Templates” on page 469.) 

5 Set up lists of values. (See “Setting Up Lists of Values” on page 467.) 

Product Marketing End-User Procedures
After the administrator has set up Release Manager, Product Marketing begins its 
work. The tasks that Product Marketing personnel perform when using Release 
Manager are listed below. It is recommended that end users do them in the order 
shown. 

1 Create features and subfeatures. (See “Creating Features and Subfeatures” on 
page 470.) 

2 Create MRDs. (See “Adding MRDs” on page 472.) 

3 Associate features with MRDs. (See “Associating Features With an MRD” on 
page 472.) 

Engineering End-User Procedures
When Product Marketing has created features, Engineering begins its work. The 
tasks that Engineering personnel perform when using Release Manager are listed 
below. It is recommended that end users do them in the order shown. 
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1 Add engineering tasks and associating features. (See “Adding Engineering Tasks 
and Linking Features” on page 473.)

2 Adding Subtasks. (See “Adding a Subtask to an Engineering Task” on page 475.) 

Quality Assurance End-User Procedures
When Engineering has implemented tasks, Quality Assurance begins its work. The 
tasks that Quality Assurance personnel perform when using Release Manager are 
listed below. It is recommended that end users do them in the order shown. 

1 Create test plans and associate features. (See “Creating Test Plans and Linking 
Features” on page 476.) 

2 Create test strategies. (See “Creating Test Strategies” on page 478.) 

3 Associate test plans with test strategies. (See “Associating a Test Plan with a Test 
Strategy” on page 479.) 

4 Record test pass results. (See “Recording a Test Pass and Linking a Test Plan” on 
page 480.) 

5 Associate change requests with test passes. (See “Associating Change Requests 
with a Test Pass” on page 481.) 

6 View test plan results. (See “Viewing Test Plan Results” on page 482.) 

Technical Publications End User Procedures
When Product Marketing has written MRDs, Technical Publications begins its work. 
The tasks that Technical Publications personnel perform when using Release 
Manager are listed below. It is recommended that end users do them in the order 
shown. 

1 Creating technical documents and linking features. (See “Creating Technical 
Documents and Linking Features” on page 483.)

2 Add activity plans to technical documents. (See “Adding Activity Plans to Technical 
Documents” on page 484.) 
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Administrator Maintenance Procedures
While end users are working with Release Manager, the administrator must 
maintain it. The tasks applications administrators and release administrators 
perform to maintain Release Manager are listed below. You can do them as needed, 
in any order. 

1 Add product prototypes. (See “Adding Product Prototypes” on page 485.)

2 Add new area and subarea combinations. (See “Adding New Area/Subarea 
Combinations” on page 485.) 

3 Update test plans and test strategies. (See “Updating Test Plans and Test 
Strategies” on page 487.) 
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Administrator Setup Procedures for Release Manager
A number of areas of Release Manager must be set up in advance to make sure of 
the application’s usability for product marketers, quality assurance testers, 
engineers, and technical writers. Depending on your company’s structure and 
policies, these activities might be the duties of the organization’s Release Manager, 
Applications Administrator, or other person responsible for setting up the system. 
For convenience and brevity, this chapter refers to this person as the administrator. 

This section provides instructions for the following procedures:

■ “Setting Up Releases” on page 465

■ “Setting Up the Access List” on page 466

■ “Setting Up Project Teams” on page 466

■ “Setting Up Activity Templates” on page 469

■ “Setting Up Lists of Values” on page 467

Setting Up Releases
When entering a release item record, an end user is required to associate it with a 
particular release. In Release Manager, a release is a type of project, and releases are 
tracked in the same way as projects in Siebel Professional Services. For more 
information on setting up projects, see Siebel Professional Services Automation 
Guide.

There are two types of releases, as follows:

■ Future Releases. Because each release item must be associated with a particular 
release, you must set up the release (project) before entering any records. 
Though only one active release may be in progress, you must set up records for 
future releases as well. That way, if a feature is deferred from the current release, 
the product marketing manager can immediately target it to a specific future 
release.
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■ Unspecified Releases. There may be times when the appropriate future release for 
a given feature or other release item is unknown. Because all release items must 
be associated with a release, you should set up at least one artificial release 
called “Unspecified Release” or some similar term. Orphan release items can be 
linked to this release. When the appropriate future release has been determined, 
an item can then be retargeted to that release.

Setting Up the Access List
Release Manager is based on the Siebel Professional Services model for project 
management, which includes the concept of an access list. Each project has a group 
of people (the ones on its access list) who are associated with a release. To be on a 
release’s access list, an employee must be associated in your Siebel application with 
that release project. 

To be added to an access list, a person must first be added as an employee in your 
Siebel application. For information on setting up employees, see Security Guide for 
Siebel eBusiness Applications.

For information about adding employees to an access list, see the chapter on project 
management in Siebel Professional Services Automation Guide.

Setting Up Project Teams
Release Manager is based on the Siebel Professional Services model for project 
management, which includes the concept of project teams. Each project has a group 
of people (the project team) who own, approve, or otherwise are associated with 
each release item (feature, MRD, engineering task, QA test plan, QA test, or 
document). To be associated with any release item, an employee must be a member 
of the project team. 

To be added to a project team, a person must first be added to the release’s access 
list. See “Setting Up the Access List.” For information about setting up project teams 
and adding employees to them, see the chapter on project management in Siebel 
Professional Services Automation Guide.
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Setting Up Lists of Values
The Siebel Administrator is typically responsible for setting up lists of values (LOVs) 
for use in Siebel eBusiness Applications. Although the Status field is shared by all 
types of release items, the LOVs for the Status field are likely to be specific to each 
release item. 

For example, while the Status values for an engineering task typically relate to the 
development phase of the task (Unit Test, Final, and so on), the Status values for a 
technical publications document typically relate to the production phase of the 
document (Draft, Final Edit, and so on). To prevent end users from having to sift 
through long lists of LOV values for phases that are related to their work, you may 
need to restrict the views in which specific LOV values appear. 

For information on setting up LOVs and restricting the views associated with 
specific LOV values, see Applications Administration Guide.

Table 119 displays information about the LOVs to be set up before using Release 
Manager.

Table 119. Release Manager LOVs

View 
Label

Associated 
Release 
Items Type1 Usage Typical Values

Client OS QA Tests PSTASK_CLIENT_OS Type of operating system 
running on the client test 
machine.

Windows 2000, 
Mac OS

Client 
Type

QA Tests PSTASK_CLIENT_TYPE Type of test machine used by 
the tester.

Dedicated, HTML

Database QA Tests PSTASK_CLIENT_DB Type of database running in 
the test environment.

IBM DB2, 
Microsoft SQL 
Server 7.0

Effort Engineering 
Tasks

PSTASK_ENGINEER_EFFORT Level of effort required of 
the engineer to complete the 
task.

High, Low, 1 Man 
Month

Priority Features PSTASK_PRIORITY Relative importance of the 
feature.

High, Medium, 
P1-Critical
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Revenue Features PSTASK_REVENUE Amount of revenue that can 
be expected if the feature is 
implemented.

High, Low, >5M, 
<1M

Risk Engineering 
Tasks

PSTASK_ENGINEER_RISK Level of risk to destabilizing 
the product by undertaking 
this engineering task.

High, Low

Server OS QA Tests PSTASK_SERVER_OS Type of operating system 
running on the server.

Windows NT

Source Features PSTASK_SOURCE Source of the feature. Customer Input, 
Market Survey

Status All PSTASK_STATUS Current implementation or 
development phase of the 
release item.

Draft, Unit Test, 
Final

Test Class QA Tests PS_QA_TEST_STRATEGY_
TEST_CLASS

Sequence category of the 
test. 

Certification 
Pass, Full Pass, 
Final Pass, 
Acceptance Pass, 
Browser 
Certification

Test Set QA Tests PS_QA_TEST_PLAN_TEST_
SET

Product area to which the 
test was applied. 

Install, Upgrade, 
Report, Charts, 
General

Type QA Tests PSTASK_ALT_TYPE Type of test that was 
conducted.

Blitz, Ad Hoc, 
Detailed, White 
Glove

1. Type value of the picklist record in the Application Administration List of Values view. 

Table 119. Release Manager LOVs

View 
Label

Associated 
Release 
Items Type1 Usage Typical Values
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Adding Special Tag LOVs
You must also add a list of values for the Special Tag field on the QA Test Plans view. 
Table 120 shows an example of how you might set the fields of several new LOV 
records to populate the Special Tag field with values.

Setting Up Activity Templates
The QA and Technical Publications teams have access to activity templates. An 
activity template contains multiple “canned” activities that can be associated with 
a release item. This saves end users from having to enter each activity manually, 
and helps to standardize activities for groups or teams. If end user teams need 
activity templates, set them up before anyone uses Release Manager. 

For information about how to create activity templates and add activities to them, 
see “Setting Up Field Service Activity Templates” on page 93.

Table 120. Special Tag LOV Examples

Field Record 1 Record 2 Record 3 Record 4

Type LOV_TYPE PS_TEST_PLAN_
SPEC_TAG

PS_TEST_PLAN_
SPEC_TAG

PS_TEST_PLAN_
SPEC_TAG

Display Value PS_TEST_PLAN_
SPEC_TAG

Browser Specific EBIZ Specific Config. Specific

Language Independent 
Code

PS_TEST_PLAN_
SPEC_TAG

Browser Specific EBIZ Specific Config. Specific

Language Name English-American English-American English-American English-American

Active True True True True

Replication Level All All All All
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Product Marketing End-User Procedures for Release 
Manager

After Release Manager is set up, product marketers can record the progress and 
results of their product design efforts into the system. Their managers can monitor 
the information they enter. 

This section provides instructions for the following procedures:

■ “Creating Features and Subfeatures” on page 470

■ “Adding MRDs” on page 472

■ “Associating Features With an MRD” on page 472

Creating Features and Subfeatures
Product marketing managers can use Release Manager to enter new product 
features and, if appropriate, subfeature components of the features. 

To add a feature

1 Navigate to Site Map > Release > All Features.

2 Add a new feature record.

3 Complete the fields. Some fields are described in the following table.

Field Comments

Account Account that requested the feature or to which your company is 
contractually obligated to deliver the feature.

Area Product area associated with the feature. 

Associated 
Parties

Individuals associated with the feature. The product marketing 
manager responsible for the feature should be set as Primary. 
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To add a subfeature to a feature

1 Navigate to Site Map > Release > All Features.

2 In the Features list, select a feature to which you want to add a subfeature.

3 Click the Subfeatures view tab.

4 In the Subfeatures list, add a new record and complete the fields as needed. 

Parent Parent feature to the current feature. You can use this field to set up 
an n-level hierarchy of parent features and child subfeatures. 
However, linking to a parent feature with the Parent field does not 
add this feature to the parent feature’s Subfeatures list. See “To add 
a subfeature to a feature.”

Priority Priority of this feature relative to other features targeted for the same 
release.

Product Line The list of product line choices depends on the selection in the 
Subarea field. 

Release Name or number of the product release for which the feature is a 
candidate.

Revenue Indicator of the level of revenue tied to delivering this feature in the 
targeted release.

Source Source of the idea for this feature.

Status Shows color codes with the following meanings:

■ Green - Approved for the release

■ Yellow - May make the release

■ Red - Not going to make the release

Subarea Product subarea associated with the feature. The list of subarea 
choices depends on the selection in the Area field.

Field Comments
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Adding MRDs
Product marketing managers can group like features together into an MRD and track 
the development of the MRD in Release Manager. Authors of the MRDs can attach 
electronic copies to MRD records.

To add an MRD

1 Navigate to Site Map > Release > MRDs.

2 Add a new MRD record.

3 In the Related Features field, select the features you want to link to this MRD.

4 Complete the other fields. Some fields are described in the following table.

Associating Features With an MRD
Product marketing managers can link an MRD with the features that it incorporates.

To associate a feature with an MRD

1 Navigate to Site Map > Release > MRDs.

2 Select an MRD record.

3 Click the Features subview tab.

4 In the Features list, add a new feature record. 

5 In the Add Features dialog box, select a feature you want to link to this MRD.

Field Comments

Associated Parties Individuals associated with the MRD. The author should be set 
as Primary.

Release Name or number of the product release with which the MRD is 
associated.
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Engineering End-User Procedures for Release Manager
After features and MRDs are entered in Release Manager, engineers can begin 
recording the progress and results of their development efforts into the system. 
Their managers can monitor the information they enter. 

This section provides instructions for the following procedures:

■ “Adding Engineering Tasks and Linking Features” on page 473

■ “Adding a Subtask to an Engineering Task” on page 475

Adding Engineering Tasks and Linking Features
After product marketing managers have entered some features and their 
corresponding MRDs into Release Manager, engineering managers can begin 
analyzing the development work and identifying the discrete tasks required to 
implement the features. These tasks can be entered directly into Release Manager. 
As engineering task records are created, they are linked to the features they are 
designed to implement.

The product marketing and engineering managers match the requested features 
with the available engineering resources. During this process, the relative 
importance of the features are weighed against the investment required to 
implement them. Some features may be deferred to a future release. The end result 
is a final set of release features for which the necessary engineering resources are 
available.

To add an engineering task and link features

1 Navigate to Site Map > Release > Engineer Tasks.

2 Add a new task record.

3 In the Related Features field, select the features you want to link to this task.
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4 Complete the other fields, as needed. Some fields are described in the following 
table.

Field Comments

Associated Parties Individuals associated with the engineering task. The 
engineering manager responsible for the task should be set as 
Primary.

Code Review For software releases. Date when the code review took place.

Comp % Portion of the task that has been completed to date.

Design Review Date when the design review took place.

Effort Indicator of the level of effort required on the part of the engineer 
to complete the task.

Engineering Group Engineering group responsible for the task. Usually, this is the 
group to which the engineering manager (owner) of the task 
belongs.

Parent Task Parent task to the current task. You can use this field to set up a 
hierarchy of parent tasks and child subtasks.

Release Name or number of the product release with which the 
engineering task is associated.

Risk Level of risk of destabilizing the product by undertaking this 
engineering task.

Target Date Date when the task is expected to be completed.
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Adding a Subtask to an Engineering Task
If a task is a complex one with multiple components, Engineering enters each 
component as a subtask record, then links it to the main engineering task. 

To add a subtask to an engineering task

1 Navigate to Site Map > Release > Engineer Tasks.

2 In the Engineer Tasks list, select a task to which you want to add a subtask.

3 Click the Subtasks view tab.

4 In the Subtasks list, add a new record and complete the fields as needed. 
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Quality Assurance End-User Procedures for Release 
Manager

After engineering tasks are entered in Release Manager, QA testers can begin 
recording the progress and results of their testing efforts into the system. Their 
managers can monitor the information they enter. 

This section provides instructions for the following procedures:

■ “Creating Test Plans and Linking Features” on page 476

■ “Creating Test Strategies” on page 478

■ “Associating a Test Plan with a Test Strategy” on page 479

■ “Recording a Test Pass and Linking a Test Plan” on page 480

■ “Associating Change Requests with a Test Pass” on page 481

■ “Viewing Test Plan Results” on page 482

Creating Test Plans and Linking Features
After the features for a release have been identified, QA can begin revising existing 
test plans or developing new ones to exercise new product functionality. Test plan 
development is tracked in Release Manager, with the test plan available as an 
attachment to the record. Parties such as product marketers who are associated with 
the development of the test plan are linked to the record, and their approvals are 
recorded. 

For each test plan, the fraction completed and the target completion dates are logged 
so that potential issues will be flagged before they become critical. The QA manager 
decides whether they need to run a particular test plan against one or more test 
strategies, and if so, specifies those strategies. 

To add a test plan and link features

1 Navigate to Site Map > Release > Test Plan Administration.

The QA Test Plans view appears.

2 Add a new test plan record.
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3 In the Related Features field, select the features you want to link to this test plan.

4 Complete the other fields, as needed. Some fields are described in the following 
table.

Field Comments

% Auto Percent of the test that is automated. 

% Auto Horizontal Percent of the horizontal version of the product that the test is 
automated on. 

% Auto 
International

Percent of the international version of the product that the test is 
automated on. 

% Auto Platforms Percent of platforms that the test is automated on. 

Auto Complete 
Date

Date the automated test is completed. 

Automated If selected, indicates this test is automated.

Complete % Portion of the test plan that has been completed to date.

Product Line Automatically populated based on the values selected in the Area 
and Subarea fields. 

QA Owner Person responsible for doing the testing. 

Release Name or number of the product release with which this test plan 
is associated.

Special Tag Tags defined by your company for convenience in grouping or 
querying tests. You can specify multiple tags. For information 
about defining special tags, see “Adding Special Tag LOVs” on 
page 469.

Suggested 
Strategies

Test strategies to apply to this test plan. Available selections 
come from test strategy records entered in the Strategy 
Administration view. See “Creating Test Strategies” on page 478. 

Tag Summary Expanded area field that makes multiple tags visible in the view. 
For convenience in querying tags that are selected in, but that 
might not appear on the view in, the Special Tag field. 

Target Date Date when the test plan is expected to be completed.
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Adding Activity Plans to Test Plans
An activity plan derives from a predefined activity template. An activity template 
contains multiple “canned” activities that can be associated with a release item. 
This saves end users from having to enter each activity manually, and helps to 
standardize activities for QA teams. 

To add an activity plan to a test plan

1 Navigate to Site Map > Release > QA Test Plans.

2 In the QA Test Plans list, select a test plan to which you want to add activities.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, add a new record.

5 In the Template field, select an activity template on which to base this activity 
plan. 

6 Complete other fields as needed. 

When you have associated the activity plan with the test plan, all the activities 
in the activity plan become associated with the test plan and appear in the 
Activities view tab. 

Creating Test Strategies
At the beginning of a release cycle, you define a set of criteria (or matrix) showing 
the various combinations that any given QA test plan can be run against. For 
example, the matrix for a software product might include criteria such as Server, 
Database, Browser, and so on. These criteria sets are known as test strategies. 

Test Plan Owner Individuals associated with the test plan. The author of the test 
plan should be set as Primary.

Test Set Indicates what grouping of tests this test belongs to. Groupings 
may reflect, for example, parts of the product being exercised 
through multiple tests.

Tools Software used to automate this test.
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To create a test strategy

1 Navigate to Site Map > Release > Strategy Administration.

The QA Test Strategy view appears.

2 Add a new test strategy record.

3 Complete the other fields. Some fields are described in the following table.

After the test strategy is saved, it appears as a choice in the Suggested Strategies 
field in the QA Test Plan Administration view, where QA managers can associate 
their test plans with test strategies. 

Associating a Test Plan with a Test Strategy
A QA Release Administrator can select a test strategy record and associate one or 
more test plans with it. This is based on the Test Matrix selection that the QA 
managers made on the Test Plan Administration view. See “Creating Test Plans and 
Linking Features” on page 476.

To add a test plan to a test strategy

1 Navigate to Site Map > Release > Strategy Test Plan Admin.

2 In the QA Test Strategy form, query for the test strategy to which you want to 
add test plans.

3 In the QA Test Plans list, add a new record.

Field Comments

Interactivity Specifies whether the test is either in High Interactivity Mode or 
in Standard Interactivity Mode. 

Release Name or number of the product release with which this test 
strategy is associated. 

Test Class Type of test pass to be done with this test strategy.

Web Srv App Application that runs on the selected Web server. 
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4 In the Test Plan # field, select the test plan you want to add to the current test 
strategy. 

Recording a Test Pass and Linking a Test Plan
When a QA test plan is complete and is associated with a test strategy, tests can be 
done against it. Because test plans are linked to their features in Release Manager, 
QA managers can focus their teams’ efforts on those test plans that are associated 
with the greatest number of new features. As each test is executed, QA testers record 
the results in Release Manager. Each test pass is linked to the test plan that it 
executes.

To record a test pass and link a test plan

1 Navigate to Site Map > Release > QA Tests.

2 Add a new test record.

3 In the Test Plan field, select the test plan on which the test pass is based. 

4 Complete the other fields, as needed. Some fields are described in the following 
table.

Field Comments

Build Product prototype that was tested.

Client OS Type of operating system running on the client test machine.

Client Type Type of test machine used by the tester.

Cover % Portion of the test plan that was executed (covered) by this test.

Database Type of database running in the test environment.

Date Date when the test was conducted.

Interactivity Specifies whether the test is either in High Interactivity Mode or 
in Standard Interactivity Mode. 

Pass % Portion of the test plan that passed this test.

Release Name or number of the product release with which the test is 
associated.
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Associating Change Requests with a Test Pass
While doing a test pass, QA testers encounter product defects and ideas for design 
improvements. QA testers record these defects and ideas as change request records 
and associate them with the test pass in which they were found. 

To associate a change request with a test pass

1 Navigate to Site Map > Release > QA Tests.

2 Select the test record to which you want to link a change request.

3 In the Change Requests list, click Add.

4 In the Add Change Request dialog box, do one of the following:

■ To link an existing change request to the test pass, select a change request 
record and click OK.

■ To log a new change request against the test pass, click New.

The Change Requests view tab displays a change request entry form. For 
information about entering change requests, see Chapter 12, “Quality.”

Server OS Type of operating system running on the server machine in the 
test environment.

Status Stability of the prototype as assessed by the tester during that 
test.

Tester Individuals associated with the test. The individual who 
conducted the test should be set as Primary.

Type Type of test that was conducted.
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Viewing Test Plan Results
After test passes are logged, Quality Assurance personnel can view the test pass 
results that were logged against a test plan. 

To view the results of test passes against a test plan

1 Navigate to Site Map > Release > QA Test Plans.

2 Select a test plan.

3 Click the QA Tests view tab.

4 View the information in the fields. Some fields in the QA Test Plans form are 
listed in the following table.

Field Comments

Last Build Read-only. From the most recent test pass recorded against this 
test plan. Last product prototype version tested, and stability of 
the prototype as assessed by the tester. 

Passes Read-only. Number of test passes that have been executed 
against this test plan.
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Technical Publications End User Procedures for Release 
Manager

As design, development, and test data are entered in Release Manager, technical 
writers can begin recording the progress and results of their documentation efforts 
into the system. Their managers can monitor the information they enter. 

This section provides instructions for the following procedures:

■ “Creating Technical Documents and Linking Features” on page 483

■ “Adding Activity Plans to Technical Documents” on page 484

Creating Technical Documents and Linking Features
After release features have been identified, Technical Publications can begin 
revising existing documentation or developing new documents to describe new 
product functionality. 

Documentation development is tracked in Release Manager, with the document 
available as an attachment to the record. Associated features are linked to the 
document. Parties such as product marketers who may be associated with the 
development of the document are linked to the record, and their approvals are 
recorded. For each document, the fraction completed and the target completion date 
are logged so that potential issues can be flagged before they become critical. 

To add a document and link features

1 Navigate to Site Map > Release > Technical Documents.

2 Add a new technical document record.

3 In the Related Feature field, select the features you want to link to the document.
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4 Complete the other fields. Some fields are described in the following table.

Adding Activity Plans to Technical Documents
An activity plan derives from a predefined activity template. An activity template 
contains multiple “canned” activities that can be associated with a release item. 
This saves end users from having to enter each activity manually, and helps to 
standardize activities for technical publications teams. 

To add an activity plan to a technical document

1 Navigate to Site Map > Release > Technical Documents.

2 In the Technical Documents list, select a technical document to which you want 
to add activities.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, add a new record.

5 In the Template field, select an activity template on which to base this activity 
plan. 

6 Complete other fields as needed. 

When you have associated the activity plan with the technical document, all the 
activities in the activity plan become associated with the technical document 
and appear in the Activities view tab. 

Field Comments

Associated Parties Individuals associated with development of the document. The 
author should be set as Primary.

Complete % Portion of the document that has been completed to date.

Est Pages Estimated number of pages for the completed document.

New % Portion of the document that will be new in this version.

Release Name or number of the product release with which the 
document is associated.

Target Date Date when the document is expected to be completed.
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Administrator Maintenance Procedures for Release 
Manager

You must perform some Release Manager maintenance tasks on an as-needed basis. 
These tasks are your ongoing responsibility.

This section provides instructions for the following procedures:

■ “Adding Product Prototypes” on page 485

■ “Updating Test Plans and Test Strategies” on page 487

■ “Adding New Area/Subarea Combinations” on page 485

Adding Product Prototypes
As a product progresses through the release cycle, increasingly advanced product 
prototypes become available for testing. (In the case of software development, these 
prototypes are known as builds.) When QA testers execute a test plan, they select 
the version number of each tested prototype. As each new prototype becomes 
available, you are responsible for entering it into Release Manager so that QA can 
record tests against it. 

You enter builds as products in the Quality screen, Release Product Administration 
view.

Adding New Area/Subarea Combinations
Area and Subarea fields are linked so that the values available in the Subarea field 
change dynamically according to the value selected in the Area field. These lists of 
values appear in both the Release Manager and Quality modules of your Siebel 
application. In Release Manager, an area value is associated with a feature.

As product parameters change in the course of development, you may need to add 
new Area and Subarea combinations to Release Manager. 

To add an area/subarea combination

1 Navigate to Site Map > Quality > Quality Administration.
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2 In the Quality Administration list, add a record for each area/subarea 
combination.

For example, if you want a selection of Inventory in the Area field to constrain 
the choices in the Subarea field to Shipping, Receiving, and Cycle Counting, then 
create three records with the Area and Subarea fields completed as shown in the 
following table.

3 Complete the other fields in each of the records. Some fields are described in the 
following table.

NOTE: Because of the mappings created by Area records in this view, when a feature 
record is added, selecting a value in the Area field automatically populates the 
Subarea, Product Line, QA Owner, and Engineering Group fields.

Area Subarea

Inventory Shipping

Inventory Receiving

Inventory Cycle Counting

Field Comments

Product Line Grouping of products with which this Area/Subarea combination 
is associated. 

QA Owner Quality Assurance team owner with which this Area/Subarea 
combination is associated.

Engineering Group Engineering team with which this Area/Subarea combination is 
associated.
486 Siebel Field Service Guide Version 7.5, Rev. A



Release Manager

Administrator Maintenance Procedures for Release Manager
Updating Test Plans and Test Strategies
When a new release cycle begins, some test plans and test strategies from the 
previous release are relevant to the new release, while some are not. Existing test 
plans and test strategies must be sifted for relevance to the new release, and the 
relevant ones updated. Gaps in the existing resources must be identified and filled 
with new test plans and test strategies. These are ongoing tasks for a QA Release 
Administrator. 

For information about adding and linking test plans and test strategies, see “Quality 
Assurance End-User Procedures for Release Manager” on page 476.
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Assets 14
This chapter describes the capabilities in Siebel Field Service for tracking and 
managing assets. Field Service also provides for automating the collection of data 
from assets in the field, providing information for preventive maintenance, repairs, 
billing, and marketing.
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Properties of Assets
An asset in Siebel Field Service is an instance of a product that has an individual 
identity and an association with a customer. An asset can be created for any product 
by assigning it a unique asset number. An asset has a quantity, a location, and a 
monetary value. An asset is associated with a product and an organization.

In Siebel Field Service, assets have these additional properties:

■ An asset can be physical or virtual. 

■ Assets can have serial numbers or not.

■ Assets can exist individually or they can have components. 

■ Assets can be related to or dependent upon other assets. 

Assets can be associated with other Siebel business objects as well as with internal 
data and calculations. Some examples are as follows:

■ Assets can contain a hierarchy of other assets as components. There is no 
restriction to the number of tiers and the number of components that comprise 
a multi-tiered asset.

■ Actions such as install, uninstall, upgrade, or downgrade can be performed on 
an asset. Install and uninstall actions are recorded as asset transactions.

■ The same asset can have different products over time. For example, the product 
on which an asset is based may become obsolete and be replaced with a 
different product. In this case, the same asset record can remain in your Siebel 
application but the product with which it is associated can be changed.

■ When an asset is serviced, service requests, preventive maintenance records, 
and repair records can be associated with the asset, and a service history is 
maintained for that asset.

■ Assets can have multiple types of measurements set up, including gauges, 
counters and sensors. Each measurement can have multiple readings recorded 
manually or automatically and stored for diagnosis or for usage tracking.

■ The current value of an asset can be calculated or revalued and stored based on 
its condition, value basis, and cost method.
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Asset Serialization
Not every asset requires a serial number. If an asset requires a serial number, it is 
known as serialized.

If an asset is serialized, then a serial number is required for all movements and 
transactions for this asset, including the following:

■ Inventory transactions

■ Field part movements

■ Cycle counts

■ Shipments

■ Receipts

For all inventory transactions involving serialized products, an asset is considered 
equivalent to one part (quantity = 1).

If a product is serialized (see “Product Field Service Details View” on page 302), 
then the assets of this product must also be serialized. However, an asset can be an 
instance of a non-serialized product and still have a serial number. 

Serialized assets are treated differently from non-serialized ones. For example, 
whenever serialized assets are shipped or received, Siebel Field Service expects the 
right number of assets with matching serial numbers.

Asset Registration
An asset can be associated with an account and with an account site. An asset can 
also have an owner and one or more contacts associated with it. If a customer buys 
an asset, then the owner and the account are the same. If, however, the asset is 
leased or rented, then the account is where the asset is located, and the owner is 
the leasor or rental agent for the asset. All registered assets for an account can be 
viewed from the Accounts screen.
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Hierarchical Assets
Assets can be hierarchical with other asset components.

A hierarchical asset is an asset with a hierarchical structure consisting of asset or 
product components. The hierarchical structure of a complex asset can consist of 
multiple levels and sub-levels of asset or product components and sub-components. 
There is no restriction on the number of levels or the number of components that 
can comprise a complex hierarchical asset. Asset components can be serialized or 
non-serialized. For example, a computer is a parent asset that has child assets: a 
motherboard (Part # M, Qty 1, Serial # 123), RAM (Part # RAM, Qty 16, no Serial 
#), and so on.

A customizable asset is an asset that is instantiated from a configurable product. It 
can be customized by eConfigurator. For information about configurable products, 
see Product Administration Guide.

Components of a hierarchical asset inherit some properties of the top-level asset. 
Changing the following fields of the top or parent level asset of a hierarchical asset 
changes the same fields in all installed components: Account (and all Account-
related fields; for example, Site, Address Line 1, and so on), Owner, Ownership, and 
Organization. 

Inheritance applies whether the change is initiated by a user action or by an 
automated process. Changes to the components occur when a user updates the 
fields mentioned in the previous paragraph and the record is saved. Only the top-
level asset's fields can be updated. The fields of component assets are read-only.

Siebel Field Service offers views to display complex asset hierarchies. See “Explorer 
View” on page 514 and “Explorer Across Organizations View” on page 514.
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Asset Transactions 

The installed base or BOM for an asset is maintained with asset transactions of the 
types Install, Uninstall, Upgrade, and Downgrade. These transactions must be 
created manually. 

For example, a computer (asset A) has a defective disk drive (asset H) that must be 
replaced with another disk drive (asset N). The change is effected by two asset 
transactions. The first uninstalls the defective asset (H) from the parent asset (A). 
The second installs the new part (N) in the parent asset (A).

If an asset has components, a transaction done to that asset automatically includes 
its components. 

Some asset transactions change inventory levels directly. For details, see “Mobile 
Inventory Transactions” on page 330.
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Follow these procedures to set up assets.

To create an asset

1 Navigate to the Assets screen.

2 In the More Info form, click the show more button to see all of the fields for an 
asset.

3 Create an asset record.

4 In the Product field, select a product.

5 Enter values for the other fields, as needed.

NOTE: If a predefined query on the Assets view limits the displayed records to a 
subset of all the assets, creating an asset with a customizable product and 
clicking Customize refreshes the view. This causes the new asset record to 
disappear from the visible part of the view. To find the record again, you must 
query for it, then click Customize again to complete the configuration. 

For information about the Customize button, see “Assets View” on page 507.

To associate change requests with an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Change Requests view tab.

4 Add a new change request record.

5 In the Add Change Request dialog box, select an existing change request or 
create a new change request.

To associate a backup or dependent asset with a primary asset

1 Navigate to the Assets screen.

2 Select an asset.
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3 Click the Relationships view tab and create a related asset record.

a In the Asset # field, select an asset.

b In the Relationship field, select Backup or Dependent.

4 Enter values for other fields, as needed.

Transactions and Components
End users must create transactions to add components to an asset. 

To manually associate a transaction with an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Transactions view tab and create an asset transaction record.

a In the Type field, select a transaction type.

b In the Asset # field, select the parent asset or any one of its components.

c Enter values for other fields, as needed.

To create components

1 Follow the steps of “To manually associate a transaction with an asset.” 

a In the Type field, select Install as the transaction type.

b In the Asset # field, select an asset. 

2 Click the Components tab.

The asset selected in the transaction record appears in the Components list for 
the primary asset.

Creating a Hierarchical Asset From a Product Bundle
You can generate a hierarchical asset from a product bundle. For information about 
hierarchical assets, see “Hierarchical Assets” on page 492.
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To generate a hierarchical asset from a product bundle

1 Navigate to the Assets screen.

2 Create an asset record.

3 In the Product field, select a product bundle.

4 Enter values for the other fields, as needed.

5 Click the Components tab.

The Components list shows the asset components created from the child 
products in the product bundle.

CAUTION: To successfully generate a hierarchical asset, a product bundle can consist 
only of parent and child products; for example, a laptop computer that comes with 
a CD-ROM drive. It cannot include grandchild products; for example, an airplane 
that comes with an engine, which in turn comes with a fuel tank.

Asset Mapping
Asset mapping records the factors that adjust the cost of assets. Adjustments 
depend on the Condition, Value Basis, Cost List, and Cost Method fields for each 
asset. These factors are used to calculate the Asset Values and the Replacement 
Costs on the Asset Valuation screen (see “Value View” on page 508). 

NOTE: Asset mapping applies to product lines and to all assets that belong to the 
same product line and cost list.

To map the cost of assets for specific product lines

1 Navigate to Site Map > Pricing Administration > Cost List.

2 Select a cost list. 

3 Click the Asset Mapping view tab.

4 In the Asset Mapping form, click New.
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a Select values in the Cost List, Product Line, and Cost Method fields.

The Cost Method field should match the cost method used in the Cost List 
Line Items view.

b In the Cost Field field, select Asset Value or Replacement. 

Asset value and Replacement specify two different methods of calculating 
the cost. See “Value View” on page 508 for details.

c Select values for Condition and Value Basis fields, if needed. 

d Enter a value (percentage) for the Factor field.

NOTE: To assign the same factor to various cases of Condition and Value Basis, 
leave these values blank in the corresponding records and add a value for Factor. 
This factor applies to all of the unspecified cases of Condition, Value Basis, or 
both. If another record specifies either Condition or Value Basis, that record 
overrides the default record.

If there are no asset mapping records and a cost list is specified, the Value view 
(see “Value View” on page 508) uses the asset cost from Cost List Line Items 
views. For more information, see Pricing Administration Guide.

Writer’s note: Replace the whole preceding procedure with a cross-reference to the 
Pricing Admin. Guide?

To associate a preventive maintenance plan with an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Preventive Maintenance view tab.

4 From the Preventive Maintenance tab’s Show drop-down list, select Plans.

5 In the Preventive Maintenance view, create a new record.

6 In the Name field, select a PM plan.
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Asset Measurements
Measurements are defined for a product and apply to the assets of that product.

To define measurements for assets

1 Navigate to Site Map > Product Administration.

2 Select a product.

3 From the More Info tab’s Show drop-down list, select Product Measurements.

4 Create a new record in the Product Measurements subview tab.

5 Enter the name of the product measurement and complete other fields as 
needed.

The defined measurement applies to all assets generated from the selected 
product.
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Obtaining Information About Assets
Follow these procedures to obtain information about assets.

To review all change requests for a selected asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Change Requests view tab.

NOTE: Click the hyperlink in the Change Request # field to see more information 
about a change request. 

To review all repairs for a selected asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Repairs view tab.

The Repairs view shows all recorded repairs to the selected asset.

To review all activities associated with an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Activities view tab.

To review preventive maintenance activities associated with an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Preventive Maintenance view tab.

4 In the Show drop-down list, make sure that History is selected.
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To view the status of a preventive maintenance plan for an asset

1 Navigate to the Assets screen.

2 Select an asset. 

3 Click the Preventive Maintenance view tab and select Plans from the Show drop-
down list.

To view an asset hierarchy

1 Navigate to the Assets screen.

2 In the Show drop-down list, do one of the following:

■ To view assets associated with your organization, select Assets Explorer.

■ To view assets associated with all organizations, select Assets Explorer 
Across Organizations.

3 In the explorer list in the left pane, click the plus sign (+) in front of each asset 
to see a hierarchical list of its components. 

Calculating the Value and Cost of an Asset
Follow these procedures to calculate the costs and value of assets.

Adjusted Cost
The following procedure calculates the adjusted cost of an asset from the original 
cost, plus the value of enhancements, minus the value of depreciation, write-
downs, and so on. 

To calculate the adjusted cost of an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Value view tab.

a In the Original Cost field, enter the original cost, if it is not already there.

b In the Value Basis field, select Adjusted.
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c In the Condition field, select the asset’s condition.

4 To create a record for an action that affects the value of the selected asset, create 
a new record in the Asset Valuation subview.

5 On the Value view tab, click Recost.

Field Service calculates the adjusted cost as the original cost plus or minus the 
sum of values in the Amount column of the Asset Valuation subview. The 
calculation also includes a factor for the asset’s condition.

Field Service calculates and returns the Adjustment amount and Adjusted Cost 
to the corresponding fields on the Value form. The adjusted cost is calculated as 
the original cost, plus or minus the sum of values in the Amount column of the 
Asset Valuation subview. The calculation also includes a factor for the asset's 
condition. See “Asset Mapping” on page 496.

Value-based Cost
The following method of determining the cost of an asset uses the value basis for 
the asset. These variables are defined in the “Asset Mapping View” on page 505.

To calculate the value and replacement cost of an asset

1 Navigate to the Assets screen.

2 Select an asset that has one or more associated cost lists.

NOTE: An asset is associated with a cost list through the product on which it is 
based. To display the selected cost list’s associated products, navigate to Site 
Map > Pricing Administration > Cost Lists and click the Cost List Line Items 
tab. 

3 Click the Value view tab.

4 In the Cost List field, select a cost list.

5 In the Value Basis field, select a value other than Adjusted.
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6 Click Recost.

Field Service calculates and returns the Asset Value and Replacement Cost to the 
corresponding fields on the Value form. The calculation is done by one of the 
following methods:

■ Asset Value = Factor * Original Cost 

■ Replacement Cost = Factor * Cost List Value of Product

NOTE: To specify which method to use for the value-based cost calculation, 
navigate to Pricing Administration > Cost List and click the Asset Mapping view 
tab. In Cost Field, selecting Asset Value or Replacement. See “Asset Mapping” 
on page 496.

Setting Up Asset Measurements
Follow these procedures to set up measurements for assets.

To associate measurements with an asset

1 Navigate to the Assets screen.

2 Select an asset. 

3 Click the Measurements view tab.

4 In the Measurements list, create a record for a measurement type to associate 
with this asset.

5 Enter information in the required fields.

NOTE: You are only allowed to select measurement types that are already defined for 
the product. To define the measurement types that are associated with assets, see 
“To define measurements for assets” on page 498.
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Recording Readings From Assets
Follow these procedures to record readings of measurements from assets.

To record a reading for an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Readings view tab and select a measurement type record.

4 Click the Readings subview tab.

5 In the Readings form, create a new record for a reading associated with this asset 
and measurement type.

6 In the Reading field, enter the value of the reading.

7 Enter information in the required fields.

8 When the reading is complete, select the Done check box. 

The record becomes read-only. This check box must be selected in order for the 
reading to be charted.

CAUTION: If the product of an asset has been changed since the asset was created, 
then measurement types that are not defined for the current product may remain 
associated with the asset. Thus it is possible to record a measurement that is invalid 
for the asset. This may cause a database integrity failure. Therefore, it is 
recommended that you validate measurement types between the asset and its 
product every time you take a reading.

To record a reading for an asset associated with a selected activity

1 Navigate to the Activities screen.

2 Select an activity with an associated asset.

3 Click the Readings view tab and select a measurement type record.

4 In the Readings form, create a new record for a reading associated with this asset 
and measurement type.
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5 In the Reading field, enter the value of the reading.

6 Enter information in the required fields.

To analyze the results of readings for a selected asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Charts view tab.

4 From the Show drop-down list, select Measurement Analysis.

5 In the Charts list, select a measurement type record.

The Readings subview tab shows the readings from a selected measurement type 
as a function of the date of the readings.
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Pricing Administration Screen
The Pricing Administration screen has one view for configuring the calculation of 
an asset’s value. To see this view, navigate to Site Map > Pricing Administration > 
Cost List, and click the Asset Mapping view tab.

Asset Mapping View
The Asset Mapping view records the factor (percentage) that is used to adjust the 
cost of an asset. These factors are used to calculate the Asset Values and the 
Replacement Costs in the Value view (see “Value View” on page 508). Table 121 
describes items in Asset Mapping records.

Asset mapping values apply to specific cost lists at the level of product lines 
(including their hierarchies of products and assets). Each combination of cost field, 
cost list, product line, condition, value basis, and cost method can have a record for 
asset mapping.

For a complete discussion of costs lists and asset mapping, see Pricing 
Administration Guide.

Table 121. Selected Items in the Asset Mapping View

Item Description

Cost Field The field in the Asset Value view to which this calculation applies; for 
example, Asset Value or Replacement Cost.

Factor A percentage of the cost, from the cost list, for the selected asset. If a 
mapping is unspecified, the factor defaults to 100%.
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The Product Administration screen has a view for defining measurements of specific 
products. To see this view, navigate to Site Map > Product Administration, click the 
click the More Info view, and then select Product Measurements from the Show 
drop-down list.

Product Measurements View
The Product Measurements view defines measurements that may be obtained from 
specific assets. Table 122 describes items in product measurements records.

Upper and lower limits for readings may indicate threshold or trigger values for 
an asset. For example, exceeding an upper limit could trigger a preventive 
maintenance action.

Measurements associated with a product are not automatically associated with 
assets of the product. 

Table 122. Selected Items in the Product Measurements View

Item Description

Maximum The largest possible value for the measurement device.

Minimum The smallest possible value for the measurement device.

Upper Limit The upper control limit for readings. This is less than or 
equal to the Maximum.

Lower Limit The lower control limit for readings. This is greater than 
or equal to the Minimum.

Use Plan Bill Method The method of accumulating data from readings, chosen from 
a list:

■ Incremental. Counter increments continuously with 
each reading.

■ Absolute. Counter is set to a predetermined minimum or zero 
after each reading.

Expected Usage A numeric value for the expected use, which the Invoice Engine 
uses to bill for usage if readings of usage are unavailable and if 
Estimate is checked (see “Use Plans View” on page 225).

Use Basis (Days) The time period, in days, over which the expected use is to occur.
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The Assets screen records all information about assets, including service and repair 
history, components, associated activities, and preventive maintenance.

Assets View
The All Assets view defines assets. Some fields in the Assets view are described in 
Table 123.

A Customize button appears in the top bar of the Asset form. The button is available 
only if your company has a license for eConfigurator and the asset was instantiated 
from a configurable product. When an end user clicks this button, Siebel Field 
Service launches eConfigurator for the asset displayed in the form. For information 
about configurable products and eConfigurator, see Product Administration Guide.

Table 123. Selected Fields in the Assets View

Field Comments

Serialized Selected if the product selected is a serialized product. Read-
only in the Assets screen.

Reference Indicates that the asset can be referenced to customers or to 
other vendors, depending on the organization’s business 
process.

Operating Status Whether the asset is operational and at what level. 

Purchase Site Location of the asset.

Product Line Inherited from the product from which this asset is derived.

Class Inherited from the product from which this asset is derived.

Parent Asset # Read-only. The next higher level asset that the selected asset 
is currently installed under. For example, the parent asset of 
a disk drive is a computer. 
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Activities View
The Activities view associates activities with specific assets. For more information, 
see Chapter 3, “Field Service Activities.”

Warranty View
For information about this view, see “Warranty View” on page 524.

Value View
The Value view calculates the current value of an asset based on its history.

There are two ways that assets can be valued:

■ Changes in asset value. An asset value is based on the original cost of the asset, 
plus or minus changes to the asset (such as upgrades or damage). This is an 
accurate method for tracking assets, but requires entry of detailed asset 
information. This information is entered in the Asset Valuation subview. 

NOTE: Asset Valuation records can have negative cost values to reflect 
devaluation in the asset cost.

■ Asset mapping. An asset is valued as a percentage of its value on the cost list. 
The percentage is based on the current condition of the asset. For example, 
a new asset in excellent condition would be 100% of the cost list value, while 
a used asset in average condition would be 40% of the cost list value. For 
information about setting these percentages, see “Asset Mapping View” on 
page 505.

Both cost and value are important because they allow businesses to report the value 
of their inventory accurately and to make repair versus replace decisions based on 
asset valuation.
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Recost
A Recost function is available as both a button and a menu command in the Asset 
Screen’s Value view. Recost assesses an asset’s cost by applying data from asset 
value records. To calculate the current cost and the replacement value of the asset, 
an end user must select a cost list, condition, and value basis and then click the 
Recost button or choose Recost from the view menu. Recost calculates the values 
by taking the cost of the asset from the cost list, factoring in the cost method, and 
applying the factor from Asset Mapping. Asset Mapping must provide mapping for 
Asset Value and Replacement Cost. If the mapping is unavailable, the factor defaults 
to 100%. 

Readings View
Together with the Measurements view, the Readings view does the following:

■ Captures asset usage and compares actual versus expected usage.

■ Captures data needed for preventive maintenance.

■ Automates meter reading, fee-per-use, and other usage-based service models.

■ Captures performance and quality data. 

The Readings view records data from measurements of an asset. The Done check 
box indicates that the reading is complete and the record becomes read-only.

Charts View
The Asset screen has a Measurement Analysis chart that shows the readings from 
a selected measurement as a function of the date of the readings. The upper and 
lower limits of readings, set in the Product Measurements view (see “Product 
Measurements View” on page 506), are also shown on the graphs.
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Components View
The Components view displays immediate components of specific assets. The 
parent asset record appears in the Asset form, while the parent asset’s child 
components appear in the Components list below. The sub-components of these 
components do not appear in the list. To view the sub-components of a child 
component, click on the hyperlink in the Asset # field and click on the Components 
view tab.

For example, asset A has a component asset B, which in turn has a sub-component 
asset C. The Component list for asset A displays only asset B. To view asset C, click 
on the hyperlink for asset B and click on the Components view tab. Asset C is 
displayed in asset B's Component list.

You can build a hierarchy of assets by defining each level in the hierarchy as a 
component. Components are themselves individual assets that must exist before 
being entered into component relationships. Component relationships are defined 
in the Transactions view. 

Transactions View
The Transactions view allows an end user to create asset transactions manually. 
These transactions are of the types Install, Uninstall, Upgrade, and Downgrade. 

Transactions of the type Install can create a hierarchy of components for existing 
assets. Removing a component requires another transaction of the type Uninstall. 
An Install transaction sets the Status and Install Date. An Uninstall transaction 
clears the Status and Install Date. Install and uninstall transactions can be entered 
manually in the Transactions list, or field part movements can create these 
transactions automatically. See “Parts Movement Administration View” on 
page 342. 

Depending on which transaction type you select, assets become available for 
selection as follows:

■ Uninstall - Only assets that are currently installed

■ Downgrade - All assets

■ Install - Only assets that are not currently installed and are in the same inventory 
location, an external location, or no location 
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■ Upgrade - All assets

NOTE: The asset transactions (Install, Uninstall, Upgrade, and Downgrade) do not 
directly update quantities for inventory levels. 

Change Requests View
For information on Change Requests, see Chapter 12, “Quality.”

Repairs View
The Repairs view lists all of the repair numbers recorded for an asset. See “Repairs 
View” on page 574 for details.

Relationships View
The Relationships view records backup assets for a primary asset and assets that 
depend on the operation of a primary asset.

An example of a dependent asset is a hospital power system; hospital medical 
equipment is dependent on the power system. By checking this view, the engineer 
can tell what other assets may be affected by a defective asset. The field service 
engineer can then take steps to make sure that no unintended disruptions occur. In 
this example, the engineer would make sure that the medical equipment was 
switched to the backup power supply before down taking the primary 
power supply.

Measurements View
Together with the Readings view, the Measurements view does the following:

■ Captures asset usage and compares actual versus expected usage.

■ Captures data needed for preventive maintenance.

■ Automates meter reading, fee-per-use, and other usage-based service models.

■ Captures performance and quality data. 
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Measurement records are defined for a product. One or more measurement type 
records can be inherited by an asset of this product and adapted for the selected 
asset. See “Product Measurements View” on page 506. 

Preventive Maintenance View
The Preventive Maintenance view contains two subviews, accessible from the Show 
drop-down list:

■ History. Displays preventive maintenance actions associated with assets.

■ Plans. Associates preventive maintenance plans with assets. The Active check 
box indicates that the Preventive Maintenance Engine can use this plan to 
schedule preventive maintenance action.

In the Asset form, an End Date field allows an end user to set the latest date that 
the Preventive Maintenance Engine considers when generating preventive 
maintenance actions. Setting a date in the future allows the Preventive Maintenance 
Engine to generate a future schedule of preventive maintenance actions. The Run 
PM button runs the Preventive Maintenance Engine for the selected asset.

For more information about the PM plans, PM actions, and the Preventive 
Maintenance Engine, see Chapter 16, “Preventive Maintenance.”

Audit Trail View
The Audit Trail view displays an audit trail for a selected asset.

When any of the following fields in an asset record are modified, the change is 
automatically recorded and time stamped in the Audit Trail view. 

■ Account

■ Status

■ Operating Status

■ Revision

■ Inventory Location

■ Contacts
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■ Employees

■ Ownership

■ Owner

■ Installed Date

■ Registered Date

■ Shipped Date

■ Manufactured Date

■ Purchased Date

■ Primary Warranty

■ Organization

The following actions are also tracked as part of the audit trail:

■ Changes to the asset’s components; that is, when components are installed or 
uninstalled.

■ Changes to the asset's value.

Entitlements View
The Entitlements view displays all entitlements that cover the selected asset. This 
view is read-only.

Uptime Data View
The Uptime Data view displays a selected asset’s operating status, operating history, 
and a chart showing its operating status over time.

This view shows a timestamp of when the Operating Status field of the asset was 
changed, the original value, the new value, the employee who made the change, 
and comments. This view shows when the asset was taken down and why. The 
view also displays a chart titled Operating Status Over Time. This chart plots the 
Operating Status value (y-axis) over time (x-axis). 
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Attributes View
The Attributes view shows the attributes associated with the selected asset. This is 
a read-only view. Attributes are associated with configurable products and can only 
be changed by invoking the eConfigurator through the Customize button on the 
Asset form.

Explorer View
The Explorer View is accessed through the Assets Show drop-down list. This view 
shows an explorer-format view of assets, including a hierarchical view of assets that 
have components. This view displays only the assets in the user's organization.

For each hierarchical parent asset, a + sign is displayed to the left of the first 
column, denoting a tree structure under it. Clicking the + sign expands the tree to 
the next level of components. If there are further levels below, a + sign is displayed 
next to each line item that has more sub-components at a lower level.

Explorer Across Organizations View
The Explorer Across Organizations View is accessed through the Assets Show drop-
down list. This view is the same as the Assets Explorer View, except that it shows 
all assets across organizations.
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This chapter describes how to use Siebel Field Service to track the warranties 
for products.
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Warranties Overview
Field Service offers multi-level warranty tracking, immediate recognition, and 
closed-loop handling. Warranties are categorized into three types: product, 
manufacturer, and component. Each warranty includes a duration and specifies the 
covered products, costs, and service providers. These warranties are separate from 
entitlements that are sold to a customer. 

When an asset is created for a product that is covered by warranties, the user can 
verify the applicable warranties by clicking the Get Warranties button. The number 
of days remaining on the warranty is automatically tracked. 

When creating a service request or repair number for repairing an asset, the user 
can choose the Check Warranty menu command to immediately find out the valid 
warranty coverage based on a specified day.

When an asset returned from the field is still under warranty, an order can be 
created for the warranty provider, and each line item is tracked through closure, 
based on the warranty recovery process.
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Follow these procedures to set up warranties.

To create a new warranty

1 Navigate to Site Map > Service Administration > Warranties.

2 Create a new warranty record.

3 Enter values for the required fields.

To specify the products covered by a warranty

1 Navigate to Site Map > Service Administration > Warranties.

2 Select a warranty.

3 Click the Products view tab.

4 Create a record and associate a product with the selected warranty.

5 Enter values for the required fields. 

6 Repeat Step 4 and Step 5 for each additional product covered by the selected 
warranty.

To associate a warranty with warranty service providers

1 Navigate to Site Map > Service Administration > Warranties.

2 Select a warranty.

3 Click the Service Providers view tab.

4 Create a new record to associate a service provider with the current warranty.

To associate warranties with an asset manually

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Warranty view tab.

4 Create a record to associate a warranty with the selected asset.
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5 Enter values in the Start Date, End Date, and Name fields.

NOTE: Before a warranty can appear in the Pick Warranty dialog box, a product 
must be associated with that warranty in the Service Administration screen, 
Warranties view, Products subview. 

To associate warranties with an asset automatically

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Warranty view tab.

4 Click Get Warranty.

All warranties that are associated with the asset's product and that are 
applicable to the asset will be automatically instantiated in the Warranty list.

5 Modify the values in the Start Date, End Date, and Name fields of the Warranty 
records as required.

CAUTION: The Start Date Type field in a warranty record specifies which field 
value in the current asset record to use as the start date of the warranty’s 
coverage of that asset. For example, if the Start Date Type of the warranty is 
Installed Date, then the Installed Date of the asset is used as the start date of the 
warranty associated with that asset. If the date field specified by Start Date Type 
is not populated in the asset record, then the Get Warranty command will fail.

To associate warranties with an order line item

1 Navigate to the Orders screen.

2 In the Show drop-down list, make sure one of the Service Orders options is 
selected. 

3 Select an order.

4 Click the Line Items view tab.

5 Select a line item.
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6 Click the Warranty subview tab.

7 Create a record to associate a warranty with the selected line item.

8 Enter values for the required fields.

NOTE: Before a warranty can appear in the Pick Warranty dialog box, a product 
must be associated with that warranty in the Service Administration screen, 
Warranties view, Products subview. 
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Obtaining Information About Warranties
To verify warranties and related information for an asset

1 Navigate to the Assets screen.

2 In the Assets list, select an asset.

3 In the More Info form, click the show more button.

The form shows the Status, Installed date, and the Registered date for the 
selected asset. 

4 Click the Warranty view tab.

5 In the Warranty list, click Get Warranty.

The Warranties dialog box displays all warranties associated with the selected 
asset. Each warranty record shows the start date, the end date, and the number 
of days left on the warranty.

To verify the warranties for a product

1 Navigate to the Products screen.

2 Select a product.

3 Click the Warranties view tab.

The Warranties list shows the warranties associated with this product.

To check the products covered by a warranty

1 Navigate to Site Map > Service Administration > Warranties.

2 Select a warranty.

3 Click the Products view tab.

The Products list shows the products covered by this warranty.

To verify warranties for a service request

1 Navigate to the Service screen. 
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2 Select a service request that has an associated product or asset.

3 Click the Service Details view tab.

4 In the Warranty As of field, enter a date on which you want to assess the 
warranty status of the selected service request. (The default date is the date the 
service request was created.)

5 Click Check Warranty.

This shows which warranties, if any, are in effect on the date you entered.

To verify warranties for an order

1 Navigate to the Orders screen.

2 In the Show drop-down list, make sure one of the Service Orders options is 
selected. 

3 Select an order.

4 Click the Line Items view tab.

5 Select a line item.

6 Click the Warranty subview tab.

The Warranty list displays the warranties for the selected line item.

To identify the service providers for a warranty

1 Navigate to Site Map > Service Administration > Warranties.

2 Select a warranty.

3 Click the Service Providers view tab.

The Service Provider list shows the service providers for this warranty.
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To track warranty recovery

1 Navigate to the Orders screen.

2 In the Show drop-down list, make sure one of the Service Orders options is 
selected. 

3 Select an order with the type RMA Return, RMA Repair Return, or RMA Advance 
Exchange.

4 Click the Line Items view tab.

5 Select a line item.

6 Click the Warranty subview tab.

7 In the Warranty list, select or add a record for the appropriate warranty.

8 Record the warranty claim information in the Status, Planned Recovery, and 
Actual Recovery fields.

To verify the warranty status for defective parts

1 Navigate to the Repairs screen.

2 Select a repair record.

3 On the More Info view tab, click the show more button.

4 In the Warranty As of field, enter a date on which you want to assess the 
warranty status of the selected repair. 

5 Click Check Warranty.

This shows which warranties, if any, are in effect on the date you entered.
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The Service Administration screen provides views for defining warranties offered 
to customers.

Warranties View
The Warranties view lists warranties and their terms for all products and service 
providers. Table 124 describes the check boxes in the Warranties view.

Products Subview
The Products subview specifies the products covered by a warranty. The products 
are selected from a dialog box. Products are configured on the Product 
Administration screen (see Product Administration Guide). 

Service Providers Subview
The Service Providers subview records the accounts that supply services for a 
warranty. The service providers are selected from a dialog box. 

Table 124. Selected Items on the Warranties View

Item Description

Parts Indicates that this warranty covers the cost of replacement parts. 

Labor Indicates that this warranty covers the cost of labor. 

Transportation Indicates that this warranty covers the cost of transportation.

Expenses Indicates that this warranty covers the cost of expenses incurred by field 
service agents.
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Assets Screen
The Assets screen has one view that displays information about warranties.

Warranty View
The Warranty view displays the warranties associated with selected assets. 
Table 125 describes the Get Warranty button in this view.

Table 125. Selected Item on the Warranty View

Item Description

Get Warranty This button and command lists all warranties associated with a product 
and fills in the fields that describe the warranty.
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Orders Screen
The Orders screen associates warranties with line items in an order.

Warranty Subview
The Warranty subview (under the Line Items view) associates warranties with line 
items in an order and allows users to record details of expected credit recovery. 
Version 7.5, Rev. A Siebel Field Service Guide 525



Warranties

Products Screen
Products Screen
The Products screen has one view for warranties.

Warranties View
The Warranties view shows the warranties that apply to selected products. 
This view is read-only.
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Repairs Screen
The Repairs screen provides a Check Warranty button and menu command.

More Info View
A Check Warranty button and command in the More Info tab’s menu provides 
warranty information for an asset. Choosing this menu command checks the 
appropriate warranty boxes (Product Warranty, Component Warranty, and 
Manufacturer Warranty) as of the date specified in the Warranty As of field.
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Service Screen
The Service screen has one view with a Check Warranties button and menu 
command.

Service Details View
The Service Details view contains a Check Warranty button and command. This 
command identifies the warranties that are associated with a service request on a 
selected date.
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This chapter describes the Preventive Maintenance module for Siebel Field Service 
and the automatic generation of service requests and activities for maintenance.
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Preventive Maintenance Overview 
The Preventive Maintenance Engine can automatically generate preventive 
maintenance (PM) service requests and actions (or activities), triggered by elapsed 
time, asset usage, measurement thresholds, or events (see Figure 21 on page 532): 

■ Time-based triggers call for maintenance actions at regular time intervals. 

■ Usage-based triggers are for equipment that can keep track of usage with a 
counter (for example, number of copies for photocopiers).

■ Threshold-based triggers initiate a service activity when a measurement falls 
above or below a set level (similar to an alarm or engine warning light). 

■ Event-based triggers use predefined events to determine if a PM activity 
is required.

When a PM activity is required, Field Service creates service requests and detailed 
activities. Figure 21 on page 532 shows the process of the Preventive Maintenance 
Engine, which is as follows:

1 Run the PM Engine for an asset or an agreement.

2 Select the PM Plan for the asset or for the entitlement’s assets.
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3 For each trigger, if conditions require an action, create service requests or 
activities, then run the PM Engine. If conditions do not require an action, run 
the PM Engine. 

4 Continue the process until all necessary service requests and activities have 
been created.
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Figure 21. Logic of the Preventive Maintenance Engine
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Preventive Maintenance Triggers
Preventive Maintenance triggers set off processes in Field Service to plan and 
schedule routine service activities. The Preventive Maintenance Engine responds to 
triggers and plans service activities. The Optimization Engine can schedule these 
activities (see “Best Practice: Preventive Maintenance and the ABS” on page 173).

There are five types of triggers for preventive maintenance plans: Time Interval, 
Date (see “Date Triggers” on page 534), Usage, Threshold, and Event. 

Logic Governing Triggers
The following rules regulate the operation of Preventive Maintenance triggers:

■ Time Interval and Date triggers are the only trigger type that can fire for a date 
in the future. All other triggers can fire only for the current date (when the 
engine runs). 

■ Triggers never fire in the past. If the Preventive Maintenance Engine finds a 
trigger that should have fired in the past, it fires for the current date unless some 
other constraint or condition prevents that.

■ No trigger can fire more than once a day.

■ No trigger can fire while there is an outstanding (future) PM activity for the asset 
and its associated PM plan. 

When the trigger logic evaluates whether a trigger should fire, it prevents the 
creation of a new PM action whenever there is an existing action for the current date 
or any date in the future. This behavior is by design, to prevent triggers from firing 
multiple times for the same trigger condition. However, it means that plans with a 
Time or Date trigger combined with another trigger should not be run with end 
dates too far in the future. Time- or Date-triggered preventive maintenance actions 
in the future might prevent other valid triggers (such as Usage triggers) from firing, 
thus preventing valid service actions from being created.

NOTE: There are no constraints built into the PM module limiting multiple triggers. 
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For example, a plan with Time and Usage triggers might run with an end date one 
year in the future. All the PM actions for the next year are created based on the Time 
trigger, and during that time the Usage trigger will never fire, whatever the actual 
usage. This conflict can be avoided by only scheduling PM actions a few weeks or 
one month in advance. Then, in the worst case, the engine runs and schedules a 
PM action based on the Time trigger even though the asset meets the usage criteria 
tomorrow. The actual difference in the time between when the PM action should 
have been scheduled and when it was scheduled is, at most, the difference between 
the end date passed to the engine and the current date (when the engine runs).

Time Interval Triggers 
A Time Interval trigger activates a PM plan after a fixed time interval, measured in 
days. Each time interval record has a start and end age (in days from the asset’s 
install date) so that the frequency of PM service requests can change, depending on 
the age of the asset. For example, in the first year, PM service can take place every 
6 months (180 days). After the first year, service calls can occur more often; for 
example, every 3 months (90 days).

NOTE: The age of the asset is determined by the Install Date (see “Assets View” on 
page 507). If the Install Date is missing, the asset is considered to be 0 days old.

Although the interval could be less than 1 day, currently higher-level logic prevents 
triggers from firing more than once a day.

Date Triggers
Date triggers fire on a specific date. Like Time Interval triggers, they may have a 
valid start and end that are measured from the asset’s install date. 

NOTE: In the out-of-the-box configuration, Date triggers are not exposed on the 
user interface.
534 Siebel Field Service Guide Version 7.5, Rev. A



Preventive Maintenance

Preventive Maintenance Triggers
Usage Triggers 
Usage triggers activate a PM plan when the reading from an asset changes by a 
specified amount. Each usage trigger record has start and stop values, so that the 
activation of a PM plan can change with the usage of the asset. For example, a 
service request may be generated every 3,000 counts for the first 15,000 counts, 
then every 10,000 counts after 15,000. 

NOTE: For Time Interval and Usage triggers (which use Valid Start and Valid End 
settings), if the interval falls beyond the Valid End, the trigger does not fire.

The trigger fires if the readings for the specified measurement have a delta greater 
than the specified interval. The delta is determined by the difference between the 
most recent reading and the reading at the time of the last PM action. To be 
considered, the readings must be marked as Done (see “Warranty View” on 
page 508). If the most recent reading is less than the reading at the time of the last 
PM action, then the measurement is assumed to have wrapped around and the delta 
is calculated as follows:

delta = (max – last) + (new – min) + 1

Usage triggers may also specify a valid start and end, defining the values of the 
reading for which the trigger is valid.

A measurement is specified only by its type (see “Measurements View” on 
page 511). If an asset is given more than one measurement of the type specified by 
a Usage trigger, then if any of the measurements exceed the usage specified by its 
type, the trigger fires. To avoid this, it is recommended that specific types be 
defined, as applicable, in the measurement type LOV (ASSET_MEAS_TYPE).
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Threshold Triggers 
A Threshold trigger activates a PM Plan when a reading from an asset exceeds a 
set value. Threshold triggers can fire in response to a change in a binary value; for 
example, a threshold of 0.5 would trigger a PM plan when an on/off alarm 
changes state.

Threshold triggers examine the readings since the most recent PM action. If any 
completed reading exceeds the lower or upper limit, the trigger fires.

Like Usage triggers, Threshold triggers specify a measurement type to which they 
apply. The same potential issues and solutions for “Usage Triggers” on page 535 
apply to Threshold triggers.

Measurements and Readings
Measurements are defined for products on the Product Administration screen 
(see “Product Measurements View” on page 227).

The Measurements view on the Assets screen (see “Measurements View” on 
page 511) associates measurements from an asset’s product with the selected asset. 
The view allows these measurements to be customized for this asset. For example, 
a relevant measurement for a copy machine would be the number of copies, read 
from a counter; for a car it would be the distance traveled, read from an odometer; 
and for a pump it might be oil level, oil, pressure, and temperature, read from 
gauges.

The Readings view on the Assets screen allows a technician to record the readings 
for specific measurements and specific assets. These readings may act as triggers 
for usage and threshold triggers.

Event Triggers
An Event Trigger activates a PM Plan when the number of service requests for an 
asset exceeds a threshold number in a specified time period. This trigger is useful 
for activating a higher level PM plan when a certain number of routine PM plans 
have taken place. For example, this trigger could activate a complete overhaul.

Currently, the only event supported is the number of service requests in a 
specified period.
536 Siebel Field Service Guide Version 7.5, Rev. A



Preventive Maintenance

PM Plans and Actions
PM Plans and Actions
PM plans define sets of activities for preventive maintenance. The steps in 
setting up a PM plan are also useful for understanding the function of a plan:

1 Create an SR template. Each SR template defines a type of preventive 
maintenance; for example, 5,000 mile service, or major overhaul.

2 Associate one or more activity templates with each SR template. An activity 
template (described in “Using Activity Templates and Plans” on page 89) is a set 
of activities to carry out a preventive maintenance objective.

3 Create a PM plan. Define triggers and products or assets covered by the PM plan. 
Associate one or more SR templates with the PM plan. You can also directly 
associate activity templates with the PM plan. 

Service Request Templates
A Service Request Template is used to create service requests whenever a preventive 
maintenance trigger is activated. An SR Template includes one or more activity 
templates and holds default values for the following service request fields:

■ Name 

■ Description 

■ Area 

■ Subarea 

■ Symptoms 

■ Severity 

■ Status 

■ Substatus 

■ Priority 

■ Resolution

SR templates apply only to preventive maintenance.
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When a trigger fires, the Preventive Maintenance Engine creates a service request. 
Activities are created in two ways:

■ Activities are derived from SR templates (and PM plans). These activities are 
associated with the service request. See “Service Request Template Activities 
View” on page 547 and “Actions View” on page 552.

■ Activities are derived from activity templates associated directly with a PM plan. 
See “Actions View” on page 552, Activities subview.

NOTE: The association between activities and activity templates is made in the 
Activity Templates view in the Applications Administration screen (see “Application 
Administration Screen” on page 102).

Validating PM Plans for an Asset
The Products view on the Preventive Maintenance screen allows you to associate 
products and assets with PM plans. The PM Engine retrieves these products and 
assets as follows:

■ The products are obtained by querying the database for all the products that are 
associated with the PM plan and have their All Assets flags set to TRUE.

■ The assets are obtained by querying for all the assets that are associated with 
the PM plan and have their products’ All Assets flags set to FALSE.

You set the All Assets flag for products associated with PM plans on the Products 
view of the Preventive Maintenance screen. See “Products View” on page 551.

NOTE: PM plans are always associated with products and not with product lines.
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To determine if a plan is applicable to an asset, the Preventive Maintenance Engine 
applies the following logic:

1 The engine checks the product of the asset against the collection of products 
held in the plan. If a match is found, the plan applies to the asset; otherwise 
processing continues.

2 The engine checks the asset against the collection of assets held in the plan. If a 
match is found, the plan applies to the asset; otherwise the plan does not apply.

Running the Preventive Maintenance Engine
There are two methods of invoking the Preventive Maintenance Engine: through 
server requests and through the Field Service client.

Using Server Requests
Administrators can set up requests (one-time or repeating) for tasks that are 
serviced by the Preventive Maintenance Engine. The component-specific 
parameters specified by the request determine what the engine does for that 
request. For a detailed explanation, see “Parameters for the Preventive Maintenance 
Engine” on page 540. 

In general, tasks must define these variables: 

■ A set of objects for the engine to operate on. 

■ A date that is the latest date to schedule preventive maintenance during the run. 

■ The mode in which the task is to be run. When invoking the PM Engine through 
server requests, you can specify either ID or SQL mode for this variable. (The 
Field Service client uses another mode, TempTbl, when invoking the PM 
engine.)

■ The sub-mode, which determines the entities that are specified for the selected 
mode.
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The set of objects must include either assets and plans or agreements, as defined 
by the sub-mode parameter in the request. In the case of assets and plans, if only 
assets or only plans are specified, then all of the other object types are assumed. 
For example, if only assets are specified (SubMode=Assets), then the Preventive 
Maintenance Engine checks the specified assets against all plans. When agreements 
are specified, each agreement implicitly defines a set of assets and plans 
(entitlements have both associated assets/products and PM plans) that the engine 
is to process for that agreement.

System Preferences for the Preventive Maintenance Engine
The Preventive Maintenance Engine uses the two system preferences described in 
Table 126.

Parameters for the Preventive Maintenance Engine
Siebel Business Process Designer or the client can invoke all engines. These engines 
require certain parameters to be passed. Table 127 contains the parameters for the 
Preventive Maintenance Engine, and what they mean.

Table 126. System Preferences for the Preventive Maintenance Engine

Sys. Pref. Default Value Comments

 FSPrevMnt: Default Org ID Org ID The value of this system preference is the ROW_ID of 
the default organization. This default organization is 
stamped on generated service requests when the asset 
for which the service request is being generated does 
not have a specified account. If the owner account is 
specified for the asset, then the account’s BU_ID is 
used.

FSPrevMnt: Def Act Owner ID Act Owner ID The value of this system preference is used when 
creating activities from a template in which the activity 
owner (Employees) has not been defined. The value 
specified should be the ROW_ID of the desired 
employee.
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Table 127. Preventive Maintenance Engine Parameters

Parameter Values Explanation

Mode {SQL, Id, TempTbl} This required parameter specifies how the engine 
locates the entities to process. Only SQL or ID is 
intended to be specified in user requests. TempTbl 
is used by the client applications for submitting 
requests.

Sub-mode {Assets, Plans, Assets&Plans, 
Agreements}

This required parameter specifies what entities 
are specified. A SubMode of Assets implies ALL 
PM Plans, and a SubMode of Plans implies ALL 
Assets.

EndDT YYYY-MM-DD format This required parameter specifies the date furthest 
into the future for which the engine will generate 
PM Actions. Note that currently, only time-based 
triggers can fire for a future date.

AssetID Row ID of an asset This parameter specifies a specific asset. It is 
required when the Mode is Id and the SubMode 
is either Assets or Assets&Plans.

PlanID Row ID of a PM Plan This parameter specifies a specific PM Plan. It is 
required when the Mode is Id and the SubMode 
is either Plans or Assets&Plans.

AgreementID Row ID of an agreement This parameter specifies a specific Agreement. 
It is required when the Mode is Id and the 
SubMode is Agreements.

AssetSQL Where clause in the form [BusComp 
Field Name] = ‘Value’

This parameter specifies a search specification 
for assets. It is required when the Mode is SQL 
and the SubMode is either Assets or Assets&Plans. 

PlanSQL Where clause in the form [BusComp 
Field Name] = ‘Value’

This parameter specifies a search specification for 
PM plans. It is required when the Mode is SQL 
and the SubMode is either Plans or Assets&Plans. 

AgreementSQL Where clause in the form [BusComp 
Field Name] = ‘Value’

This parameter specifies a search specification for 
agreements. It is required when the Mode is SQL 
and the SubMode is Agreements.
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Setting Up the Preventive Maintenance Engine
Follow these procedures to set up the Preventive Maintenance Engine.

To set asynchronous operation of the Preventive Maintenance Engine

1 From the application-level menu, choose View > User Preferences.

2 From the Show drop-down list, select Service.

3 In the Asynchronous Processing Of section, select Preventive Maintenance.

To set parameters for the Preventive Maintenance Engine 

1 Insert or edit a component request for the Preventive Maintenance Engine 
server component.

2 Add or modify the server component parameters as needed.

For information about server components and component parameters, see Siebel 
Server Administration Guide.

To change system preferences for the Preventative Maintenance Engine

1 Navigate to Site Map > Application Administration > System Preferences.

2 Locate the name of the system preference (System Preference Name column).

For the names of applicable system preferences, see Table 126 on page 540.

3 Type in a new value for System Preference Value.

4 To register changes to system preferences, restart the Field Service server.

For information on how to restart servers, see Siebel Server Administration 
Guide.

To define preventive maintenance plans

1 Navigate to Site Map > Preventive Maintenance.

The Plans view appears.

2 Add a new preventive maintenance plan record.
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3 Enter the name for a plan.

4 Enter values for other fields, as needed.

To define triggers for a selected PM plan

1 Navigate to Site Map > Preventive Maintenance.

The Plans view appears.

2 Select a preventive maintenance plan.

3 Click the Triggers view tab.

4 Create a new trigger record in any applicable subviews (Time Interval, Usage, 
Threshold, and Event).

5 Enter values for the fields, as needed.

NOTE: PM plans can have any number of triggers of any type (Time Interval, 
Usage, Threshold, and Event).

To associate a PM plan with an agreement

1 Navigate to the Agreements screen.

2 Select an agreement.

3 Click the Entitlements view tab.

4 Select an entitlement.

5 Click the Preventive Maintenance subview tab.

6 In the Preventive Maintenance subview’s frame, make sure that PM Plans is 
selected in the drop-down list.

7 In the Preventive Maintenance list, create a new record and associate a PM plan.

To associate assets with PM plans

1 Navigate to the Assets screen.

2 Select an asset.
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3 Click the Preventive Maintenance view tab.

4 In the Preventive Maintenance view’s Show drop-down list, select Plans.

5 In the Preventive Maintenance list, create a new record and associate a PM plan.

To associate activity templates with a PM plan

1 Navigate to Site Map > Preventive Maintenance.

The Plans view appears.

2 Select a preventive maintenance plan.

3 Click the Actions view tab. 

4 In the Activity Templates list, create a new record and associate an activity 
template.

Creating Service Request Templates for Preventive Maintenance
Service Request Templates provide one or more activity templates to carry out 
preventive maintenance. 

To create a service request template for preventive maintenance

1 Navigate to Site Map > Service Administration > Service Request Templates.

2 Add a new service request template record.

3 Enter values for the fields, as needed.

4 Click the Service Request Template Activities view tab.

5 Add activity templates as needed for preventive maintenance.
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Generating Preventive Maintenance Activities
Use the following procedures to generate preventive maintenance activities 
(actions).

To run PM plans for an asset 

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Preventive Maintenance view tab.

4 From the Show drop-down list, select Plans. 

5 Create a new record to associate a preventive maintenance plan to the selected 
asset.

6 In the Assets view bar, complete the End Date field.

This is the latest date that the PM Engine considers when generating PM actions. 
The field defaults to the current date and can be set to any date in the future. 

7 Do one of the following:

■ To run the PM Engine for the selected asset and all its associated 
maintenance plans, click Run PM in the Assets view. 

■ To run the PM Engine for all assets and all their associated maintenance 
plans, click the menu button in the Assets view and click Run PM All. 

To review generated PM actions

1 Navigate to Site Map > Preventive Maintenance.

The Plans view appears.

2 Select a PM plan.

3 Click the History view tab. 

4 The History list displays the PM actions for this plan.
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To review generated PM actions for an asset

1 Navigate to the Assets screen.

2 Select an asset.

3 Click the Preventive Maintenance view tab.

4 From the Show drop-down list, select History.

The History list displays the PM actions generated for this asset and the plans 
that initiated the actions. 
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Two views in the Service Administration screen are for configuring activity 
templates for preventive maintenance. These templates become part of PM plans 
(see “Preventive Maintenance Screen” on page 548).

Service Request Templates View
The Service Request Templates view creates templates for preventive maintenance 
service requests. An SR template includes one or more activity templates plus 
default values for a preventive maintenance service request; for example, Area, 
Status, Priority, Symptoms, and Resolution. The preventive maintenance trigger, 
when activated, creates the service request using this template.

NOTE: Service request templates apply only to preventive maintenance.

Service Request Template Activities View
The Service Request Template Activities view associates activity templates with 
preventive maintenance service request templates. 

Activity templates are set up in the Application Administration screen, Activity 
Templates view. For more information, see “Setting Up Field Service Activity 
Templates” on page 93.
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The Preventive Maintenance screen configures preventive maintenance plans for 
specific products and assets.

Plans View
The Plans view defines preventive maintenance plans for specific products 
and assets.

The Active check box in this view allows the Preventive Maintenance Engine to 
process this plan. It may be useful to uncheck this box while completing the 
definition of a plan or to temporarily disable specific plans. When the plan 
definition is complete, or a plan is reinstated, the administrator checks this box to 
activate the preventive maintenance plan.

Triggers View
The Triggers view provides four subviews to define the triggers that activate 
PM plans.
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Time Interval Subview
The Time Interval subview sets the interval in days between triggers that activate 
a selected plan. A plan can have more than one Time Interval trigger (see “Time 
Interval Triggers” on page 534). Table 128 describes items in Time Interval records.

NOTE: The age of the asset is measured from the Install Date (see the “Assets View” 
on page 507). If the Install Date is missing, the asset is considered to be 0 days old.

Table 128. Items in the Time Interval Subview

Item Description

Interval Length of the interval between triggers, in number of days. Must be an 
integer. 

Valid Start The age of an asset, in days, at which this trigger becomes effective. 
Required.

Valid End The age of an asset at which this trigger is no longer effective. Leaving this 
value blank sets the end to infinity.
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Usage Subview
The Usage subview defines the measurement and measurement parameters that 
trigger a PM plan. A plan can have more than one Usage trigger (see “Usage 
Triggers” on page 535). Table 129 describes items in Usage records.

NOTE: For Time Interval and Usage triggers (which use Valid Start and Valid End 
settings), if the interval falls beyond the Valid End, the trigger does not fire.

Threshold Subview
The Threshold subview defines a reading from an asset that triggers a PM plan. 
A plan can have more than one Threshold trigger (see “Threshold Triggers” on 
page 536). Table 130 describes the item in Threshold records.

Table 129. Items in the Usage Subview

Item Description

Measurement Type A type of reading, chosen from a dialog box. 

Interval The change in a reading that triggers a PM plan. Interval uses the 
units set in Measurement Type.

Valid Start The measurement at which the trigger becomes valid. The value is 
in the same units as the interval.

Valid End The measurement at which the trigger is no longer valid. The value 
is in the same units as the interval. Leaving this value blank sets the 
end to infinity.

Table 130. Items in the Threshold Subview

Item Description

Measurement Type A type of measurement, chosen from a dialog box. 
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Event Subview
The Event subview defines the number of service requests in a time interval that 
trigger a PM plan. A plan can have only one Event trigger (see “Event Triggers” on 
page 536). Table 131 describes items in the Event subview. Both items are required.

Products View
The Products view associates specific products and assets with PM plans. Table 132 
describes the check box in the Products subview.

CAUTION: You must set up the correct measurement types in the Product 
Administration screen for the products covered in the preventive maintenance plan. 
In the Product Administration screen’s More Info view, select Product 
Measurements from the Show drop-down list. If you do not set up measurement 
types, then Usage and Threshold triggers will cause unpredictable and undesired 
results. For more information about setting up products, see Product Administration 
Guide.

Table 131. Items in the Event Subview

Item Description

# of SRs The number of service requests which, when exceeded, triggers a 
PM plan.

Over # of Days The time interval, in days, during which the number of service requests 
must occur.

Table 132. Item in the Products Subview

Item Description

All Assets A check box that indicates all assets of this product are covered by the PM 
plan, whether or not they appear in the Assets list.

To cover only the specified assets, make sure that All Assets is not checked.
Version 7.5, Rev. A Siebel Field Service Guide 551



Preventive Maintenance

Preventive Maintenance Screen
If the asset is already associated through the All Assets flag, adding the PM plan as 
a record has no effect other than displaying the relationship directly. 

NOTE: To perform this procedure, navigate to the Assets screen, select the Preventive 
Maintenance view, and then select the Plans subview. See “To associate assets with 
PM plans” on page 543. 

Assets Subview
The Assets subview lists the assets for each product covered under the PM plan. 

Actions View
The Actions view associates service request templates and activity templates with 
PM Plan records. The application does not verify duplication of activity templates, 
so the same activity template may be associated directly with a PM plan and 
indirectly through an SR template.

To create SR templates, see “Service Administration Screen” on page 547. 

History View
The History view displays past preventive maintenance actions for each selected PM 
plan. This view is read-only.
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Assets Screen
The Preventive Maintenance view on the Assets screen associates PM plans with 
specific assets and shows the history of PM plans scheduled or carried out. The 
Preventive Maintenance view has two subviews, Plans and History, selected from 
the Show drop-down list.

Plans Subview
The Plans subview associates PM plans with selected assets.

The Active check box in this view allows the Preventive Maintenance Engine to 
process this plan. You can clear this check box while completing the definition of a 
plan or to temporarily disable specific plans. When the plan definition is complete, 
or a plan is reinstated, select this check box.

NOTE: The All Assets check box in the Products view (see“Products View” on 
page 551) associates all assets of a product line with a selected PM plan. If the asset 
is not already associated with a PM plan (the All Assets check box is not checked 
for the product), users can cover the asset by adding the PM plan as a record in this 
subview.

History Subview
The History subview reports all of the PM actions in the history of a selected asset. 
All fields in this form are read-only except for the Completed field, which accepts 
the date that the activities in a plan are completed. 
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Agreements Screen
The Agreements screen, Entitlements view, has one subview for preventive 
maintenance, which shows the PM plans that are associated with specific 
agreements and their entitlements and PM actions for this entitlement and 
agreement that are scheduled or completed. This subview is read-only.

Preventive Maintenance Subview
Select PM Plans or PM Actions from the drop-down list at the top on the Preventive 
Maintenance subview.
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This chapter describes how to use the Repair module to process and track 
equipment repairs.
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Overview of Siebel Repair
Siebel Repair generates repair activity plans, assigns and schedules repair activities, 
tracks symptoms and resolutions, and stores repair histories. 

The workflow for repairs is illustrated in Figure 22 on page 557, which shows the 
steps of the process as follows:

1 Receive and tag. Receive RMA and create a repair order. The item may have been 
received as a stock transfer or over the counter. 

2 Internal or external repair. If this is an internal repair, generate a repair activity and 
verify the service agreement. If this is an external repair, generate a repair order, 
ship to the external provider, and receive from the external provider.
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3 Return or keep in inventory. After the repair is done, if the item is returned to the 
customer, allocate the item, generate the pick ticket, and ship. If the item is 
returned to good or defective inventory, generate the inventory transaction.

Figure 22. Repair Workflow
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Repairs begin when a customer calls a service center about a defective product. The 
customer service representative assigns an RMA (Return Material Authorization) to 
the product, and requests that the customer ship the product to the service center. 
The RMA (either RMA Repair Return or RMA Advance Exchange) signifies that the 
product is to be repaired. 

Receiving Items for Repair
At the service center, the defective item is either repaired or shipped to a third-party 
provider for repair. If an external repair is chosen, a repair order (RO) number is 
assigned, which can track the item to and from the external vendor. When an 
external repair vendor performs the repair, the item’s repair is tracked to completion 
using the ship and receive dates to and from the external vendor. Siebel Repair 
generates the inventory transactions that record the product’s travels. 

The defective product may be repaired and returned to the customer, or the product 
may be repaired and placed in good stock. 

There are three routes for placing defective parts in the repair process:

■ Repair items from customers generally arrive by a freight carrier and have an 
attached RMA. If no RMA is attached, it is necessary to create one.

■ The field service engineer or an internal department can deliver a defective part 
over the counter to a repair center agent.

■ The repair center may receive transfers from other internal locations (for 
example, if defective parts were collected at a field office and then sent to a 
repair facility). In the latter case, an internal order can track the parts transferred 
from one inventory location to another, or a stock transfer (inventory 
transaction) can be issued directly.
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Repair Numbers
A repair number is a number assigned to a repair record, uniquely identifying the 
product to repair. A repair center agent physically attaches a tag containing this 
number to the product. The repair number, either a card or a marker (often a bar-
coded label), lets the service business track defective parts through the repair 
process, whether or not they have serial numbers. For methods to customize this 
number, see “Numbering Service Requests and Other BusComp Object Types” on 
page 64.

If the product is serialized, add the asset number to the repair record. This 
automatically provides the product name, inventory location, and inventory level 
(status and availability).

Some businesses prefer to speed up the receiving process by creating batches of 
repair numbers in advance. To do this, they create multiple blank repair records. 
When a defective part arrives, the repair center uses one of these blank records 
and its repair number. An agent then completes the record for this part.

Serialized Products and Inventory Locations
To generate a repair number for a serialized product, an asset number must be 
assigned. The transactions that accompany receiving the asset, through an RMA 
or field part movement, identify the destination inventory locations for these 
incoming parts.

Repair Activities
For the repair of an item, Siebel Field Service provides activity plans and activities:

■ Repair activity plans automatically set up activities and generate activity 
records.

■ Field service staff can manually create or update activity records. 

Repair activities, activity plans, and activity templates function much as they do for 
other field service activities. See Chapter 3, “Field Service Activities,” for more 
information.
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As an item moves among inventory locations, Field Service records its movements 
by updating the Location, Status, or Availability fields in the repair record. These 
updates automatically generate inventory transactions.

Repair Orders
If a third-party provider performs repairs, Field Service can create a repair order. 
These orders record the transactions involved in shipping items to the external 
vendor and receiving the repaired items back from this vendor. For more 
information, see Siebel Order Management Guide. 

Asset Repair Histories
Repair histories can be attached to assets to track defects over time. A repair history 
can associate several repair numbers with an asset. Failure trends can be detected 
from asset repair histories. Based on the occurrence of repair numbers, an asset can 
be identified as a financial liability. The decision to scrap may be justified if the 
repair cost is too high and a more reliable substitute product can be found.

Inventory Transactions for Repairs
Repair activities, generated from an activity plan, move parts from inventory 
location to inventory location. Each time a part moves, an inventory transaction 
is generated. Validations are performed for each transfer; for example, to move 
an asset to a destination inventory location, it must belong to a source inventory 
location. These steps summarize the transaction process for an internal repair:

1 Generate an inventory transaction as a Stock Transfer.

2 Commit the inventory transactions.

3 Update the inventory location ID (Prod_INV_ID) on the repair number 
(S_PART_RPR).
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The rules for these inventory transactions are summarized in Table 133.

Repairs Sent to a Third-Party Vendor
In Shipping > Repair Pick Ticket (see“Repair Pick Ticket View” on page 369), the 
Process Shipment button generates transactions of the type Ship to TP (Third Party) 
to move a product from the defective inventory location to the third-party vendor, 
and sets the variables Defective and On Hand. This transaction updates the 
variables INVLOC_ID, INV_STATUS_CD, and INV_AVAIL_CD. These steps 
summarize the transaction process:

1 Generate inventory transaction as Ship to TP and De-Allocate.

2 Commit inventory transactions.

3 Update the inventory location ID (Prod_INV_ID), inventory location 
(INVLOC_ID), status (INV_STSTUS_CD), and availability (INV_AVAIL_CD) on 
the Repair Number (S_PART_RPR), using the BusComp FS Repair Without 
Update logic.

Table 133. Rules for Inventory Transactions: Internal Repair

Inventory Level1
(InvLoc + Status + Avail)

1. Previously a “bucket.”

Old Value New Value Transactions Required?

NULL NULL No

NULL INV1 No

INV1 INV1 No

INV1 INV2 Yes. Normal inventory transaction as Stock Transfer, with 
all validations.

INV1 NULL No
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The rules for these inventory transactions are summarized in Table 134.

Repairs Received from a Third-Party Vendor
On the Receiving screen, the Receive PO, Receive RMA, and the Receive Internal 
Order views, the Process Receipt command generates transactions, of the type 
Receive from TP, to move a product from a third-party vendor to the desired 
inventory location. This transaction updates the variables INVLOC_ID, 
INV_STATUS_CD, and INV_AVAIL_CD.

To receive an item from a third-party location, define the third-party location in the 
Orders screen, Terms view and the receiving location in the To Inventory field in the 
Receiving screen, Line Item Receipts view.

Table 134. Rules for Inventory Transactions: Send to Third-Party Vendor

Inventory
Transaction
Type

Source Destination

Inventory Inventory Level1 Assets2 Inventory
Inventory 
Level1 Assets2

Ship to TP Source Invloc ID
Comes from the 
Service Order 
screen, Line 
Items view, 
Actions subview 
and is the Source 
Location field.

On Hand

Good/Defective

Yes Destination Invloc 
ID
Comes from the 
Service Order 
screen Line Items 
view, Actions 
subview and is the 
Destination 
Location field.

On Hand

Defective

Yes

De-Allocate Source Invloc ID
Comes from the 
Service Order 
screen, Line 
Items view, 
Actions subview 
and is the Source 
Location field.

Reserved No Customer On Order No

1. Previously a “bucket.”

2. The assets rows are included in the transaction validation if the product is serialized.
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To go to the Receive PO, Receive RMA, or the Receive Internal Order view, first 
navigate to the Receiving screen, All Pending Orders view, and then click on a 
Receive Type field for any record. This exposes the Receive PO, Receive RMA, or 
Receive Internal Order views, with their subviews: [Receipt] Line Items, Received 
Line Item, and Serial Numbers.

These steps summarize the transaction process:

1 Generate an inventory transaction as Receive from TP.

2 Commit the inventory transaction.

3 Update the inventory location ID (Prod_INV_ID), inventory location 
(INVLOC_ID), status (INV_STSTUS_CD), and availability (INV_AVAIL_CD) 
on the Repair Number (S_PART_RPR), using the BusComp FS Repair Without 
Update logic.

The rules for these inventory transactions are summarized in Table 135.

Table 135. Rules for Inventory Transactions: Receive from Third-Party Vendor

Inventory
Transaction
Type

Source Destination

Inventory Inventory Level1 Assets2 Inventory Inventory Level1 Assets2

Receive from 
TP

Source Invloc 
ID
Comes from 
Service Order 
screen, Line 
Items view, 
Actions 
subview 
and is the 
Destination 
Location field.

On Hand

Defective

Yes Destination Invloc 
ID
Comes from Service 
Order screen, Line 
Items view, Actions 
subview and is the 
Source Location 
field.

On Hand

Good/Defective

Yes

1. Previously a “bucket.”

2. The assets rows are included in the transaction validation if the product is serialized.
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Third-Party Vendor Swaps an Asset During Repair
If the third-party repair vendor returns a different part, the inventory transactions 
fails unless the new asset exists in the third-party inventory location. The user can 
accomplish this in one of two ways:

■ Use the same Asset ID and change the serial number associated with this record. 

■ Create a new asset. Receive it from the third-party vendor using a Receive 
Other transaction. Then delete the previous asset, using another transaction.

Returning to Good Inventory
To return a product to good inventory:

■ For internal repairs, set the Inventory Location, Availability, and Status 
(usually Good) in the repair record.

■ For repair orders, set the Inventory Location, Availability, and Status in the 
repair record.

Changing the values in the repair record triggers an inventory transaction which 
changes the inventory quantity.

Shipping to a Customer 
If the defective part was received with an RMA Repair/Return, then the repair center 
returns the part using the regular shipping process (Allocate, Pick Ticket, and Ship).

When the part is repaired, either internally or by a third-party vendor, it receives 
an inventory level; for example, On Hand/Good. When the part is shipped, the 
inventory transaction records the product movement, but the information on the 
Repairs screen still points to the same inventory level, that indicates the last location 
for the repaired item in inventory. The inventory movements for a product do not 
update the last location of the product in the repair record.
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Setting Up and Configuring Repairs
The following sections describe the configuration and transactions for repairs.

Setting Up Repair Activities
Follow these procedures to set up repair activities.

To create activity templates for repairs

■ See “To define activity templates” on page 93.

To associate activities with a template

■ See “To associate activities with activity templates” on page 93.

To define activity plans for repairs

1 Navigate to the Repairs screen.

2 Select a repair.

3 Click the Activity Plans view tab.

4 Add a new activity plan record.

This action populates the fields in the Activities Plans and Activities lists.
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Processing Defective Items for Repair

To receive defective parts with an RMA

1 Navigate to the Receiving screen.

2 In the Show drop-down list, make sure All Pending Orders is selected.

3 In the Pending POs/ROs/RMAs list, select an RMA Repair Return order.

4 Click the hyperlink in the Receive Type field. 

The Receive RMA view appears.

5 In the Line Items list, select a line Item.

6 In the Received Line Item list, create a record describing the received item.

7 Enter values in the fields, as needed.

8 If the item is a serialized asset, in the Serial Numbers list, create a record for it.

9 Enter values in the fields, as needed.

10 In the Receive RMA form, click Process Receipt.

To receive defective parts over the counter

1 Navigate to the Repairs screen.

2 Do one of the following:

■ Query for the repair item record with the repair number.

■ Create a new repair record.

3 Copy the value in the Repair # field.

4 Navigate to Site Map > Inventory Transactions.

5 In the More Info view, click the show more button.

6 Create an inventory transaction record.

a In the Type field, select Over-the-counter.
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b In the Repair ID field, enter (paste) the repair number.

c Enter values for the required fields.

To receive defective parts by stock transfer

1 Navigate to the Receiving screen.

2 In the Show drop-down list, make sure All Pending Orders is selected.

3 In the Pending Internal Orders list, select an order.

4 Click the hyperlink in the Receive Type Field.

The Receive Internal Order view appears.

5 In the Line Items list, select a record.

6 In the Received Line Item list, create a new record.

7 Enter receipt details, as needed.

8 In the Serial Numbers list, create a new record.

9 Enter serialized asset details, as needed.

10 In the Receive Internal Order list, click Process Receipt.

To create a repair record

1 Navigate to the Repairs screen.

2 Create a new repair record. 

3 If this repair record is for a serialized item, in the Asset # field, select an asset.

4 Associate the repair record with its service request by entering it in the SR # 
field.

5 Associate the repair record with its RMA by clicking the show more button and 
selecting it in the RMA # field.

To add an activity plan and generate activities for a repair

1 Navigate to the Repairs screen.
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2 Select a repair record. 

3 Click the Activity Plans tab. 

4 Add an activity plan record. 

5 In the Template field, select an activity template.

This populates the Activities list with the activities in the template.

To view or update repair activities

1 Navigate to the Repairs screen.

2 Select a Repair record. 

3 Click the Activities tab.

4 Select an activity record.

5 Change the value of any field.

To track the movement of a defective part

1 Navigate to the Repairs screen.

2 Select a repair record.

3 In the More Info view, click the show more button.

4 Update the Location, Status, and Availability fields to show the current location 
and inventory level for a part.

To associate a repair order, RMA, or service request with a repair record

1 Navigate to the Repairs screen.

2 Select a repair record.

3 In the More Info view, click the show more button.

4 Do one of the following:

a To associate a repair order, in the Repair # field, select a repair order.

b To associate an RMA repair return, in the RMA # field, select an RMA.
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c To associate a service request, in the SR # field, select a service request.

To create a repair order

1 Navigate to the Orders screen.

2 In the Show drop-down list, make sure one of the Service Orders options is 
selected.

3 Add a new order record.

a In the Type field, select Repair Order.

b Enter values for the required fields.

4 Click the Line Items view tab. 

5 Create a record for each item to be repaired.

6 Complete the required fields.

To ship a defective part to an external repair provider

1 Navigate to the Repairs screen.

2 Select a repair record or create a new repair record.

3 Copy the value in the Repair # field.

4 Navigate to Site Map > Inventory Transactions.

5 Create a transaction record.

6 In the More Info tab, click the show more button.

7 In the Type field, select Ship to TP.

8 In the Repair ID field, enter (paste) the repair number.

9 Complete the required fields.

To receive a repaired item from a third-party vendor

■ See “To receive repaired items from a third-party vendor” on page 363.
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To return a repaired or exchanged part to a customer

1 Navigate to the Orders screen.

2 In the Show drop-down list, make sure one of the Service Orders options is 
selected.

3 Add a new order record.

a In the Type field, select RMA Repair Return or RMA Advance Exchange.

b Enter values for the required fields.

4 Click the Line Items view tab. 

5 Create a record for each item to be repaired or exchanged.

6 Complete the required fields.

To record time and expenses for a repair activity

1 Navigate to the Repairs screen.

2 Select a repair record.

3 Click the Activities view tab.

4 Select an activity record.

5 Click the hyperlink in the Type field.

The Activity Attachments view appears.

6 Click the Time Tracker view tab. 

7 Create a time record and complete the required fields.

For more information, see the “Time Tracker View” on page 112.

8 Click the Expense Tracker view tab. 

9 Create an expense record and complete the required fields.

To view an asset’s repair history

1 Navigate to the Repairs screen.
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2 Select a repair record.

3 Copy the value in the Asset # field.

4 Navigate to the Assets screen.

5 Query the asset, using the asset number.

6 Click the Repairs view tab.

The Repairs list shows the repair records for this asset.
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Repairs Screen
The Repairs screen identifies repairs and the activities associated with these repairs.

More Info View
The More Info view records the information that is necessary to identify a repair, 
such as location, status, asset number, service request number, assigned technician, 
repair station, and relevant dates. Clicking Check Warranty button or selecting the 
Check Warranty command provides information about warranties for the asset 
requiring repair.

Activity Plans View
The Activity Plans view associates an activities plan and its activities with a repair 
number record. For more information, see “Activity Templates View” on page 102.

Activities View
The Activities view associates individual activities with a repair number record. 
Users can create and associate numerous activities with a single repair record.
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Repair Reports
The Repairs screen provides the reports listed in Table 136.

Table 136. Repair Reports

Report Description

Repair Summary A summary of each repair.

Repair Detail 
(Barcode)

One page for each repair and its associated activities. Includes 
barcodes. 

Repair Detail (No 
Barcode)

One page for each repair and its associated activities. Does not 
include barcodes. 
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Assets Screen
The Assets screen records all information about assets, including service and repair 
history, components, associated activities, and preventive maintenance.

Repairs View
The Repairs view lists all the repair records for a selected asset. 
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This chapter presents the feature of Siebel Field Service that allows end users to 
enter data through barcodes. 
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Concepts and Terms
The following terms and concepts are specific to the Barcode module.

Barcode A series of vertical bars printed or stamped on parts, containers, labels, 
or other media. These bars represent information that can be read by an 
electronic barcode reader attached to a computer system. 

Barcode types Multiple types of barcodes exist. Some can encode only numbers, while 
others can encode numbers, letters, and special computer control 
characters. Each uses a series of varying-width bars and spaces to 
represent characters. 

For information about supported barcode types, see the system 
requirements and supported platforms documentation for your Siebel 
application.

Barcode scanner An electronic device that detects a barcode’s pattern of bars and spaces 
and transmits the pattern to a barcode reader. 

Barcode reader An electronic device that decodes the barcode patterns sent from a 
scanner into the characters they represent, and transmits those characters 
to a computer as though the data were typed in. 
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Barcode Reader Input
Control character sequences before and after the barcode information notify your 
Siebel application that input is from a barcode reader, as follows:

■ Ctrl - \ is the prefix signalling that the next input will be from a barcode reader. 

■ Ctrl - / is the suffix signalling that the barcode reader input has ended.

Any programmable barcode reader that can be configured to send this prefix and 
suffix before and after the barcode can be used with Siebel Field Service’s barcode 
automation functionality. To program the scanning preamble into a barcode reader, 
refer to the user manual or product reference guide provided with the barcode 
reader. 
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Using the Barcode Interface
This section includes procedures for using the screens and features for reading 
barcode data. For guidelines and details of configuration, see “Setup and 
Configuration for Barcode Reading” on page 586. 

Siebel Field Service accepts data from a barcode reader into individual, active fields 
in your Siebel application. Data such as the following is often available in barcode 
format:

■ Part numbers

■ Asset numbers

■ Repair numbers

■ Order numbers

■ Service request numbers

■ Pick ticket numbers

CAUTION: The automated barcode module does not accept serial numbers as input. 
If end users need to scan serial numbers, make sure that the asset numbers are the 
same as the serial numbers.

With data from the barcode reader, an end user can perform the following types of 
operations:

■ New. Enter the number from the barcode in a new line (record) in the view. In 
this mode, an end user goes to the view that is to receive a number, then clicks 
on a specific tab. Siebel Field Service creates a new record and fills the 
appropriate field in this record.

■ Update. Update the number in a selected line (record) in the view. The new 
number replaces the existing number. In this mode, an end user goes to the view 
that is to receive a number, clicks on a specific tab, and selects a record. Siebel 
Field Service fills the appropriate field in the selected record.
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■ Find. Search the Siebel application for the place where the barcode input should 
go. In this mode, the incoming barcode finds its own destination, opens the 
appropriate view, selects a tab, and fills in the appropriate fields.

An end user can do the following operations:

■ Enter individual barcodes of any acceptable type. Individual barcodes are 
entered with either the New or Update option.

■ Read multiple barcodes in succession, all of the same type (for example, either 
asset numbers or repair numbers). Individual barcodes are entered with the New 
option only.

CAUTION: If end users will be creating multiple barcodes in succession, make sure 
that all required fields in the records, except for the target field for the barcode 
data, have a default value. 

The Barcode Toolbar
Siebel Field Service provides a barcode toolbar that sets Siebel Field Service to use 
incoming data from a barcode reader. The barcode toolbar appears immediately 
below the application-level menu in the Siebel Service application. 

The barcode toolbar is shown in Figure 23. It contains the following controls, from 
left to right: a New button, an Update button, a Find button, a Use drop-down list, 
and an Activate button. 

Figure 23. The Barcode Toolbar

New

Update

Find ActivateUse List
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The barcode toolbar is shown or hidden according to the following factors:

■ For a mobile client, the sfs.cfg file’s ShowBarcodeToolbar parameter must be set. 
A value of TRUE shows the barcode toolbar, while a value of FALSE hides it. If 
your Siebel application is licensed to include barcode automation functionality, 
the parameter is set to TRUE by default.

■ For a server configuration, a barcode toolbar parameter must exist in the 
SFSObjMgr. The name of this parameter is Barcode Toolbar Enable Flag. A value 
of TRUE enables the barcode toolbar, while a value of FALSE disables it.

CAUTION: A Siebel client running on an individual workstation cannot have both the 
Barcode toolbar and the CTI toolbar displayed at the same time.

Table 137 summarizes the functionality of the barcode toolbar buttons.

Of the first three buttons (New, Update, or Find), only one at a time can be active. 
Once clicked, a button remains active until another button is selected.

Table 137. Barcode Toolbar Buttons, from Left to Right

Button Action

New Enters a value of the specified type (Use) into a new record in the 
selected view.

Update Enters a value of the specified type (Use) into an existing record and 
field in a selected record, replacing the number that was there.

Find Locates the appropriate view and field, and enters a value of the 
specified type. When an end user scans the barcode, the application 
brings up the applicable view with the query already executed. The 
displays only those records that match the value scanned from the 
barcode.

Activate Turns the barcode functionality on or off.
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The Use drop-down list contains entry modes that define the type of information 
coming from the next barcode to your Siebel application. The contents of the Use 
drop-down list changes according to the following factors:

■ Whether the New, Update, or Find button is selected

■ The active screen and view

It is necessary to select a value in the drop-down list only if more than one value 
appears in it. 

Keyboard Shortcuts for the Barcode Toolbar
Shortcut keys for barcode operation are shown in Table 138.

Table 138. Additional Keyboard Shortcuts for the Barcode Toolbar

Shortcut Action

Ctrl - \

Ctrl - /

The first shortcut precedes the barcode data input and the second one 
follows it. When your Siebel application receives such input, it carries out 
a series of steps to copy the data from the barcode into the correct field 
in a view:

1 Determines the current view, tab, and active button on the Barcode 
toolbar.

2 Examines the records in the Barcode Mapping list to determine if there 
is a record for this combination of view, tab, and button selection. See 
“Setting Up a Barcode Interface” on page 586.

3 From the Barcode mapping record, determines the field in the 
corresponding record to receive the data.

4 Enters the barcode data in the target field defined in the Barcode 
Mapping list.

Normally, these commands are programmed into the barcode reader and 
delivered as a prefix and suffix to the barcode data; they are not entered 
from the keyboard. See “Barcode Reader Input” on page 577.
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Printing Barcodes in Reports
The following reports include barcodes, when available:

■ Pick Ticket Details (Shipping screen). The Pick Ticket number is barcoded.

■ Repair Detail (Repairs screen). The Repair Number number is barcoded.

■ Order Detail (Orders screen). The Order number is barcoded.

■ Service Request Detail (Service screen). The Service Request number is barcoded.

The Reports menus display two versions for each report: barcoded and not 
barcoded. For information about barcode fonts, see the system requirements and 
supported platforms documentation for your Siebel application.

Scanning Barcodes for Toolbar Actions
You can scan barcodes into Field Service to trigger the same actions as clicking the 
toolbar buttons. This is for the convenience of end users who do not have access to 
a mouse for clicking the toolbar buttons, or who need to shift frequently between 
the New, Update, and Find operations. 
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Table 139 shows the barcode character combinations and their associated actions. 
The middle column, labeled Barcode Example, shows the actual barcodes that 
correspond to the Barcode Values (such as *New*), in a typical barcode font. 

CAUTION: If you scan only the letters in barcode without the leading and trailing 
asterisks, the operation will fail. For example, to represent NEW, you must use this 
form: *NEW*

Table 139. Barcode Actions

Barcode Value Barcode Example Action Name

*NEW* New Button. Scanning this barcode 
simulates clicking New on the barcode 
toolbar. 

*UPDATE* Update Button. Scanning this barcode 
simulates clicking Update on the barcode 
toolbar. 

*FIND* Find Button. Scanning this barcode 
simulates clicking Find on the barcode 
toolbar. 

*OPTIONS* Use ComboBox Selection. Scanning this 
barcode toggles between the various Use 
drop-down list selections in the barcode 
toolbar. 
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Entering Information from a Barcode Reader
This section explains how to enter information from a barcode reader into your 
Siebel application. 

To create new records for barcode data

1 On the Barcode toolbar, click New.

2 Navigate to the view that is to receive the barcode information.

3 If more than one value appears on the Use drop-down list, select the type of 
information contained in the barcode; for example, an asset number.

4 Scan the barcode.

The system creates a new record in the active tab and populates the appropriate 
field in the new record with the information from the barcode. 

5 If you want to create multiple records, continue scanning the barcodes.

To update a record with barcode data

1 On the Barcode toolbar, click Update.

2 Navigate to the view that is to receive the barcode information.

3 If more than one value appears on the Use drop-down list, select the type of 
information contained in the barcode; for example, a part number.

4 Click the tab and select the record that is to receive the number from a barcode.

5 Select the record where you want the barcode information to go.

6 Scan the barcode.

The system populates the appropriate field in the selected record with the 
information from the barcode. If the field already has a value, the barcode 
information replaces it. 
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Finding Information With a Barcode Reader
This section explains how to find information in your Siebel application with a 
barcode reader. 

To find a record with barcode data

1 On the Barcode toolbar, click the Find button.

2 If more than one value appears on the Use drop-down list, select the type of 
information contained in the barcode; for example, a repair number.

3 Scan the barcode.

If the data exists in the database, the system displays the record that matches the 
barcode input.
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Setup and Configuration for Barcode Reading
This section describes the setup and configuration procedures for barcode reading.

Setting Up a Barcode Interface
The FS Barcode Mapping view on the Service Administration screen sets the 
destinations for barcode data. Based on these mappings, barcode data is copied to 
specific views, tabs, and fields. The data may create a new record or update an 
existing record. When mapping barcode data to fields, you add a record for each 
field that is to receive data from a barcode. 

NOTE: Your Siebel application comes with a complete series of barcode mappings. 
You do not have to add or change any mappings unless you want to configure 
custom mappings. 

To set the destinations for barcode data in specific views, tabs, and fields, use the 
procedure that follows.

To map barcode data to views, tabs, and fields

1 Choose Site Map > Service Administration > FS Barcode Mapping.

2 Add a new record for every field that is to receive barcode data.

3 Complete the fields. Some fields are described in the following table.

Field Description

View Name View that is to receive the data.

Applet Name Applet (tab) that is to receive the data.

Field Name Field that is to receive the data.

Entry Mode Type of information to receive from the barcode input. Corresponds to 
the values in the Use drop-down list. 

Process Mode Type of operation that will bring focus to the specified field (New, 
Update, or Find). 
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Changing the Barcode Font for a Report
You can change the barcode font in reports that include barcodes. For instructions 
about how to change the font, see the chapter on global report modifications in 
Siebel Reports Administration Guide.
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Operation of Barcode Reading
This section describes the mechanism of operation your Siebel application uses for 
barcode reading.

Barcode Data Destinations
In the New or Update mode for barcode input, the data goes to a specified field or 
fields in the active view. The end user is responsible for selecting the appropriate 
view and tab. In the Update mode, the end user must also select the record to 
update. Barcode mappings specify the views, tabs, and fields where the specified 
data type (for example, asset number or part number) is added. In the Find mode, 
Siebel Field Service selects the view, tab, and field for the barcode data. 

Barcode mappings specify the views, tabs, and fields where the specified data type 
is added.

Barcode Data Processing
In the New or Update mode, your Siebel application follows this process to add 
barcode data to the database:

1 Checks for these settings in the Barcode toolbar: 

■ New or Update mode

■ Data type in the Use drop-down list

2 Checks in the Barcode Mapping table to determine the following:

■ Whether the barcode data is to update an existing record or create a new 
record in the selected view

■ Which field the barcode data goes to

3 Writes the barcode data to the selected view, tab, and field. 

NOTE: When the system creates new records for barcode data, it also fills in other 
fields as appropriate; for example, the current date and time.
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Barcode Data Searching
In the Find mode, Field Service follows this process to find data that matches input 
from a barcode:

1 Checks for these settings in the Barcode toolbar: 

■ Find mode

■ Data type in the Use drop-down list

2 Checks in the Barcode Mapping table where the selected data type is defined.

3 Searches the database for the data in the view, tab, and field specified in the 
barcode mapping record. 

4 If a record exists that matches the barcode data and mapping, displays that 
record on screen. 
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This appendix provides reference information about logging levels for the engines 
available in Siebel Field Service as business services.
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Business Service Engines
To facilitate configuration, maintenance, and multi-language support, the following 
engines within Siebel Field Service are implemented as business services:

■ Cycle Counting Engine

■ Fulfillment Engine

■ Mobile Inventory Transaction Engine

■ Part Locator Engine

■ Preventive Maintenance Engine

■ Replenishment Engine

Server Component Aliases
As with every component of the Siebel Server, each of these engines has an alias. 
These aliases are used as parameters in SRVRMGR commands. Table 140 lists the 
aliases for the server components associated with each engine. 

Table 140. Engine Server Component Aliases

Engine Server Component Alias

Cycle Counting FSCyccnt

Fulfillment FSFulfill

Mobile Inventory Transaction FSInvTxn

Part Locator FSLocate

Preventive Maintenance FSPrevMnt

Replenishment FSRepl
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Logging Levels
Each engine has an associated logging level. A logging level is a level of detail for 
automatic event logging when a Siebel application component is running. The 
logging level is expressed as a number, with higher numbers representing greater 
levels of detail. Table 141 shows the logging levels and their definitions.

The default logging level for each of the engines is 1. If you need more detail in 
testing or troubleshooting, you can specify a higher logging level for the engine. You 
can modify the logging level by using one of the following methods:

■ For individual event types. Navigate to Site Map > Server Administration > 
Components > Component Event Configuration. For the component selected in 
the Components list, the Component Event Configuration list shows every type 
of event that can be logged, and its associated logging level. 

■ For all event types. Invoke the SRVRMGR.EXE command line utility. The 
command to pass is as follows:

change evtloglvl <parameter> = <log level> for comp <parameter>

For example,

change evtloglvl FSPrevMnt = 3 for comp FSPrevMnt

This changes the logging level for all event types associated with the engine. 

NOTE: This command is case insensitive except for the parameter. 

Table 141. Engine Logging Levels

Level Name Comments

1 Error Logs anything that goes wrong.

2 Warning Logs anything exceptional even if it does not stop the operation.

3 Trace Traces the functioning of the engine. Generates a chronology of 
events even if they are not errors or warnings.

4 Debug Generates a very detailed log. Mainly for use by Siebel developers. 
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For more information about configuring business services, see the chapter on 
business services in Integration Platform Technologies: Siebel eBusiness Application 
Integration Volume II. 
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reassigning 439
related change requests, linking 443
reopening change requests 448
resolving, process of 422
service request, associating a change 

request to 50
solution, associating change request 

with 80
test passes, associating with 481
unassigned change requests, 

closing 439
unassigned change requests, querying 

for 438
Change Requests view

Service screen, about using to describe 
manufacturing defects 71

Solution Administration screen, about 
using to associated changes requests 
to 82

Solutions screen, about using to associate 
a solution 84

change requests, logging by quality 
assurance

See also individual change request entries
about 434
attachments, adding to a change 

request 436
change requests, resolving by engineering

See also individual change request entries
about 441
closing resolved change requests 445
engineers, assigning change requests 

to 441
multiple occurrence change requests, 

creating 441
multiple occurrence links, breaking 442
related change requests, linking 443

charts
service analysis charts, list of 74
view, about and fields (table) 113

Charts view
Assets screen, about using 509
Service screen, analyses of activities (list 

of) 74
Check Trunk, using to verify on-hand 

inventory 98
closing service request 55
Commit buttons

mechanism described 330
using, about 110

component request parameters
Cycle Counting Engine, setting a 

repeating request 386
Cycle Counting Engine, setting for 386
Fulfillment Engine, setting 295
Part Locator Engine, setting 295
Preventive Maintenance Engine 

(table) 540
Replenishment Engine (table) 396
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Components view, about using 510
configuration parameters

Cycle Counting Engine, technical 
explanation 381

inventory, about aspect precedence 382
precedence rule for cycle counting 378
Replenishment Engine (table) 394

Consolidated Lines subview, about 
using 371

Consolidation view
Consolidated Lines subview, about 

using 371
Qualified Lines subview, about 

using 370
Shipping screen, about using 370

constraints
ABS and Optimization engine 

(table) 144
Constraint Wizard, about using to 

create 143
creating constraints (procedure) 166
service business constraints and 

examples 142
types of 134
work hours, examples of limiting 146

Constraints Sets view
Constraints view, about 167
Service Regions view, about 168

Constraints view
Constraints Sets view, about 167
creating constraints (procedure) 166
Server Key Mappings view, about and 

fields (table) 168
contacts

verifying for service 48
viewing invoices for 266

Contacts screen, about 266
Contacts view, about using 60
Contract Schedule button, about 183
contract scheduling

See also Optimization Engine
about and running 181
Contract Schedule button, about 183

cost function, factor calculations 183
Insert Activity button, about and 

conditions for using 182
Load button, about and conditions for 

use 183
Contract Scheduling period, about 124
contract-based pricing

about 223
associating with entitlement 215
defining 198
order-entitlement-based pricing, 

configuring 201
contracts

See agreements
correspondence, generating for a service 

request 55
Cost Function Details View, about 164
cost functions

about 135
factor calculations 183

Cost Functions view, about defining 
Optimizer function 164

cost lists, about tracking 251
costs, calculating asset adjusted cost 500
Counted Serial Numbers subview, 

about 411
Counted Serial Numbers subview, about 

using 411
customer responses, viewing 73
Customer Satisfaction Survey view, 

about 84
customers

repaired or exchanged parts, returning 
to 570

repaired parts, shipping to 564
repairs, shipped directly from third-party 

vendor 562
cycle count basis

inventory location type, defining for 388
inventory location, defining for 388

cycle count class
inventory type and product, 

defining 389
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location and product, defining for 388
cycle count setup

cycle count class, defining for products at 
inventory location 388

inventory location type, defining for 388
inventory type and product, 

defining 389
Cycle Count view, about using 350
cycle counting

See also Cycle Counting Engine
completing a cycle count 392
frequency and periods, defining for an 

inventory location type 389
overview 378
Part List view, about displaying product 

counts by location 410
parts lists, reviewing 391
parts, specifying manually 390
pending cycle counts, reviewing 391
populating variance and serial number 

data 392
precedence rule, about 378
results of a cycle count, recording 391
results, reviewing 392
scenario 381
variance information, viewing 411

Cycle Counting Detail report 412
Cycle Counting Engine

See also cycle counting
about 38
component request parameters, 

setting 386
component request parameters, setting a 

repeating request 386
configuration parameters (table) 382
configuration parameters, technical 

explanation 381
configuring tracing 390
counting results, reviewing 392
cycle count, running 392
FSCyccnt parameters (table) 384
input and output 378
logging levels, modifying 593

methods, using to invoke 385
process overview and logic diagram 379
product classification methods 378
running interactively 391
synchronous or asynchronous operation, 

specifying 386
system preferences, changing 387
tracing levels, about 385

cycle counting parameters, viewing for a 
location 338

cycle counting setup
cycle count, defining basis for inventory 

locations 388
frequency and periods, defining for an 

inventory location 389
frequency and periods, defining for an 

inventory location type 389
Inventory Location Types view, about 

assigning cycle counting 
parameters 402

inventory location, setting up by 388
parameters by location, defining 405
product parameters by location 403
start and end dates, defining 388
system preferences 383

Cycle Counts screen
Cycle Counts view, about and fields 

(table) 410
using, about 410

Cycle Counts subview, about and fields 
(table) 409

Cycle Counts view
Cycle Counts subview, about and fields 

(table) 409
Inventory screen, about and fields 

(table) 408
More Info subview, about and fields 

(table) 408
Part List view, about and fields 

(table) 410
Variance view, about and fields 

(table) 411
604 Siebel Field Service Guide Version 7.5, Rev. A



Cycle Counts views, about and fields 
(table) 410

D
data

employee data, maintaining and 
loading 141

loading for service regions 139
Data Administration screen

Order Action Types view, about 
using 306

Order Types view, about using 306
views for configuring orders, about 306

data cleansing application, about 138
data set, extending 278
databases

remote and local databases, about 
synchronizing 337

synchronization, trunk inventory 318
Date triggers, about 534
De-Allocate transaction

about and using Process Shipment 
button 357

Shipped Line quantity conflict 368
decision issues

service request, viewing for a 71
service requests, finding for 58

Def Act Owner ID system preference, 
about 540

defective parts
See also repairs
defective items, receiving 558
external provider, shipping to 569
movement, tracking 568
over the counter, returning 566
processing for repair 566
stock transfers, tracking 567
warranty status, verifying 522

DeInstall transaction, about 493
dependent assets, recording 511
Details subview, about and fields 

(table) 272
discounts, viewing 239

dispatch
See also Dispatch Board; field service 

engineers
Dispatch Board, adding service regions 

to 189
dispatcher responsibility, assigning to 

users 187
Dispatch Board

See also scheduling
about and scheduling activities 122
Activity Gantt Chart, about 191
dispatcher responsibility, assigning to 

users 187
field service engineers, assigning and 

scheduling 189
graphical interface, about 33
queries, using 193
queries, using legacy data 193
service regions, adding to 189
setting up 185
Unscheduled Activities list (table) 191

dispatcher responsibility, assigning to 
users 187

dispatching field service engineers
about 189
selecting based on skill 189
service activities, assigning 

manually 188
service activities, assigning with 

Assignment Manager 188
documentation, additional 24
Documents view, about and fields 

(table) 239
Downgrade transaction, about 493

E
employee availability

employee data, maintaining and 
loading 141

shifts, about and rate types 141
employee data, maintaining and 

loading 141
employee schedules
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about and control of 141
ABS and Optimization Engine constraints 

(table) 144
associating with services 130
break time, recording 147
break type, setting name 147
break, including activities 147
breaks, about and rules 146
breaks, defining and allowing them for 

activities 147
constraints, about and examples 142
constraints, about creating 143
constraints, examples of 146
exception hours, defining 130
skill-based routing, about 142
travel conditions and travel time, about 

and setting fields 148
employees

exception hours, defining 130
schedule, associating with 130

Employees view, about listing employees 
assigned to service region 163

employees, roles, defining with 
locations 350

Entitle button, about using 220
entitlement templates

defining 202
metrics, defining 221
overview 220
preventive maintenance plans, 

defining 205
Preventive Maintenance subview, about 

and preventive maintenance 
plan 221

products, associating 206
products, defining 203
service billing details, defining 204
special pricing, defining 205
template metrics, defining 202

entitlements
See also agreements; preventive 

maintenance
accounts, associating manually 213

agreements, viewing for 208
assets, associating manually 214
assets, viewing 223
automatic entitlements, about 196
billing terms, defining 221
Contacts subview, about using to 

associate contacts with an 
entitlement 235

contacts, associating manually 214
contract-based order pricing, 

associating 215
Entitlements view, about 61
Metrics subview, about recording 

performance measurements for 235
performance metrics, adding 216
preventive maintenance plans, 

associating manually 214
products, associating manually 214
service billing details, viewing 236
service hours, viewing 73
service request, selecting for 49
service request, verifying for and 

selecting an entitlement 216
use plan pricing, defining 200
Verify button, using to find 65
verifying for service 49
viewing 234

Entitlements view, about 513
entitlements, setting up

entitlement template metrics, 
defining 202

entitlement templates and products, 
associating 206

entitlement templates, defining 
preventive maintenance plans 205

entitlement templates, defining service 
billing details 204

entitlement templates, defining special 
pricing 205

products covered by entitlements, 
defining 203

schedule exceptions, defining 203
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service activity, defining billing 
exception 204

service activity, defining expense 
exceptions 204

service calendar, associating 216
service hours, defining 203
system preferences for verifying, table 

of 206
verification system preferences 206
Verify entitlements button, setting system 

preferences 202
Event subview, about and fields 

(table) 551
Event triggers, about 536
Exception Hours view, about defining day or 

continuous blocks of days 133
exceptions

exception hours, defining for an 
employee 130

schedule, adding to 129
exchanged part, returning to customer 570
expense exceptions, defining 204
Expense Tracker view

field service activities, about and fields 
(table) 106

invoices, about using for 262
expenses

activity, logging for 96
recording for repair activities 570

explanations, finding for service 
requests 58

Explorer Across Organizations view, about 
using 514

Explorer view, about using 514
external locations

about 321
setting up 347

F
Fast Guided Local search optimization 

method, about 156
features, new in this release 23
field part movements, verifying 53

field service activities
invoice, automatically generating 

automatically for 99
invoices, generating automatically 99
material, verifying availability 96
materials, ordering 97
new activity, adding 99
on-hand inventory, verifying 98
order status, verifying 96
service parts, recording movement 98
substitute product suggestions, 

viewing 323
time, logging 96
tracking 106
trunk inventory, verifying 98

field service activities, setting up
alarms, setting for activities 94
field service activity templates, setting 

up 93
field service activities, using

activity, logging hours spent on 96
expenses, logging for an activity 96
field service engineer’s activities, 

reviewing 101
instructions, recording additional 100
material, ordering for an activity 97
materials for an activity, verifying 

availability and order status 96
new activity, entering for a service 

request 99
on-hand inventory, verifying using Check 

Trunk 98
on-hand inventory, verifying using Part 

Browser 98
part movements in the field, 

verifying 101
parts and tools, recording to complete a 

service activity 97
service activity steps. recording 

additional 99
service parts, recording movement in the 

field 98
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skills required to complete activity, 
recording additional 100

field service activity templates
activity templates, associating activities 

with 93
activity templates, defining 93
steps, skills, parts and tools, and 

instructions, associating with an 
activity 93

Field Service client, invoking Preventive 
Maintenance Engine 539

field service engineers
activities, reviewing 101
Assign command, about using to provide 

ranked list of 68
assigning and scheduling manually 189
Assignment Manager, employee 

assignment rules 68
assignment rule, accessing 69
service activities, assigning 

manually 188
service activities, assigning with 

Assignment Manager 188
skill, selecting based on 189

Field Service Part Browser, about 35
files, attaching to agreements 212
FS_PROD_ALLOC_RULES, about 

specifying 290
FSCyccnt component request 

parameters 384
FSFulfill component request parameter, 

about and table 292
FSLocate component request 

parameter 292
FSPrevMnt component request parameter, 

about 540
FSRepl component parameters (table) 396
fulfillment

See also Fulfillment Engine; Part Locator 
Engine

Allocate button, about using 284
Fulfill command, about 284

Generate PickTickets command, business 
flow 284

Locate button, about using 284
methods for 282
parameters, Fulfillment and Part Locator 

Engines 292
parameters, setting (procedure) 292
replenishment relationships, about 

setting 318
system preferences, about and table 287

Fulfillment Engine
See also fulfillment; Part Locator Engine
about 38
auto-substitution, conditions for 290
component request parameters, setting 

up 295
filling orders 299
inventory line items, status 

requirement 283
inventory locations, overview of 

locating 283
inventory option fields 304
inventory-specific attributes, list of 289
logging levels, modifying 593
overview 282
parameters, about and table 292
Parts Locator, compared to 282
process overview and function 

diagram 285
starting 294
substitute products, viewing 305
synchronous/asynchronous operation, 

setting 296
system preferences, about 287
system preferences, setting 296
system preferences, table of 291

Fulfillment view, about using the Auto 
Receive flag 310

Future Release release type, about 432

G
Generate Orders view
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Inventory Locations view, about 
using 406

Source Locations subview, about 
using 407

Target Locations subview, about 
using 407

Generate Orders view, about using 348
Generate PickTickets command, business 

flow 284
geocode

about 136
data, specifications for 137
importing geocode data 137

Get Warranty button, about 524
global SMS centers, about using Siebel 

Wireless Messaging 37
Glued period, about 124
Greedy search optimization method, 

about 156
Greenwich Mean Time (GMT), about and 

list of time zones 138
guide

audience for 21
documentation, additional 24
new features in this release 23
organization of 22
revision history 25

guided tabu search optimization method, 
about 155

H
hard constraints, about 134
hierarchical assets

See asset hierarchy
history of revisions 25
History subview, about using 553
History view, about using 552
holidays, about using the Exception Hours 

view 133

I
importing geocode data 137

incremental usage plan 227
Insert Activity button, about and conditions 

for using 182
Install transaction, about 493
installment plan

See nonrecurring payment plans
Instructions view, about 108
internal orders, allocating parts 

manually 298
inventory

See also cycle counting; products
assets and products, linking 332
cycle count, adjusting after 392
Inventory module, about 35
inventory order, about specifying 322
mobile inventory transactions, 

about 330
on-hand inventory, verifying 98
on-hand inventory, verifying using Check 

Trunk 98
on-hand inventory, verifying using Part 

Browser 98
options allocated 345
Pending Internal Orders subview, using to 

view orders 373
Received Line Item subview, about 

recording inventory level 374
replenishing (procedure) 401
status for allocation 283

inventory categories, setting 342
Inventory Level Categories view, about 

using 344
Inventory Level subview

Product Inventory view, about and fields 
(table) 348

Product Inventory view, about using 351
inventory levels

about and examples 320
creating (procedure) 334
defining (procedure) 336
Inventory Level Categories view, about 

using 344
negative levels 321
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products, associated with 348
Inventory Location Types subview, about 

using 342
Inventory Location Types view, about and 

fields (table) 402
inventory locations

See also replenishment
across organizations 346
cycle count parameters, viewing for a 

location 338
cycle count, defining basis for 388
cycle counting frequency and period, 

defining for an inventory location 
type 389

employee, associating with 335
Inventory Locations Types view 343
location choices, displaying 346
multiple locations, viewing relationships 

among 349
organization, associating with 335
overview and location types, list of 316
relationships between, defining 336
Relationships view, about viewing 

relationships 407
repair numbers and 559
truck inventory 318
Vendor view, about recording 

vendors 349
vendor, associating with a location 335

inventory locations and cycle count
classes, defining for locations 388
cycle basis, defining 388
frequency and periods, defining 389
inventory location types, defining cycle 

count basis for 388
setting up 388

inventory locations and products
assets, by product, viewing 348
products associated with, viewing 347
products at location, viewing 351

Inventory Locations view
All Inventory Locations Across 

Organizations, about 346
external location, setting up 347

Generate Orders view, about using 406
Inventory screen, about and fields 

(table) 405
Inventory screen, about using 346
Pending Orders view, about using 407
Product Inventory subview, about and 

fields (table) 406
inventory locations, setup

cycle count classes, defining 388
cycle count, setting up 388
external location, setting up 347
frequency and periods, defining 389
inventory location types, defining cycle 

count basis for 388
location types, about setting 343
overview of setting up 334
positions, defining roles 350
replenishment relationships, 

defining 399
setup diagram 317
structure network, overview 318
virtual locations 352

Inventory Options subview
Product Field Service Details view, about 

and fields (table) 304
Product Service Details view, about 

using 345
Products screen, viewing from 115
Service Details view, about and fields 

(table) 403
Inventory screen

about using 345
Cycle Count view, about using 350
cycle counting and replacement, about 

using for 405
cycle counting parameters, viewing for a 

location 338
Cycle Counts view, about and fields 

(table) 408
Generate Orders view, about using 348
Inventory Location view, about and fields 

(table) 405
Inventory Locations view, about 

using 346
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inventory status reports, generating 338
inventory status, using to verify 338
Pending Orders view, about using 349
Product Inventory view, about 

using 347
Relationships view, about and fields 

(table) 349
Roles view, about 350
Vendors view, about 349

inventory structure
inventory hierarchy structure, about 318
structure diagram 314

inventory tracking
cycle counting parameters, viewing for a 

location 338
inventory levels, about and 

examples 320
inventory status reports, generating 338
inventory status, verifying using the 

Inventory screen 338
inventory status, verifying using the Part 

Browser 338
reports, list of 354
tracking methods, about 320

inventory transaction types
defining 336
view containing 343

Inventory Transaction Types view, about 
using 343

inventory transactions
about 325
across organizations, about 352
Allocate button, using to allocate 284
asset numbers by product, viewing 352
asset swaps during repair 564
assets, adding to transactions 339
assets, assigning to transactions 339
Commit buttons, mechanics of 330
conditions for generating, types of 

(table) 327
customers, shipping to 564
destination mobile client, moving item to 

another trunk 340

good inventory, returning to 564
hierarchical assets 324
inventory generation rules 329
mobile client transactions, 

committing 340
negative inventory level, and 321
over-the-counter transaction, receiving a 

product as 339
products created automatically 344
repair activities, about 560
screen and view 352
serialized assets, quantity definition 491
source mobile client, moving item to 

another trunk 340
stock transfer, receiving a product 

as 339
third-party vendor, repairs received 

from 562
third-party vendors, repairs sent to 561
types, summary of (table) 326
viewing 339
write-off 341

Inventory Transactions screen
Assets view, about using 352
Inventory Transactions view, about and 

fields (table) 352
using, about 352

Inventory Transactions subview, about 411
Inventory Transactions view

inventory transactions across 
organizations, about 352

Inventory Transactions screen, about and 
fields (table) 352

inventory transactions, creating
asset, adding to 339
creating manually 339
destination mobile client, moving item to 

another trunk 340
source mobile client, moving item to 

another trunk 340
stock transfer or over-the-counter 

transaction, receiving product 
as 339
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inventory, products
creating (procedure) 332
restocking products 348
serialization 323
substituting products, about using 345
writing off inventory 341

Invoice Engine
activities processing logic 246
adjustment line item processing 

logic 250
agreements processing logic 247
nonrecurring charge line items, 

processing logic 248
overview 260
recurring charge line items, processing 

logic 248
required information 262
service request processing logic 246
usage-based charges, processing 

logic 248
invoice integration

data set, extending 278
overview 276
service ports, defining 278
terms, invoicing integration 276
third-party invoicing software, 

disabling 278
Web services, configuring 277
workflow processes, about creating 279

invoice, billable items
expense tracking 262
expenses, recording for an activity 257
labor charges, tracking 261
orders, recording for a service 

request 257
parts, recording for an activity 257
time, recording for an activity 257
viewing, about and Line Items view 271

invoices
activity invoice, creating 

automatically 258
auto-invoice feature, about setting 

up 251

auto-invoice, required information 262
automatic agreement invoicing, setting 

up 253
billable activities, recording for a service 

request 256
creating and modifying 268
creating automatically for service 

requests 258
creating for agreement line items 258
creating manually 256
discounts associated with 

agreement 239
field service activity, generating 

automatically 99
nonrecurring charges 248
nonrecurring plans 224
overview and diagram 244
part, product, and asset tracking 262
payments, associating 259
printing 259
report for 273
service request, generating and 

printing 54
status indicators (table) 269
types of charges 247

invoices and agreements
discounts, viewing 239
invoices and agreement line items, 

associating 233
line item billing details, viewing 232
line items, creating manually 212
line items, modifying 265

Invoices screen
Invoices view, about and fields 

(table) 268
invoices, about using for 268
Line Item Details view, about and fields 

(table) 272
Line Items view, about and fields 

(table) 271
Payments view, about and fields 

(table) 272
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Payments view, about and fields 
(table0 272

Invoices view
field service activities, about using 

for 108
invoices, about using for 262
Line Items view, about and fields 

(table) 271
invoices, viewing

agreement line item billing details 264
billable items. about and Line Items 

view 271
by activity 262
by contact 267
discounts 239
line item detail, viewing and Details 

subview 272
Payments view, about and fields 

(table) 272
Items view, about and fields (table) 109
items, definition of and repair activities 86

L
labor charges, tracking 261
laptop computers

remote and local databases, about 
synchronizing 337

synchronization of trunk inventory 318
Latitude format, about 137
legacy data and Dispatch Board 

queries 193
Line Detail subview, about and fields 

(table) 308
Line Item Details view, about and fields 

(table) 272
line items

Line Items Receipts view, about using to 
show all 374

orders, reviewing 364
Line Items Receipts view, about using 374
Line Items subview, about using 374
Line Items view

Actions subview, about using 309

Activity Plans subview, about using 309
Agreements screen, about using and 

fields (table) 264
Attributes subview, about using 309
Invoice Plan subview, about using 264
Invoices screen, about and fields 

(table) 271
Invoices view, about using 265
Line Detail subview, about and fields 

(table) 308
Orders screen, about and fields 

(table) 307
Part Locator subview, about using and 

lists 309
Repair subview, about using 310
Totals subview, about using 308
updating order line items, configuration 

note 308
Warranty subview, about using 310

Load button, about and conditions for 
use 183

Locate button, about using 284
location order, about specifying 322
Lock Assignment check box, about 91
logging levels, service engines 593
Longitude format, about 137

M
Manual assignment, about and scheduling 

activities 122
Marketing Release Document (MRD)

adding 472
features, associating with 472

materials
activity, ordering for 97
availability and order status, 

verifying 96
Measurement Analysis chart, about 509
measurements

about defining 536
Product Measurements view, about 

defining assets 506
Measurements view, about using 511
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Metrics view, about using 221
metrics, viewing for service request 54
Missing Assets subview, about 411
mobile clients

about synchronizing 337
Commit buttons, mechanics of 330
committing transactions 340
destination mobile client, trunk-to-trunk 

transfers 340
inventory transactions, about 330
parts movement, process overview 342
source mobile client, trunk-to-trunk 

transfers 340
Mobile Inventory Transaction Engine

asset transactions, about using for 324
logging levels, modifying 593

Mobile Inventory Transaction Engine, 
about 38

mobile inventory transactions
about 330
Commit buttons, mechanism of 330

More Info subview, about and fields 
(table) 408

More Info view
repairs, about using for 572
warranties, about using for 527

multiple occurrence
change requests, creating 441
links, breaking 442

multi-processor support, about and 
examples 158

N
No Barcode report, about 372
nonrecurring charges, about 247
nonrecurring payment plans

about 224
agreement line item billing details, 

viewing 232
defining 199
NRC view 224

non-serialized products
creating (procedure) 332
treatment of 117

numbering
about 64
record ID, alternative values for 65

O
one-time charges 224
on-hand inventory, verifying 98
operating status and history, viewing by 

asset 513
Optimization Engine

See also contract scheduling; Optimizer
about 175
ABS, comparison, service region 

scheduling 126
appointments, moving and classes of 

operations 155
best practices 176
business priorities, about 176
centralized dispatch model, about 177
contractual or legal constraints, about 

enforcing 177
engine, requirements 179
optimization, levels of 177
optimizing scheduling, role in 175
parts, availability of 181
repairs and service contracts, scheduling 

concerns 176
schedule data, cache management 139
scheduling calls, high-traffic areas 177
service region’s schedule, methods for 

obtaining 155
Workflow Manager, about using 180

Optimizer
See also Optimization Engine
constraints (table) 144
geocode and ZIP Code requirements 136
Scheduling Administration screen buttons 

and commands 162
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scheduling horizons, example 125
scheduling horizons, list of 124

Optimizer horizon, about 124
Order Action Types view, about using 306
order line items

activity templates, associating with 309
adjustment line items, logic for 250
allocating using Part Locator Engine 299
attributes, selecting for customizable 

products 309
deallocating (procedure) 300
fields in view 307
fulfilling (procedure) 299
invoicing logic for nonrecurring 

charges 248
line items processed, viewing 374
locating parts using Part Locator 

subview 309
locating using Part Locator Engine 298
pick tickets, finding for line item 361
pricing details, viewing for 308
reviewing line items 364
selected order line item, getting more 

details on 308
transactions, viewing 309
updating, configuration note 308
warranties, associating with 518
warranties, verifying for 521

order line items, receiving
incomplete documentation, 

reviewing 365
order, receiving 363

order line items, shipping
allocated items and associated pick ticket, 

viewing 368
allocated items and shipment, 

viewing 368
qualified items, viewing 370
Repair Pick Ticket view, about viewing 

items allocated for repairs 369
serial numbers 369
shipping orders, viewing 361

Order Types view, about using 306

order, defined 30
order-entitlement-based pricing, about and 

configuring 201
orders

All Pending Orders view, about 
using 373

billable orders, recording for service 
request 257

contract-based pricing 223
Fulfillment Engine, using to fulfill 

orders 299
Generate Order view, about generating by 

Replenishment Engine 406
Order Action Types view, about 

using 306
Order Types view, about 306
pick ticket, generating for an order 298
pick tickets, relationship with 366
receiving hierarchical assets 360
related agreements, viewing 239
related service requests, viewing 74
repair orders, creating 569
restocking inventory 348
service or internal orders, allocating parts 

manually 298
service requests, reviewing associated 

with 54
status, verifying for field service 

activity 96
Orders screen

Fulfillment view, about using the Auto 
Receive flag 310

fulfillment, about using for 307
Line Items view, about and fields 

(table) 307
warranties, about using for 525

orders, receiving
line items for all order, reviewing 364
line items with incomplete 

documentation, reviewing 365
overview 358
pending orders (purchase, repair and 

return material), viewing 373
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receiving (procedure) 363
repaired items from vendor, 

receiving 363
Unknown Receipt records, adding 364
validations for transactions 359
viewing received orders 373

orders, setting up
Fulfillment and Part Locator Engines, 

setting asynchronous or synchronous 
operation of 296

Fulfillment and Part Locator Engines, 
setting system preferences 296

order action types, defining 295
types of orders, defining 295

orders, shipping
hierarchical assets, considerations 360
pick ticket generation, process 

overview 356
pick ticket, finding for line item 361
pick tickets, consolidating 362
Process Shipment button, processes 

invoked 357
reports 372
Shipped Line quantity conflict 368
shipping procedure 361
validations for transactions 359

organization of guide 22
organizations

defined 346
inventory locations across 

organizations 346
inventory transactions across 

organizations, about 352
primary organization, setting for 

inventory location 335
role of 59
service requests, visibility across 

organizations 63
overtime, about defining and 

scheduling 127

P
Parameter Sets view, about 165

parameters
Cycle Counting Engine (table) 384
fulfillment and Part Locator Engine, 

setting parameters (procedure) 292
Fulfillment and Part Locator Engines, 

about and table 292
precedence rule for cycle counting 378
Preventive Maintenance Engine 

(table) 540
Replenishment Engine (table) 396
Replenishment engine, configuration of 

(table) 394
Parameters view, about 165
parameters, scheduling

about and table 150
appointments, moving about and classes 

of operations 155
Part Browser screen

inventory status, using to verify 338
on-hand inventory, using to verify 98
Part Locator, about and differences 

from 118
Product Inventory view, about using 351
service inventory, about using for 351

Part List view
Counted Serial Numbers subview, about 

using 411
Cycle Counts view, about and fields 

(table) 410
Part Locator Engine

See also Fulfillment Engine
automated function, about 38
component request parameters, setting 

up 295
Fulfillment Engine, compared to 282
inventory line items, status 

requirement 283
line item fulfillment, about 287
logging levels, modifying 593
order line items, allocating 299
order line items, finding 298
parameters, about and table 292
parameters, setting (procedure) 292
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service inventory, about using to 
manage 35

synchronous/asynchronous operation, 
setting 296

system preferences, about and table 287
system preferences, setting 296

Part Locator subview, about using and 
lists 309

Part Locator, differences from Part Browser 
screen 118

Part Movement Administration view, about 
using 342

part movements
field part movements, verifying 53
verifying in the field 101

Part Tracker view
Activities screen, about and fields 

(table) 107
Commit button, about 110
invoices, about using for 262
service industry, about using for 353

parts
allocating manually 298
availability of 181
billable parts, recording for activity 257
customers, shipping repaired parts 

to 564
exchanged, returning to customer 570
on-hand inventory, verifying 98
physical location in inventory 322
Pick Ticket view, about viewing allocated 

parts 367
repaired parts, returning to the 

customer 570
specifying manually for cycle 

counting 390
tracking by activity 262
trunk inventory, verifying 98

parts movement
asset transaction generation 324
Commit buttons, mechanism of 330
defective parts, receiving 558
good inventory, returning 564

mobile clients, process overview 342
mobile inventory transactions, 

about 330
physical location, tracking 320
recording movement 98
tracking by asset or serial number 353

patch requests, creating
about 450
approving and shipping patch 

requests 451
change request, generating from 450
process of creating 425

payment plans
nonrecurring payments 224
usage-based plans 225

payments
See also invoices
invoice payments, viewing and Payments 

view 272
invoices, associating 259

Payments view, about and fields 
(table) 272

Pending Internal Orders subview, about 
using 373

Pending Orders view
cycle counting and replenishment, about 

using for 407
Relationships view, about using 407
service inventory, about using for 349
Vendors view, about using 407

Pending POs/ROs/RMAs subview, about 
using 373

performance metrics
entitlement, adding manually 216
Metrics subview, about using 235
service benchmarks, viewing 73
service request, viewing for 54

Pick Ticket view
Allocated Lines subview, about and fields 

(table) 368
Pick Tickets view, about and fields 

(table) 367
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Serial Numbers subview, about and fields 
(table) 369

Shipped Line subview, about and fields 
(table) 368

pick tickets
See also shipping; waybills
allocated line items and pick tickets, 

viewing 368
allocated line items and shipment, 

viewing 368
consolidated pick tickets, viewing 370
consolidating (procedure) 362
line item, finding for 361
order, generating for 298
orders, relationship with 366
overview 356
Pick Ticket Details report, about 372
Pick Ticket view, about using and 

fields 366
products and quantities, viewing on one 

pick ticket 371
qualified order line items, viewing 370
waybills, filling in 362

Pick Tickets view
Consolidation view, about using 370
Pick Ticket view, about and fields 

(table) 367
Repair Pick Ticket view, about 369
Shipping screen, about using and fields 

(table) 366
Waybill view, about and fields 

(table). 370
Planned Completion, about making 

schedule changes 148
Planned End, about making schedule 

changes 148
Plans subview, about using 553
Plans view, about using 548
positions

defining with locations 350
inventory locations, associating 

with 335
postal code

 See ZIP Code

Preventative Maintenance view, about 
using 512

preventive maintenance
See also Preventive Maintenance Engine
activities, reviewing by asset 499
asset, reviewing generated activities 

for 546
assets and preventive maintenance plans, 

associating with 543
Event triggers, about 536
generated actions, reviewing 545
history, viewing 553
plans, setup overview 537
preventive maintenance plans, 

defining 542
service request templates, creating 544
status of plan, viewing for an asset 500
Threshold triggers, measurements and 

readings 536
Time Interval triggers, about 534
triggers, rules and examples 533
usage triggers, about 535

Preventive Maintenance Engine
See also preventive maintenance
about 38, 530
activities, about creating 538
asset, validating PM plans for 538
FSPrevMnt server component 540
logging levels, modifying 593
logic (diagram) 530
parameters, listed (table) 540
parameters, setting 542
running 539
synchronous or asynchronous operation, 

setting 542
system preferences, changing 542
triggers, defining for preventive 

maintenance plans 543
Preventive Maintenance module, about 36
preventive maintenance plans

activity templates, associating with 544
agreements, associating with 543
asset, running for 545
associating actions 215
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entitlements, associating manually 214
entitlements, manually associating 214
generating for agreements and 

entitlements 215
preventive maintenance action, 

associating 215
use with entitlement templates 221

Preventive Maintenance screen
Actions view, about using 552
History view, about using 552
Plans view, about using 548
Products view, about and fields 

(table) 551
Triggers view, about using 548
using, about 548

Preventive Maintenance subview, about 
using 554

Price Details view, about using 236
pricing

aggregate, about setting up 226
asset-based 198
contract-based pricing 223
nonrecurring payments 224
service pricing and exceptions 221
time exceptions 222
usage-based plans 225
use plan pricing, defining 200

Pricing Administration screen
Asset Mapping view, about and fields 

(table) 505
using, about 505

printing
barcodes in reports 582
invoice, generating and printing 54
invoices 259

Process Receipt button, about processes 
generated 359

Process Shipment button, processes 
invoked 357

processor, about multi-processor support 
and example 158

Product Administration screen
assets, about using for 506

fulfillment, about using for 301
Product Field Service Details view, about 

and fields 302
Product Measurements view, about and 

fields (table) 506
Products Service Detail view, about 345
Products view, about using 345
service industry, about using for 345

product builds, adding 432
product defects, viewing 71
Product Field Service Details view

Inventory Options subview, about 304
Product Administration screen, about and 

fields (table) 302
Substitute Products subview, about and 

using 305
Product Inventory subview, about and fields 

(table) 406
Product Inventory view

Assets subview, about using and 
fields 348

Inventory Level subview, about 
using 351

Inventory Level subview, about using and 
fields 348

Inventory screen, about using 347
Part Browser screen, about using 351
Substitutes subview, about using 351

Product Measurements view, about and 
fields (table) 506

product prototypes, about 485
product serialization

about 323
serialized compared to 

nonserialized 323
serialized products, creating 332

Product Service Details view
Inventory Options subview, about 

using 345
Product Administration screen, about 

using 345
Substitute Product subview, about 

using 345
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products
See also inventory
allocation of, specifying 332
asset, specifying for 332
associating inventory levels with 348
change requests, verifying associated 

for 57
displaying information about using 345
in inventory locations 351
inventory locations for, viewing 347
inventory, adding to 334
locating and allocating, views for 302
mapping cost of assets 496
nonserialized products, creating 332
Product Measurements view, about 

defining measurements from 
assets 506

Products view, about associating with PM 
plans 551

repair history, verifying 57
restocking 348
returning to good inventory 564
serialized and non-serialized, treatment 

of 117
serialized compared to 

nonserialized 323
service pricing exceptions 223
service products and asset-based 

pricing 219
substitute service product suggestions, 

viewing 323
warranties, verifying for 520
warranty coverage, checking 520
warranty coverage, specifying 517

products and agreements
agreement line item attributes, 

viewing 231
agreement, adding sold under 211
products in an agreement, viewing 208

products and assets
asset-based pricing 198
assets by products for a location, 

viewing 348

assets, specifying 332
products and entitlements

associating 228
associating manually 214
entitlement template, defining 203
products covered by entitlement, 

viewing 223
Products screen

cycle counting and replenishment, about 
using for 403

field service activities, about and fields 
(table) 115

Service Details view, about using 403
Substitute Products subview, about 117
warranties, about using for 526

Products subview, about using 523
Products view

Assets subview, about using 552
fulfillment, about and fields (table) 301
Preventive Maintenance screen, about 

using and fields (table) 551
service inventory, about using for 345

project teams, about setting up 466
publications

See Release Manager, technical 
publications

purchase orders, about viewing orders 
arriving from external locations 373

Q
Qualified Lines subview, about using 370
quality assurance

See change requests, logging by quality 
assurance

quality management
See also individual change requests 

entries
area-subarea combination, adding 430
best practices 415
change requests, logging 419
features of 413
list of values, setting up 428
overview 413
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process example 416
release product builds, releasing 432
roles and responsibilities, about setting 

up 427
setup and maintenance, list of 418

querying
closed change requests, querying 

for 448
Dispatch Board predefined queries, about 

and list of 193
Dispatch Board, using with legacy 

data 193
existing change requests, querying 

for 434
unassigned change requests, querying 

for 438
Quota field, about 61

R
readings (meter) and triggers 536
Readings view

Activities screen, about using 108
Assets screen, about using 509

receipts
All Unknown Receipts view, about 

using 375
Line Items subview, about listing items 

received in 374
Receive Orders views

Line Items subview, about using 374
Received Line Item subview, about 

using 374
Receiving screen, about using 373
Serial Numbers subview, about 

using 374
Receive Unknown view, about using 375
Received Line Item subview, about 

using 374
receiving

See also shipping
hierarchical assets, considerations 360
line items for all orders, reviewing 364

line items with incomplete 
documentation, reviewing 365

overview 358
pending orders (purchase, repair and 

return material), viewing 373
receiving an order 363
repaired items from vendor, 

receiving 363
Unknown Receipt records, adding 364
validations for transactions 359
viewing received orders 373

Receiving screen
All Pending Orders view, about 

using 373
All Unknown Receipts view, about 

using 375
Line Items Receipts view, about 

using 374
Receive Orders views, about using 373
shipping and receiving, about using 

for 373
recommended parts, about and repair 

activities 86
recommended tools, about and repair 

activities 86
record ID

alternative values for 65
numbering, about 64

Recost view, about using 509
recurring charges, about 247
registration of assets 491
Related Solutions view

service support, about associating 
solutions records towards 
resolution 82

Solutions screen, about associating a 
solution with solution records 83

Relationships view
Assets screen, about using 511
Inventory screen, about and fields 

(table) 349
Pending Orders view, about using 407

release features
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creating 470
engineering subtasks, adding 475
engineering tasks, linking to 473
new features and subfeatures, 

adding 470
technical documentation, linking to 483
test plans, linking to 476

Release Manager
access lists, role of 466
activity templates 469
administrator setup procedure 

process 462
area-subarea combinations, adding 485
business scenarios 459
engineering procedures overview 462
features, creating 470
list of values, setting up (table) 467
maintenance procedures 464
marketing procedures overview 462
overview 454
product prototypes, adding 485
product release, process diagram 458
product release, process overview 457
project teams, setting up 466
quality assurance procedures 463
releases, types of 465
Special Tag, list of values (table) 469
Status field, about setting up and 

example 467
structure diagram 455
subfeatures, creating 470
technical publications procedure, 

overview of 463
test strategies, creating 478

Release Manager, engineering
procedures overview 462
subtasks, adding 475
tasks, linking to features 473

Release Manager, marketing
MRDs, adding 472
MRDs, associating features to 472
procedures overview 462

Release Manager, technical publications

activity plans, adding 484
features, adding and linking to 483
procedures, overview of 463

Release Manager, test plans
creating and linking to 476
updating 487

release product builds, adding 432
repair history, verifying for a product 57
repair items

good items, returning to inventory 564
receiving items, overview 558

repair numbers, viewing 310
repair orders

creating 569
external locations, about viewing orders 

arriving from 373
Repair Pick Ticket view, about 369
Repair subview, about using 310
repaired items

Repair Pick Ticket view, about using to 
view 369

vendors, receiving from 363
repaired part, returning repaired parts to 

customer 570
repairs

activities and activity plans, 
generating 567

activities, recording time and 
expenses 570

activities, viewing and updating 568
asset swapping during repair 564
asset’s repair history, viewing 570
assets, reviewing for selected asset 499
customers, shipping to 564
defective items, processing for 

repair 566
defective part, shipping to external repair 

provider 569
defective parts, receiving 558
defective parts, receiving by stock 

transfer 567
defective parts, receiving over the 

counter 566
622 Siebel Field Service Guide Version 7.5, Rev. A



defective parts, tracking movement 
of 568

inventory transactions, about 560
pending orders, viewing 373
received repair order, viewing 373
repair activities and activity plans, 

about 559
repair activities, setting up 565
repair histories, about attaching to 

assets 560
repair number, about 559
repair order, creating 569
repair orders, about 560
repair records and orders, linking 568
repair records, creating 567
repaired or exchanged part, returning to 

customer 570
reports, list of 573
serialized product numbers, about 

generating 559
service contract scheduling 

concerns 176
shipping, third-party vendor ships to 

customer 562
third-party vendor, received from 562
third-party vendors, repairs sent to 561
workflow process steps 556

Repairs screen
using, about 572
warranties, about using for 527

Repairs view
assets, about using for 511
repairs, about using for 574

replacement cost of asset, calculating 501
replenishment

See also cycle counting; fulfillment; 
Replenishment Engine

inventory location and vendor, 
associating 401

inventory location relationships, 
setting 399

inventory, procedures for 401

maximum and minimum stock levels, 
setting 399

orders, verifying pending 401
overview 393
Pending Orders view, about viewing 

internal orders 407
Pending Orders view, about viewing 

pending orders 407
restocking orders 348
Source Locations subview, about 

identifying sources for target 
locations 407

Target Locations subview, about listing 
target locations 407

Vendors view, about viewing vendors by 
location 407

vendors, defining 399
Replenishment Engine

See also replenishment
about 38
configuration parameters (table) 394
Generate Orders view, about automatic 

order generation 406
implementation logic, setting 396
logging levels, modifying 593
methods to invoke 398
overview 393
parameters (table) 396
system preferences (table) 394

reports
activity reports (table) 114
activity reports, described 114
agreement reports, viewing 242
barcode, printing in 582
barcodes, changing fonts for 587
Customer Invoice report 273
Cycle Counting Detail report 412
inventory reports, list of 354
inventory status reports, generating 338
invoice report 273
repairs, list of 573
service inventory reports. list of 354
service, list of 61
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shipping 372
resolution code, recording for service 

activity 53
resolution documents

See also solutions
editing 82
solutions, adding to 79

Resolution Documents view, about 83
resources, additional 24
Response Time metric, about using 235
Return Material Authorizations (RMAs)

See also inventory; repairs
defective part, receiving with an 

RMA 566
described 556
external locations, about viewing orders 

arriving from 373
pending orders, viewing 373
received RMA, viewing 373
repair record, associating with 568
RMA repair and return, about shipping to 

a customer 564
revision history 25
Roles view, about 350
ROs (repair orders)

See repairs

S
S_SHIPMENT table and Generate 

PickTickets command 284
S_SYS_PREF table, about system 

preferences 287
S_ZIPCODE table

geocode data, importing 137
schedule exceptions, defining 203
Schedule Hours view, about using to define 

day and time periods 131
Schedule view, about and fields 

(table) 110, 170
schedules

See also Service Administration screen
creating and setting schedule hours 128
defined 120

employee, associating a schedule 
with 130

employee, defining exception hours 130
exceptions and exception hours, adding 

to 129
Optimization Engine methods 155
service region, associating schedule 

with 130
schedules, making changes to

See also individual schedule entries
about 148
caution, about making manual 

changes 149
freezing time or assignment, flags 149
service regions, moving activities 

between 150
scheduling

See also Dispatch Board; Optimization 
Engine

activities, tools for assigning and 
scheduling 121

business requirements 122
optimization, levels of 177
optimizing for high-traffic areas 177
server inventory system, integration 

with 123
service regions, defining schedules 

for 126
time periods, example 125
time periods, list of 124
wireless updates, best practices 

examples 123
Scheduling Administration screen

buttons and commands (table) 162
Cost Functions view, about 164
Parameter Sets view, about 165
scheduling and dispatch, about using 

for 160
Service Regions view, about 160
Time Windows view, about 165

scheduling, setting up
See individual schedule entries
guidelines 134
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service regions, setting up 135
universal time codes, about and list 

of 138
serial numbers

allocating inventory, about selecting 
for 369

assets, serialization of 491
Counting Serial Numbers subview, about 

input serial numbers 411
populating in a cycle count 392
Serial Numbers subview, about recording 

serial/asset numbers 374
transactions and 323

Serial Numbers subview
Pick Ticket view, about and fields 

(table) 369
Receive Orders views, about using 374

serialized orders, receiving 363
serialized products

creating (procedure) 332
nonserialized, compared to 323
repair number, about generating for 559
serial numbers, about for Allocated line 

items 369
treatment of 117

server inventory system, about integration 
with 123

Server Key Mappings view, about and fields 
(table) 168

server processes, setting up
about and server regions 157
ABS and Optimizer, interaction with 157
multi-processor support 158

server requests, invoking the Preventive 
Maintenance Engine 539

servers component aliases, about and 
table 592

service activities
billing exception, defining 204
expense exceptions, defining 204
resolution code, recording for 53
skills required to complete, 

recording 100

steps, recording additional 
recommended 99

viewing 70
service activity template, creating 46
Service Administration screen

See also schedules
All Exceptions view, about 132
All Schedules view, about 131
cycle counting and replenishment, about 

using for 402
Exception Hours view, about 133
Inventory Location Types view, about and 

fields (table) 402
Parts Movement Administration view, 

about using 342
preventive maintenance, about using 

for 547
Schedule Hours view, about 131
scheduling and dispatch, about using 

for 131
service industry, about using for 342
Service Inventory view, about using 342
Service Request Template Activities view, 

about using 547
Service Request Templates view, about 

using 547
Warranties view, about and fields 

(table) 523
warranties, about using for 523

service agreements
account, verifying for 49
service, verifying for 49

service analysis charts, list of 74
service calendar

See also schedules
Siebel Scheduler, about and features 33

service center, handling sequence of 
inbound calls 31

Service Details view
Inventory Options subview, about and 

fields (table) 403
Products screen, about using 403
Service screen, about 528
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Substitutes subview, about using 404
service hours

See also schedules
defining 203
viewing by entitlement 73

service inventory
cycle counting parameters, viewing for a 

location 338
flow of goods (diagram) 312
hierarchy structure, about 318
inventory status reports, generating 338
inventory type, defining 333
inventory, scrapping 341
locations, overview and location 

types 316
overview 312
and product serialization 323
products, adding to inventory 334
reports. list of 354
setting up, sample structure 

diagram 314
setup diagram 317
status, verifying using the Inventory 

screen 338
status, verifying using the Part 

Browser 338
structure diagram 314
transactions, creating manually 339
truck inventory 318
vendors, associating with inventory 

locations 335
service inventory levels

creating (procedure) 334
defining (procedure) 336

service inventory locations
creating (procedure) 334
defining relationships between 

locations 336
employee positions, associating 

with 335
organizations, associating with 335
tracking, methods of 320
vendors, associating with locations 335

service inventory transactions
about 325
asset transactions, about 324
asset, adding to 339
destination mobile client, moving item to 

another trunk 340
mobile client transactions, 

committing 340
source mobile client, moving item to 

another trunk 340
stock transfer or over-the-counter 

transaction, receiving product 
as 339

transaction types, defining 336
Service Inventory view

Inventory Level Categories subview, 
about using 344

Inventory Location Types subview, 
about 342

Inventory Transaction Types subview, 
about using 343

service metrics, setting up 47
service orders, allocating parts, 

manually 298
service parts, recording movement in the 

field 98
service ports, defining 278
service pricing, grouping multiple 

products 219
Service Profile view, about 61
Service Providers subview, about 

using 523
service providers, identifying for a 

warranty 521
service regions

See also service regions, setting up
about and defining scheduling 126
Dispatch Board, adding to 189
schedule, associating with 130
schedules, about and ABS and 

Optimizer 139
schedules, about defining for 126

Service Regions view
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Activities view, about 163
Constraints Set view 168
Cost Functions view, about 165
Cost Functions view, about using 164
Employees view, about 163
regions, using to define in terms of 

employees 160
Time Windows view 166
Zip Codes view, about 164

service regions, setting up
See also Scheduling Administration 

screen; service regions
about 135
break time, recording 147
breaks, defining and allowing for 

activities 147
caution, defining service area and ZIP 

Code 135
employee availability and schedules 141
employee travel conditions and travel 

time, about 148
geocode data and ZIP Codes, about 136
geocode data, importing 137
geocode data, specification for 137
parameters, scheduling 150
schedules, making changes to 148
server processes, setting up 157
service region data, loading and 

reloading 139
service region schedules 139

service reports, list of 77
service request activities

activity details, viewing 70
activity plan, defining 70
new activity, adding 99
viewing using the Calendar view 71

Service Request Template Activities view, 
about using 547

service request templates
Actions view, about associating PM plans 

with 552
preventive maintenance service 

request 537

preventive maintenance templates, 
creating for 544

Service Request Templates view, about 
using 547

service requests
See also individual service request entries, 

and searching; services
activity plan, associating with 51
activity, associating with 51
agent committed time, calculating 66
asset swapping during repairs 564
asset, generating plans for 545
attachments, viewing and directories 

written to 70
audit trail records, viewing 71
billable activities, recording 256
change request, associating to 50
change request, generating from 436
completed service request, verifying valid 

hours for 50
correspondence, generating for 55
decision issues (explanations), 

viewing 71
defined 30
entitlement, selecting for 49
entitlements, verifying and selecting an 

entitlement 216
FAQ and solutions, about associating 

to 74
invoices, creating automatically 258
invoices, logic for generating 246
Invoicing Engine, about using 260
logging 49
messages to field personnel 71
numbering, about and displaying 

alternative values 64
organizational visibility 63
parts and tools, recording additional item 

to complete activity 97
performance, viewing benchmarks 73
problem resolution, about using Solution 

Administration screen 47
processing workflow 44
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related orders, viewing 74
repair record, associating with 568
service activity template, creating 46
service details by asset, viewing 72
service hours by entitlement, 

viewing 73
service metrics, setting up 47
Service Request record fields (table) 63
Service screen, tasks summarized 62
Verify button, about 65
viewing 237
warranty, verifying for 520

Service Requests view
Solution Administration screen, about 

associating service requests to a 
solution 82

Solutions screen, about associating a 
selected solution with a service 
request 83

service requests, logging
See also individual service request entries, 

and service
active entitlement, selecting for 49
activity plans, associating 51
asset change request, logging 50
service agreement and entitlements, 

verifying 49
verifying caller identity 60
warranties, verifying for the asset 50

service requests, solving
See also individual service request entries, 

and services
change requests, verifying associated for 

a product 57
change requests, verifying previous and 

related requests 57
explanations (decision issues), finding 

for 58
product repair history, verifying 57
related service request, associated service 

request with 57
repair history, verifying for a product 57
solution, associating 79

symptom codes, about 73
service requests, updating

See also individual service request entries, 
and service

activities, updating for a service 
request 52

asset, adding to service request 52
assets, adding 52
assets, adding additional to 52
assets, associating multiple with 52
closing service request 55
field part movements, verifying 53
invoice, generating and printing 54
invoice, generating and printing for 54
orders linked to service requests, 

reviewing 54
orders, reviewing associated with service 

requests 54
performance measurements, viewing for 

a service request 54
performance metrics, viewing 54
resolution code, recording for a service 

activity 53
symptom and resolution codes, 

recording 53
service schedules

ABS and Optimization cache 
management 139

associating with service regions 130
entitlements, associating 216

Service screen
Activities view, about and buttons 

(table) 169
appointment booking, conditions 

for 169
appointment, conditions for 

cancelling 170
scheduling and dispatch, about using 

for 169
warranties, about using for 528

service support
problem resolution views 47
service activity templates, creating 46
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service metrics, setting up 47
service support requests, viewing customer 

surveys 73
service support, setting up

problem resolutions, about using Solution 
Administration screen 47

service activity template, creating 46
service metrics, setting up 47

service, logging requests for
See also individual service requests entries
account, contact, and asset, verifying 48
activity plan, associating with a service 

request 51
activity, associating with a service 

request 51
change request, associating to a service 

request 50
completed service request, verifying valid 

hours for 50
entitlement, selecting for a service 

request 49
service agreements and entitlements, 

verifying 49
service request, logging 49
warranties, verifying for an asset 50

SFPrevMnt component request parameter, 
about 540

shifts, about and rate types 141
Shipped Line quantity and De-Allocation 

transactions 368
Shipped Line subview, about and fields 

(table) 368
shipping

See also pick tickets; receiving
agreements, adding information to 211
costs, about using Consolidation view to 

reduce cost 370
De-Allocate transaction 357
hierarchical assets, considerations 360
pick ticket generation, process 

overview 356
pick ticket, finding for line item 361
pick tickets, consolidating 362

Process Shipment button, processes 
invoked 357

reports 372
Shipped Line quantity conflict 368
shipping, procedure 361
validations for transactions 359
waybills, filling in for pick tickets 362

shipping and receiving, about 37
Shipping screen

Pick Tickets view, about using and fields 
(table) 366

shipping and receiving, about using 
for 366

ShowBarcodeToolbar parameter, 
about 580

Siebel Appointment Booking System
See ABS

Siebel data model and third-party invoicing 
software, about extending the data 
set 278

Siebel Field Service
components, list of 32
Dispatch Board screen, about 33
inbound service center calls, handling 

sequence 31
overview and process scenarios 30
Siebel Scheduler, about and features 33

Siebel Field Service Analytics Applications, 
about 37

Siebel Invoice ASI, about 276
Siebel Invoice business service, about 276
Siebel Professional Services, about 

integration with Siebel Field 
Service 38

Siebel Remote
audit trail, about using 71
synchronizing, about 337

Siebel Scheduler, about and features 33
Siebel Shipping and Receiving

about 37
Siebel Short Messaging Service (SMS) 

Adapter, about 37
Siebel Wireless, about using 37
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skills
recording required skills 100
skills-based routing, about 142

Soft constraints, about 135
Solution Administration screen

See also solutions; Solutions screen
Change Requests view, about 82
Related Solutions view, about 82
Resolution Documents view, about and 

editing documents (procedure) 82
Service Requests view, about 82
service support, about using for 81
Solution Categories view, about 82
Solutions list, about and views 

(table) 81
views (table) 47

Solution Categories view, about 82
solutions

See also Solution Administration screen; 
Solutions screen

adding a solution 79
change request, associating 80
change request, associating with a 

solution 80
multiple solutions, associating 79
problem resolution views 47
resolution codes 53
resolution document, adding to 

solution 79
resolution documents, adding 79
service request, associating 79
service request, associating with a 

solution 79
Solutions module, about using 78
Solutions screen

See also solutions
Change Requests view 84
Customer Satisfaction Survey view, 

about 84
Related Solutions view, about 83
Resolution Documents view, about 83
Service Requests view, about 83
service support, about using for 83

Solutions view, about 83
Solutions view

Service screen, associating existing 
solutions to a service request 74

Solutions screen, about describing name 
and description of a solution 83

Source Locations subview, about 
using 407

SRVRMGR command, about 592
Start and End Date fields, about 61
Steepest search optimization method, 

about 156
Steps view, about and fields (table) 112
Substitute Products subview

Product Field Service Details view, about 
and using 305

Product Service Details view, about 
using 345

Products screen, about 117
viewing 115

Substitutes subview
Product Inventory view, about using 351
Service Details view, about using 404

substitution, conditions for auto-
substitution 290

Survey view, about 73
symptom codes, service requests 73
system preferences

Cycle Counting Engine, changing 387
Cycle Counting Engine, location and list 

of 383
Dispatch Board 185
Fulfillment Engine and Part Locator 

Engine, about and table 287
Fulfillment Engine, table of 291
Preventive Maintenance Engine 

(table) 540
Replenishment EngineS_SYS_PREF 

table 394
Verify button 67, 202

System Preferences BusComp, about and 
table 287
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T
Tabu search optimization method, 

about 156
Target Locations subview, about using 407
technical publications

See Release Manager, technical 
publications

templates
See also activity templates
activity templates, associating with 

preventive maintenance plans 544
activity templates, setting up 469
service activity template, creating 46
service request template, creating for 

preventive maintenance 544
test passes

change requests, associating with 481
linking to test plan 480
results against test plan, viewing 482

test plans
activity plans, adding to 478
creating and linking to 476
results against test passes, viewing 482
test pass, linking to 480
test strategies, associating with 479
updating 487

test strategies
creating 478
test plans, associating with 479
updating 487

third-party invoicing software
disabling 278
service port definition 278
Siebel data model, extending to 

accommodate 278
Siebel Invoice integration, overview 276
terms, invoicing integration 276
Web service configuration 277
workflow, about defining 279

third-party vendors
asset swapping during repair 564
defective parts, shipping to 569

repaired items, receiving 363
repairs, received from 562
repairs, sent to 561
repairs, shipped directly to 

customer 562
replenishment, defining for 399
Vendors view, about viewing by 

replenishment location 407
Threshold subview, about and fields 

(table) 550
Threshold triggers, measurements and 

reading 536
time and exception pricing 222
time codes, about and list of 138
Time Interval subview, about and fields 

(table) 549
Time Interval triggers, about 534
time recording

logging for service activities 96
repair activities, recording for 570

Time Tracker view
field service activities, using for 112
invoices, about using for 261

Time Window Details view, about 165
Time Windows view

Scheduling Administration screen, about 
and using 165

Service Regions view, about 166
Time Window Details view, about 165

tracing
Cycle Counting Engine, configuring 390
levels, about setting for Cycle Counting 

Engine 385
Transaction view, about using 510
travel

conditions and travel time, about and 
setting fields 148

employee travel conditions and travel 
time, about and field values 148

triggers
Event triggers, about 536
measurements and readings, about 

associating with an asset 536
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preventive maintenance plans, defining 
for 543

rules and examples 533
Threshold triggers, measurements and 

reading 536
Time Interval subview, about setting time 

interval 549
time interval triggers, about 534
Usage triggers, about 535

Triggers view
Event subview, about and fields 

(table) 551
preventive maintenance, about using 

for 548
Threshold subview, about and fields 

(table) 550
Time Interval subview, about and fields 

(table) 549
Usage subview, about and fields 

(table) 550
trunk inventory

about 318
database synchronization 318
source mobile client, moving item to 

another trunk 340
verifying 98

turning on alarms for an activity 95

U
Unknown Receipt records, adding 364
Unscheduled Activities list, about and 

table 191
Unspecified Release release type, 

about 432
Upgrade transaction, about 493
Uptime Data view, about using 513
Usage subview, about and fields 

(table) 550
Usage triggers, about 535
usage-based charges

estimated usage, calculation fields 248
invoice charge, about 247

line items, invoicing logic 248
usage-based payment plans

about 225
billing methods 227
defining 199
measurements, defining 227
pricing, defining 200

usage-based pricing, usage data, about 
capturing 509

V
Value view

Assets screen, about using 508
Recost view, about using 509

Variance view, about and fields (table) 411
vendors

asset swaps during repair 564
associating with inventory locations 349
inventory location, setting a vendor 

for 401
inventory locations, associating 

with 335
product, setting up for 399
repair items, receiving from 363
repairs received from 562
repairs sent to 561
repairs, shipped directly to 

customer 562
Vendors view

Inventory screen, about 349
Pending Orders view, about using 407

Verify button
agent committed time, calculating 66
Service screen, about using 65
system preferences (table) 67
system preferences for verifying 206
system preferences, setting 202

W
warranties

asset requiring service, verifying for 50
asset, verifying for 50
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asset, verifying warranties and related 
information 520

defective parts, verifying warranty 
status 522

order, verifying for 521
overview 516
product, verifying warranties for 520
products, checking coverage 520
service providers, identifying 521
service request, verifying for 520
warranty recovery, tracking 522

Warranties view
Products screen, about using 526
Products subview, about using 523
Service Administration screen, about and 

fields (table) 523
Service Providers subview, about 

using 523
warranties, setting up

asset, associating with 
automatically 518

assets and warranties, associating 517
covered products, specifying 517
new warranties, creating 517
order line items, associating 518
warranties and warranty service 

providers, associating 517

Warranties screen and views 523
Warranty subview

Line Items view, about using 310
Orders screen, about using 525

Warranty view, about using 524
Waybill view, about and fields (table) 370
waybills

See also pick tickets
about 356
pick tickets, filling in 362
Waybill view, about using to associate 

with pick tickets 370
Web services, configuring for invoice 

integration 277
wireless application protocol (WAP)-

enabled phone, about using Siebel 
Wireless 37

Workflow Manager and scheduling 180
workflow processes, about creating for 

invoicing functions 279

Z
ZIP Code

about 136
data cleansing, about 138

Zip Codes view, about list Zip Codes in a 
service region 164
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